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Workforce Management 8.5 Administrator's
Guide
Welcome to the Workforce Management 8.5 Administrator’s Guide. The topics in this guide introduce
you to the concepts, terminology, and procedures relevant to Genesys Workforce Management.

Find the information you need by clicking the topic links below or by using the Table of Contents in
the left-side navigation bar.

Orientation
Find information that provides an
overview of Workforce Management.

Overview
Architecture
Integration
High Availability

Deployment
Find procedures that will help you to
deploy WFM manually or by using
wizards.

Planning
Installing Workforce Management
Starting and Stopping WFM
Using ETL Database

Daily Operations
Find information about setting up and
performing WFM Daily Operations in your
environment.

Scheduling
Forecasting
Monitoring
Calendar Management

Localization
Find procedures and other information
about how to localize your WFM
deployment.

Genesy Localization (Language Packs)
Self-Localization

Reports and Metrics
Find information about WFM reports,

WFM Primers
Find information about how to use WFM

Workforce Management 8.5 Administrator's Guide
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metrics, and use ETL Database to enable
other customized reporting.

Schedule Summary View and Report
Contact Center Performance Report
Agent Adherence Report

Primers to optimize the efficiency of your
contact center.

Multi-Forecasting
Time Off
Overlays

Workforce Management 8.5 Administrator's Guide
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About Workforce Management
Genesys Workforce Management (WFM) provides the tools that enable contact center managers to
better manage their workforce. It is designed for the true multi-media, multi-site environment,
providing optimal schedules for multi-skilled agents who may handle customer interactions of
different media types. Agent preferences, skills, proficiency, customer segmentation, historical
trends, such as e-mail response times, and outbound call lengths are all considered within the
forecast, schedule, and adherence components.

WFM is designed to integrate tightly with the Framework components of the Genesys Customer
Interaction Management Platform. Agents and their skill sets are entered and maintained in Genesys
Configuration Manager, so there is no need to re-enter this information in a stand-alone workforce
management application. This integration also allows contact centers to leverage real-time statistics,
contact-center performance, and agent adherence data across all communication channels.

Workforce Management consists of the following components:

• WFM Web (with separate interfaces for Supervisors and Agents)
• WFM Server
• WFM Daemon
• WFM Builder
• WFM Database Utility
• WFM Configuration Utility
• WFM API.

WFM also requires a database to store all the relevant configuration, forecasting, scheduling, agent
adherence, performance, and historical data.

Review these additional topics to get a high-level overview of Workforce Management:

• Overview
• Architecture
• Integration
• High Availability

About Workforce Management
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Overview
Genesys Workforce Management (WFM) provides a sophisticated package of contact-center
management tools. It provides additional value through its tight integration with Genesys Framework
and Genesys Routing. Key functionality is presented through a web interface, which increases its
accessibility and flexibility.

WFM is a strategic asset in advancing your goals of providing the highest-quality customer service for
the best value. In today’s contact center, interactions take a multitude of forms, and agents may
have a broad variety of skills. WFM creates forecasts and schedules for multi-skilled agents who are
handling interactions in a variety of media, as well as for a more traditional single-skilled agent pool
handling mostly voice interactions.

WFM enables Supervisors to create proposed future schedules, Agents to bid on those schedules, and
Supervisors to integrate the bids into real schedules.

WFM enables agents to request time off and specific working hours, and also to trade schedules with
other agents, without sacrificing optimal staffing levels. Flexible agent scheduling can help improve
agent retention, resulting in fewer new hires who require training before they can become effective
promoters of your business.

WFM provides real-time contact-center performance and agent-adherence monitoring. You can
immediately adjust the number of agents working on a specific activity if you see that the service-
level statistics for that activity have fallen out of the acceptable range. Or, if the service levels are
more than satisfactory, you can encourage agents to spend additional time up-selling new products,
move them to another activity, or even give them time off.

The next few topics provide a high-level overview of the WFM features and functions. In New In this
Release you will find recent additions and changes to WFM functionality that may be of particular
interest to those migrating from an earlier release of Genesys WFM.

The information in this Administrator's Guide:

• Is valid only for the 8.5 release(s) of this product.
• Introduces the product, lists important features, and presents the WFM architecture.
• Offers deployment-planning recommendations and considerations.
• Explains how to configure and install the Workforce Management (WFM) components.
• Explains how to start and stop all components.
• Explains how to use the WFM Database Utility.
• Provides troubleshooting suggestions.
• Includes a list of WFM-specific terms and their definitions.

Overview
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Other topics of interest:

• New In this Release
• High Availability
• Integration
• Daily Operations

Important WFM Features

WFM features and functionality:

Forecasting
Scheduling
Calendar Management
Policy Objects
Multi-Channel Adherence

WFM features and functionality:

User Security
Notifications
Performance
Adherence
Reports

Overview
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New In This Release
This topic contains a brief description of new features in the Genesys Workforce Management (WFM)
8.5 release.

Multi-Channel Adherence

WFM supports multiple media channels to track agent real-time states in the Web for Supervisors
Adherence module; WFM Agent Adherence and Agent State reports now include historical multi-
channel agent states and non-adherence events for each channel separately.

For more information about this feature, see Monitoring Workforce Performance and Adherence and
How WFM Calculates Adherence

Time-Off (Vacation) Bidding

Time-off requests are processed within a configured bidding period for selected date ranges. When
this feature is enabled (default, WFM delays granting agent time-off requests (that fall within the
bidding period) until the processing date for that bidding period. On that date WFM grants time-off
requests, based on seniority and/or rank. If there are available slots in time-off limits, WFM processes
any time-off requests that were not granted, based on their submission order.

For more information about this feature, see Time-Off Bidding.

Single Sign-On

Genesys Platform on Demand (PoD) users (administrators, supervisors and
agents) can now use a Single Sign-On (SSO) interface, which acts as a portal to
the underlying Genesys components, including WFM. SSO provides a unified and
simplified user experience without restricting the functionality of the underlying
systems. Users navigate to a central landing page (Genesys Hub) that contains
links that point to various Genesys platforms, based on their level of access
permissions. For example, administrators see different links than supervisors or
agents. Administrators or supervisors provide their agents with the landing page
URL. SSO simplifies user provisioning for administrators and provides a unified
security model for all users. See more.. [+]
Genesys Hub is the main access point to all Genesys Engage cloud user interfaces. Interfaces on the
Hub are divided into three separate categories that can be separated by clicking corresponding
category links at the top of the Hub:

• User interfaces—User interfaces are standard Contact Server user interfaces, such as Desktop,
Workforce Management, and Reporting. These interfaces can be used by Contact Center agents,
supervisors, and managers.

• Administration interfaces—Administration interfaces can be used by Contact Center administrators,
supervisors, and managers to configure users, resources (such as IVR), and applications based on their
roles.

Overview New In This Release
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• Support interfaces—Support interfaces can be used by authorized Contact Center administrators to
submit requests with Genesys Customer Care and to view service status and schedule.

Supported Operating Systems and Browsers

• Microsoft Windows Server 2012, native 64-bit
• Microsoft Internet Explorer, version 11

A complete list of the operating systems and databases that are supported by WFM can be found in
the Genesys Supported Operating Environment Reference Manual.

Overview New In This Release
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Architecture
This topic explains the interconnections among the various components of Genesys Workforce
Management (WFM) and how WFM interacts with the Genesys Framework. It includes information
about WFM components, data flow, and the Genesys Framework servers to which WFM connects in
the following sections:

• Applications
• Servers
• Related Topics

Workforce Management (WFM) functionality is provided via four graphical user interface (GUI)
applications and four servers. See Data Flow—WFM Components for a graphic overview of all the
components and their connections.

Applications

The user-facing applications are:

• WFM Web for Supervisors (browser-based)
• WFM Web for Agents (browser-based)
• WFM Configuration Utility (client application)
• WFM Database Utility (client application)

Servers

These applications are supported by these servers:

• WFM Server
• WFM Data Aggregator
• WFM Builder
• WFM Web
• WFM Daemon (server/background process)

In addition, you need to use a web server as a container for the WFM Web server. Genesys WFM
supports Tomcat and WebSphere. WFM does not include Tomcat in its installation package. You must
obtain and install it separately.

Overview Architecture
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Important
For supported versions of WebSphere and Tomcat, see the Genesys Supported
Operating Environment Reference Manual.

Related topics:

• Components and Connections
• Data Flow

Overview Architecture
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Components and Connections
This topic contains descriptions of the Workforce Management (WFM) components and connections.

Web

WFM Web is a server application that is hosted on a servlet container and provides content for two
Web browser-based user interfaces, one for Supervisors and one for Agents. The appropriate
interface opens after login, depending on the login information you enter.

• Web for Supervisors—Includes calendar management, forecasting, scheduling, real-time agent
adherence, contact-center performance statistics, configuration of e-mail notifications, and reporting.
These functions are all entirely accessible through any computer with a supported browser and network
access.

When you open WFM Web for the first time in your browser, it installs a Java applet on your machine.
This applet provides WFM functionality and is presented in the user’s web browser. An updated version
of this applet is downloaded to each user’s machine each time a more recent version of WFM Web is
installed on the web application server.

Important
There is an increased demand on the web server when WFM Web is deployed, because it now provides almost
all client user-interface functionality. In addition, WFM Web is also the web server component that generates
reports. To find sizing recommendations for WFM Web server, see the Genesys Hardware Sizing Guide.

• Web for Agents—Enables contact center managers to easily distribute schedule information to their
employees and provides agents with proactive scheduling capabilities, such as entering schedule
preferences, planning time off, schedule bidding, and trading schedules.

Configuration Utility

Use this application to configure sites, business units, shifts, task sequences, and most other
Workforce Management database objects. Also use it to set constraints such as site rules, working
hours, and time-off accrual rules; to define contracts; and to set the week start day and the default
time zone.

Back to Top

Overview Architecture
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Database Utility

Use this application to create and format a new database (for new users or those migrating from a
previous WFM release), to migrate your existing data to the new database, and to perform database
maintenance and cleanup.

You also use the WFM Database Utility to update the WFM database, which is a common task that
must be done as part of an upgrade to a newer WFM release. If you are upgrading from WFM 7.x to
the most recent 8.5 release, you will need to perform a database update.

Important
If you are migrating from an earlier release to WFM 8.5 and want to find important
advisories about the database migration process, see the procedures provided in the
“Workforce Management Migration Procedures” chapter of the Genesys Migration
Guide.

Servers

The GUI applications are supported by the following servers:

• WFM Server—Acts as the main data and application services source and locator for WFM clients.
• WFM Data Aggregator—Automatically synchronizes configuration data, collects historical data, and

provides real-time agent-adherence information to users of WFM Web for Supervisors.
• WFM Builder—Builds WFM schedules.
• WFM Web Server—Serves content for the Web browser-based GUI applications and generates reports

upon request from users of WFM Web for Supervisors.
• WFM Daemon—can be configured to send (through a customer-supplied SMTP server) e-mail

notifications to agents and supervisors.

Back to Top

Database

WFM also requires a database to store all the relevant configuration, forecasting, scheduling, agent
adherence, performance, and historical data.

Important
If you have been using WFM 6.x, you must migrate your existing data into a new

Overview Architecture
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database using the WFM Database Utility before starting to use WFM 8.5. For details,
see the “Workforce Management Migration Procedures” chapter in the Genesys
Migration Guide.

Connections

WFM connects to the following Genesys Framework servers:

• Stat Server—Provides statistical data to WFM Data Aggregator.
• Configuration Server—Provides Genesys’ centralized configuration information to the WFM

Configuration Utility, and authenticates all WFM users and components.

WFM works in single-site environments or across multi-site enterprises.

Back to Top

Overview Architecture
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Data Flow
The figure below Data Flow—WFM Components shows the Workforce Management components and
their interrelationships. It also shows how WFM draws on Configuration Layer data and statistical data
that Stat Server provides.

Important
Tomcat and WebSphere, the supported web server containers, are not Workforce
Management components. This graphic includes them to show how they fit into the
total Workforce Management architecture.

Overview Architecture
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Figure: Data Flow—WFM Components

Component Connections

Table: WFM Component Connections shows the connections that are configured on the Connections
tab of each component’s Application object. These connections offer an alternative, but
complementary, way of understanding the Workforce Management architecture. Here are some
things to consider:

• As you can see, WFM Server acts as a hub, connecting to, and being connected to, every component.

Overview Architecture
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• The WFM database (represented in Table 1 by its Data Access Point (DAP) (see Create a Data Access
Point) forms a different sort of central hub, with many of the components connecting directly to it.
Others connect indirectly, through WFM Server.

• Through its connection to Stat Server, WFM Data Aggregator provides one point of interaction between
Workforce Management and the Genesys Framework. All components are connected to the
Configuration Layer in the sense that they exist as objects in the Configuration Database. The WFM
Configuration Utility draws actively on this connection to import configuration objects, such as agents,
agent skills, and time zones, into the WFM database during synchronization.

Important
The WFM Configuration Utility accesses large amounts of data from the WFM
Database during its normal operation. As a result, users of the WFM Configuration
Utility who are not co-located on the same LAN as the WFM Database will experience
slow response times when accessing certain parts of the software. Therefore, Genesys
recommends that the WFM Configuration Utility be deployed over Citrix or Windows
Terminal Services for those remote users. Users of the WFM Configuration Utility who
are on the same LAN as the WFM Database should not see this issue with application
response time.

• If you are using Management Layer, the Message Server connections and the WFM Solution object
specification of the instance of SCI used to control the solution also connect Workforce Management
with the Genesys Framework.

Table: WFM Component Connections

Component
name Connections to:

Server Builder Daemon Data
Aggr. Web DAP Stat

Server
Msg
Server

Server (X+) X+ X X (X)
Builder X (X)
Daemon X (X) (X)
Data
AggregatorX X X (X)

Web X (X) (X)
Config
Utility X X

Database
Utility X X

Legend:

• X—single connection
• X+—one or more connections

Overview Architecture
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• (X)—optional connection

Footnotes to Table:

1. Configure the Message Server connections if you are using Management Layer to run Workforce
Management.

2. WFM Server may connect to other instances of WFM Server if you are using an environment with a
number of WFM Servers and want to create schedules for all the sites they serve. For information about
how to create this configuration, see Configuring Multiple WFM Server Applications and Multi
Forecasting Primer.

3. You can configure and connect to multiple instance of WFM Builder. See Configuring Multiple WFM
Builder Applications.

Important
The WFM Daemon background process connects to Genesys Configuration Server for
authentication, configuration and connection to other Genesys servers’ information. It
retrieves all data required for its work from WFM Server.

Overview Architecture
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Integration
In this topic, find out how WFM integrates with other Genesys Solutions and about the WFM
Integration API.

WFM Integration API

The WFM Integration API enables you to create a client application that, in turn, enables you to
retrieve WFM information and make certain changes to WFM objects.

For example:

• The WFM Schedule includes planned meetings, trainings, time-off, and so on for all agents. You can use
the WFM Integration API to facilitate integration of this WFM data with third-party human resources
applications and PIMs such as Outlook.

• You can take information from third-party applications and incorporate it in WFM without having to
manually re-enter each update into WFM.

• You can retrieve WFM data and use it to generate custom reports using your preferred reporting tool.
• You can read agent schedule information, such as the total number of paid hours an agent worked

during a particular day, and automatically feed this information into a payroll system.

Important
Not all WFM functionality is available through the WFM Integration API.

For detailed information about the WFM Integration API, see the Integration API Developer's Guide
(JavaDoc).

Integration With Other Genesys Solutions

Workforce Management is tightly integrated with the Genesys Customer Interaction Management
(CIM) environment.

Configuration Layer Integration
WFM can automatically retrieve agent and skills information from the Genesys unified configuration
environment, reducing the effort needed to maintain the WFM system and removing the chance of
human errors caused by redundant data entry. You can configure WFM to place agents within a site
automatically, based on their switch logins, if the switch is used to represent a site in WFM. Also, you
can easily configure WFM to retrieve statistics from Routing objects (queues, routing points, virtual

Overview Integration
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queues, and so on) within the Genesys platform, reducing the effort needed to support changes in
routing strategies

Management Layer Integration
Management Layer delivers powerful solution-wide control of Genesys solutions from a single access
point. Through Solution Control Interface (SCI), Management Layer provides control and monitoring
functions that allow a user to start or shut down single applications, or an entire solution, in a single
operation and to monitor current runtime status of applications and entire solutions.

Workforce Management is integrated with the Genesys Management Layer, enabling easy solution-
wide configuration, overview of Workforce Management status, and automatic switching to backup
servers if necessary.

If you use Management Layer to control and monitor WFM, each computer on which a Workforce
Management server is installed also runs a Local Control Agent that constantly checks that server’s
status. If a server goes down, SCI signals the user, enabling a prompt response.

Problems are centrally logged for convenient access. For more information on the Management
Layer, see the Management Layer User’s Guide. Management Layer installation and configuration are
described in Genesys Management Framework documentation.

Enterprise-Routing Integration
You can configure Genesys Enterprise Routing (ER) to route calls based on WFM schedules. Doing so
can help ensure a more-balanced multi-skill workload for agents and improved schedule adherence.

Routing strategies can route based on the anticipated availability of an agent. For example,
interactions are not routed to agents immediately before they are scheduled for a break. This
improves agent adherence and leads to better customer service and worker efficiency. Schedules are
created in WFM Web for Supervisors and stored in the WFM database. You configure WFM routing
strategies in Interaction Routing Designer, a user interface provided with ER to create routing
strategies.

Overview Integration
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High Availability
WFM Data Aggregator supports hot-standby high availability. You can install a second Data
Aggregator server as a backup and configure it to take over automatically if the primary server goes
down.

The backup reads the same information as the primary Data Aggregator, so if it is necessary to
switch to the backup, there is no delay or loss of data. At the transition, the backup Data Aggregator
simply starts writing to the database, beginning where the primary Data Aggregator left off.

Because the failure of other WFM servers does not result in critical data loss, they do not support hot-
or warm-standby high availability. However, if you are using Management Layer, you can configure
the Local Control Agents running on the server computers to restart the WFM processes and re-
establish their connections.

Overview High Availability

Workforce Management Administrator's Guide 22



Deploying WFM
A successful Workforce Management (WFM) deployment requires more than installing and setting up
the software. You must design effective strategies to use for translating corporate business rules into
WFM objects and constraints. For this reason, it is important to understand key WFM concepts before
configuring and using the application.

This topic introduces the WFM features and functions you must understand to effectively deploy this
product in your enterprise, and provides procedures to help you install WFM and maintain it after it is
up and running. It includes information about how to complete the following tasks:

Planning your deployment

Installing the WFM components

Starting and stopping WFM

Use the information in these sections to achieve an efficient, customized deployment.

Important
This topic provides a conceptual overview of WFM objects and settings. For software
and hardware prerequisites, see the Genesys Supported Operating Environment
Reference Manual, and the Genesys Hardware Sizing Guide, both of which are
available on the Genesys Customer Care web site.

Deploying WFM High Availability
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Planning
Before configuring Workforce Management (WFM), plan a detailed, suitable combination of
Configuration Manager objects and workforce management activities. This information is the basis for
all subsequent workforce planning and should not be changed. Any changes to the workforce
management activity configuration might compromise the usefulness of historical data. Agents,
users, time zones, and skills are defined as objects in Configuration Manager. These objects are
brought into WFM through synchronization with the Configuration Database performed by the WFM
Configuration Utility.

Carefully consider the relationships among these objects when using them for enterprise planning.
The relationship between skills, configured in Configuration Manager, and activities, created in the
WFM Configuration Utility, is especially important.

Using the WFM Configuration Utility
You configure WFM objects and working rules in the Configuration and Policies sections of the
application. Configuration objects include user security settings, organizations, activities, schedule-
state groups, skills, time zones, and events. Organization rules, contracts, shifts, task sequences,
timeoff types, time-off accrual rules, exception types, meetings, marked-time types, and rotating
patterns are set up in the Policies section.

The WFM Configuration Utility also includes a module that enables you to import and export historical
data.

Using WFM Web
WFM Web for Supervisors provides calendar management, forecasting, scheduling, performance
monitoring, real-time agent-adherence monitoring, and reporting capabilities. The success of your
forecasts and schedules depends considerably on the accuracy and completeness of your
configuration of WFM objects and working rules.

See these topics:

• About WFM Configuration Objects
• About WFM Policy Objects
• Forecasting Considerations
• Scheduling Considerations
• About Performance Monitoring
• About Adherence Monitoring

Deploying WFM Planning
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About WFM Configuration Objects
The Configuration modules of the WFM Configuration Utility and WFM Web enable you to configure
a number of object types. The following sections briefly describe each object type and offer some
considerations to assist you in planning your configuration.

Topics on this page include:

• User Security
• Organization
• Activities
• Skills
• Schedule State Groups
• Events
• Time Zones
• Synchronization
• Procedures

Important
The following sections provide only brief introductions to these objects and focus on
aspects relevant to deployment planning. For a full description, refer to Workforce
Management Configuration Utility Help and Workforce Management Web for
Supervisors Help.

User Security

The User Security module enables you to configure security settings for all supervisors (that is, all
non-agents who use WFM). It groups security settings into the following categories: General,
Configuration, Policies, Calendar, ForecastInsert text, Schedule, Trading, Performance,
Adherence, reports, and Data Import/Export. Under each category are various options.

For example, Notifications is an option under Configuration. If a user is assigned Notifications
permission, that user can then access the Notifications module in WFM Web for Supervisors. Users
without this permission cannot access and therefore cannot modify the configuration of email
notifications.

The user security settings allow for a great deal of flexibility. You can specify which sites and business
units, teams, and so on, the user can access. You can configure no calendar, forecast, and schedule

Deploying WFM Planning
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access; read-only access; or full access.

In addition, you can enable users to make only pending schedule changes—that is, schedule changes
that require approval from a qualified user before they are incorporated into the Master Schedule.

To configure user security settings efficiently, determine the access levels appropriate for all users.
You can change settings at any time, as necessary. You can also use Security Roles to more easily
configure security settings for users, by creating a Security Role, assigning permissions to it, and then
assigning one or more WFM users to that Security Role.

An administrator can configure a security role as the default. All new users added to the WFM system
will be assigned to this default security role—and will be limited to its access permissions. See
Defining the Default Security Role

Back to Top

Organization

Use the Organization module to configure sites and business units (formerly called virtual PABXs),
teams, and agents. To configure this module, determine the sites that belong to business units.
Decide on the site properties, the maximum seats, the Data Aggregator and WFM Server the site
uses, the switch you will use to collect statistics (if you want to use one different from the one
automatically associated with the site during synchronization), and so on. Collect information about
agent team and site associations, as well as agent settings, such as rotating pattern (if any),
contracts, and rules for the accrual of accrued time off.

Keep in mind that there are many WFM configuration objects that are associated with a site, including
Rotating Patterns, Contracts, Activities, Time Off Types, Time Off Rules, Exception Types, and more.
When you move an agent from one site to another, you must reassign that agent to a new Contract,
Time Off Rules, and new Rotating Patterns—if these were previously assigned. You must take this
action to correctly schedule the moved agent under the new site.

Creating a New Business Unit
You might need to create a new business unit during database synchronization. To configure your new
business unit, see the Configuration > Organization > Business Units > Creating Business
Units topic in the Workforce Management Configuration Utility Help.

Back to Top

Activities

Activities are defined as different categories of work that comprise the total workload for a contact
center. Workload and staffing forecasts are created for each activity. Each site configures its own
activities, to take into account of local conditions. All agent work that is forecast and scheduled must
be assigned to an activity.

Activities can take various forms. They might describe types of work, such as inbound calls or e-mail;

Deploying WFM Planning
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groups of customers served, such as preferred customer care; or work times, such as overnight. You
can also use activities for non-CTI work. Each activity is then associated with one or more
preconfigured skills. Because activities are a fundamental unit for forecasts and schedules, it is
critical that you configure them accurately.

Maximum Simultaneous Users for Activities
The Maximum Simultaneous Users feature limits the number of agents that can be scheduled for an
activity, even if the workload requires more. Maximum Simultaneous Users can be understood as a
way to prevent excessive staffing for some activities so that the agents can be moved to more
important activities, even if it leaves some less-important activities understaffed. This feature is best
used when the contact center is understaffed as a whole. As the Maximum Simultaneous Users value
is reached, agents are then assigned to other activities.

Important
Only use the Maximum Simultaneous Users feature in a multi-skilled environment.

Multi-site Activities
Multi-site activities, formerly called virtual activities, are performed at multiple physical sites. They
enable you to view several local activities as a single WFM object. The performance information is
split among the sites that perform the activity. You can build interaction volume forecasts, staffing
forecasts, and view contact center performance for multi-site activities.

Configuring Statistics
WFM uses the WFM Data Aggregator to track four statistical categories: Interaction Volume,
Abandonment Percentage, Quality of Service, and Handle Time. These statistics are written to
the WFM database, providing the historical data necessary for WFM Forecasting, Scheduling,
Performance monitoring, and Adherence monitoring.

Because WFM Data Aggregator receives its statistics from the Genesys Stat Server, it supports a very
flexible configuration. In the WFM Configuration Utility you associate Stat Server statistics with
activities. These Stat Server statistics may be ones that are provided out-of-the-box, or they can be
customized statistics.

For example, you can sum up values from any set of statistics you want, such as totalTalkTime +
totalHoldTime + totalAfterCallWorkTime. This type of flexible configuration overcomes the
limitations of ACD switch reports and integration, allowing you to choose the statistics that best
represent the work associated with servicing each customer interaction.

Back to Top

Adding Reason Codes
When associating agent schedule states provided by WFM with Genesys events, you can configure
reason codes with Genesys events. This allows you to refine the Genesys agent-state information that
WFM uses to track agent compliance with their scheduled states.
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WFM Data Aggregator can process reason codes that come from hard and/or soft phones. To receive
reason codes from hard phones, or in a mixed hard/soft phone environment, set the
ReasonCodeKeyName option in the WFM Data Aggregator Application object to ReasonCode. See
Configuring Data Aggregator to process Reason Codes.

Using Hot-Standby Backup for WFM Data Aggregator
You can configure a hot-standby backup WFM Data Aggregator for each primary WFM Data
Aggregator server: see Step 5 in the procedure Creating a Data Aggregator Application Object. The
backup reads the same information as the primary WFM Data Aggregator, so if it is necessary to
switch to the backup, there is no delay or loss of data. At the transition, the backup WFM Data
Aggregator simply starts writing to the database starting from where the primary WFM Data
Aggregator left off.

If configured properly, WFM Data Aggregator also backs up data in the event of a disconnect from the
database and the subsequent WFM Data Aggregator shutdown. It first writes all current data to a
local dump file. You must specify a path and file name for the DBDumpFile option on the Options tab
of the WFM Data Aggregator Application object. See Configuring Data Aggregator to Backup Data
on Disconnect

Back to Top

Skills

You can configure interactions to be routed to specific agents within a contact center, based on skill
definitions.

For example, you may want to have incoming interactions go first to an agent at the highest level of
a certain skill. If no agent with that skill level for that activity is available, then the interaction can be
routed to an agent with the next highest level of that skill. If no agent is available at that level, then
the interaction can be routed to the next available agent, regardless of the agent’s skill level for the
activity.

The contact center manager can decide whether to staff for the higher skill levels, or whether to staff
so that any agent can handle the interaction.

Skills are defined and assigned to agents in Configuration Manager. To learn how to import
Configuration Manager skills into the WFM Utility Skills list, see the Configuration > Skills
topic in the Workforce Management Configuration Utility Help.

Matching Skills and Activities
Activities often correspond to skills but may also correspond to agent skill levels. Choosing an
appropriate strategy for a contact center’s activities allows for improved staffing decisions.

For example, in a simple scenario, the relationship among the queue, skills, and activities is a 1-1-1
correspondence. As things get more complex, the relationships get more complex. Activities consist
of multiple skills, and each site has many activities associated with it. The goal is to find the best
combination of relationships to meet staffing requirements.
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Back to Top

Schedule-State Groups

A schedule-state group is a collection of schedule states that is linked to a site. These include breaks,
meals, exceptions, activities, time off, and so on. You can group these, and then associate the group
with one or more Genesys states.

Additionally, you can configure adherence thresholds for this schedule state group, which define
when an agent should be considered to be non-adherent to the schedule states contained in the
group.

To configure schedule-state groups, determine what schedule states you are using, what are the most
logical groupings, and which Genesys state(s) best corresponds to each group.

To learn how to configure Schedule State Groups and Adherence Rules for them, see the
Configuration > Schedule State Groups topic in the Workforce Management Web for Supervisors
Help.

Events

Events are specific instances of occurrences that affect scheduling requirements. For example, a
catalog drop might increase demand for agents handling inbound interactions. By configuring an
event, you can forecast and schedule to incorporate its effects, ensuring appropriate staffing levels
throughout the period that the event affects.

To learn how to create and configure Events and Factors (Events are instances of Factors), see the
Forecast > Historical Data Views > New Event Page topic in the Workforce Management Web
for Supervisors Help.

Back to Top

Time Zones

Time zones are set up in Configuration Manager and imported into WFM during synchronization. You
can assign time zones to sites and business units. You can also configure a default time zone, for
efficiency in configuring new objects, and a user time zone, which is used as the alternative time
zone in WFM Web Performance views. All newly created sites and business units use the default time
zone, unless specified otherwise.

To learn how to configure and work with Time Zones, see the Configuration > Time Zones topic in
the Workforce Management Configuration Utility Help.
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Synchronization

Synchronization brings Configuration Database objects, such as agents, agent skills, time zones, and
users into WFM. You can configure security settings to determine the users who are able to perform
synchronizations.

To learn about synchronization, see the Configuration Utility Interface > Synchronization
topic in the Workforce Management Configuration Utility Help.

Important
To avoid errors during synchronization and further work, your configuration must not
contain duplicate names for switches, time zones, or skills—not under different
tenants, and not in different Configuration Manager instances that access the same
WFM database.

Back to Top

Procedures

Click the red arrow below to see a list of procedures related to the topics on this page.

<multistep>

|-| Defining the Default Security Role=

Purpose: To specify the access permissions that is assigned to all new users who are added to the
WFM system.

Prerequisite: You installed WFM Configuration Utility. See the Procedure: Installing WFM
Configuration Utility.

Start of Procedure

1. Open WFM Configuration Utility.
2. In the Modules pane, select User Security.
3. In the Objects pane, select Security Roles/Users.
4. (Optional): In the Objects pane, create a new security role.
5. In the Data pane, select a security role from the Default Security Role drop-down list.
6. Click Apply

The selected role becomes the default security role.
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Tip
The default security role has a special icon; its upper left corner is red.

End of Procedure

|-| Configuring Data Aggregator to Process Reason Codes=

Purpose: To enable Data Aggregator to process Reason Codes.

Prerequisite: You created a WFM Data Aggregator application object for the current installation in
Configuration Manager.

Important
You can use reason codes only if your CTI environment supports them.

Start of Procedure

1. Open Configuration Manager (a Management Framework component).
2. Open the WFM Data Aggregator Application object.
3. On the Options tab, create an option named ReasonCodeKeyName, if it does not already exist.
4. Set the value of ReasonCodeKeyName to ReasonCode.
5. Save the changes.

End of Procedure

|-| Configuring Data Aggregator to Backup Data on Disconnect=

Purpose: To enable an emergency Data Aggregator info dump.

Prerequisite: You created a WFM Data Aggregator application object for the current installation in
Configuration Manager.

Important
You can use reason codes only if your CTI environment supports them.
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Start of Procedure

1. Open Configuration Manager (a Management Framework component).
2. Open the WFM Data Aggregator Application object.
3. On the Options tab, create an option named DBDumpFile, if it does not already exist.
4. Set the value of the DBDumpFile option to a path and file name—for example: C:\DAEmergency\

DBDumpFile.txt.
5. Save the changes.

If WFM Data Aggregator loses its connection to the database, before closing down it writes all current
data to the local file (the so-called dump file). After restart and reconnection to the database, WFM
Data Aggregator reads the dump file, writes the data to the database, and deletes the dump file.

Important
The dump file does not prevent data loss during the period that WFM Data Aggregator
is shut down.

End of Procedure

</multistep>

Back to Topic
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WFM Policy Objects
Contractual obligations, legal requirements, and business practices comprise constraints under which
a contact center operates. Workforce Management (WFM) enables you to use Policy objects to specify
constraints in great detail, resulting in forecasts and schedules that comply with constraints while
optimizing staffing levels.

Topics on this page include:

• Time-Off Rules
• Activity Policies
• Contracts
• Shifts
• Exception Types
• Meetings
• Time-Off Types
• Marked Time
• Rotating Patterns

Time-Off Rules

The Time-Off Rules module enables you to set allocation parameters for both accrued and awarded
time-off types. Constraints include the number of hours that are assigned per year or that
accumulate per working period, and the carry-over date for each time-off type you use, and whether
time-off requests can be auto-approved.

Each type of time off can be associated with one or more time-off rules. Because you can configure a
number of time-off types (using the WFM Configuration Utility Time-Off Types module), you can have
time off accumulate at different rates, providing more flexibility in managing contact-center staff.

You also use this module to assign time-off rules to specific agents. Agents can have multiple time-off
rules assigned, each with its own time-off type.

Configure Time Off Rules
To learn how to create and configure Time Off rules, see the topic Policies > Time-Off Rules in
WFM Configuration Utility Help.
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Activity Policies

The Activities module enables you to set activity open hours and staffing constraints. You can also
use it to create activity sets (previously called exclusivity sets).

Activity sets provide a means to combine activities into groups for multi-skilled scheduling. Activity
sets are associated with sites. Any agent can work on an activity set if that agent has the skills
required for the activities included in the activity set. When performing activity set work, agents must
perform only the activities included in the set for a specified period of time.

When planning your deployment, consider which activities could logically be grouped into activity
sets.

Back to Top

Contracts

Contracts are sets of rules that describe the contact center’s contractual obligations to agents. The
maximum working hours for a contract should include allowances for meetings, training, overtime,
and other planned, paid activities. You can configure an unlimited number of contracts. In some cases
a unique contract might be necessary for each agent.

Use contracts to describe a single agent’s availability. For example, a student might prefer to work
Monday, Wednesday, and Friday evenings, any time Tuesday and Thursday, and have weekends off
for study and fun. You could configure this student’s contract to enable these availability parameters.

A contract is not the same as a shift. A shift indicates the hours an agent will work, whereas a
contract describes how many hours an agent should work. For further details on shifts, see Shifts.

Constraints for Working Days, Hours, and Days Off
You can set the numbers of working days and hours and days off for one of several scheduling
periods, depending on which best suit your enterprise’s business practices and any applicable legal
requirements. You can set these parameters per week, per month, or per any period of 2 to 6 weeks.

For example, you can ensure that employees always receive 2 weekends off per month or work an
exactly specified number of hours per 6-week period.

Configuring Profiles
A profile is an abstract or hypothetical agent constructed from user-defined contract data. You can
create multiple profile types, which you can use to construct schedules containing empty schedule
slots appropriate for the contracts you have or intend to hire for. You can insert actual agents into the
schedule slots after you build the schedule.

Back to Top

Deploying WFM Planning

Workforce Management Administrator's Guide 34



Shifts

The method used to create WFM shifts allows for a flexible description of shift durations and of start
and end times. Additionally, WFM schedules use flexible break and meal parameters.

In a sense, a WFM shift is an abstraction, representing countless possible working times, even though
you can configure a shift to produce very regular, fixed, agent schedules.

A single WFM shift can incorporate hundreds of possible start times and durations as long as they fall
within the parameters of the contract. However, through more rigid shift configuration, agent start
times and workday durations can be fixed. This combination of flexibility and structure makes the
WFM shift a tremendously powerful scheduling mechanism. In fact, in some cases, you can configure
an entire contact center using only a few WFM shifts.

Allocating WFM Shifts Effectively
The WFM shift contrasts sharply with the conventional notion of a shift, with fixed weekly start time,
fixed duration, and set breaks. You can configure shifts to work in tandem with contracts, which
efficiently and effectively controls the placement of working times.

For example, consider a contact center with a standard full-time shift of 8 hours a day, 5 days a
week, and an alternative full-time shift of 10 hours a day, 4 days a week. Both types of agents can
use a single shift with a flexible duration of 8–10 hours per day. In either case, the agents are
contracted to receive 40 hours work each week and to work 4 or 5 days. You can configure WFM to
guarantee that specific agents work 4 or 5 days a week, or you can leave it to the WFM Scheduler to
determine how many agents of each full-time type should be used to provide the least costly
schedule.

Such an efficient method of shift allocation allows you to take into account the effect of complex
scheduling requirements and agent-centric considerations, while making the best possible use of
multi-skilled agents.

If you have a need in your contact center for more precise control over when an agent works and the
duration of his workday, you may consider using Rotating Patterns. This is a way to lock in specific
types of schedules for an agent without creating a unique shift for him.

Exception Types

Exception types define periods of time when agents are engaged in non-work activities, such as
training or meetings. Each site configures its own set of exception types based on its business
requirements. You can configure exceptions to be considered during Meeting Planner use, to be
convertible to a day off, and so on. You can assign agents to multiple partial-day exceptions if the
exceptions do not overlap.

Because you can group agents into teams, you can assign exceptions to large groups of agents at
one time.
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Important
Genesys recommends that you make use of the time-off capabilities introduced in 8.x
releases, rather than configuring time off using exception types.

Back to Top

Meetings

Use the Meetings module to create meetings and assign them to agents. You can set up a series of
recurring meetings that must meet your constraints for frequency, number of occurrences, and so on.

Use the Meeting Planner in the WFM Configuration Utility to configure preplanned meetings such as
team meetings that recur weekly or monthly. If you need to create an ad hoc meeting, use the
Meeting Scheduler within the WFM Web for Supervisors Application.

Time Off Types

Use this module to create time-off types for each type of time off that you want to be able to track.

Time-off types can be accrued (time off accumulates over time) or awarded (the total amount of time
off for the year is assigned at a single time). For example, you might want personal time off to
accumulate, whereas holidays—since there is a fixed number during the year—can be awarded.

You can associate multiple time-off rules with a single time-off type. This enables you to have
different time-off types accumulate at different rates. For example, you can set different time-off
rules for different levels of seniority.

Marked Time

By configuring marked-time types, you can specify periods of time that you want to monitor and
report on that are not already labeled using an existing category. For example, you might want to
mark the periods that agents worked on a particular project. Or you can mark overtime so that you
can report on it.

You can insert and view marked time in the Schedule Intra-Day views. Two new reports, the Schedule
Marked Time Report and the Schedule Marked Time Totals Report, display marked time statistics.

Rotating Patterns

Rotating patterns increase scheduling flexibility and control. A rotating pattern is a series of weekly
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patterns arranged in a repeating sequence. You construct each weekly pattern from a combination of
shift assignments, agent availability times, days off, and so on, depending on what constraint is most
important for any specific day.

Rotating patterns include availability times as options for weekly pattern days. If used, these
availability settings override the availability settings that you configured in the Contract module for
that day. Rotating pattern assignments are displayed in the Calendar along with all other pre-planned
data.

Back to Top
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Forecasting and Scheduling
This topic provides information that you should consider when planning your forecasting and
scheduling requirements for your contact center. See:

• Forecasting Considerations
• Scheduling Considerations

Forecasting Considerations

You can create forecasts based on various kinds of data. Ideally, you already have a substantial
quantity of good-quality historical data on contact center interactions that you can import into the
WFM database. If you have historical data, you can use either of two forecasting algorithms
depending on the amount of quality historical data available. The Expert Average Engine requires a
full week of historical data with no missing timesteps. To use the Universal Modeling Engine, you
must have at least a full year of historical data to create forecasts.

If historical data is unavailable or of poor quality, you can create forecasts based on templates.
Templates reflect estimated interaction levels for different days and times and can be constructed for
each activity.

When you do not have enough historical data to use the Expert Average Engine or the Universal
Modeling Engine, you can combine the historical data with overlap templates, which fill in gaps in the
historical data.

Creating optimal forecasts depends not only on whether historical data is available, but also on usual
workflow. Contact centers with very regular interaction volumes require different forecasting
considerations than contact centers that experience frequent or marked variations of interaction
levels.

If your site activity load is highly predictable, you can apply a specific interaction volume or AHT to
each time interval in the scenario.

Forecasting also incorporates figures such as staffing overheads, service objectives, and occupancy
into the staffing calculations, allowing precise regulation of forecasting levels. You can create a
variety of forecast scenarios, by using different service objectives or staffing parameters to help you
create realistic contact center strategies for varying circumstances. After you decide which scenario
best fits your environment, you publish it to the WFM database, where it becomes a part of your
Master Forecast, upon which schedules are built.

Factors and Events
WFM can track events that may affect interaction volume. These events are based on factors, which
are event types upon which events are built. When planning your forecasting, consider what factors
and events might affect forecasts so you can configure them before creating forecasts. A sales
promotion or marketing campaign, for example, may cause a predictable peak in interaction volume.
Such events are entered in WFM Web and used by the advanced WFM algorithms. If an event recurs,
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the forecasting algorithms learn the impact of that event and account for its impact in future
forecasts.

Back to Top

Scheduling Considerations

WFM schedules each agent individually, building schedules that allow for intra-day overhead.
Therefore, you do not need to inflate staffing requirements to accommodate overhead. The only
overhead additions that you need to account for are intangibles, such as starting up agent desktop
applications, bathroom breaks, and so forth, and unplanned overhead, such as training or meetings
that are not yet scheduled (or sick days, which, presumably, are always unplanned).

Important
The schedule is only as accurate as the forecast. If you do not build the forecast
carefully, the schedule will not necessarily provide adequate coverage.

Because each site is different, some planners might choose to fully configure meetings and training.
Others might opt to build these into the schedule after it is generated. WFM supports both strategies.
However, a good rule of thumb says that if the meeting or training must occur at a specific time, it
should be configured beforehand. Otherwise, you can add meetings and training after building the
schedule.

Creating Blank Schedules
Agent-based scheduling might not always be appropriate for your contact center. If not, you can also
create schedules using profile agents. Profile agents are user-defined, hypothetical agents, based on
contract data. Using profile agents results in blank schedules that contain an appropriate number and
assortment of schedule slots for the agents to be hired.

Tip
You can combine profile agents with actual agents when creating a schedule.

Managing Schedule Bidding
Supervisors can create a profile schedule which authorized Agents then bid against, for the schedule
slots that they prefer. The Supervisor can automate the resolution of conflicting bids according to
stated Agent preferences as well as their Seniority and Rank, and then tweak it manually before
publishing the official schedule. Such a schedule can be designed to repeat over an entire quarter.

Back to Top
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Performance and Adherence Monitoring
This topic provides information that you should consider when planning your performance and
adherence monitoring for your contact center. See:

• About Performance Monitoring
• About Adherence Monitoring

About Performance Monitoring

The Performance module of WFM Web for Supervisors enables you to view how closely your service
objectives are being met at the site, business unit, and activity level. You can also configure alerts to
appear when service objective statistics fall outside of an acceptable range. You need to consider
what your target service objectives are. To help you determine the most effective way to resolve
unacceptable performance, the Performance module includes What-If capabilities, where you can see
the potential effect of changing some parameter in your environment.

The table below lists the statistics shown on the Performance > Intra-Day view and explains how
each is calculated. For more information about how to configure statistics, see Locating Preconfigured
Stat Server Statistics in Configuration Manager and the "Activities" section in Workforce Management
Configuration Utility Help.

Statistic Definition

Interaction Volume—Forecast
Taken from the Master Forecast Interaction Volume.
For sites, business units, and the enterprise, this is
the sum of the associated local activities.

Interaction Volume—Actual

The Interaction Volume collected by WFM Data
Aggregator. The specifics of the statistic being
monitored is determined by the Interaction Volume
statistic defined for this activity in the WFM
Configuration Utility. For sites, business units, and
the enterprise, this is the sum of the associated
local activities.

Interaction Volume—Difference
The difference between the forecast and actual
Interaction Volume collected by WFM Data
Aggregator.

Interaction Volume—Difference %
The difference between the forecast and actual
Interaction Volume collected by WFM Data
Aggregator, expressed in a percentage.

AHT—Forecast

Taken from the Master Forecast AHT. For sites,
business units, and the enterprise, this is the
weighted average of the associated local activities
(weighted by the corresponding forecast
interaction volumes).

AHT—Actual The AHT collected by WFM Data Aggregator. The
specifics of the statistic being monitored is
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Statistic Definition
determined by the AHT statistic defined for this
activity in the WFM Configuration Utility. For sites,
business units, and the enterprise, this is the
weighted average of the associated local activities
(weighted by the corresponding actual handled
interaction volumes).

AHT—Difference The difference between the forecast and actual
AHT collected by WFM Data Aggregator.

AHT—Difference %
The difference between the forecast and actual
AHT collected by WFM Data Aggregator, expressed
in a percentage.

Abandoned-Interactions—Scheduled

The percentage of calls expected to be abandoned
with the number of scheduled agents working,
assuming that the forecast IV and AHT are correct.
For sites, business units, and the enterprise, this is
the sum of the associated local activities (weighted
by the corresponding forecast interaction volumes).

Abandoned-Interactions—Calculated

The number of required calls expected to be
abandoned with the number of calculated agents
working, assuming that the forecast IV and AHT are
correct. For sites, business units, and the
enterprise, this is the sum of the associated local
activities (weighted by the corresponding forecast
interaction volumes).

Abandoned-Interactions—Required

The number of required calls expected to be
abandoned with the number of required agents
working, assuming that the forecast IV and AHT are
correct. For sites, business units, and the
enterprise, this is the sum of the associated local
activities (weighted by the corresponding forecast
interaction volumes).

Abandoned-Interactions—Actual

The actual number of abandoned calls as collected
by WFM Data Aggregator. The specifics of the
statistic being monitored is determined by the
Abandoned Calls Percentage statistic defined for
this activity in the WFM Configuration Utility. For
sites, business units, and the enterprise, this is the
sum of the associated local activities (weighted by
the corresponding actual interaction volumes).

Service-Level—Scheduled

The Service Level that would be expected if the
scheduled number of agents are working, assuming
that the forecast IV and AHT are correct. This
calculation is based on the Service-Level objectives
defined when you built the Staffing forecast. If you
did not define these objectives, this value is not
calculated. For sites, business units, and the
enterprise, this is the weighted average of the
associated local activities (weighted by the
corresponding forecast interaction volumes).

Service-Level—Calculated
The expected Service Level if the calculated
number of agents are working, assuming that the
forecast IV and AHT are correct. This calculation is
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Statistic Definition
based on the Service-Level objectives defined
when you built the Staffing forecast. If you did not
define these objectives, this value is not calculated.
For sites, business units, and the enterprise, this is
the weighted average of the associated local
activities (weighted by the corresponding forecast
interaction volumes).

Service-Level—Required

The Service Level that would be expected if the
required number of agents are working, assuming
that the forecast IV and AHT are correct. This
calculation is based on the Service-Level objectives
defined when you built the Staffing forecast. If you
did not define these objectives, this value is not
calculated. For sites, business units, and the
enterprise, this is the weighted average of the
associated local activities (weighted by the
corresponding forecast interaction volumes).

Service-Level—Actual

The actual Service-Level percentage collected by
WFM Data Aggregator. The specifics of the statistic
being monitored is determined by the Service
Level Percentage statistic defined for this activity
in the WFM Configuration Utility. For sites, business
units, and the enterprise, this is the weighted
average of the associated local activities (weighted
by the corresponding actual distributed interaction
volumes).

Deferred Service-Level—Scheduled
Weighted average of (achieved) scheduled Service-
Level percentage (weighted on Forecasted
Interaction Volume) for the activity of type
Deferred.

Deferred Service-Level—Calculated
Weighted average of (achieved) calculated Service-
Level percentage (weighted on Forecasted
Interaction Volume) for the activity of type
Deferred.

Deferred Service-Level—Required
Weighted average of (achieved) required Service-
Level percentage (weighted on Forecasted
Interaction Volume) for the activity of type
Deferred.

Deferred Service-Level—Actual
Weighted average of (achieved) actual Service-
Level percentage (weighted on Actual Distributed
Interaction Volume) for the activity of type
Deferred.

Actual Queue The actual number of interactions in the backlog
queue at the end of the period.

ASA—Scheduled

The ASA that would be expected with the number
of scheduled agents, assuming that the forecast IV
and AHT are correct. For sites, business units, and
the enterprise, this is the weighted average of the
associated local activities (weighted by the
corresponding forecast interaction volumes).

ASA—Calculated The ASA expected with the number of calculated
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Statistic Definition
agents, assuming that the forecast IV and AHT are
correct. For sites, business units, and the
enterprise, this is the weighted average of the
associated local activities (weighted by the
corresponding forecast interaction volumes).

ASA—Required

The ASA that would be expect with the number of
required agents, assuming that the forecast IV and
AHT are correct. For sites, business units, and the
enterprise, this is the weighted average of the
associated local activities (weighted by the
corresponding forecast interaction volumes).

ASA—Actual

The ASA collected by WFM Data Aggregator. The
specifics of the statistic being monitored is
determined by the ASA statistic defined for this
activity in the WFM Configuration Utility. For sites,
business units, and the enterprise, this is the
weighted average of the associated local activities
(weighted by the corresponding actual interaction
volumes).

Coverage

Number of agents scheduled for each activity. If an
agent works only part of a time interval, only the
portion during which the agent works (rounded to
the nearest minute) is counted toward scheduled
staffing. As a result, these values may be fractions
or decimals.

Staffing—Calculated

The number of agents per timestep for each
activity. Taken from the Master Schedule.
In a multi-skill environment, an agent may be available for
multiple activities but will only be scheduled for one activity in
any timestep.
If an agent is scheduled to work only part of a time interval, only
the fraction of the time period during which she or he works is
counted.
Therefore, the value for staffing may be expressed as a fraction.
For example, if an agent is scheduled to work for 10 minutes of
a 15–minute timestep, she is counted as 2/3 (or .667) of an
agent.

Staffing—Required Required number of agents per timestep scheduled
for each activity. Taken from the Master Forecast.

Variance—Scheduled

The value obtained by subtracting the scheduled
number of agents working during a timestep from
the optimal staffing for that timestep.
Optimal staffing is a calculation based on actual
interaction volume, actual AHT, and the service
objectives specified in the forecast. This value is
not displayed but is used in calculating Variance
values.

Variance—Required

The value obtained by subtracting the required
number of agents working during a timestep from
the optimal staffing for that timestep.
Optimal staffing is a calculation based on actual
interaction volume, actual AHT, and the service
objectives specified in the forecast. This value is
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Statistic Definition
not displayed but is used in calculating Variance
values.

Headcount—Scheduled

The number of agents scheduled for each timestep.
Multi-skilled agents are counted once for each
activity they can potentially work on for each
timestep. If a multi-skilled agent has the skills to
work on two activities that are both open during a
particular timestep, she or he is counted twice.
As a result, in a multi-skilled environment the total
number of agents for a timestep may be larger
than the total number of agents.

Headcount—Actual
The actual number of agents working on an activity
during each timestep. This value may be a fraction
because an agent may work on the activity for only
part of a timestep.

Back to Top

About Adherence Monitoring

WFM Adherence monitors real-time agent status on multiple media channels using statistical
information that Data Aggregator draws from Stat Server. Agent adherence to schedule states is
evaluated based on user-defined adherence thresholds. To enable Adherence features such as real-
time monitoring, you must configure Stat Server and WFM Data Aggregator to collect and store the
appropriate interaction information.

For a detailed explanation of the setup required for accurate adherence monitoring, see Configuring
Stat Server Statistics.
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Installing Workforce Management
This topic provides step-by-step instructions for installing and configuring Workforce Management
(WFM), including creating your WFM database.

Important
If you are migrating from a previous version of WFM, read the instructions in the
“Workforce Management Migration Procedures” chapter of the Genesys Migration
Guide before beginning your installation. In particular, WFM 8.1 requires a new,
separate database into which your existing data is imported.

This topic includes the following pages:

• Preparing to Install WFM
• WFM Configuration Wizards
• Manually Creating and Configuring the Application Objects
• Installing WFM Database Utility
• Installing and Uninstalling WFM Components

You can install, create, and configure WFM components, by using the Configuration Wizards or
perform these tasks manually. The procedures are the same to the end of the section Import the WFM
Templates. For instructions about how to perform a manual setup of WFM Application objects, see
Manually Create and Configure the Applications.

Important
Genesys recommends that you do not install WFM components, by using a Microsoft
Remote Desktop connection. The installation must be performed locally.

Before running Workforce Management Setup or the Installation and Configuration Wizards:

• Review the predeployment topics in Deployment Planning.
• Verify that you have set up the computers that will be running WFM, as described in Preparing to Install

WFM.
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Preparing to Install WFM
To prepare Workforce Management (WFM) for installation, read through the topics on this page and
complete the procedures as required.

WFM works in conjunction with a number of software components. Before installing WFM, set up
Genesys Framework. The installation should include at least the following components:

• Configuration Manager
• Configuration Server
• DB Server
• T-Server
• Stat Server

Important
For full interoperability with WFM 8.5, the Genesys components must be release 7.0 or
later. Using WFM 8.5 with earlier releases of these components limits use of the
Configuration Wizards, Management Layer support, and Reason Code support. For
example, the WFM Daemon wizard will work only with Genesys Framework 7.6 or
greater, because it uses new the WFM Daemon application type, which was
introduced in Configuration Manager 7.6.

Software Requirements

For complete and up-to-date information on software requirements, review the Genesys Supported
Operating Environment Reference Manual. You will need a Genesys-supplied login and password to
access certain documents there.

Important
When installing WFM components, ensure they are all within the same major release
stream. Mixing components from different major release streams is untested and
therefore, not supported in production environments. The major release stream is
determined by the first three digits in the release number. For example, 8.1.0, 8.1.1,
8.1.2, 8.1.3.

Back to Top
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Management Layer System Requirements

The Management Layer of Genesys Framework enables administrators to start, stop, and monitor the
status of entire solutions from a centralized location. To use Management Layer, you must also have
the following Genesys Framework components installed:

• DB Server
• Configuration Server
• Message Server
• Log Database
• Solution Control Server (SCS)
• Solution Control Interface (SCI)
• Local Control Agents (LCA)

For more information on installing any of these components, see the Management Framework
documentation.

To use Management Layer, you must install LCA on the servers running WFM Builder, WFM Server,
WFM Data Aggregator, and WFM Daemon.

Register the Server Host Computers

You must register each host computer that runs one or more of the servers. See Registering a host
computer.

Connect to Backup Configuration Server

After installation, WFM components connect to Configuration Server to obtain information about the
environment. If the primary Configuration Server is not available during startup, WFM Web, Server,
Builder, Daemon, and Data Aggregator can connect to the backup Configuration Server.

To implement this feature in 8.1.3 and later releases

• For WFM Web and Daemon, this feature is implemented automatically during installation.
• For WFM Server, Builder, and Data Aggregator this feature is implemented by setting the backuphost

and backupport options in the Start command line or in the NT Service command line.

To implement this feature in 8.1.2

• For WFM Web, manually configure two optional keys backuphost and backupport in the
ConfigServer.properties file located in the Tomcat directory webapps\wfm\WEB-INF (assuming WFM
Web was deployed as wfm.war, otherwise replace wfm with the specified name). After you have made
the changes, save the file and restart the host.
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• In the WFM Server Application, WFM Builder Application, and Data Aggregator Application
objects, set the backuphost and backupport options to take effect during startup. (These options are
not set automatically during installation for these components.)

• For WFM Daemon, do nothing (no configuration required).

Connect to Backup WFM Server

If you plan to install a redundant WFM Server, you can configure it as the backup server for the
primary WFM Server Application in Configuration Manager (or Genesys Administrator). All WFM
components will then connect to it if this WFM Server is running in primary mode.

Create Your WFM Database

If you are updating from WFM 7.x to WFM 8.5, you do not need to create a new database. Simply
update your current database as described in Managing WFM Database Utility.

If you are installing WFM for the first time or migrating from version 6.x, you must create a new
database.

Important
If you are migrating from WFM 6.x, see the “Workforce Management Migration
Procedures” chapter in the Genesys Migration Guide to find information about how to
transfer your data from your current database to the new one.

Ensure your database meets the following criteria:

• Is of an appropriate size.
• Allows room for expansion.
• Is configured to be case insensitive.

Back to Top

Database Access Privileges
You must have specific privileges or security roles to access the database, which differ slightly,
depending on the platform being used.

Microsoft SQL Server (MSSQL) Security Roles:

Creates and maintains WFM database (can use all WFM applications and their functionality):

• db_datareader
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• db_datawriter
• db_ddladmin (must to be able to CREATE/ALTER/DROP OBJECTS, DISABLE/ENABLE TRIGGERS, TRUNCATE

TABLES, UPDATE STATISTICS)

Uses WFM applications only (does not access database server directly nor modify WFM database
objects):

• db_datareader
• db_datawriter

Oracle Database Server Security Roles:

• GRANT CREATE SESSION TO <user name>
• GRANT CREATE TABLE TO <user name>
• GRANT CREATE VIEW TO <user name>
• GRANT CREATE PROCEDURE TO <user name>
• GRANT CREATE SEQUENCE TO <user name>
• GRANT CREATE TRIGGER TO <user name>
• GRANT CREATE TYPE TO <user name>
• GRANT UNLIMITED TABLESPACE TO <user name>

Important
The privileges listed above must be assigned to Oracle database owners to ensure
WFM Applications are fully functional when the WFM database runs on an Oracle
platform.

IBM DB2 Server Security Roles:

• Connect to database
• Create tables
• Create packages
• Register routines to execute in database manager's process
• Database administrator authority
• Create schemas implicitly
• Access to the load utility
• Create external routines
• Connect to quiesced database
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Important
A DB2 database requires specific configuration, which is described in the section New
Database Configuration.
For an Oracle database, the database server name that the client application uses to access the database is
actually an alias. If you use different database aliases on the various client computers, you cannot use the
same Database Access Point (DAP) for data from each client.

The procedure required to create your WFM Database varies, depending upon which database type you are
using. A qualified database administrator should perform this procedure.

In order for the Configuration Utility to work properly, you must set Microsoft SQL and
Oracle database management systems to be case-insensitive.

Back to Top

Create a Database Access Point

Many of the WFM Application objects require a connection to a Database Access Point (DAP), which
specifies the name and location of the WFM Database. To create a DAP, see Creating a Database
Access Point.

Requirements for Using an Oracle Database
Before you install an Oracle Database, ensure you are using:

• The latest Oracle Client 11 with Oracle NET and Oracle Provider for OLE DB.
• The 64-bit Oracle Client with 64-bit WFM servers.
• The 32-bit Oracle Client on the WFM Database Utility and/or WFM Configuration Utility host computers

(which are 32-bit

applications).

Important
• Do not install 64-bit WFM Data Aggregator and WFM Server on the same machine as

32-bit WFM Database Utility, because they require different Oracle Clients.
• Regardless of the version of Oracle Database Server used, Genesys recommends that

you use Oracle Client version 11.2 or later on all WFM hosts.
• To install all required components, use the Oracle Client or Oracle ODAC installation

packages.
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Import the WFM Templates

Import the Application templates. The WFM component applications use the Application
template. See Importing the Application Templates.

Back to Top

Procedures

Click the red arrow to display a list of procedures related to the topics on this page. <multistep>

|-| Registering a host computer=

Purpose: To enable the computer to run one or more servers required by WFM.

Prerequisites: The computer that is being registered is on the same network as the computer you
are using to register it.

Start of Procedure

1. Identify the host computer’s assigned name on the network.
2. Open Configuration Manager and select Environment > Hosts.
3. Right-click Hosts and from the shortcut menu, select New > Host.
4. In the dialog box that opens, enter the host name of a computer on which you are installing a WFM

server.

Important
Host names must be lowercase. They are case sensitive.

5. Enter the host computer’s operating system, version, and its IP address.
6. Accept the default port number, and ensure the State Enabled check box is selected.
7. Click Apply.

Repeat the process for all computers that are to run a WFM server.

End of Procedure

|-| Creating a Database Access Point=

Purpose: To enable the Configuration Utility, the Database Utility, and WFM Server to specify the
DAP on their Application object Connections tab.
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Prerequisites: You know the name of your new WFM Database, its location, its type, and the login
name and password for a user with DBO privileges.

Start of Procedure

1. In Configuration Manager, open Environment and then right-click Applications.
2. From the shortcut menu that appears, select New Application.
3. From the Templates list, choose your DAP Application template and then click OK.
4. On the General tab, enter a unique DAP name.

Important
You do not need to select a DB Server. WFM does not use DB Server to access its database.

5. On the Server Info tab, enter any valid host name and port number.
WFM does not use them, but you cannot save the DAP Application object unless these fields are filled
in.

6. Enter the appropriate information on the remaining Application object tabs.
If you need help with this step, see “Configuring Database Access Points” in the Framework 8.0 DB
Server User's Guide.

7. To save the new Application object, click OK.

End of Procedure

|-| Installing the Oracle Client with Oracle NET and Oracle Provider for OLE Database=

Purpose: To install the Oracle Client with Oracle NET.

Start of Procedure

1. Uninstall all Oracle Client software that is currently installed. Use the Oracle Deinstall Tool and steps
described in the Oracle® Database Client Quick Installation Guide. See the topic, "Removing Oracle
Database Client Software".

2. Download the latest Oracle Client 11g complete installation package with the appropriate bit version:
Oracle ODAC 11g 32-bit or Oracle ODAC 11g 64-bit.

3. During Oracle Client installation, use any type of installation.

Important
Recommended types are Administrator or Runtime installation types which will install all required
components. The installation type Instant Client will need an additional Oracle Provider for OLE DB
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installation, found in Oracle ODAC. The installation type Custom will require you to manually select the Oracle
NET and Oracle Provider for OLE DB.

4. Connect Oracle Database Client to an Oracle Database. In the Oracle® Database Client Quick
Installation Guide], see the topic, "Oracle Database Client Post installation Tasks".

End of Procedure

|-| Installing Oracle ODAC with Oracle Provider for OLE DB and Oracle Instant Client=

Purpose: To install Oracle ODAC with Oracle Provider.

Start of Procedure

1. Uninstall all Oracle Client software that is currently installed. Use the Oracle Deinstall Tool and steps
described in the Oracle® Database Client Quick Installation Guide. See the topic, "Removing Oracle
Database Client Software".

2. Download the latest Oracle Client 11g complete installation package with the appropriate bit version:
Oracle ODAC 11g 32-bit or Oracle ODAC 11g 64-bit.

3. During the Oracle ODAC installation, select Oracle Provider for OLE DB and Oracle Instant Client
components.

4. Connect Oracle Database Client to an Oracle Database. In the Oracle® Database Client Quick
Installation Guide, see the topic, "Oracle Database Client Post installation Tasks".

End of Procedure

|-| Importing Application templates=

Purpose: To enable WFM installation, which requires the current Application templates.

Start of Procedure

1. In Configuration Manager, select Environment > Application Templates.
2. Right-click Application Templates and from the shortcut menu, select Import Application

Template.
A dialog box opens that enables you to browse to the Application templates on your Workforce
Management installation disk.

3. Select one of the following templates and then, click Open:
• WFM_Builder.apd

• WFM_Client.apd (used for both Database and Configuration Utilities)
• WFM_Data_Aggregator.apd

• WFM_Daemon.apd

• WFM_Server.apd

Deploying WFM Installing Workforce Management

Workforce Management Administrator's Guide 53



• WFM_Web.apd

Important
Beginning with release 7.6, these template names no longer contain a version number.

4. If you want to, enter a name for the template in the Name text box on the General tab.

Important
Do not make any other changes to the template. When you create Application objects using the imported
templates, you configure them as explained in the following sections.

5. To save the template, click OK.
6. Repeat Steps 1–5 to import all of the Application templates.

End of Procedure

Next Steps: Configure the new Application objects, based on the imported Application
templates, as described in the various sections in Installing Workforce Management. </multistep>

Back to Top
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WFM Configuration Wizards
The Workforce Management (WFM) Configuration Wizards guide you through the process of creating
the Application objects for the WFM components. It is run from the Genesys Wizard Manager. This
topic includes the following sections and contains procedures that will help you to install and run the
wizards, and create the WFM Application objects:

• Installing and Running the Configuration Wizards
• WFM Server Wizard
• WFM Data Aggregator Wizard
• WFM Daemon Wizard
• WFM Builder Wizard
• WFM Client Application Wizard
• WFM Web Wizard
• Procedures

You can also create and configure the component Application objects manually. For instructions, see
Manually Create and Configure the Applications.

Important
You must manually configure the Options tab. For a list of the options on the Options
tab, with default settings and descriptions, see Configuring the Options Tabs.

Installing and Running the Configuration Wizards

You must install the wizards before you can run them. After you install them, start the Configuration
Wizards and use them to create WFM Application objects. To install and start the Configuration
Wizards, see Installing WFM Configuration Wizards and Starting the Configuration Wizards.

Back to Top

WFM Server Wizard

Clicking the Add button opens the Browse for Application (WFM Server) window, which shows
the contents of your Configuration Manager Applications folder.

You can also configure multiple WFM Server Applications for your multi-site environment and if
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required, add connections to WFM Server. To install one or many WFM Server instances and add
connections, see Creating a Server Application Object and Configuring Multiple Server Application
Objects.

WFM Data Aggregator Wizard

The WFM Solution Wizard now looks for a Data Aggregator Application object. If you have already
created any WFM Data Aggregator Application objects, they are listed in this window. At this point
you can:

• Select an already-created Application object and click Next to proceed to the next wizard.
• Select an already-created Application object and then click Properties to edit it before proceeding.
• Click Add to create a new Application object.

Clicking Add in the Configuration Wizard opens the Browse for Application (WFM Data Aggregator)
window, which shows the contents of your Configuration Manager Applications folder. To install
Data Aggregator, see Creating a Data Aggregator Application Object.

Back to Top

WFM Daemon Wizard

Use the WFM Daemon Wizard to create an WFM Daemon Application object. See Creating a Daemon
Application Object.

WFM Builder Wizard

Use the WFM Builder Wizard to create an WFM Builder Application object. See Creating a Builder
Application Object.

WFM Client Application Wizard

The Configuration Utility and the Database Utility use the same Application object. To create it,
start at the WFM Solution Wizard WFM Client window. See Creating a Configuration Utility
Application Object.

Back to Top
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WFM Web Wizard

To create the WFM Web Client Application object, start at the WFM Solution Wizard WFM Web
window, which appears after the WFM Application Wizard closes. See Creating a Web Application
Object.

Procedures

Click the red arrow below to see a list of procedures relevent to installing WFM components, by using
the wizards.

<multistep>

|-| Installing WFM Configuration Wizards=

Purpose: To install the wizards.

Start of Procedure

1. On the Workforce Management release disk, open the root directory or navigate to the
configuration_wizard directory.

2. Double-click Setup.exe.
The Welcome window opens.

Important
If you have already installed the Wizards, the window offers a Remove option.

3. Click Next.
The Choose Solution Destination window opens, displaying a default directory, for example:
C:\Program Files\Common Files\GCTI\CFG Wizards 8.5.

4. Click Default to accept the default directory, or click Browse to select a different directory.
5. Click Next.

The Ready to Install window opens.
6. Click Install to start the installation process.

A progress bar appears as the Wizard files are copied.
7. Click Finish to exit the setup after all files have been copied.

End of Procedure

|-| Starting the Configuration Wizards=
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Purpose: To start the WFM Configuration Wizards

Start of Procedure

1. Select Start > Programs > Genesys Solutions > Workforce Management > Workforce Management
Configuration Wizards > Start Wizard Manager and click the log into the Configuration
Layer link.

2. When the LogIn window appears, enter the login information for your Configuration Server.
3. From the list of solutions at the left side of the main Genesys Wizard Manager window, click Workforce

Management.
4. Click the Deploy Workforce Management link that appears in the right-hand pane of the Set Up Your

Solutions window.
The Workforce Management Wizard Welcome window opens.

Important
If you already have a WFM solution set up, it appears instead of the Deploy Workforce Management link. You
can edit your existing solution by clicking Properties, or delete it and configure a new one.

5. Click Next.
The General window opens.

6. Enter a name for your WFM solution and select a Solution Control Server.
This is the Solution Control Server that Management Layer uses to start, stop, and monitor your WFM
solution.

7. Click Next.

End of Procedure

Next Steps:

• If you have already created any WFM Server Application objects, they are listed in this window. At this
point you can:
• Select an already-created Application object and click Next to proceed to the next wizard.
• Select an already-created Application object and then click Properties to edit it before

proceeding.
• Click Add to create a new Application object.

|-| Creating a Server Application Object=

Purpose: To create a WFM Server Application object.

Start of Procedure

1. To create your WFM Server Application object, click the New Application icon.
It is the left-most icon at the top of the window and looks like this:
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The WFM Server Wizard Welcome window opens.
2. Click Next. The WFM Server Name window opens.
3. Enter a name for your WFM Server Application object, and then click Next.

The Server Info window opens.
4. Select or modify the host name and port number of the computer where you want to install this

application, and then click Next.

Important
This is the information for the computer where WFM Server will run, not the host and port for the
Configuration Server computer.

5. In the Installation Package window, specify the Source and Destination directories for copying the
Installation Package, and then click Next.

6. On the Installation Ready window, click Next.
7. On the Connections window, select from the drop-down list or browse to the DAP Application object

you created previously.
See Creating a Database Access Point.

Important
The Connections window also asks for the WFM Builder Application option. This procedure assumes that
you have not yet created this Application object. If you already have created, select the object here. If you
do not have a WFM Builder Application object, leave the Connections field empty for now. You will add
connections to this Application object later. See Adding Connections in the WFM Server Application Object
for instructions.

8. Click Next to open the Log Configuration window.
You can click Run Log Wizard to customize your log settings or click Next to accept the default log
settings. You can change these settings at any point by using the Wizard to edit your WFM Server
Application object or by editing the Log section on the Options tab of the WFM Server Application
object. Procedures that describe how to edit the Options tab settings are found in WFM Configuration
Options.

9. To close the WFM Server Wizard, click Finish.
The Application object appears in your Configuration Manager Applications folder.

10. Select your new WFM Server Application object and click OK.
The new Application object now appears in the Solution Components list.

11. Click Next to continue.

End of Procedure

Next Steps:

• (Optional) If you are planning to schedule for multiple sites served by multiple WFM Servers, you must
configure the correct connections. See Configuring multiple WFM Server Application objects.
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|-| Configuring Multiple Server Application Objects=

Purpose: To configure multiple WFM Server Applicaitons for multi-site environments.

Start of Procedure

1. Configure a WFM Server Application object for each WFM Server and install the WFM Servers as
instructed in this section and in Installing WFM Server.
Decide which of the WFM Servers will act as the main WFM Server and which are to be configured as
subordinate.

2. Open the main WFM Server Application object’s Connections tab and add all the subordinate WFM
Servers.

3. When your entire installation is complete, open the WFM Configuration Utility and specify which WFM
Server is associated with each site using the Site Properties window.

4. Start all the WFM Servers.
Assuming that the objects in the WFM Configuration Utility are fully configured, you should be able to
use WFM Web for Supervisors to create schedules for activities on all sites in any WFM Server
Application object.

End of Procedure

|-| Adding Connections in the Server Application Object=

Purpose: To add a connection to WFM Builder in the WFM Server Application object.

Prerequisites: You have created a WFM Builder Application object.

Start of Procedure

1. Select your WFM Server Application object from the Solution Components list and then click
Properties.
The Properties dialog box of the WFM Server Application object opens.

2. Click the Connections tab.
3. Enter or browse to your WFM Builder Application object, and then click OK.

The Application objects are now configured for the four solution components in the Solution
Components list.

4. To begin client Application object configuration, click Next.

End of Procedure

Next Steps:

• You must now create Application objects for the client components:
• WFM Configuration Utility/WFM Database Utility—See WFM Client Application Wizard.
• WFM Web—See WFM Web Wizard.

Deploying WFM Installing Workforce Management

Workforce Management Administrator's Guide 60



|-| Creating a Data Aggregator Application Object=

Purpose: To create a WFM Data Aggregator Application object

Start of Procedure

1. To create your WFM Data Aggregator Application object, click the New Application icon.
It is the left-most icon at the top of the window and looks like this:
The WFM Data Aggregator Wizard Welcome window opens.

2. Click Next. The WFM Data Aggregator Name window opens.
3. Enter a name for your WFM Data Aggregator Application object, and then click Next.

The Server Info window opens.
4. Select or modify the host name and port number of the computer where you want to install this

application, and then click Next.

Important
This is the information for the computer where WFM Data Aggregator will run, not the host and port for the
Configuration Server computer.

5. (Optional) Select a backup WFM Data Aggregator if you are planning to use a redundant architecture
such as Hot-Standby or Warm-Standby.
If you have not yet created another Data Aggregator Application object, skip this step. You can add
a connection to the backup WFM Data Aggregator after you create its Application object. To do so,
edit the Application object from the Solution Components list in the WFM Solution Wizard.

6. Click Next to continue.
7. In the Installation Package window, specify the Source and Destination directories for copying the

Installation Package, and then click Next.
8. On the Installation Ready window, click Next.
9. On the Connections window, browse to or select from the drop-down list:

i. Your WFM Server Application object
ii. The DAP Application object you created previously (see Creating a Database Access Point)
iii. Your Stat Server Application object.

10. Click Add WFM Statistics to have the Wizard add preconfigured WFM-specific statistics to your Stat
Server.

Important
See Configuring Stat Server Statistics for a list of all the preconfigured statistics that are added by the Wizard
if you select this option and explanations of how to configure these statistics manually, if necessary.
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11. Click Next to open the Log Configuration window.
You can click Run Log Wizard to customize your log settings or click Next to accept the default log
settings. You can change these settings at any point by using the Wizard to edit your WFM Data
Aggregator Application object or by editing the Log section on the Options tab of the WFM Data
Aggregator Application object. Procedures that describe how to edit the Options tab settings are
found in WFM Configuration Options.

12. To close the WFM Data Aggregator Wizard, click Finish.
The Application object appears in the Browse for Application (WFM Builder) window.

13. Select your new WFM Data Aggregator Application object and click OK.
The new Application object now appears in the Solution Components list.

14. Click Next. The Solution Components window opens.

End of Procedure

|-| Creating a Daemon Application Object=

Purpose: To create a WFM Daemon Application object:

Start of Procedure

1. Click Add.
The Component Types window appears. It lists the components for which you can create an
Application object.

2. Select the WFM Daemon radio button and click OK.

3. Click the New Application icon ( ), which is the left-most icon in the row at the top of the Browse for
Application (WFM Daemon) window.
The WFM Daemon Wizard Welcome window opens.

4. Click Next.
The WFM Daemon Name window opens.

5. Enter a name for your WFM Daemon Application object, and then click Next.
The Server Info window opens.

6. Select or modify the host name and port number for the computer where you want this application
installed.

Important
This is the information for the computer where WFM Daemon will run, not the host and port for the
Configuration Server computer.

7. On the Installation Package window, select the Source and Destination directories for the
Installation Package, and then click Next.

8. In the Installation Ready page, click Next.
9. In the Connections window, browse to or select your WFM Server Application object from the drop-

down list, and then click Next.
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10. In the Log Configuration window, click Run Log Wizard to customize your log settings, or click Next
to accept the default log settings. You can change these settings at any point by using the Wizard to
edit your WFM Daemon Application object, or by editing the Log section on the Options tab of the WFM
Daemon Application object. Procedures for editing Options tab settings are described in WFM
Configuration Options.

11. To close the WFM Daemon Wizard, click Finish.
The Application object appears in the Browse for Application (WFM Daemon) window.

12. Select your new WFM Daemon Application object and click OK.
The new Application object appears in the Solution Components list.

The WFM Solution Wizard displays the following message:
The following components will be part of your solution. If you need to set up client
applications for your solution, click Next. To complete this wizard, click Finish.

Important
For information about setting up WFM Daemon, see Setting Up WFM Daemon.

End of Procedure

|-| Creating a Builder Application Object=

Purpose: To create a WFM Builder Application object.

Start of Procedure

1. Click Add.
The Component Types window appears. It lists components for which you can create an Application
object.

2. Select the WFM Builder radio button and then click OK.

3. Click the New Application icon ( ), which is the left-most icon in the row at the top of the Browse for
Application (WFM Builder) window.
The WFM Builder Wizard opens.

4. Click Next.
The WFM Builder Name window opens.

5. Enter a name for your WFM Builder Application object, and then click Next.
The Server Info window opens.

6. Select or modify the host name and port number for the computer where you want this application
installed.

Important
This is the information for the computer on which WFM Builder will run, not the host and port for the
Configuration Server computer

Deploying WFM Installing Workforce Management

Workforce Management Administrator's Guide 63



.
7. In the Connections window, select from the drop-down list or browse to your WFM Server Application

object, and then click Next.
8. Click Next to open the Log Configuration window.

You can click Run Log Wizard to customize your log settings or click Next to accept the default log
settings. You can change these settings at any point by using the Wizard to edit your WFM Builder
Application object or by editing the Log section on the Options tab of the WFM Builder Application
object. Procedures for editing Options tab settings are described in WFM Configuration Options.

9. To close the WFM Builder Wizard, click Finish.
The Application object appears in the Browse for Application (WFM Builder) window.

10. Select your new WFM Builder Application object and click OK.
The new Application object now appears in the Solution Components list.

11. Click Next to continue.

End of Procedure

Next Step:

• If the WFM Builder Application object was not in the list of Applications when you created your WFM
Server Application object (because the object did not exist or had not been specified), add the
connections to this component now. See Adding Connections in the WFM Server Application object.

Warning
If you do not add a WFM Builder connection to the WFM Server Application object,
Workforce Management will not function correctly.

|-| Creating the Configuration Utility Application Object=

Purpose: To create an Application object for the Configuration Database Utilities.

Start of Procedure

1. In the WFM Solution Wizard WFM Client window, click New.

2. Click the New Application icon ( ).
The WFM Client Application Wizard Welcome window opens.

3. Click Next.
The WFM Application Name window opens.

4. Enter a name for your WFM Client Application object, and then click Next.
The Installation Package window opens.

5. Select or specify the Source and Destination directories for the Installation Package, and then click
Next.

6. On the Installation Ready window, click Next.
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7. On the Connections window, browse to or select a DAP Application object from the drop-down list,
and then click Next.

8. In the Log Configuration window, click Run Log Wizard to customize your log settings, or click Next
to accept the default log settings. You can change these settings at any point by using the Wizard to
edit your WFM Client Application object or by editing the Log section on the Options tab of the WFM
Client Application object. Procedures for editing Options tab settings are described WFM
Configuration Options.

9. To close the WFM Client Application Wizard, click Finish.
The new Application object appears in your Configuration Manager Applications folder.

10. Select your new WFM Client Application object and then click OK.
The new Application object now appears in the Solution Components list.

11. Click Next to continue.

End of Procedure

Next Step:

• Genesys recommends that you add a connection to WFM Server. To do so, open the WFM Client
Application object after you finish the sequence of Configuration Wizards and on the Connections
tab, add a connection to WFM Server.

|-| Creating the Web Application Object=

Purpose: To create the WFM Web Application object.

Start of Procedure

1. In the WFM Solution Wizard WFM Web window, click New.

2. Click the New Application icon ( ).
The WFM Web Wizard opens.

3. Click Next to start using the WFM Web Wizard.
4. Enter a name for your WFM Web Application object, and then click Next.

The Server Info window opens.
5. Select the host name and port number for the computer on which you want this application installed,

and then click Next.
The Installation Package window opens.

6. Select or specify the Source and Destination directories for the Installation Package, and then click
Next.

7. On the Installation Ready page, click Next.
8. Select from the drop-down list or browse to your WFM Server Application object, and then click Next.
9. Click Next.

10. On the Log Configuration window, click Run Log Wizard to customize your log settings, or click Next
to accept the default log settings. You can change these settings at any point by using the Wizard to
edit your WFM Web Application object or by editing the Log section on the Options tab of the WFM Web
Application object. Procedures for editing Options tab settings are described in WFM Configuration
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Options.
11. To close the WFM Web Wizard, click Finish.

The new Application object appears in your Configuration Manager Applications folder.
12. Select your new WFM Web Application object and then click OK.

The new Application object now appears in the Solution Components list.
13. Click Next to continue.

This step completes the WFM Solution Wizard.
14. To close the wizard, click Finish.

Your new WFM Solution appears on the Genesys Wizard Manager Workforce Management window.

End of Procedure

</multistep>

Back to Top
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Manually Creating and Configuring WFM
Application Objects
This topic contains information and procedures that will help you to use Genesys Administrator and
other tools to manually create Workforce Management (WFM) Application objects and perform
other configurations manually. It contains the following sections:

• Manually Create the Application Objects
• WFM Daemon Setup
• Manually Change Configuration Server Host and Port
• Procedures

Manually Create the Application Objects

If you are familiar with Genesys Administrator, you might choose to create and configure the
component Application objects manually, rather than using the wizards. See Creating Application
Objects Manually.

Tip
You might also want to install redundant WFM Servers. If so, see Connect to Backup
WFM Server.

WFM Daemon Setup

To successfully run WFM Daemon, you must set the correct SMTP server host and port. Depending on
your configuration, you might also need to set the user name and password. For information about
how to set these options, see the “SMTP Section” of WFM Daemon Options.

To support automatic report creation, perform these configurations using Genesys Administrator:

• In the WFM Web Application, set the Reports section variable ServerURL. See Installing WFM Web as
Report Server.

• In the WFM Web Application, set the Reports section variable PathToAutoGeneratedReports to the
network path for storing generated reports. See WFM Web Options.

• In the WFM Daemon Application, add a connection to the WFM Web Application that you installed as
the report server in Installing WFM Web as Report Server.
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For notifications to work successfully:

• Each agent and supervisor must have the proper e-mail set. As described in the Workforce Management
Configuration Utility Help, e-mail addresses are initially defined in Genesys Administrator as part of the
Person object. Once e-mail addresses exist in the Configuration Database, you have the option of
importing them into the WFM Database.

• The supplied SMTP server must be configured to accept e-mails for those addresses. Before anything
can be sent, you must first configure notifications in the WFM Web for Supervisors, Configuration
module, as described in Workforce Management Web for Supervisor Help.

• A Supervisor’s ability to receive notifications depends on their security settings (see User Security).
Supervisors must be granted rights to receive notifications for each notification type and have access
to the agent teams for which they want to receive notifications, as described in Workforce Management
Configuration Utility Help.

Back to Top

Manually Change Configuration Server Host and Port

You might need to change the Configuration Server host and port information for the WFM servers
after installing WFM.

Important
Editing a startServer.bat file is effective only if the server is started by using the
.bat file. If you start the server manually from the control panel, or if it is started
automatically as a Windows service, you must unregister the server and then re-
register it. If you start the server using the Solution Control Interface (SCI), you must
change the settings for the server in the server’s Application object, by using
Genesys Administrator.

To update or change this information manually you can use one of two methods:

• Edit the startServer.bat file for each affected server.
• Unregister the servers and then reregister them, by using the updated host, port, and application name

information.

For procedures that describe both methods, see Editing the startServer.bat files and Using Server
Registration to change Host and Port.

The startServer.bat files for each server are located in the same directory as the executable for
that server.

Backup Configuration Server Host and Port
WFM Web supports backup Configuration Server during application startup with the addition of two
new values in ConfigServer.properties file: BackupHost and BackupPort. These options are
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specified in the same way as the Host and Port options and have the same meaning, except that
they specify how to connect to the backup Configuration Server. If the primary Configuration Server is
not available, WFM Web uses this information to connect to the backup Configuration Server.

To configure these options manually, edit the ConfigServer.properties file in the Tomcat directory
webapps\wfm\WEB-INF (assuming that WFM Web was deployed as wfm.war, otherwise wfm should be
replaced with the specified name). In addition, the application name must be the same on both
primary and backup Configuration Server.

For more information about configuring connections to backup Configuration Server, see Connect to
Backup Configuration Server.

Important
These options might not set automatically during application startup. By default they
do not exist. Therefore, you must configure the options manually, as described above.

Back to Top

Procedures

Click the red arrow to display a list of procedure related to the topics on this page.

<multistep>

|-| Creating Application objects manually=

Purpose: To create WFM Application objects manually (not using the Configuration Wizards).

Start of Procedure

1. In Genesys Administrator, open the Environment > Applications folder.
2. Right-click in the folder and select New Application from the shortcut menu that appears.
3. Browse to and select the appropriate application template from those you previously imported. If

necessary, see Import the WFM Templates for instructions.
4. Enter the appropriate information in each tab of the Application object. The information on most of

these tabs is familiar to regular users of Genesys Administrator. Ensure the settings are correct on the
Connections tab of each Application object. For the complete set of required connections, see Table:
WFM Component Connections.

End of Procedure

Next Steps:

• Manually configure the Options tab settings. For a list of options with default settings and descriptions,
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see WFM Configuration Options.

|-| Editing the startServer.bat files=

Purpose: To edit the WFM startServer. bat files.

Start of Procedure

1. To edit the WFM startServer. bat file, stop the WFM server.
2. Open the startServer.bat file in a text editor, such as WordPad.
3. Change the host and port information.
4. Save the edited file.
5. Restart the server.

End of Procedure

|-| Using Server Registration to change Host and Port=

Purpose: To change the host and port for a server.

Summary: You can also change the host and port information for the servers by unregistering them
as services and then re-registering them using the new host and port.

Start of Procedure

1. Execute the following command from the command line to unregister the installed service:

<server .exe filename> -remove

For example, WFMServer.exe -remove
2. Register the service with new host and port information:

<server .exe filename> -install -host “<hostname>” -port “<portnumber>” -app
<applicationname>

For example, WFMServer.exe -install -host “Siamese” -port 4000 -app WFMServer_76

End of Procedure

</multistep>

Back to Top
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Installing WFM Database Utility
The Workforce Management (WFM) Database Utility configures the database you created (see Create
Your WFM Database) to receive WFM data. If you are migrating from a previous version of Genesys
Workforce Management (WFM), the WFM Database Utility also transfers your existing data into the
new database.

Important
If you are migrating, see the "Workforce Management Migration Procedures" chapter
in the Genesys Migration Guide for instructions. The procedures in this Administrator’s
Guide are based on the assumption that this is a new installation and do not describe
the steps that are necessary for migration.

Procedure: Installing the WFM Database Utility

Purpose: To install the WFM Database Utility.

Start of Procedure

1. Ensure the Microsoft .NET Framework Version 1.1 or higher is installed on the host.
See the Genesys Supported Operating Environment Reference Manual.

2. On your Workforce Management release disk, navigate to the solution_specific\
WFMDatabaseUtility\windows directory.

3. Double-click Setup.exe.
The Database Utility Installation Wizard opens.

4. Click Next to start using the Database Utility Installation Wizard.
5. Select the directory into which you want to install the WFM Database Utility and then click Next.
6. On the Ready to Install window, click Install.

A progress bar shows the setup status.
7. Click Finish to close the Installation Wizard.

Important
You must restart your computer before you can use the WFM Database Utility.

End of Procedure
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Running the WFM Database Utility

When you start the 8.1 WFM Database Utility for the first time, the options that are available depends
on whether the WFM Database Utility finds a 7.x database. If you have only a blank database, you
can choose one of three actions:

1. Restore Database from .MDB File—Use this option to restore your database from a backup file.
Restoring creates a database with the same version number as the database you backed up and
restores your data from the backup file to the new database.

Important
In some cases, after restoring your database, you must run the WFM Database Utility again and select Update
Database to update your database to the latest 8.1 version.

2. Create Database—Use this option to create your 8.1 database if this is your first WFM installation.
3. Migrate Database—Use this option to migrate data from a release 6.x database.

If you have been running WFM 7.x, select Update Database to update the database to the latest
version.

Important
You must configure your database to be case insensitive.

Back to Top
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Installing and Uninstalling WFM
Components
This topic provides information and procedures about how to install and uninstall the Workforce
Management (WFM) components. All of the component installation are straight forward, but you will
need to complete some additional tasks for WFM Web. See Installing WFM Web.

To uninstall any or all WFM components, see Uninstalling Workforce Management.

Installing the Components

Before you begin installing the WFM components, determine whether to install more than one
component on a single machine. If you do so, determine which components should be installed
together.

See Deploying WFM, for some general deployment guidelines and recommendations. See the
Genesys Hardware Sizing Guide for more extensive recommendations.

By default, all the servers are installed as Windows Services. For instructions about how to use
Windows services, see the Windows Help file.

For instructions about how to install the WFM components, see:

• Installing WFM Server
• Installing WFM Builder
• Installing WFM Data Aggregator
• Installing WFM Configuration Utility
• Installing WFM Daemon
• Installing WFM Web.

Date and Time Dependencies for WFM Applications
The following are the sources of the date and time setting for WFM applications:

• In WFM Web Supervisor, the date, time, and number formats depend on language preference that is
configured in the browser that is being used.

• In WFM Web Agent, the date and time format depends on the locale of Web Server and is identical for
all agents connected to the same server.

• In WFM Configuration Utility, the date and time format depends on the locale of the Configuration Utility
workstation.
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Configuring Multiple WFM Builder Applications
If multiple WFM Builder Applications are connected to the WFM Server, you can configure WFM
Server to select the Builder Applications with the shortest queue.

Go to the Configuration > User Security > User_name > Modules tab and select None (the
default) from the WFM Builder drop-down list box. The result:

For each supervisor's request to build a schedule, WFM Web asks WFM Server to locate an instance of
WFM Builder. To do so, WFM Web goes to an original locator—although not to the WFM Server in its
current session.

WFM Server selects a WFM Builder instance from its Configuration Server Application connection
list. (WFM Server periodically polls all of the Builder Applications that are specified in its
connection list, to get information about their current request queue and to make sure the
connections remain active.) In response to the request from WFM Web to locate a WFM Builder
instance, WFM Server returns the active WFM Builder Application with the shortest queue.

Selecting a Specific Builder Application

For each user that is defined in WFM, you can select a specific WFM Builder Application (one that is
installed on a user's workstation or dedicated to a group of users) that would serve all schedule
building requests initiated by that user.

Go to the Configuration > User Security > User_name > Modules tab and select an item (not the
default None) from the WFM Builder drop-down list box. However, you do not need to select a specific
WFM Builder Application. If you want all users to share the same WFM Builder server, you can
specify None as described above.

Back to Top

Uninstalling Workforce Management

Use the Task Summary in this section to ensure you have completely uninstalled WFM.

Task Summary: Uninstalling WFM Web
Task Description and procedures

Stop all WFM components, including those running
as Windows Services. See Starting and Stopping WFM Components.

If you are using Tomcat, delete WFM from Tomcat. For instructions, see Deleting WFM Web from
Tomcat.

If you are using WebSphere, delete WFM from
WebSphere.

For instructions, see Deleting WFM Web from
WebSphere and your WebSphere documentation.

Use Add/Remove Programs to uninstall the WFM
components from the Windows platform.

For instructions, see Using Add/Remove Programs
to Uninstall WFM.

If you are using a Unix-based platform, delete all
files in the relevant folders. Be sure to use caution when deleting files.

Deploying WFM Installing Workforce Management

Workforce Management Administrator's Guide 74



Deleting WFM Web from WebSphere
Delete WFM Web, by using your WebSphere Administrative Console. For the procedure that describes
how to do this, see your WebSphere documentation.

Important
After completing the uninstall, you can then deploy a new version of WFM Web, by
again, using the WebSphere Administrative Console to do so.

Back to Top

Procedures

Click the red arrow below to see a list of procedures related to the topics on this page.

<multistep>

|-| Installing WFM Server=

Purpose: To install WFM Server.

Start of Procedure

1. On your Workforce Management release disk, navigate to the solution_specific\WFMServer\windows
directory.

2. Double-click Setup.exe.
This WFM Server Installation Wizard open.

3. Click Next to begin using the Wizard.
4. Enter your Configuration Server host name, port number, user name, and password, and then, click

Next.
A list of WFM Server Application objects displays.

5. Select the correct Application object and then click Next.
The properties for each WFM Server Application object display in the Application Properties list
when that Application is selected.

Important
If you are running a Framework 6.x environment, your WFM Server’s Application type must be Third Party
Server.

6. Specify the destination directory into which you want to install WFM Server. Then, click Next.
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7. In the Ready to Install window, click Install.
A progress bar shows the setup status.

Important
You must restart your computer before starting WFM Server. If you are installing multiple components on one
machine, you can install them all before restarting. However, you cannot install multiple instances of the
same component on the same host.

End of Procedure

|-| Installing WFM Builder=

Purpose: To install WFM Builder.

Start of Procedure

1. On your Workforce Management release disk, navigate to the solution_specific\WFMBuilder\
windows directory.

2. Double-click Setup.exe.
This WFM Builder Installation Wizard open.

3. Click Next to begin using the Wizard.
4. Enter your Configuration Server host name, port number, user name, and password, and then, click

Next.
A list of WFM Builder Application objects displays.

5. Select the correct Application object and then click Next.
The properties for each WFM Builder Application object display in the Application Properties list
when that Application is selected.

Important
If you are running a Framework 6.x environment, your WFM Builder’s Application type must be Third Party
Server.

6. Specify the destination directory into which you want to install WFM Builder. Then, click Next.
7. In the Ready to Install window, click Install.

A progress bar shows the setup status.
8. Click Finish to close the Installation Wizard.

End of Procedure

|-| Installing WFM Data Aggregator=
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Purpose: To install WFM Data Aggregator.

Important
A restriction limits the number of clients to about 8 if WFM Data Aggregator and WFM
Web are installed on the same computer. For full details, see TCP/IP Connection
Settings.

Start of Procedure

1. On your Workforce Management release disk, navigate to the solution_specific\
WFMDataAggregator\windows directory.

2. Double-click Setup.exe.
This WFM Data Aggregator Installation Wizard open.

3. Click Next to begin using the Wizard.
4. Enter your Configuration Server host name, port number, user name, and password, and then, click

Next.
A list of WFM Data Aggregator Application objects displays.

5. Select the correct Application object and then click Next.
The properties for each WFM Data Aggregator Application object display in the Application
Properties list when that Application is selected.

Important
If you are running a Framework 6.x environment, your WFM Data Aggregator’s Application type must be
Third Party Server.

6. Specify the destination directory into which you want to install WFM Data Aggregator. Then, click Next.
7. In the Ready to Install window, click Install.

A progress bar shows the setup status.
8. Choose to restart your computer now or later and then, click Finish to close the Installation Wizard.

Important
You must restart your computer before starting WFM Data Aggregator. If you are installing multiple
components on one machine, you can install them all before restarting. However, you cannot install multiple
instances of the same component on the same host.

End of Procedure

|-| Installing WFM Configuration Utility=
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Purpose: To install WFM Configuratin Utility.

Start of Procedure

1. On your Workforce Management release disk, navigate to the solution_specific\
WFMConfigurationUtility\windows directory.

2. Double-click Setup.exe.
This WFM Configuratin Utility Installation Wizard open.

3. Click Next to begin using the Wizard.
4. Specify the destination directory into which you want to install WFM Configuration Utility. Then, click

Next.
5. In the Ready to Install window, click Install.

A progress bar shows the setup status.
6. Click Finish to close the Installation Wizard.

End of Procedure

|-| Installing WFM Daemon=

Purpose: To install WFM Daemon.

Prerequisites: Framework and Java SDK are installed and configured. To determine the required
versions of Framework and Java, consult the WFM section at the end of the table “Product
Prerequisites” in the Genesys Supported Operating Environment Reference Manual.

Important
You must install a Java version that includes the <specifier> time zones update. See
details and use the Java version that is specified on the java.sun.com website.

Start of Procedure

1. On your Workforce Management release disk, navigate to the solution_specific\WFMDaemon\windows
directory.

2. Double-click Setup.exe.
This WFM Daemon Installation Wizard open.

3. Click Next to begin using the Wizard.
4. Enter this information for your Configuration Server: host name, port number, user name, and

password. Then click Next.
A list of WFM Daemon Application objects displays.

5. Select the correct Application and then click Next.
The properties for each WFM Daemon Application object displays in the Application Properties list
when that Application is selected.
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Important
If you are using Genesys Configuration Server releases later than

7.2 but earlier than 7.5, your WFM Daemon’s Application type must be Genesys Generic Server. If you are
using Genesys Configuration Server 7.5 or later, your WFM Daemon’s Application type must be WFM Daemon.

6. Specify the destination directory into which you want to install WFM Daemon. Then, click Next.
7. In the Ready to Install window, click Install.

A progress bar shows the setup status.
8. Choose to restart your computer now or later and then, click Finish to close the Installation Wizard.

End of Procedure

Important
You must restart your computer before starting WFM Daemon. If you are installing
multiple components on one machine, you can install them all before restarting.
However, you cannot install multiple instances of the same component on the same
host.

For more information about WFM Daemon, see Using E-mail Notifications in WFM.

|-| Deleting WFM Web from Tomcat=

Purpose: To delete WFM Web from Tomcat.

Summary:

• Genesys recommends using Tomcat Manager to correctly deploy/undeploy WFM Web.
• Uninstalling WFM Web does not remove the .war file or the WFM directory from the webapps folder.

Genesys recommends that you remove the .war file and WFM directory prior to reinstalling or updating
WFM Web.

• If you reinstall or update WFM Web, before clients can access the software, you must remove the old file
and replace the .war file with the new version of the file. The default file name is wfm.war and the
default directory name is wfm.

• If you reinstall WFM Web without first manually deleting these files, the files are not updated. WFM Web
will not run if you install a later version of WFM Web over an earlier one without first deleting these
files.
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Start of Procedure

1. Open the >CATALINA_HOME>\webapps directory.
See Set Environment Variables.

2. Delete the WFM .war file and the WFM directory from the webapps folder.
3. Delete the $CATALINA_BASE\work\Catalina\localhost\wfm folder.

End of Procedure

|-| Using Add/Remove Programs to Uninstall WFM=

Purpose: To uninstall WFM components, by using the Add/Remove Programs tool on Windows
platforms.

Start of Procedure

1. Select Start > Settings > Control Panel and open Add/Remove Software.
2. Scroll through the list of programs to locate the one you intend to uninstall.
3. Click Change/Remove.
4. When the UninstallShield Wizard that opens, follow the prompts.

Important
Although you might not be prompted to restart your computer after removing a WFM component, it is
recommended.

End of Procedure

</multistep>

Back to Top
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Installing WFM Web
Before you install Workforce Management Web, you must consider ensure the prerequisites, and
some web tools and applications are installed and configured on the WFM Web host computer. Use
the Task Summary in this section to ensure you have adequately prepared the WFM host and your
installation goes smoothly.

This page includes the following topics:

• Browser Security Considerations
• TCP/IP Connection Settings
• Configuring Tomcat for WFM Web
• Configuring WebSphere for WFM Web
• Choosing the Platform for WFM Web
• Recommendations for WFM Web as a Report Server
• Procedures

Important
For information and procedures describing how to uninstall WFM Web, see Uninstalling
Workforce Management.

Task Summary: Preparing and Installing the WFM Web Host
Task Description and procedures

Ensure the prerequisites are installed.

Framework 7.2 or higher and Java SDK are
required.
To learn which version of Java is required, consult the WFM
section at the end of the table “Product Prerequisites” in the
Genesys Supported Operating Environment Reference Manual.

Install and configure Jakarta Tomcat or IBM
WebSphere.

For installation and configuration instructions
specific to Genesys Workforce Management:

• For Tomcat see, Configuring Tomcat for WFM
Web

• For WebSphere see, Configuring WebSphere for
WFM Web

Install the WFM Web application. See Choosing the Platform for WFM Web.
Install a supported browser on each workstation
that will access WFM Web.

For WFM Web for Supervisors, the browser
installation must include the appropriate Java plug-
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Task Description and procedures
in. If this plug-in was not installed with the browser,
download the plug-in from java.sun.com.
To learn which version of Java is required, consult the WFM
section at the end of the table “Product Prerequisites” in the
Genesys Supported Operating Environment Reference Manual.

Important to Note—If the computers that will be accessing
WFM Web for Supervisors have pop-up blockers installed, they
must be configured to allow popups from the WFM Web URL.
Otherwise, pop-up blockers prevent WFM Web for Supervisors
from opening.

The version of Java that you install must include the latest time
zones update (TZ/Olson database). See java.sun.com for details
and use the Java version that is specified there.

Ensure your browser and TCP/IP settings are
configured to run WFM Web for Supervisors
correctly.

See Browser Security Considerations and TCP/IP
Connection Settings

Verify that your window resolution has been set to
display WFM Web
correctly.

WFM Web is optimized for a window resolution of at
least 1024 x 768. At lower resolutions, some
elements (such as table headers) might not display
correctly.

(Optional) Set up WFM Web as Report server. See Recommendations for WFM Web as a Report
Server.

Back to Top

Browser Security Considerations

WFM Web uses technical approaches that might be affected by web browser security settings, such
as:

• WFM Web uses signed Java applets on Supervisors’ workstations.
• WFM Web uses Java applets on Supervisors’ workstations that are run by Sun’s Java Plug-in. On

Windows operating systems, the Java Plug-in is running as ActiveX, which means that supervisors must
have rights to run ActiveX controls.

• WFM Web uses non-encrypted form data in the login page for all users.
• WFM Web relies on active scripting for all users.
• When running WFM Web in an AIX or Solaris operating system environment, if the X Server software is

not installed, reports might not be generated or might be generated incorrectly. In the case of WFM
Web, X Server provides fonts and related functionality.

TCP/IP Connection Settings

In environments with higher loads (more than 100 total supervisors or 50+ supervisors running agent
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real-time adherence views) you might need to change the default TCP settings on computers running
the WFM servers: WFM Web, WFM Data Aggregator, and WFM Server. You can determine whether you
need to adjust your settings by monitoring the number of TCP sockets in the TIMED_WAIT mode. If the
number exceeds 2000 on one computer or if WFM Web with servers start to report TCP socket errors,
modify the settings to make TCP release port resources faster.

Important
Genesys has identified this issue on Windows-based machines. Similar changes are
probably required for other operating systems. However, Genesys has not determined
recommended adjustments to other operating systems.

To resolve this issue, you must make changes to the HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\Tcpip\Parameters\ section in the registry of the host computers.

You can find a reference for this registry modification in the Microsoft TCP/IP Implementation Details
document for the appropriate operating system at www.microsoft.com.

Genesys recommends these values:

• Increase the MaxFreeTcbs configuration option value from 2000 to 9000.
• Increase the MaxFreeTWTcbs option value from 1000 to 8000.
• Increase the MaxHashTableSize option value from 512 to 2048.
• Increase the MaxUserPort option from value 5000 to 65534.
• Reduce the TcpTimedWaitDelay option value from 240 to 60.

Back to Top

Configuring Tomcat for WFM Web

After installing WFM Web, you must manually copy the .war file (by default, located in the WFM8\Web
directory) to the Tomcat webapps directory.

Important
Tomcat is available for download at jakarta.apache.org. There is no charge for this
program. For basic installation and configuration instructions, see the Tomcat
documentation, available at the same website as the program.

Warning

Deploying WFM Installing Workforce Management

Workforce Management Administrator's Guide 83



Genesys developed and tested supported servlet containers using the default settings
as configured for each particular servlet runner during installation time. Any changes
to default settings are described in this document. If you use custom settings for
servlet containers and experience issues while configuring and/or running WFM Web,
Genesys recommends that you evaluate the impact of those custom settings. You
might need to re-adjust them to ensure they do not interfere with the operation of
WFM Web.

The following sections describe specific configurations that enable Tomcat to support WFM Web:

Set Environment Variables
When configuring Tomcat, add the variables JAVA_HOME and CATALINA_HOME to the Windows Start >
Settings > Control Panel > System > Environment > System Variables list. Enter the full path to
each home directory for the values for theses variables. CATALINA_HOME is the folder in which Tomcat
is installed.

JVM Command-Line Settings
Tomcat’s default settings are not suitable for production sites that experience moderate or heavy
load. To support Web Services, you must enter the settings in the Table: Tomcat JVM Settings for the
Java Virtual Machine (JVM) that runs Tomcat.

Important
You can enter Tomcat settings in different ways, depending on your Tomcat version
and configuration. Refer to your Tomcat documentation for details.

Table: Tomcat JVM Settings

JVM Setting Purpose

-Xms256m Instructs JVM to initially allocate 256 MB of memory
for its own needs.

-Xmxnm

Determines the maximum amount of memory the
JVM can allocate for its own needs. For example,
-Xmx256m would allocate a maximum of 256 MB.
If you are experiencing OutOfMemory exceptions with Tomcat,
increase this setting’s n parameter to provide Tomcat more
memory. Make sure that enough physical memory is available to
support the parameter that you choose.

-XX:MaxPermSize =256m
Sets the size of the Permanent Generation, so
Tomcat can run properly. 256 is the mandatory
minimum value.

WFM 8.5 requires settings changes to the Apache Tomcat Properties dialog, accessible by opening
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the file C:\Apache\Tomcat6.0\bintomcat6w.exe (the location on your computer might be different).
Select the Java tab. See Table: Minimum Tomcat Java Settings.

Table: Minimum Tomcat Java Settings

Item Recommended setting
Initial memory pool 256
Maximum memory pool 1024

Back to Top

Configuring WebSphere for WFM Web

Important
See the Warning, which applies to configuring both Tomcat and WebSphere.

The libraries that WebSphere provides by default for web services are older than, and incompatible
with, the libraries that WFM Web requires. If you do not set the Classloader Mode option to
PARENT_LAST, the WebSphere libraries are loaded first, causing WFM Web not to run. After you set
PARENT_LAST, the WFM Web libraries are loaded first, which enables WFM Web to run correctly.

Important
Configuring the Classloader Mode option to PARENT_LAST in no way affects other
applications running simultaneously in WebSphere.

See also, Configuring WebSphere.

Choosing the Platform for WFM Web

Install WFM Web on either a Windows or a Unix-based platform:

• To install on Windows platforms, see Installing WFM Web (Windows).
• To install on Unix-based platforms, see Installing WFM Web (Unix).
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Recommendations for WFM Web as a Report Server

Workforce Management no longer uses the WFM Reports server component found in previous WFM
versions to generate reports. Instead, Workforce Management uses the WFM Web component to
generate reports.

Important
In addition to functioning as a report server, by default, WFM Web 8.1 continues to
perform all its usual WFM Web functions.

Report generation requires the same, and sometimes more hardware requirements than other WFM
Web functions, Genesys recommends that medium or large sites (as described in the Genesys
Hardware Sizing Guide) install a separate WFM Web Server to function as a report server. If you are
upgrading, use the same hardware previously used for the 7.2 WFM Reports component to set up 8.1
WFM Web as the report server.

To install WFM Web as the reports, see Installing WFM Web as Report Server server.

Back to Top

Procedures

Click the red arrow to display a list of procedure that are related to the topics on this page.

<multistep>

|-| Configuring WebSphere=

Purpose: To configure WebSphere for WFM Web.

Start of Procedure

1. Log in to the WebSphere Administration Console.
2. Navigate to Applications > Enterprise Applications.
3. Install the WFM Application from the wfm_war directory and save it to the master configuration.
4. Locate the newly-installed WFM WebApp and click its link to drill down into the configuration.
5. On the Configuration tab, locate the Related Items group. The Classloader Mode setting, located

on Configuration tab, is not the correct place to set the classloader option. It will not provide the
desired effect if set only in that tab.

6. Click the Web Modules link to open the WebModuleDeployment page.
7. Click the *.war link to open Web Module configuration properties.
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8. Locate the Classloader Mode row and change the control value to PARENT_LAST.
9. Save the changes.

End of Procedure

Next Steps:

• Start the WFM application.

Important
Genesys recommends that you adjust memory and processing thread settings for
WebSphere to similar values as specified for Tomcat (see Table: Tomcat JVM Settings).
For the exact location of those settings, consult the Websphere documentation.

|-| Installing WFM Web (Windows)=

Purpose: To install WFM Web on the Windows platform.

Start of Procedure

1. On your Workforce Management release disk, navigate to the windows subdirectory in the
solution_specific\WFMWeb directory.

2. Double-click Setup.exe.
The WFM Web Installation Wizard opens.

3. Click Next to begin using the Wizard.
4. Enter your Configuration Server host name, port number, user name, and password, and then, click

Next.
A list of WFM Web Application objects displays.

5. Select the correct Application object and then click Next.
The properties for each WFM Web Application object display in the Application Properties list
when that Application is selected.

Important
If you are running a Framework 6.x environment, your WFM Web’s Application type must be Third Party
Server.

6. Specify the destination directory into which you want to install WFM Web. Then, click Next.
7. In the Ready to Install window, click Install.

A progress bar shows the setup status.
8. Click Finish to close the Installation Wizard.
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9. Using the Tomcat or WebSphere Administrative Console, locate the WFM .war file and move it to the
appropriate directory for the web server you are using.
For example, if you are using Tomcat, deploy the .war file in the webapps directory. For the location if
you are using WebSphere, see your WebSphere documentation.

End of Procedure

|-| Installing WFM Web (Unix)=

Purpose: To install WFM on the Unix platform.

Start of Procedure

1. On your Workforce Management release disk, navigate to the appropriate subdirectory in the
solution_specific\WFMWeb directory.
Your choice of subdirectory depends on the platform on which you are installing WFM Web. The choices
are AIX and Solaris.

2. Launch install.sh.
3. Enter this information for your Configuration Server: host name, port number, user name, and

password.
4. Enter the name of your WFM Web Application object.
5. Specify the destination directory into which you want WFM Web installed.
6. Click Finish to close the Installation Wizard.
7. Using the Tomcat or WebSphere Administrative Console, locate the WFM .war file and move it to the

appropriate directory for the web server you are using.
For example, if you are using Tomcat, deploy the .war file in the webapps directory. For the location if
you are using WebSphere, see your WebSphere documentation.

End of Procedure

|-| Installing WFM Web as a Report Server=

Purpose: To install and configure a separate instance of WFM Web as the reports server.

Start of Procedure

1. Install WFM Web using the steps, as described in Installing WFM Web (Windows) or Installing WFM Web
(Unix). .

2. In the Configuration Manager, in the WFM Web Application properties, set the value for option
ServerURL in the Reports section, by entering the complete URL that was used to installed WFM Web.
For a complete description of the ServerURL option, see WFM Web Options.
For example: http://<host>:<port>/<appname>
In this example:
• <host> and <port> refer to where the servlet container (the one that will function as the report

server) for WFM Web is running.
• <appname> is the name that is used while WFM Web is being deployed.
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Important
You must be able to use this URL to login to the WFM Web Server that will function as the report server.

3. In the Connections tab of the WFM Web Application that will perform all the usual WFM Web functions
except report generating, include the Application name of the WFM Web Application that will
function as the report server.

End of Procedure

</multistep>
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Starting and Stopping WFM
To maintain your Workforce Management (WFM) Servers, you can start and stop them by using
Management Layer or start and stop them manually. When using Management Layer, you start WFM
Server, WFM Builder, WFM Data Aggregator, and WFM Daemon from the Solution Control Interface
(SCI).

You must start WFM Web, WFM Configuration Utility, and WFM Database Utility manually, even when
you are using Management Layer.

Important
When starting WFM, confirm that all servers are running before starting WFM Web, the
WFM Configuration Utility, and the WFM Database Utility.

This topic includes procedures you can use to start and stop WFM Applications and components in
the following sections:

• Using Solution Control Interface
• WFM Servers
• WFM Configuration Utility
• WFM Database Utility
• WFM Web

Using Solution Control Interface

Use SCI to start and stop WFM by completing the procedures in this section.

[+]

Procedure: Starting WFM Using SCI

Purpose: To start Workforce Management by using SCI.

Prerequisites: Management Layer is running.

Start of Procedure

1. Start the SCI.
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2. Go to the Solutions view.
3. Right-click the desired solution and from the shortcut menu, select Start.

-or-
Select the desired solution an, on the menu bar, choose Action > Start.
The command to start WFM is sent to Solution Control Server (SCS), which uses Local Control Agents
(LCA) to activate the WFM solution components in the order established during solution configuration.
SCI reports a successful start of WFM after all solution components display Running status within the
configured timeout. When all servers are started, the solution status changes from Stopped to Started.

Important
Many components are shared by a number of solutions, therefore,
some WFM components display the status Running before WFM is
started.

SCI reports a successful start of WFM unless a required WFM component was not started. For more
information, see Framework Solution Control Interface Help. To view the Help, open SCI and click Help.

End of Procedure

For more information on Management Layer topics, see the Framework Management Layer User's
Guide.

Procedure: Stopping WFM from Inside SCI

Purpose: To stop WFM while running SCI.
Prerequisites: You are using Management Layer.

Start of Procedure

1. Start SCI.
2. Go to the Solutions view.
3. Right-click the desired solution and from the shortcut menu, select Stop.

-or-
Select the desired solution an, on the menu bar, choose Action > Stop.
The command to stop WFM is sent to Solution Control Server (SCS), which uses Local Control Agents
(LCA) to activate the WFM solution components in the order established during solution configuration.
SCI reports a successful stop of WFM after all solution components display Running status within the
configured timeout. When all servers are stopped, the solution status changes from Started to
Stopped.

Important
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Many components are shared by a number of solutions, therefore,
some WFM components display the status Running before WFM is
stopped.

End of Procedure

For assistance, see Framework Solution Control Interface Help. To view Help, open SCI, and click Help.

Back to Top

WFM Servers

There are several ways to start the WFM servers (WFM Server, WFM Builder, WFM Data Aggregator,
and WFM Daemon). See the procedures in Starting WFM Servers

Important
The servers are installed on Windows platforms as Windows Services, by default.

You can also stop the WFM servers in several ways, depending on whether you are using
Management Layer and whether the servers are installed as Windows Services. See the procedures in
Stopping WFM Servers.

Important
If you terminate a server using the Windows Task Manager, you will lose all data on
currently active interactions because Windows does not allow enough time for the
servers to save the active data.

Starting WFM Servers
[+]

Procedure: Configuring Windows Services

Purpose: To open and configure each WFM Windows Service.
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Tip
You can configure a Windows Service to start automatically or
manually.

Start of Procedure

1. In Windows, select Start > Programs > Settings > Control Panel > Services.
The Services window appears. Each service has status settings showing whether it starts manually or
automatically and whether it is currently running.

2. Highlight the service you want to configure and then click Startup.
3. Select automatic or manual.
4. Click OK. In the Services window, click Close.

The settings are saved.

End of Procedure

Procedure: Starting a Windows Service Manually

Purpose: To start a Windows service manually.

Tip
If a Windows Service is configured to start automatically, it will start
whenever the computer is started. No further action is required.

Prerequisite: This Windows service is configured to start manually.

Start of Procedure

1. In Windows, select Start > Programs > Settings > Control Panel > Services.
The Services window appears.

2. Highlight the Service that you want to start.
3. Click Start.

End of Procedure
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Procedure: Starting WFM Servers Manually

Purpose: To start the Workforce Management servers manually.

Start of Procedure

1. In Windows, select Start > Programs > Genesys Solutions > Workforce Management > <server
name>.
The server console window opens and the server begins its initialization routine.

2. If desired, right-click the window title bar to change server display settings.
3. Minimize the window after the server has started.

End of Procedure

Stopping WFM Servers
[+]

Procedure: Stopping a Server Manually

Purpose: To terminate a server process that is running in a console window rather than as a Service,
without using the Windows Task Manager.

Summary: The method for stopping a server manually depends on whether you installed it as a
Windows Service. If the server is running in a console window rather than as a Service, shut it down
using this procedure.

Start of Procedure

1. Enter [Ctrl+Break] or [Ctrl+C].

End of Procedure

Important
You cannot close a server by clicking the Close button (X) or by
selecting File > Close from the console menu bar. Abrupt or
abnormal shutdown can cause data loss.

Procedure: Stopping a Server from Command Prompt
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Purpose: To stop a server’s Windows Service from the command prompt.

Important
This procedure does not apply to WFM Daemon.

Start of Procedure

1. In Windows, select Start > Programs > Command Prompt.
2. Change to the directory in which the server’s .exe file is located.
3. At the prompt, enter <servername>.exe -sstop.
4. If you are using SCI in the Management Layer:

i. Select the server application.
ii. Click Stop.

End of Procedure

Procedure: Stopping a Server’s Windows Service

Purpose: To stop a Service from the Services window.

Start of Procedure

1. In Windows, select Start > Programs > Settings > Control Panel > Services.
2. Select the appropriate Service.
3. Click Stop.
4. Click Close.
5. If you are using SCI in the Management Layer:

i. Select the server application.
ii. Click Stop.

End of Procedure

Back to Top
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WFM Configuration Utility

Use the procedures in this section to start and stop WFM Configuration Utility.

[+]

Procedure: Starting WFM Configuration Utility

Purpose: To start the WFM Configuration Utility.

Prerequisites: The WFM Servers are running.

Start of Procedure

1. In Windows, select Start > Programs > Genesys Solutions > Workforce Management >
Configuration Utility.
The Login dialog box appears.

2. Enter your user name and password.
3. If this is the first time you are opening the WFM Configuration Utility, click Details. Then, enter the

Configuration Server host name and port number and the name of the WFM Configuration Utility
Application object that you configured, by using Configuration Manager.

4. On the Modules pane, choose a module to start using the WFM Configuration Utility.

End of Procedure

Important
Click Help within any Configuration Utility window to open Workforce
Management Configuration Utility Help.

Procedure: Stopping WFM Configuration Utility

Purpose: To stop the WFM Configuration Utility.

Start of Procedure

1. From the File menu, select Exit. -or- In the upper-right corner of the application window, click the X
button.

End of Procedure
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WFM Database Utility

Use the procedures in this section to start and stop WFM Database Utility.

[+]

Procedure: Starting WFM Database Utility

Purpose: To start the WFM Database Utility.

Prerequisites: The WFM Servers are running.

Start of Procedure

1. In Windows, select Start > Programs > Genesys Solutions > Workforce Management > Database
Utility.
The Login dialog box appears.

2. Enter your user name and password.
3. If this is the first time you are opening the WFM Database Utility, click Details. Then enter the

Configuration Server host name and port number and the name of the WFM Database Utility
Application object that you configured using Configuration Manager. (This is the same as the WFM
Configuration Utility Application object.)

4. On the first window, select the appropriate radio button to start using the WFM Database Utility.

End of Procedure

Tip
For more information about how to use the WFM Database Utility,
see Managing WFM Database Utility.

Procedure: Stopping WFM Database Utility

Purpose: To stop the WFM Database Utility.

Start of Procedure

1. In the upper-right corner of the application window, click the X button.
-or-
In the main window, click the Close button.
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End of Procedure

WFM Web

Use the procedures in this section to start and stop WFM Web.

[+]
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Procedure: Starting WFM Web

Purpose: To start WFM Web.

Prerequisites: The WFM Servers are running.

Start of Procedure

1. Start your web server (for example, Tomcat).

Tip
For starting, stopping, and other configuration instructions, see
the documentation for your web server.

2. Open a web browser.
3. Type or paste the WFM Web URL into the address line of the browser and press Enter.

The User Login dialog box appears.

Important
Contact your system administrator for the URL. The URL is case-
sensitive. Follow the capitalization settings exactly.

4. Enter your user name and password.
5. Click OK.

Those whose logins identify them as Supervisors will see the WFM Web for Supervisors GUI. Agents will
see the WFM Web for Agents interface.

End of Procedure

Procedure: Stopping the WFM Web

Purpose: To log out of WFM Web.

Start of Procedure

1. Click Log off from any window in WFM Web.
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End of Procedure

Back to Top
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Configuring WFM Server Load Balancing
Use the information in this topic to load balance Workforce Management (WFM) Server when you
have multiple computers available, and one computer alone cannot handle the work load. Use the
procedures provided to assist you when configuring the load balancing method you choose for WFM
Server in your environment.

This topic includes the following sections:

• Load Balancing Methods
• Configuration
• Procedures

Load Balancing Methods

There are two main methods of load balancing: Processor and Memory. WFM Server supports both
types.

Processor Balancing
Processor Balancing support is based on the assignment of a session to the best-qualified processor
and is the more common type of balancing required. It is often needed when one computer does not
have enough processor power to handle a large number of simultaneous users. WFM accomplishes
this method by balancing WFM Server requests between several different WFM Server instances
running on different computers. Each server/computer instance is known as a location.

WFM Server's built-in load balancing service is called Locator Service. Every time you open a new
user session, Locator Service identifies the location that is best suited to serve the new session.
Usually that is the location that is currently handling the fewest requests. From then on, all requests
from that particular session are handled exclusively by the assigned location.

To configure the Processor Balancing on a WFM Server, Configuring Process Balancing

Memory Balancing
Memory Balancing support is based on reconfiguring at the site level. As you create multiple WFM
Servers, you can assign each to a different site as required.

Here is an example application of Memory Balancing: if your configuration has 50,000 agents, you
will likely need more than 2-3 GB of RAM (the limit on 32-bit Windows applications). One computer
alone does not have enough memory to handle this huge configuration.

In Memory Balancing, as you start each new session, you associate it with a site. The session is then
directed to the WFM Server instance that is assigned to that site. This allows different servers to work
with different subsets of data—thereby reducing the amount of memory needed per server.

Configuring WFM Server Load Balancing Starting and Stopping WFM

Workforce Management Administrator's Guide 101



Important
You can also create a configuration that uses both types of load balancing.

To configure Memory Balancing on a WFM Server, Configuring Memory Balancing

Back to Top

Configuration

As noted previously, WFM Server's built-in load balancing service is called Locator Service. Normally,
one WFM Server instance is designated as Locator.

Any client that wants to open a user session with WFM Server must first ask Locator for the URL of
the WFM Server that is best suited to serve the new session, from a load-balancing point of view.
Usually that is the location that is currently handling the fewest requests. The URL is obtained and
the client opens the new session on that server.

Tip
All WFM Servers run the Locator Service and any server can act as Locator.

To configure the Locator Server on a WFM Server, see Configuring the Locator Service

Procedures

Click the red arrow to view procedures that relate to the topics on this page. <multistep>

|-| Configuring the Locator Service=

Purpose: To enable load balancing correctly

Start of Procedure

1. Open Configuration Manager.
2. Open the WFM Server Application that will be the Locator.
3. Add all other WFM Servers (except the Locator) to the Connections list.
4. Save and close the Locator.
5. Open the WFM Web Application.
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6. Add the WFM Server Application that will be the Locator to the Connections list.
7. Save and close the WFM Web Application.

End of Procedure

Tip
Advanced users can add cross-references in the Connections lists between all
configured WFM Servers, so that any of them could act as Locator. For example, if you
are running two instances of WFM Web, you might want to assign a different WFM
Server to each WFM Web instance to act as Locator, but still have load balancing
enabled.

|-| Configuring Processor Balancing=

Purpose: To configure processor balancing. (Processor Balancing is the default method of load
balancing.)

Prerequisite: You have configure the Locator Service. See Configuring the Locator Service

Start of Procedure

1. Open Configuration Manager.
2. Open the Connections list of the WFM Server Application that you have designated to act as Locator.
3. Add a reference to each WFM Server that you want to balance.

End of Procedure

The result: Locator regularly checks the number of open sessions on the servers that it finds in its
Connections list, and then directs new sessions to the server with the least number of open sessions.
In this way, connected users are balanced across the servers.

|-| Configuring Memory Balancing=

Purpose: To enable Memory Balancing.

Prerequisites:

• You have configured the Locator Service. See Configuring the Locator Service.
• You have assigned WFM Servers to specific site(s). (Complete this procedure for each site.)

Start of Procedure

1. Open WFM Configuration Utility.
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2. Go to Configuration > Organization.
3. Select the Site Properties tab and assign a WFM Server to serve that site, by selecting a server from

the drop-down list WFM Server Name.

Important
To disable Memory Balancing, select none in the drop-down list WFM Server Name for every site. Otherwise,
the Locator will direct sessions to the selected WFM Server, in defiance of Processor Balancing.

4. Open Configuration Manager.
5. Add all WFM Servers Applications to the Connections list of the WFM Server Application that you

designate to act as Locator.

End of Procedure

The result: When you open a new session and identify it with a site, the session is automatically
directed to the WFM Server that is assigned to that site. </multistep>

Back to Top

Configuring WFM Server Load Balancing Starting and Stopping WFM

Workforce Management Administrator's Guide 104



Daily Operations
After deploying Workforce Management (WFM), there are many tasks that, as a workforce
administrator, you will need to perform regularly and sometimes on a daily basis. These topics
provides information about setting up and performing these daily operations in your environment.

WFM daily operations

Scheduling
Performance, Adherence, Reports
Forecasting
User Security

WFM daily operations

Calendar Management
Time-Off Bidding
Task Sequencing

WFM daily operations

E-mail Notifications
Scheduling Meals & Breaks
Enabling WaitLists
Tracking Overtime
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Scheduling
This topic provides detailed information about Workforce Management (WFM) Scheduling that will
help you to plan and create schedules for your workforce. It includes the following sections:

• Scheduling Overview
• Maximum Agents by Length of Schedule Period
• Profile Scheduling
• Mulit-Site Planning
• Agent Preferences
• Flexible Shifts
• Task Sequences
• Schedule Trading
• Marked Time
• Intra-Day Scheduling
• Pending Schedule Changes

Scheduling Overview

Workforce Management (WFM) uses the published Master Forecast to create agent schedules that
comply with user-defined business constraints. Or you can create “empty” schedules to which you
can then assign agents. Schedule constraints include available personnel with required skills, staffing
requirements, employment contracts, business policies, and agent preferences.

The staffing requirements act as a target for schedule generation. An optimized schedule ensures the
least amount of over- and understaffing while still meeting contractual obligations. WFM uses each
agent’s individual skills, contracted working rules, and calendar items as guides to help identify when
each agent can work, and what he or she will work on.

WFM aids compliance with regional working rules by helping to apply the following aspects of
Contract rules:

• User-defined weekend days
• Schedule synchronization based on specific days of the week
• Maximum number of consecutive weekends an agent may work

You can schedule agents to be available to perform multiple types of work at once or you can
schedule them to work on specific types of work for periods of time within their day. You can also
combine these, to create schedules in which some periods are set aside for specific types of work
while at other times agents perform any work that arrives for which they are qualified.
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Once you finalize your schedule, you can publish it to the Master Schedule, where it immediately
becomes available for agents to view through WFM Web for Agents. Agents may then trade their
schedules as needed, if the schedule trade complies with trading rules and is either auto-approved or
is approved by a qualified supervisor.

Maximum Agents by Length of Schedule Period

You can build schedules for up to 5,000 agents and 6 weeks. Memory requirements are decreased,
and contiguous memory is not necessary for scheduling. If you have 1.5 GB of virtual memory
available, you can now build large schedules (5,000 agents). Generally, for schedules with 2,000 or
fewer agents, 600 MB of virtual memory is enough.

Important
Consider the preceding limits to be rough estimates; scheduling duration varies
depending on your configuration. There is no way to provide a general estimate for
schedule build time, based on just a few simple parameters such as the number of
schedule weeks and the number of agents. The maximum schedule size must be
determined uniquely by each user, based on specific performance requirements.

Back to Top

Profile Scheduling

Although agent-based scheduling offers a multitude of advantages, in some cases you must build
schedules without agents assigned to them. To do so, you create a schedule composed of empty
schedule slots that are appropriate for the contract types or agent skill sets you currently have, or for
which you anticipate hiring. WFM offers several methods for creating blank schedules to which you
can assign agents:

• Scheduling Using Profiles—Profiles are based on contracts and include a skill set. They are used to
represent a typical kind of agent or a proposed new agent classification. For example, you can create a
new flexible full-time profile to enable planners to evaluate the adoption of a 4-day, 10-hours-per-day
work week. Each profile has a skill set with assigned skill levels. Scheduler uses either a user-specified
number of each profile type or a blend of profiles based on the current staff, to create blank schedules
to which you can assign qualified agents.

• Mixed Scheduling—You can build schedules using a combination of profiles and actual agents. This
can enable planners to create additional optimized schedules for expected new hires or for outsourced
agents to use.

• Schedule Bidding—Supervisors create an optimal set of schedules with no agent names, authorize a
set of agents to participate in the bidding process, and open the schedules for bidding. Agents review
the schedules on which they are qualified to work, and bid by numbering the most desirable and least
desirable schedules 1, 2, 3, and so on. The Supervisor can then have WFM assign the schedules to the
agents automatically, based on the agents’ bids as well as their seniority and/or "rank".
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Automated Schedule Bidding
Automated Schedule Bidding allows supervisors to create schedules with no agent names associated,
and then distribute them to agents via the Web. The agents can view, filter, and sort these schedules,
and bid on their favorite schedules over a preconfigured period of time. An automated assignment
engine then assigns schedules to agents, based on their bids and their seniority and/or rank. When
possible, preplanned Calendar items such as granted time off, days off, and exceptions are integrated
into agent schedules when the schedules are published to the Master. This new and powerful feature
helps contact centers to comply with union regulations requiring that agents be assigned their
desired schedules based on their seniority or rank. It also enhances supervisor productivity by
automating the process. Even in non-unionized contact centers, automated schedule bidding
improves agent satisfaction by giving agents more control over their future schedules.

Back to Top

Multi-Site Planning

Using a familiar tree structure, you can configure WFM’s objects to correspond exactly to your
Enterprise organization. For centralized, multi-site contact centers, WFM enables forecasting and
building of schedules for work activities spanning all sites.

For decentralized, multi-site contact centers, WFM supports two main models.

• For multi-site contact centers that distribute calls based on percentage allocation, WFM enables you to
forecast interaction volumes centrally and distribute the workload to each site for further planning
efforts. Each site can set parameters such as service objectives and staffing requirements, and can
build schedules.

• For multi-site contact centers that are virtualized and distribute calls based on agent availability, skill
set, and so on, WFM enables you to forecast staffing centrally and then split the staffing requirements
to each site. Schedules may then be built for each site. By building staffing requirements centrally,
WFM can account for the efficiencies of scale that are seen in a true virtual contact center environment.

The browser-based capabilities provided by WFM ensure that in any multi-site environment users
across the enterprise can participate in the planning process.

Also see Multi Forecasting Primer.

Back to Top

Agent Preferences

The Scheduler can optionally consider agent preferences when building schedules. Agents can enter
preferences for shifts, days off, availability, and time off using WFM Web for Agents. Supervisors can
enter agent preferences in WFM Web for Supervisors and, with the appropriate security permissions,
can grant or reject preferences. If a supervisor grants a preference, the calendar algorithm considers
that agent’s preference when building the schedule, along with various other criteria such as
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seniority.

Preference Fulfillment and Schedule Optimization
Contact center administrators can also specify whether preference fulfillment or schedule
optimization is the more important goal. This adds another layer of control over preference
scheduling.

Flexible Shifts

The method WFM uses to create shifts enables you to configure flexible shift durations and start and
end times. Additionally, WFM schedules use flexible break and meal parameters. In a sense a WFM
shift is an abstraction, representing countless possible working times. This is true even if the shift is
configured to produce very regular, fixed, agent schedules. This is in contrast to the conventional
notion of a shift with a mandatory fixed weekly start time, fixed duration, and set breaks. A single
WFM shift can incorporate hundreds of possible start times and durations as long as they fall within
the parameters of the associated contract. However, through synchronicity constraints and use of
more-rigid shift configuration settings, you can fix agent start times and workday durations. This
combination of flexibility and structure makes the WFM shift a tremendously powerful scheduling
mechanism. In fact, in some cases, you can configure an entire contact center using only a few WFM
shifts.

Back to Top

Example of a WFM Shift:

Consider a contact center with a standard full-time shift of 8 hours a day, 5 days a week, and an
alternative full-time shift of 10 hours a day, 4 days a week. You can schedule both types of agents
using a single shift with a flexible duration of 8 to 10 hours per day. In either case, the agents are
contracted to receive 40 hours work each week and to work 4 or 5 days. You can configure WFM to
guarantee that specific agents work 4 days a week and others 5 days, or let the WFM Scheduler
determine how many agents of each full-time type to use to provide the most effective schedule.

Task Sequences

WFM task-based scheduling enables you to configure sequences of work activities to be used in
shifts. These task sequences guarantee that a specific period of time is spent on a specified activity
or set of work activities.

Using task sequences, multimedia contact centers can generate agent-friendly schedules that build
in extended periods of time set aside for handling specific tasks. Agents are thus able to focus on a
single media or skill set, enabling them to complete their tasks more effectively, without the
confusing effects of frequently switching media. Contact center planners can ensure that task time is
equitably distributed among all qualified agents. And WFM can optimize the assignment of task times
based on forecasted staffing requirements.

For example, you can guarantee that all appropriately skilled agents receive exactly 2 hours of
outbound work for every shift, or you can allow WFM to determine how much outbound work to
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distribute to each agent. You can configure Genesys Routing to use WFM schedule information as
input for routing decisions. In this way, you can use task-based scheduling to provide a closed-loop
routing system that complements an agent-based approach to contact center management.

For more information about task sequences, see Configuring WFM Task Sequences.

Back to Top

Schedule Trading

WFM schedule trading enables agents to trade schedules among themselves. They can do so either
through a trade with a specified agent or through a trade open to any qualified agents within their
community.

Contact center planners no longer need to spend an excessive amount of time managing and
processing agent schedule-trade requests. Agents feel that they have flexibility when they need to
change their usual schedule and that they have more proactive control over the times they work. In
some cases, schedule trades can be approved without supervisor intervention, enabling managers to
focus on trades that may affect service levels or violate company policies.

Marked Time

Use marked time to distinguish any periods of time that are not otherwise tracked and reported on in
an existing WFM category. For example, you can create a marked-time type for a particular project.
Or you can use marked time to identify overtime periods that you want to appear in a report.

You configure marked-time types using the WFM Configuration Utility. You can specify marked time in
WFM Web for Supervisors and view periods of marked time in its Intra-Day schedule view. You can
report on marked time using the Schedule Marked Time Report and the Schedule Marked Time Totals
Report.

Intra-Day Scheduling

The WFM Web for Supervisors Intra-Day schedule views enable you to make real-time adjustments to
schedule scenarios or to the Master Schedule. You can insert exceptions, edit or change shift start
and end times, assign meetings, enter time off for an agent who has suddenly gone home ill, change
the activities agents are working on, or make other changes to the schedule to improve contact
center performance and to make the schedule reflect actual contact center circumstances.

You can make changes one at a time or use one of the Schedule wizards to make changes to multiple
agents’ schedules at once.

Back to Top
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Intra-day Schedule Re-Optimization
When you build a schedule in WFM, the scheduling algorithm minimizes the over and under-staffing
of agents against the forecasted staffing requirements, while meeting the configured working rules.
Since schedules can be built several weeks in advance, a variety of circumstances can cause the
schedule to become suboptimal by the time a particular schedule day arrives.

Here are some examples:

• Contact center management re-forecasted volumes and staffing for the day.
• Agents called in sick or were granted time off.
• Existing agent schedules were manually adjusted.
• Additional agents were added into the schedule.
• Meetings or other types of exceptions were added to the schedule.

It does not make sense to re-optimize schedule items for days or hours that have already passed. For
most contact centers, it is also not practical to re-optimize the current hour. Any changes to meals,
breaks, and/or work activities might be difficult to communicate to the affected agents. For these
reasons, a re-optimization wizard allows you to select the date, start time, affected agents, and the
set of schedule items to be re-optimized.

For example, you have the option to re-optimize the placement of:

1. Breaks only
2. Meals and breaks only
3. Activity sets/task sequences/activities only
4. Breaks/meals/activity sets/task sequences/activities without affecting shift start/end times
5. Breaks/meals/activity sets/task sequences/activities, and shift start/end times

Re-optimization provides some flexibility if you do not wish to change certain shift items or work
activities because it might be difficult for your agents to adjust to those changes. For example, if
agents use their meal breaks to go out of the office and go to appointments, you might not want to
change these times once they have been published. Similarly, you can decide whether shift durations
should be allowed to change or not. In some contact centers, this can be done to offer additional
work hours to certain agents. In other contact centers, this is not a desired practice.

Additionally, you can choose to exclude from re-optimization any agents whose schedules have
already been manually edited. You might have already spent time manually adjusting shift items or
work activities for an agent (for example, you moved meals or breaks based on a particular request
from an agent) and you don’t want to lose those changes.

Back to Top

Pending Schedule Changes

Users who do not have the Approve Changes security permission enabled can make only pending
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changes to the Master Schedule. Pending changes do not affect the official version of the Master
Schedule.

A user with the Approve Changes security permission enabled must commit pending changes before
they are incorporated into the official schedule. Discarded changes are rolled back.

Alternatively, such a user can go to the Master Schedule Changes Approval module (invisible to users
without the Approve Changes security permission enabled). There, she or he can review the pending
changes to the Master Schedule made by any user, and approve or reject them.

You can also enter pending changes into a schedule scenario. Such pending changes are visible only
to the user who entered them. You can later review your pending changes, and either commit them
or roll them back. Once committed, the changes are visible to all users with access to the schedule
scenario.

Important
If a scenario with pending changes is published to the Master Schedule, the pending
changes are not included.

Schedule State Group Totals View
This view provides intra-day totals of the number of agents in each schedule state group (Meetings,
Lunch, Breaks, and more).

It helps managers and supervisors understand how many agents are scheduled for each type of
activity during a particular time period, and provides a snapshot view of productive vs. nonproductive
time on an intra-day basis.

Back to Top
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Forecasting
Use the Workforce Management (WFM) Forecasting tool to predict contact-center workload and
staffing requirements, based on historical data or user-defined templates. WFM provides multiple
methods of forecasting the workload and staffing requirements for work activities in the following
sections:

• Using Historical Data
• Using Forecasting Events
• Setting Service Objectives
• Flexible Forecasting
• Deferred-Work Forecasting
• Multi-Skill Support

Start by creating one or multiple forecast scenarios. Creating multiple scenarios enables you to see
the effects of changes to forecasting parameters, such as service objectives and predicted interaction
volume. When you have determined the most satisfactory forecast, publish it, making it the Master
Forecast on which schedule scenarios, and eventually the Master Schedule, are based.

If you choose to, you can derive workload forecasts from historical information that is either collected
automatically by WFM from the Genesys system or imported from .csv files using the WFM
Configuration Utility. You can also create workload and staffing forecasts as reusable templates. Once
you have generated a workload prediction, WFM determines the staffing requirements needed to
service the workload, taking into account any applicable service objectives.

Using Historical Data

WFM automatically collects historical data from Stat Server for all work activities handled by the
Genesys platform encompassing all media, contact segments, and service types. Using Genesys Stat
Server, rather than automatic call distribution (ACD) reports, provides you with far greater flexibility
in defining and gathering statistics that provide an appropriate measure of contact center
performance over time.

WFM analyzes interaction volumes and average handling time (AHT) in order to predict future trends
for each work activity. This data enables WFM to build accurate forecasts for the anticipated
workload, and to calculate the staffing required to meet that workload.

Using the WFM API, you can also develop a custom application that will enable Interaction Volume
and AHT data from a third-party system to be imported directly into the WFM database. This is useful
if you want to use WFM to forecast and schedule a type of work that is not being routed by Genesys.

Back to Top
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Using Forecasting Events

WFM can track events that might affect interaction volume. A sales promotion or marketing
campaign, for example, might cause a predictable peak in interaction volume. These types of events
are entered in WFM Web for Supervisors and used by the advanced WFM algorithms. If an event
recurs, the forecasting algorithms learn the impact of that event and account for its impact in future
forecasts.

Setting Service Objectives

With WFM forecasting, you can set specific service objectives. You can also adjust these objectives
and then rebuild the forecast, which provides a detailed "what-if" analysis of the potential impact of
staffing or service-objective changes. WFM forecasting uses parameters to determine effects of
different service objective settings, such as:

• Interaction volumes
• Average handle time (AHT)
• Average speed of answer (ASA)
• Desired percentage of interactions handled within a target time (service level)
• Occupancy
• Maximum percentage of abandoned interactions

Back to Top

Flexible Forecasting

WFM supports an unlimited number of forecasting scenarios, enabling you to create multiple
forecasts and evaluate how changes in the parameters or the forecasting method that you use, affect
expected service objectives. Resource planners can then easily create reliable forecasts, fine-tuning
the results in tabular and graphical data views. You can also save forecast workforce data as
templates for use in subsequent forecast building.

WFM offers several different forecasting methods of varying complexity:

• Template-Based—Good for work activities with little historical information or for activities with very
predictable interaction traffic.

• Expert Average Engine—Good for work activities that have a reasonable amount of historical data or
those that fluctuate more dramatically because of unknown factors.

• Universal Modeling Engine—Good for work activities with more than one year of historical data and
accurate forecasting event information.

• Copy Historical Data—Good for work activities when you have some historical data, but not enough to
use the Expert Average Engine or the Universal Modeling Engine. You can combine the historical data
with overlap templates, which fill in gaps in the historical data.
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• Use Value—Good for work activities if your site activity load is very regular. Applies a specific
interaction volume or AHT to each time interval in the scenario.

Deferred-Work Forecasting

WFM is designed to consider deferrable work activities, such as e-mail, as inherently different from
immediate work, such as a phone call. WFM uses a proprietary algorithm designed to distribute the
backlog of deferrable interactions across the day in order to satisfy your service goal, which is
expressed in minutes, hours, or days.

Spreading out the deferred work enables you to avoid spikes in workload forecasts when a contact
center opens for the day, or during brief periods of high volume.

Back to Top

Multi-Skill Support

A multi-skilled contact center presents an opportunity for increased productivity.

An agent might be idle in a single-skill environment, because she cannot answer calls that are
queuing for a particular activity/skill that she possesses—because the schedule prevents her from
using that skill.

In a multi-skilled environment, the agent can use her additional skills to answer calls. A multi-skilled
agent is qualified to work on multiple activities, and therefore can perform different types of work
during a shift.

In a multi-skill environment, an agent can be available for multiple activities during any timestep. The
agent can be scheduled to work on an activity for only part of a timestep, and only the fraction of the
time period during which she works is counted.

Because of this, the value for staffing can be expressed as a fraction. For details, see Multi
Forecasting Primer.

Back to Top
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Monitoring Workforce Performance and
Adherence
Workforce Management (WFM) provides the tools, described in this topic, to help you can monitor the
performance and adherence in your workforce environment. You can generate Performance and
Adherence reports, enabling you to analyze data and spot trends that might be developing over time.
These reports and many others provided by WFM, are described in this topic. See the follwing
sections:

• Performance
• Adherence
• Reports

Performance

The Performance modules compare the forecast and schedule to what is actually happening in the
contact center. WFM shows intra-day statistics, such as interaction volume, average handling time
(AHT), agents logged in, service level, average speed of answer (ASA), and abandons, and compares
them to the planned values.

Intra-day contact-center performance data is displayed in an informative and easy-to-read format,
enabling efficient performance monitoring and quick response to unanticipated interaction flow or
agent-staffing situations.

WFM also provides a “what-if” calculator as an aid to decision making. You can enter new values for
staffing, interaction volume, and/or other performance statistics into the What-If window. The what-if
calculator then supplies the results to be expected if the values change as you project.

See also, Contact Center Performance Report Metrics

Adherence

Workforce Management provides real-time agent-adherence data, which compares the current agent
status to the scheduled status. WFM can track agent adherence per time interval on a single channel
or across multiple channels simultaneously.

Agents who are not adhering to their schedules (within user-defined thresholds) are highlighted in
yellow if they are nonadherent or in red if they are severely nonadherent. WFM also displays the
amount of time, in minutes, that the agent’s current status has differed from the scheduled status.
This running total is continually updated.

Daily Operations Monitoring Workforce Performance and Adherence

Workforce Management Administrator's Guide 116



Multi-Channel Adherence
To enable tracking of multi-channel adherence in WFM Web, assign a media channel to a Schedule
State Group; WFM then calculates adherence by comparing real-time states to the scheduled states
for that channel. See the example in Use Case 1: Multi-Channel Adherence.

Use Case 1: Multi-Channel Adherence
A site in the contact center has voice and e-mail related activities, and agents can make outbound
calls, which are scheduled as exceptions. The schedule state groups can be configured as follows:

Schedule state group Channel Schedule state Real-time state

Inbound calls Voice/unspecified All (immediate) voice-
related activities

WaitForNextCall,
CallRinging,
AfterCallWork,
CallInbound

Outbound calls Voice/unspecified
Exception types that
represent outbound call
work

WaitForNextCall,
CallRinging,
AfterCallWork,
CallOutbound

E-mail <channel_name> (for
example, email)

Deferred, e-mail related
activities

WaitForNextCall,
CallRinging,
AfterCallWork,
CallInbound

Overhead None (no channel) Breaks, meals, time off,
exceptions, etc.

NotReadyForTheNextCall,
LoggedOut

If WFM is tracking multi-channel adherence (new in WFM 8.5), and there are no Schedule State
Groups with a channel name under the Site, WFM calculates adherence as it would for a single agent
real-time state, and Stat Server aggregates the statistics as it did prior to 8.5. However, if there is at
least one Schedule State Group with a configured channel name, WFM tracks multiple channels. For
each Site, WFM tracks as many different channels as there are distinct channel names for all
Schedule State Groups under the Site.

For information about how to configure multi-channel adherence, see the topic Configuration >
Schedule State Groups > Configuring Adherence Rules > Configuring Media Channels for Schedule
State Groups in the Workforce Management Web for Supervisors Help.

For information about WFM adherence calculations, see How WFM Calculates Adherence.

Important
After updating to 8.5, if any site in your environment supports multiple media
channels and you have configured Schedule State Groups to a setting other than
None, the Agent Adherence Report includes data that differs from the data in WFM
8.1.3 in two ways:

1. For any given set of criteria (site/timezone/agent/date), the data in the 8.5 report is
different than the data in the 8.1.3 report, because the adherence rules change when
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you add multi-channel settings to Schedule State Groups, which means the adherence
percentages also changes.

2. The Schedule State, Agent State, Start Time, End Time columns are in reverse order. In
8.5, the report displays the columns in this order: Start Time, End Time, Schedule State,
Agent State.

Using Reason Codes
WFM enables you to enter reason (aux) codes when you configure agent-adherence rules. The reason
codes are linked to Genesys Agent States and add additional details to the state information. The
Genesys state + reason code combination is mapped to WFM Scheduled State Groups and is
displayed in Adherence views.

Tip
When you filter on user-defined reason codes in the Adherence Filter dialog, the
reason code that you specify must not contain any spaces within or at the end of the
key value.

For example, an agent might signal that she is in a NotReady state. By adding a reason code, she
can specify that she is doing after-call work or answering email. This detailed information then
appears in the WFM Web Adherence Details view and agent-adherence reports.

To use reason codes, your switch must support them. See your T-Server documentation to find out
whether your switch can include reason codes when it sends Genesys TEvents.

See also, Agent Adherence Report Metrics and End Notes

Back to Top

Reports

WFM Web for Supervisors provides access to a variety of reports that are designed to present key
contact-center data in a flexible and accessible format. The report types are:

• Configuration Reports—Contain information about work activity configuration.
• Policies Reports—Contain information about agents, contracts, shifts, and rotating patterns.
• Calendar Reports—Contain information about time off and agent calendar items.
• Forecast Reports—Display forecast interaction volumes, AHT, and staffing requirements in tabular and

graph formats.
• Schedule Reports—Display schedule data for agents, activities, teams, sites, multi-site activities, and
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business units at various granularities. Also present budget information and schedule validation
warnings and errors.

• Performance Reports—Contain various types of contact-center performance statistics in detailed and
summary formats.

• Adherence Reports—Contain agent-adherence information for agents, teams, sites, business units, and
the enterprise.

• Audit Reports—Contain information that enables you to audit a history of changes made within the
Calendar subsystem and a history of changes made to the Master Schedule.

For more information about Workforce Management report data and other metrics, see WFM Metrics

Back to Top
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User Security
The Workforce Management (WFM) Configuration Utility User Security module enables you to fine-
tune the precise access each user has to WFM objects and functions. For example, you can:

• Limit certain users so that they can view only certain sites or teams.
• Limit certain users so that they can read the schedule but not change it.
• Limit access to reports.
• Limit access to WFM configuration settings modules, such as Contracts and Time Off Types.

Securing Schedule Changes

User security enables you to control who can make changes to schedule scenarios and to the Master
Schedule. Users might be able to enter changes to the Master Schedule, but unable to commit or
approve changes. These changes are in Pending status. An authorized user can then review the
changes, and either commit/approve them or roll back/delete the changes.

This enables contact center managers to provide Master Schedule access to certain users who might
not ordinarily have access. For example, supervisors who manage teams of agents, but who don’t
normally have any scheduling responsibility, can enter team meetings or other exceptions into the
schedule. Workforce-scheduling professionals can then review these to ensure that coverage is not
adversely affected.
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Calendar Management
Workforce Management’s (WFM) unique agent-based scheduling approach enables robust agent-
calendar management prior to scheduling. WFM can incorporate known obligations into agent
schedules to ensure that agents can keep appointments and request adjusted shifts or working hours
while WFM maximizes contact-center efficiency. By more accurately planning for known obligations,
WFM can take the guesswork out of forecasting for staffing overheads, leading to more efficient use
of the agent pool.

Calendar Management includes the following sections:

• Planning and Scheduling Meetings
• Time Off
• Schedule Exceptions

Planning and Scheduling Meetings

The Meeting Planner provides great flexibility when planning meetings. You select the meeting
participants, define the range of time in which the meeting should occur, and set the duration of the
meeting. You can configure recurring meetings, specifying either the number of occurrences or the
start and end dates of the meeting series and the interval (weekly, for example).

The Meeting Scheduler builds the meeting into the work schedules of the participants during the
scheduling process, finding the optimal times for agents’ shifts and the meeting at the same time.

The meeting is included as an exception in all attendees’ schedules. WFM displays the meeting
exception in the Schedule views using the meeting short name, so you can find it easily when looking
at schedules. If a sufficient percentage of participating agents is unavailable, then the meeting is not
scheduled, and you receive a warning.

Additional Functionality
Use the Meeting Scheduler...

• To insert meetings directly into multiple agent schedules as an exception after building the schedule.
• To create optimally-scheduled meetings within an existing schedule.

Use the Meeting Planner...

• To configure meetings that are pre-planned, such as recurring team meetings.

Play ‘what if’...

• To add a meeting to a schedule that has already been built, and WFM will insert the meeting into the
most optimal time slot, based on the list of participants.
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Supervisors can use this feature to better determine the optimal meeting times that otherwise
required manual calculation or guesswork.

Back to Top

Time Off

You can use the WFM Configuration Utility Time Off Types module to configure multiple types of
time off. Doing so enables you to set different characteristics for each type, define different rules for
the accumulation of accrued time off and distribution of awarded time off, and fine-tune your record-
keeping using the Time Off Report.

Time off can be accrued or awarded. The settings for these differ slightly, but both are configured in
the WFM Configuration Utility’s Time-Off Rules module. You can configure separate time-off rules
for each time-off type.

You can associate multiple time-off rules with one time-off type. For example, you might want to have
different accrual rules for agents with more seniority than for those who were recently hired. By
assigning the appropriate time-off rule to each agent who receives time off of that type, you can
determine the rate at which each agent accrues the time off.

Use the Calendar module in WFM Web for Supervisors to set time-off limits. You can set time-off
limits for an activity, for a team, or for an entire site. You can also set different time-off limits for a
specified period. For example, you might want to further limit time off because of special
circumstances.

You can also set different time-off limits for various periods during the day. For example, you might
permit more time off in the evening than in the busier morning.

Agents can view their balances for each time-off type and request time off in WFM Web for Agents.
Agents can request both full-day and part-day time off. Supervisors can enter time-off requests into
the WFM Web for Supervisors Calendar module.

Requested time off can be manually approved by the supervisor or automatically approved by WFM
Web, based on agent time-off balances and the limits set on the number of agents with time off per
activity, team, or site.

When the Scheduler runs, all time off that has been granted is scheduled. Additional time off can be
scheduled, depending on whether it meets time-off limits and scheduling optimization constraints.
Once time off is scheduled, agents can no longer edit or remove the time-off assignment using WFM
Web for Agents.

Time Off Wait-List
When a time-off request is made, but time off limits have already been reached, if the agent asks for
the request to be wait-listed, the request remains in the WFM Calendar in a Preferred status, rather
than being declined. Supervisors can view this wait list in the Calendar, sorting the time off requests
by timestamp, and selectively grant time off requests.

Supervisors can grant agent time off for future periods, if the time off limits are raised, or if other
agents cancel their existing requests. This improves supervisor productivity by no longer requiring
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them to track these requests with a paper-based system.

Your supervisor can enable automatic approval (also known as auto-granting), which eliminates the
need for that supervisor to approve your legitimate time-off requests.

Time Off Within Bidding Periods
You can enable Time-Off Bidding by configuring bidding periods in WFM Web and associating them
with sites within your enterprise. Agents within the site can submit multiple time off requests
concurrently and WFM processes them within the specified bidding period. This configuration ensures
that agent requests are all granted, declined, or wait-listed on the same processing date and
eliminates the possibility of some requests for a vacation period being granted, while others are not.
For details, see Time-Off Bidding.

Back to Top

Schedule Exceptions

Exceptions are additions to a schedule that are not work, but which must be taken into account to
allocate agent time correctly. Examples of exceptions include meetings, training, and special projects.

Exception Types
You create exception types based on the needs of your contact center. These types can be extremely
flexible and you can link them to other WFM scheduling features. For example, you can specify that
some exception types are used in meeting planning, and that some can be converted to a day off, if
necessary.

Exceptions can be full-day or part-day. You can assign multiple part-day exceptions, assuming they do
not overlap or otherwise violate internal WFM consistency checks.

Exception and Preference Hierarchy
Exceptions and preferences are ranked in a hierarchy. This means that, if multiple exceptions and
preferences are assigned for an agent on a single day, Calendar Management analyzes the
assignments and immediately selects the highest-priority exception for assignment, noting the others
as declined.

However, declined exceptions and preferences are stored in the WFM database, in case there are
changes to calendar information later. If, for example, a training session is canceled, an agent’s
previously overridden day-off preference might then change status and be available for scheduling.

Back to Top
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Time-Off Bidding
When you enable time-off bidding, WFM processes agent requests for time off that are within a
configured bidding period on the same process date and time. This ensures that all requests that
were made concurrently within this period are all granted, declined, or wait-listed on the same
processing date, and eliminates the possibility that some requests for a vacation period are granted,
while others are not. WFM grants these requests, based on seniority and/or rank. If there are
available time slots, WFM grants any requests that were not previously granted, based on the order
of submission.

Bidding Period

The bidding period is the time interval (in days) when agents can request time off. You determine and
configure, edit, or delete bidding periods, based on your contact center requirements. However, you
cannot change a bidding period that is being processed or has been processed. All requests within
that period are processed on a specified date with a configured ranking, which determines how the
requests are resolved.

Any changes you make to the bidding period can take effect immediately. For example, you might set
the processing date to a date in the past when the actual bidding period, and the requests within that
period, have not yet been processed. If items are flagged by a bidding period and you later delete the
period before the processing date occurs, requests for that period are not processed unless you
create a new bidding period that covers the dates of those items. If you enter items and then set the
bidding period, items are processed if they are eligible for processing (if the preferred wait-list flag is
present).

Each bidding period has a status that indicates when it is complete.

Request Processing

WFM batches all agent time off requests that fall within a bidding period, marks them as one request
and, after all of the items pass validation, saves them to the WFM database. The initial request can
contain any number of items. (Items entered in a previous version of WFM can contain only one item
per request.) If items in a request fall within multiple bidding periods, WFM processes the request
only once, on the latest processing date for all bidding periods.

You cannot modify single items in a request. If one item is modified, deleted, or recalled, the same
action is performed on all items in the request.

Bid Processing

You can manually modify all items in a request before the processing date. Any request items that
you manually grant are not automatically processed. WFM processes bidding items when the
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processing date conditions are met and the requests in a specified bidding period have not been
processed.

During bid processing, any one of the following scenarios can occur:

• All items in request can be auto-granted (and possibly auto-published), based on the agent's seniority
or rank.

• All items can be removed from the processing list and remain in Preferred status. They can become
eligible for wait-list processing (on a first-come, first-served basis by the original submission date), if
the following conditions occur:
• Auto-grant does not apply for at least one item in the batch request.
• The bidding period no longer applies (was deleted or edited) for at least one item in the request.
• There are no time-off slots available to accommodate all batch request items on the bidding period

processing date.

Time-Off Balances

Bidding time-off items display as regular time-off items and reduce the agent's time-off balance for
the specific time-off type.

Wait-List Processing

Wait-listed items are not processed within bidding periods that are not yet processed. If there are no
configured bidding periods or a bidding period for the wait-listed item date is already processed, the
entire request is wait-listed and the BatchRequest configuration option in the CalendarService
section of WFM Server Application is set to true. In previous WFM releases, items were wait-listed
one by one.

WFM generates a warning when the time-off limit has been reached.

Time-Off Limits

Time-off limits can be changed during active the bidding period, but do not take effect until the
processing date for that period. The bidding period implies that time-off limits are set to 0 and time-
off requests are not granted. If there is no configured bidding period for a certain date, time-off limits
work as in previous WFM releases.
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Configuring WFM Task Sequence
This topic presents information about how to configure task sequences. It supplements the
information found in Workforce Management 8.1 Configuration Utility Help and includes the following
sections:

• Definitions
• Purpose of Task Sequencing
• Creating Task Sequences
• Procedure: Creating a Task Sequence

Definitions

Within Genesys Workforce Management, a task sequence is a defined period of time during that
agents can work only on one task or a specified set of tasks, called an activity set. You could also
think of a task sequence as an activity sequence.

Activities
Activities (tasks) are work that is tracked and managed using Workforce Management. For example, a
business might define the following activities in WFM Configuration Utility for product A:

• Answering inbound calls
• Responding to e-mail
• Completing after-call work
• Performing scheduled callbacks
• Participating in chat sessions

These same activities might also be defined for products B and C.

Back to Top

Purpose of Task Sequencing

Task sequences enable you to control how much the nature of an agent’s work changes during part of
a day. You can avoid asking agents to jump constantly from activity to activity—a situation that can
result in agent confusion and fatigue and lower productivity. You do this by configuring task
sequences. Once configured, you can assign a task sequence to any compatible shift in the same
site.
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Creating Task Sequences

You create task sequences in the WFM Configuration Utility, Shifts window, Task Sequence dialog
box. The Task Sequence dialog box is also where you will use the information given in this appendix.
To provide context for the examples presented later on, see a quick overview of task sequence
configuration in Creating a Task Sequence.

How Task Sequences Appear in WFM
After you configure task sequences and assign them to shifts (which are then assigned to agents),
task sequences appear in the Intra-Day and Agent-Extended views. Task sequences appear as
yellow areas on the color-coded bar (unless you changed the color in the Configuration module in
WFM Web Supervisor), where each type of schedule item is represented by a different color. For an
example, see the figure below.

Figure: End-Anchored Task in Schedule

In the above example, the task (in yellow) is anchored to the end of the shift, but the Task Sequence
(Add) dialog, Type drop-down menu displays various anchoring choices:

• Not Anchored
• Start Anchored
• End Anchored
• Start/End Anchored
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The anchoring type selected indicates when a task can happen during the day.

Back to Top

Anchoring Task Sequences
This section describes when to use the various anchoring types available from
the Type drop-down menu in Task Sequence (Add) Dialog (see Procedure:
Creating a Task Sequence). Assume that the shift and meals are flexible. See
examples.. [+]
Task A Ends the Day

Task Sequence (Add) dialog in the configuration: Only Task A is configured. Task Type is End
Anchored (see the figure below).

Figure: End-Anchored Task

Task A Starts the Day

Task Sequence (Add) dialog configuration: Only Task A is configured. Task Type is Start Anchored
(see the figure below).

Figure: Start Anchored Task

Task A Can Happen Anytime During the Day

Task Sequence (Add) dialog configuration: Only Task A is configured. Task Type is Not Anchored
(see the figure below).

Figure: Not Anchored Task

Back to Top

Task A and Task B Can Happen Anytime During the Shift

In this diagram, A is followed by B, but the order does not matter. Task Sequence (Add) dialog
configuration: Two task sequences must be configured:

1. Task A (Not Anchored) followed by Task B (Not Anchored)
2. Task B (Not Anchored) followed by Task A (Not Anchored)

See the figure below.
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Figure: Not Anchored Task (A&B)

Task A Starts the Day; Task B Can Happen Anytime During the Day

Task Sequence (Add) dialog configuration: Task sequence contains Task A Start Anchored. Task B
is the second task in the sequence. Task B is Not Anchored (see the figure below).

Figure: Start Anchored and Not Anchored Tasks

Task A Starts the Day; Task B Ends the Day

Task Sequence (Add) dialog configuration: Task A is Start Anchored. The next task is Task B, which
is End Anchored (see the figure below).

Figure: Start and End Anchored Tasks

Back to Top

Task A and B Can Start Anytime During the Day and Are Consecutive

Task Sequence (Add) dialog configuration: Task A is End Anchored. The next task is Task B which is
Start Anchored (see the figure below).

Figure: End Anchored and Start Anchored

Task A and B Start the Day and Are Consecutive

Task Sequence (Add) dialog configuration: Task A is Start/End Anchored. The next task is B, which
is Start Anchored (see the figure below).

Figure: Start/End Anchored and Start Anchored

Task A and B Finish the Day and Are Consecutive

Task Sequence (Add) dialog configuration: Task A is End Anchored. The next task is Task B which is
Start/End Anchored (see the figure below).

Figure: End Anchored and Start/End Anchored
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Task A is Full-Morning (or Full-Afternoon)

Task Sequence (Add) dialog Full morning configuration: Task A is Start Anchored. Minimum and
maximum task duration must be set to fill the entire shift duration before the meal. The Activity Set
used for task can be strict to prevent the task and meal from overlapping.

Full afternoon configuration: Task A is End Anchored. Minimum and maximum task duration must be
set to fill the entire shift duration after the meal. The Activity Set used for task can be strict in order
to prevent the task and meal from overlapping (see the figure below).

Figure: Start Anchored and End Anchored (A)

Back to Top

All Work Must Belong to Tasks

A is full morning. B is full afternoon. The order of the tasks does not matter. Task Sequence (Add)
dialog box configuration: Task A is Start/End Anchored. Task B is Start/End Anchored (see the
figure below).

Figure: Start/End Anchored, Start/End Anchored

Minimum and maximum durations of tasks must be set to fill the entire shift duration. In this case it is
highly recommended to use non-strict Activity Sets. Without these settings the meal cannot be
scheduled

All Work Must Belong to Tasks—Order Does Not Matter

The order does not matter, but A, B, C and D must be scheduled once. Possibly, A=C and / or B=D
and but you want to insure a succession of tasks. Task Sequence (Add) dialog configuration: All
tasks are set to be Start/End Anchored. The order of tasks is ABCD (see the figure below).

Figure: All Start/End Anchored

Either all Activity Sets used by tasks should be non-strict (to allow for the meal) or at least the tasks
around the potential meal time must be non-strict.

Task A Starts the Shift. B is Free of Constraints—C and D Are Consecutive

Sequence (Add) dialog configuration: Task A is Start Anchored. Task B is Not Anchored. Task C is
End Anchored. Task D is Start Anchored. Placement of the meal after Task B can not be guaranteed
in this case (see the figure below).
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Figure: Start Anchored, Not Anchored, End Anchored, Start Anchored

Back to Top

Procedure: Creating a Task Sequence

Purpose: To open the dialog box for creating a task sequence.

Start of Procedure

1. In Configuration Utility , on the Modules pane, click Shifts.
2. In the Objects pane, select a shift.
3. Click the Task Sequences tab.
4. To create a new task sequence, click Add.

The Task Sequence (Add) dialog opens (see the figure 5 below).

Figure: Task Sequence (Add) Dialog
5. Enter a task sequence name to replace the default name.

The name must be unique within the site.
6. Create a new row in the task sequence list; Click Add.
7. Ffrom the Type drop-down list, select an anchor type.

Read the section How Task Sequences Appear in WFM and review the examples in Anchoring Task
Sequences to understand the various anchoring types.

8. Configure the task sequence, as described in Workforce Management 8.1 Configuration Utility Help.
The figure 6 below shows an example of the dialog after a single task has been configured.
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Figure: Example Task Sequence

Tip
While the above example shows only one task, you can add as many rows as you need to create a sequence
of tasks.

9. After completing the configuration of your task sequence, click Apply.
You can now assign a task sequence to any compatible shift in the same site.

End of Procedure

Back to Top
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Using E-mail Notifications in WFM
This provides information about how to use the Notifications module in Workforce Management
(WFM) Web for Supervisors to configure e-mail notifications, by site, for the following types of events:

• Schedule trade status changes—This type of notification can be received by both agents and
supervisors who are affected by a schedule trade proposal or response.

• Time off request status changes—This type of notification can be received by both agents and
supervisors who are affected by a time off request.

• Schedule modifications—This type of notification can be received by the agent who is affected by the
schedule change.

The Role of WFM Daemon

A standalone server component, WFM Daemon sends out notifications to agents and supervisors.

Important
By default, WFM does not send notifications. To send notifications, you must select at least one site to send
notifications of a given type in the Targets tab of the Notifications module and save.

Agents and supervisors who are to receive e-mail notifications must have their e-mail addresses configured.
These e-mail addresses are stored as part of the Person object in the Genesys Configuration Database and
are (optionally) synchronized into WFM, by using the WFM Configuration Utility.

Additionally, WFM must be set up properly and connected to a customer-supplied SMTP server. For details
about how to configure WFM Daemon to send notifications, see WFM Daemon Options. After you complete
these steps,

WFM sends notifications of the selected type(s).

Back to Top

Schedule Trade Status Changes
WFM Daemon uses the following rules when sending schedule trade status change notifications:

• Both the proposing agent (creating the trade request) and responding agent (receiving the trade
proposal) associated with the selected site(s) get notified when a trade status is User-declined, User-
approved, Autodeclined, Auto-approved, or Cancelled.

• Supervisor(s) associated with the selected site(s) are notified when a trade status is Pending.
• The responding agent is notified when the status of a trade proposal is In Review or Open.
• The proposing agent is notified when the response status of a trade proposal is Accepted, In Review,
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or Cancelled.

Time Off Request Status Changes
WFM Daemon uses the following rules when sending time off status change notifications:

• When a supervisor manually changes agent time off in the Calendar module, the affected agent
receives a notification.

• When an agent time off request is saved in a Preferred status, all supervisors with access to the
agent’s team, are notified.

Schedule Modifications
When a supervisor changes one or more schedule days, WFM sends a schedule modification
notification to the configured site's affected agent.

Back to Top

Procedures

Click the red arrow to view a list of the procedures in the summary. <multistep>

|-| Summary: How to Set Up E-mail Notifications in WFM=

To set-up e-mail notifications in WFM, complete the following five tasks.

1. Create and configure WFM Daemon.
2. Configure user security.
3. Add e-mail addresses to the WFM database
4. Enable e-mail synchronization
5. Enable notifications in Web Supervisor

|-| Creating and Configuring WFM Daemon=

Purpose: To create and configure the WFM Daemon Application object.

Start of Procedure

1. Open Configuration Manager.
2. Create the WFM Daemon Application and install it.
3. Configure the WFM Daemon’s connection to the WFM Server Application.
4. Configure the SMTP server settings for the WFM Daemon.

See WFM Daemon Options and the Framework 8.1 Configuration Manager Help, steps 2 to the end.
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End of Procedure

|-| Configuring User Security=

Purpose: To configure permissions to users or others with security roles so they can configure
notifications.

Start of Procedure

1. Open WFM Configuration Utility and go to the User Security module.
2. In the Configuration module's Notifications section, grant permission to any users or security role

that will be configuring notifications.
See the Workforce Management 8.1 Configuration Utility Help.

Figure: WFM Configuration Utility—Notifications Permission
3. With Configuration Utility still open, grant security permissions to any user or security role that need to

receive e-mail notifications. See the figure below.
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Figure: WFM Configuration Utility—Receive Notifications Permissions

Important
Supervisors can receive e-mail notifications related to Schedule Trade requests or Time Off requests. You
might want to configure the notifications permission for one or both of these. Agents do not hold security
roles or permissions in WFM.

End of Procedure

|-| Adding E-mail Addresses to the WFM Database=

Purpose: To add Supervisor and Agent e-mail addresses to the WFM Database, so they can receive
notifications.

Important
To receive notifications, Supervisor and Agent e-mail addresses must be in the WFM
Database.
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Start of Procedure

1. In Configuration Manager, enter these e-mail addresses into the Supervisor and Agent person objects.
2. Use the WFM Configuration Utility to synchronize the WFM database with the Framework database.

End of Procedure

|-| Enabling E-mail Synchronization=

Purpose: To enable e-mail synchronization in the Configuration Utility.

Start of Procedure

1. Open the WFM Configuration Utility.
2. Open the Options > Global Settings dialog.
3. Select the check box E-Mail Synchronization Enabled.

Now e-mail addresses will be synchronized for any agents in the WFM database, the next time
synchronization is run. Also, if you have dynamic synchronization configured in WFM, the e-mail
addresses for agents will be updated in WFM immediately after they are modified in Configuration
Manager. See the two figures below—one for Supervisors e=mail and one for Agents e-mail.

Warning
Dynamic synchronization does not affect non-agents (such as Supervisors) who have been moved into the WFM
Users column of the Security Roles/Users main node. The only way to update the email addresses for non-
agents is to perform manual synchronization.
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Figure: WFM Configuration Utility, Supervisor E-Mail Address
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Figure: WFM Configuration Utility, Agent E-Mail Address

End of Procedure

|-| Enabling Notifications in Web Supervisor=

Purpose: To configure the Web Supervisor Application to enable notificaitons.

Start of Procedure

1. Open the WFM Web Supervisor Application.
2. In the upper portion of the object tree, open the Configuration subsystem and then, the

Notifications module.
All three supported e-mail notification types are listed in the lower portion of the object tree.

3. Select each one that you want to enable, and in the right-hand pane of the Targets tab, check the sites
for which you want to enable notifications. See the figure below.
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Figure: WFM Web Supervisor, with Notifications Selected
4. Use the Messages tab to configure the e-mail Subject and Message for all e-mail notifications of this

type. You can change the text or keep the default.
If the WFM Daemon is running and properly connected to a running SMTP server, you can now use the
feature. (You can check WFM Daemon’s status in the Windows Services Control Panel or through
Solution Control Interface.)
For additional information, including descriptions of the rules that generate notifications, see The Role
of WFM Daemon.

End of Procedure

</multistep>

Back to Top
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Scheduling Breaks and Meals in WFM
This topic describes how to use Workforce Management (WFM) to schedule meals and breaks in
conjunction with Exceptions. It contains the following sections:

• Pre-planned Breaks and Meals
• Default Behavior of the Scheduler
• Changing the Behavior of the Scheduler

Pre-planned Breaks and Meals

Workforce Management enables you to pre-plan the breaks and meals (called shift items) that will be
scheduled during a particular shift. You can define several parameters for these shift items, such as
the time window during which they should be scheduled and whether they are paid or unpaid.

For example, if you set up a shift called 8-Hour Full-Time, as part of the shift item configuration,
you have specified that there should be a 15- minute paid break in the shift. The Min Length from
Shift Start parameter is set to 2:00 (2 hours) and the Max Length from Shift Start parameter
is set to 4:00.

Additionally, your shift item configuration specifies that there should be an unpaid meal in the middle
of the shift, with both the Min Time Before This Meal and Min Time After This Meal parameters
set to 3:00.

You have configured a rotating pattern for a particular agent that specifies that the agent should work
the 8-hour full-time shift every day, starting at 8:00 a.m.

Due to the shift item configuration, when WFM builds a schedule scenario that includes this agent, it
will try to schedule the break and meal in the following time windows:

• It will try to schedule the break in the time window between 10:00 a.m. and 12:00 p.m.
• It will try to schedule the meal in the time window between 11:00 a.m. and 1:30 p.m.

Sometimes the configured time windows for breaks and/or meals conflicts with planned exceptions,
such as meetings, training sessions, or administrative time, that were entered through the WFM
Calendar. In these cases, the behavior of the Scheduler varies, depending on the particular type of
shift item and its properties.

Back to Top

Default Behavior of the Scheduler

This section describes the default behavior of the Scheduler in three different scenarios.
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When Unpaid Breaks Conflict with Exceptions
When the time window of an unpaid break is covered by a planned exception, the Scheduler relaxes
the constraints of the break, in order to schedule it. That is, the time window is widened in both
directions (if possible) so that the break can be scheduled adjacent to the exception—either
immediately before the exception or immediately after the exception.

This relaxation of the break constraints occurs because unpaid breaks are considered mandatory by
the Scheduler due to their effect on the paid time of the shift.

There will be instances when one or more unpaid break(s) cannot be scheduled, even though they
are considered mandatory. For example, if a shift has a paid duration of 8 hours, and there is a
granted exception in the Calendar that also has a paid duration of 8 hours, that would not leave any
time remaining for the Scheduler to place an unpaid break. As a result, the unpaid break is not
scheduled and a warning is generated when the scenario is built.

When Paid Breaks Conflict with Exceptions
Unlike unpaid breaks, by default, paid breaks are not considered mandatory. Therefore, if there is a
conflict between a planned exception and a paid break—so that the time window of the paid break is
covered by the exception—by default, the paid break is not scheduled when the scenario is built.

When Meals Conflict with Exceptions
Meals are considered a mandatory part of a shift, if the shift has a meal configured. If there is a
conflict between a planned exception and a meal—so that the time window of the meal is covered by
the planned time for the exception—one of two things happen when the scenario is built:

• WFM looks for, and finds, another shift that is compatible with the agent’s contract, and allows the
exception to be scheduled, or

• When WFM resolves the conflicting items in the Calendar (prior to the schedule being built), it declines
the exception unless it can find another shift that is compatible with the agent's contract that allows
the exception to be scheduled. In this case, the exception is not scheduled and a warning is generated.

Back to Top

Changing the Behavior of the Scheduler

Configuration options are available that can change the default behavior of the Scheduler when
breaks and/or meal time windows conflict with planned exceptions. These options are:

• Paid Breaks are Mandatory
• Suppress Break-Related Warnings
• Allow Breaks and Meals During Exception
• Other Considerations
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Paid Breaks are Mandatory
This is an optional setting that controls whether or not a paid break is scheduled even when the time
window of the break is covered by an exception. As described above, this is always the behavior of
the Scheduler with unpaid breaks. However, if this setting is turned on, the same behavior occurs
with paid breaks; if the time window of the paid break is covered by an exception, the paid break will
be scheduled adjacent to the exception—either immediately before the exception or immediately
after it.

There still might be times when some breaks cannot be scheduled, even if this setting is turned on,
because there is not enough room in the shift to accommodate the exception and all the configured
breaks. In this case, a warning will be generated when the scenario is built.

See below, some sample scenarios when WFM would not be able to schedule a break (paid or
unpaid), regardless of whether the user defines this as being mandatory or not:

Examples... [+]
Example 1

There is a shift with an 8-hour duration but which is 7.5 paid hours. The user grants a paid exception
that is 7.5 hours, right in the middle of the shift, leaving 15 minutes on either side of the exception in
which to schedule any breaks. If there is a 30-minute unpaid break to schedule, it cannot be
scheduled unless the user wants to allow breaks to be scheduled “during the exception” (see below
for more information about that optional setting).

Example 2

There is an 8-hour shift from 8:00 a.m. to 4:00 p.m. The configuration of Break 1 (15-min) allows the
break to be scheduled in a time window between 9:00 A.M -10:30 a.m. The configuration of Break 2
(15-min) allows the break to be scheduled within a time window between 2:00 p.m. - 4:00 p.m. The
user grants an exception in the Calendar from 8:00 a.m. - 3:45 p.m. Unless the user wants to allow
break(s) to be scheduled “during the exception,” one of the breaks cannot be scheduled, because
there are only 15 minutes within the shift that is not already covered by the exception, and two
15-minute breaks to schedule.

Example 3

There is an 8-hour shift from 8:00 a.m. - 4:00 p.m. The user grants an exception in the Calendar from
8:00 a.m. - 11:45 a.m. and another exception from 12:00 p.m. - 4:00 p.m. This leaves only 15
minutes between the two exceptions in which to schedule any breaks. Unless the user wishes to
allow break(s) to be scheduled “during the exception,” it is likely that one or more breaks would not
be scheduled.

Example 4

Assume a shift from 8:00 a.m. - 1:00 p.m., one exception from 8:30 a.m. - 11:30 a.m., and two 1-hour
breaks (the first one with configured window from 9:00 a.m. - 11:00 a.m., and the second one from
12:00 p.m. - 1:00 p.m.). Because the exception covers the first break, the break should be placed
after the exception (because there is no room before it), from 11:30 a.m. - 12:30 p.m. Because of the
scheduling of the first break, there is no room for the second break at all (but not because of the
exception). In this case, one of the breaks would not be scheduled.
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Suppress Break-Related Warnings
This is an optional setting to control whether schedule warnings that describe issues with break
scheduling are hidden from the user. If you are scheduling a lot of long exceptions that you know will
make it impossible for the Scheduler to fit in most of the breaks you have configured, you might want
to check this setting so that the break-related warnings are suppressed. This allows you to focus on
the other schedule warnings that you want to resolve.

Allow Breaks and Meals During Exception
For each Exception Type, this setting might be turned on. If this option is configured, then if a
planned exception of this type is being scheduled and it covers the time window of a break, the
Scheduler tries to schedule the break during the exception, preserving the original configured time
window. The Scheduler might not always be able to accomplish this, so if it cannot schedule one or
more breaks during the exception, it will next try to schedule them adjacent to the exception. This
setting always affects the scheduling of unpaid breaks. This setting only affects the scheduling of
paid breaks, if paid break scheduling is configured as mandatory.

This setting also controls whether the Scheduler will try to schedule meals during an exception, in
cases when the configured time window of the meal is covered by the exception. However, if the
Scheduler is unable to schedule the meal during the exception for some reason, it will not be
scheduled adjacent to the exception as it will try to do with breaks.

It is important to note that when the user configures an exception type, such that break(s) and
meal(s) could be scheduled during the exception, it does not mean that all of these shift items will be
scheduled during the exception. For example, the user has configured a 15-minute break with a
5-minute start step. The break configuration permits the break to be scheduled somewhere between
8:45 a.m. and 10:15 a.m. There is an exception from 9:00 a.m. - 10:00 a.m. The break could be
scheduled in many possible places, including:

8:45 a.m. - 9:00 a.m.
9:00 a.m. - 9:15 a.m.
9:05 a.m. - 9:20 a.m.
9:10 a.m. - 9:25 a.m.
. . .
9:45 a.m. - 10:00 a.m.

Also note that although the absolute start and end times of the exception will not be changed. For
example, it is possible that the start of the exception could be covered by a break (both the break
and the exception start at the same time).

Back to Top

Other Considerations
When there is no conflict between an exception and some break(s), but yet the exception makes it
impossible for WFM to schedule the breaks according to all of their configured constraints, WFM
continues its default software behavior, which is to relax the break constraints so that they can be
scheduled.
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Examples... [+]
Example 1

There is a 15-minute break that could be scheduled between 9:00 a.m. - 1:00 p.m., and a second
15-minute break that could be scheduled between 10:00 a.m. - 2:00 p.m. The user has configured
that the minimum distance between these breaks must be 3 hours. The user has granted an
exception that goes from 11:00 a.m. - 3:00 p.m. It is impossible to meet the minimum distance
constraint and also schedule these two breaks within their configured time windows. Therefore, WFM
could relax the break constraints, in order to meet the minimum distance constraint and one break
would be scheduled prior to the exception, and the other break would be scheduled after the
exception.

As described above, when relaxing break constraints to accommodate planned exceptions, WFM
attempts to schedule the break immediately adjacent to the exception. However, it is not always
possible to do this, and sometimes there will be a small duration of activity work scheduled between
the break and the exception. Toggle the plus (+) sign below to see some additional examples:

Example 2

The user has granted an exception from 12:00 p.m. - 1:05 p.m., and the configured time window for a
particular 15-minute break specifies that the break must be scheduled somewhere between 1:15
p.m. - 2:15 p.m. Based on schedule coverage, WFM could place that break at 1:15 p.m., leaving just
10 minutes of activity work in between the exception and the break.

Example 3

The user has granted an exception from 12:00 p.m. - 2:00 p.m., and the configured time window for a
particular 15-minute break specifies that the break must be scheduled somewhere between 1:00
p.m. - 2:16 p.m. WFM would only have between 2:00 p.m. - 2:16 p.m. in which to schedule the break.
WFM could schedule the break from 2:01 p.m. - 2:16 p.m., leaving 1 minute of work between the
exception and the break.

Also note that the features described in this section only address partial-day exceptions, not full-day
exceptions. Therefore, if the user needs to schedule a working or non-working exception that covers a
worker's entire shift, they should consider using a full-day exception type.

Example 4

The user wants to grant an exception (type: meeting) after the Schedule has been built. In the
Calendar, the user creates the Calendar Item and rebuilds the schedule. The meeting is reflected in
the updated schedule and, in some cases, takes place during a paid break/meal or is adjacent to it.

Important
If the user attempts to schedule the meeting, by using the Meeting Planner (after the
schedule is built), the meeting is not scheduled, nor is the warning messages
suppressed—assuming that the system is configured in this way.
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Hierarchy of Constraints

If breaks cannot be scheduled according to all of their configured constraints, WFM tries to satisfy the
constraints in the following order:

1. Time window
2. Start step & start offset
3. Minimum distance between shift items
4. Maximum distance between shift items

Back to Top
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Enabling and Configuring Wait-list
Functionality
In this topic, you will find lists and descriptions of the conditions and settings that make Workforce
Management (WFM) wait-list functionality possible, and offers or refers to instructions for these tasks:

• Automatic Approval (sometimes called auto-granting)
• Auto-publishing
• Wait-listing
• Handling preferred time-off requests
• Making ungranted time-off requests count in a build
• Improved viewing time-off availability

If WFM cannot immediately grant a time-off request, it puts the request on a waiting list (called wait-
listing). When all requirements are met, including configuration, WFM can grant the request and
insert it into the Master Schedule automatically.

The information in this topic supplements the information found in ''Workforce Management Web for
Supervisors Help'' and ''Workforce Management Web for Agents Help''. It includes the following
sections:

This topic includes the following sections:

• Overview
• Enabling and Configuring Wait-listing
• Use Cases and Notes

Overview

WFM considers all wait-listed time-off requests on a First-In, First-Out (FIFO) basis, using the date and
time of the request. To determine if there are slots available for the wait-listed time-off request, the
process first considers all time off instances that are Granted/Granted and Scheduled and have
intersecting time steps with the wait-listed request for time off. If the CalendarOverSchedule option
is set, then Granted/Not Scheduled time off instances are also taken into account before processing
the wait-list.

Next, WFM considers all Preferred time-off requests that were submitted earlier than the wait-listed
request that is currently being processed. Only Preferred time-off instances that count against the
time-off limit according to their actual status are considered. Also, if an earlier Preferred request is
not valid for time-off within the various limits, it is ignored.

You can configure the advance threshold for automated time-off wait-listing. You can also configure
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the minimum number of weeks in advance that a request can be made for each time-off rule; that
minimum number is called the automatic approval threshold. If an ungranted time-off request in the
wait-list violates the automatic approval threshold, then WFM removes the request from the wait-list.
That time-off request remains in the status Preferred, but it cannot remain wait-listed.

See Enabling Automatic Approval and Configuring the Threshold.

Events that might change the system’s ability to grant time off, such as the agent’s contract
availability status, can affect the validity of any time-off request. Thus, wait-listing takes place on a
schedule that is specified by a timeout option.

Back to Top

Enabling and Configuring Wait-listing

The following sections provides information about enabling and configuring wait-listing, and describes
how auto-approvals, thresholds, and auto-publishing affect wait-listing.

Automatic Approval of Time-off Requests
Wait-list automation is related to automatic approval functionality. The common workflow of wait-list
automation is:

1. An agent’s time-off request is automatically approved, but there are no time-off slots within the limits of
the request.

2. The request is wait-listed until the appropriate time-off slots appear, and then automatically approved, if
possible.

3. If automatic approval is enabled but the time-off request is beyond the automatic approval threshold,
then the request cannot be wait-listed. It is instead saved with the status Preferred.

Important
Automatic approval must be enabled for wait-listing to work. If automatic approval is
not enabled, then the supervisor must manually grant time-off requests and a request
cannot be wait-listed, even if requested by the agent.

Enabling Automatic Approval and Configuring the Threshold

Automatic Approval must be enabled for wait-listing to work.

To learn about automatic approval, in the ''Workforce Management Configuration Utility Help'', see
Policies > Time-Off Rules > Configuring Time-Off Rules > Time Off Request Rules Area Section and
locate the option Automatic Approval A Minimum of <number> Week(s) in Advance And For A
Minimum Of <number> Hours.

To enable and configure automatic approval, see the Policies > Time Off Rules dialog box and select
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the option Automatic Approval A Minimum of <number> Week(s) in Advance And For A
Minimum Of <number> Hours. Enter values into the empty fields (<number>).

Configuring Auto-Publishing
When WFM automatically approves a time-off request, it can also insert it into the Master Schedule
automatically, if auto-publishing is enabled.

To enable and configure auto-publishing, use Configuration Manager or Genesys Administrator to set
the WFM Server AutoPublishTimeOffToSchedule option value to 1 or 2. Find this option in the
CalendarService configuration section.

Back to Top

Configuring Wait-Listing

Wait-listing is a background function that is enabled by circumstances and configuration. The
circumstances are: automatic approval must be enabled and an agent’s time-off request must be
valid (time off slots and agent credit must be available).

To configure wait-listing, use Configuration Manager or Genesys Administrator to set the WFM Server
WaitlistTimeout option in the CalendarService section.

Notes

Why does a time-off request get wait-listed?

• The time-off request is valid (for example, not for time in the past).
• The time-off request is not for more time than the agent’s time-off balance contains.
• The automatic approval option is enabled.

WFM will only wait-list those time-off requests that would have been automatically approved, if not
for time-off limits. Also:

• If automatic approval is not set up in the accrual rule or the threshold has been passed, then that
particular time-off cannot be wait-listed.

• The requesting agent should have sufficient time-off balance and there can be no other restrictions.
• If limits allow, the request will be granted and not wait-listed.

Treatment of Preferred Time-off Requests
Preferred time-off requests (having the status Preferred) are not considered during schedule
building. When a master schedule is published, Preferred time-offs do not count against limits and
agent balance anymore, because they are usually not scheduled.

To override this functionality, use Configuration Manager or Genesys Administrator to set the WFM
Server option CalendarOverScheduleData in the CalendarService section, which makes
unscheduled time-offs count against the agent balance and time-off limits.

Back to Top
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Viewing Available Time-off Slots
Now Agents can see if the time off that they want is available before they request it. At the Time Off
screen, just hover the cursor over any time slot, and you will see time off limits and wait list data
about the time slot in a popup.

In the ''Workforce Management Web for Agents Help'', see the topic Wait-Listing Notes > Time Off >
Requesting Time Off.

Use Cases and Notes

The following use cases discuss scenarios to compare availability and seniority, and provide some
additional important rules to keep in mind.

When Availability Overrides Seniority

1. Request A asks for time slots that are not available (8AM-6PM). The time 8-9AM is not available, and so
Request A is wait-listed.

2. Request B comes in later, but asks for time slots that are available (10AM-6PM).

The Result:
Request B is granted and Request A remains wait-listed, even though Request B came in later.

When Seniority Overrides Availability

1. Request A is wait-listed. The time slots for automatic approval of this request become available, but the
wait-list timeout has not yet expired.So this request remains wait-listed.

2. Request B comes in later and asks for the same time slots as Request A.

The Result:

• If the time slots are available for both requests, Request B is honored immediately and Request A is
honored after the wait-list timeout expires.

• If the time slots are available for only one request, Request B is wait-listed and after the wait-list
timeout expires, Request A is granted first.

Rules to Remember

• When the wait-list process can grant a request, it changes the saved status of that request to granted
(and removes the internal wait-list flag).

• If the auto-publish and wait-list functions are set up together, then granted requests are published to
the master schedule.

• A wait-listed request can be granted only if: automatic approval is enabled, the time-off request is valid,
there are no other restrictions.
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WFM removes from the wait-list any time-off request that has expired (the time steps that it specifies
are in the past) or belongs to an agent with no time-off balance.

Back to Top
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WFM Overtime Functionality
Workforce Management (WFM) provides Overtime planning and tracking views for supervisors, into
which they can enter overtime hours for a single agent or multiple agents by specifying the time
interval and activity.

This topic includes the following sections:

• Overview
• Overtime Requirements View
• Assigning Secondary Skill Sets for Overtime
• Tracking Scheduled Overtime Results

Overview

WFM automates the overtime insertion process in the following ways:

• Finds the appropriate shift definition for the extended shift
• Schedules break/meals on the overtime part of the shift
• Designates overtime by specifying a marked type

Important
Overtime functionality is available on the Master Schedule only. There is no overtime
interface for Agents.

You can also enter overtime in the Intra-Day, Agent Extended, and Weekly views by inserting a
work set with Marked Time. Secondary shifts and activities can be used to plan overtime.

Back to Top

Overtime Requirements View

In WFM Web, you can plan, set, and track how overtime requirements are met in the Master Schedule
> Overtime view. To use this view, set the user security rights in Configuration Utility > User Security
> Module > Access Overtime Requirement.

Overtime data is displayed in a grid, which has an editable Overtime Requirement column and a
read-only Overtime Scheduled column. The Overtime Scheduled column is calculated according to
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the scheduled Marked Time (ensure the Overtime option is checked). The following optional columns
contain information that justifies the need for overtime hours (see the figure below):

• Staffing—Calculated and required staffing.
• Difference—Schedule coverage showing the difference between calculated and required.
• Variance—Equals the coverage minus the calculated, and is the anticipated unplanned overhead.

Figure: Overtime Requirement View with Monthly Granularity

Back to Top

Assigning Secondary Skill Sets for Overtime

Shifts are assigned to contacts in Web > Policies > Contracts view (see the figure below) as either
Primary or Secondary. Secondary assignments are used for overtime only and represent a broader set
of constraints, while Primary assignments are used for other functionality.
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Figure: Web for Supervisors—Policies > Contracts > Shift Assignment

Secondary activities can be defined in one of two ways in the Web > Configuration > Agents >
Activities view (see the figure below):

1. Assigning skills to the agent as Secondary
2. Assigning activities as Secondary with an effective date.

During overtime, agents can work on activities for which they are not normally scheduled. Therefore,
entering overtime for an agent can change the agent’s work day so that the usual shift definition no
longer fits.

Figure: Web for Supervisors—Configuration > Agents > Activities View

Important
During WFM migration from 7.6.1 to 8.x, all shifts and activities are set as Primary
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assignments.

Configuring Overtime for Individual Agents
The Overtime view is available in the Master Schedule only. However, you must publish a scenario
with the inserted work sets before the information can be seen in the Overtime view.

You can schedule overtime for an agent by inserting a work set and using Marked Time to mark it as
overtime. Use one the wizards in the following views:

• Insert Wizard—Schedule > Intra-Day, Agent-Extended views (Master and Scenarios)
• Insert Multiple Wizard—Schedule > Intra-Day, Agent-Extended, and Weekly views (Master and

Scenarios)

Display procedure... [+]

Using the Insert Multiple Wizard to Set Overtime for an Agent
Purpose: To add a work set for an individual agent for overtime by using the Insert Multiple Wizard in
WFM Web.

Start of Procedure

1. In the Intra-Day, Agent Extended, or Weekly view, select Insert Multiple from one of the following:

• Actions toolbar
• Actions menu
• On the agent's schedule, Right-click and select the Shortcut menu (not in Weekly view)

If you have unsaved changes, WFM Web prompts you to save them before proceeding.

• In the Insert Multiple Wizard, select Insert Work set.
• Create a new overtime work set by selecting Marked Time for the designated work type.

Important
You must select Marked Time, otherwise the resulting work set is not created as
overtime (see the figure below). Also, inserting a work set over an existing shift can
change the scheduled activities in the affected interval.
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Figure: Insert Multiple Wizard—Inserting an Overtime Work Set

End of Procedure

Back to Top

Tracking Scheduled Overtime Results

You can use the following views to track scheduled overtime results:

• Schedule > Schedule Scenarios Intra-Day view in the Performance Data pane
• Schedule > Master Schedule Intra-Day view in the Performance Data pane
• Schedule > Master Schedule view > Overtime view

The Performance Data pane separates the scheduled overtime part of the coverage within the
calculated staffing graph and distinguishes it from the overtime requirement. See the figure below.
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Figure: Calculated Staffing Graph—Full Day View

Back to Top
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How WFM Calculates Adherence
Workforce Management (WFM) calculates adherence for single channel or multi-channel
environments. For sites, in which there are schedule state groups configured for a single channel,
WFM compares the agent's real-time state to the current schedule state. For sites, in which there are
schedule state groups configured for multiple channels, WFM compares the agent's real-time state
and reason code on each channel, with the scheduled states for that same channel during each
specified time interval. If at least one scheduled state for that channel can be mapped to the channel
real-time state, according to its adherence rules, the agent is considered adherent.

Single-Channel Adherence Calculation

Single channel agent adherence is calculated as follows:

1. WFM maps the agent's real-time state plus the reason code. If there is more than one reason code,
there is more than one state + reason code mapping. If there is no reason code, WFM uses only the
state for mapping. For example, if the agent has real-time state WaitingForNextCall with reason
codes r1 and r2, for adherence purposes, WFM maps WaitingForNextCall + r1 and
WaitingForNextCall + r2.

2. WFM then finds all schedule state groups that are adherent to at least one agent real-time state from
step 1. A list of schedule state groups is compiled that maps to the state, based on the configuration of
the schedule state groups.

3. WFM obtains all scheduled states from the current agent schedule and maps them to the schedule state
groups.

4. WFM collects all schedule state groups from step 3.
5. WFM Intersects the sets of schedule state groups from steps 2 and 4. If the intersection is not empty,

the agent is adherent.

Multi-Channel Adherence Calculation

Multi-channel agent adherence is calculated as follows:

1. Similar to step 1 in Single-Channel Adherence Calculation, WFM maps the agent real-time state +
reason code. However, in addition to the aggregated agent state, WFM also adds separate real-time
states for each channel configured on the site. (Agents can sometimes have no state on certain
channels.) If reason codes are used, WFM could map multiple state + reason code pairs for each
channel, plus the aggregated state.

2. Similar to step 2 in Single-Channel Adherence Calculation, WFM maps schedule state groups adherent
to the aggregated state. However, in addition, WFM finds a separate set of schedule state groups for
each channel. WFM considers only the schedule state groups that are specifically assigned to a
particular channel for adherence with the states on that channel. WFM considers the schedule state
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groups without a channel for adherence with the aggregated agent state.
3. WFM obtains all scheduled states from the current agent schedule and maps them to the schedule state

groups.
4. WFM collects all schedule state groups from step 3.
5. WFM Intersects the sets of schedule state groups from steps 2 and 4 separately for each channel. If

both sets are empty or the intersection is not empty, WFM considers the agent is adherent to the
channel. For the aggregated agent status, WFM assumes adherence, when either the pair in step 4 is
empty or step 2 and step 4 intersect. WFM considers the agent adherent, if he/she is adherent on all
channels and adherent to the aggregated status.

The multi-channel algorithm also comes to a boolean conclusion; that is, the agent is either adherent
or non-adherent. However, to be adherent the agent must be adherent on every channel, on which
he/she is scheduled or, for which he/she receives a real-time state. Also, if the agent is scheduled on
non-channel-related states, he/she must also be adherent to those states. See the example in Use
Case 2: Multi-Channel Adherence.

Use Case 2: Multi-Channel Adherence
This use case is based on the schedule state group configuration in Use Case 1: Multi-Channel
Adherence.

Summary Real-time state Scheduled states Adherence
Agent is working on
voice only,
but scheduled for e-mail
and voice

Agent state:
CallInbound
DN e-mail: NotReady
DN 2323: CallInbound

E-mail activity, voice
activity Not adherent

Agent is working on e-
mail and voice,
but scheduled for e-mail
only.

Agent state:
CallInbound
DN e-mail:
WaitForNextCall
DN 2323: CallInbound

E-mail activity Not adherent

Agent is on a break.
Agent state: NotReady
DN e-mail: NotReady
DN 2323: NotReady

Break Adherent

Calculation of Agent Headcount
WFM calculates the agent head count for activities in this way: If the activity belongs to a channel-
related schedule state group, the agent is counted for the activity, only if the he/she is compliant with
the adherence rules for that channel. Also, if an agent is non adherent overall, but adherent for a
channel, the agent is added to the headcount for the activities for that channel.
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WFM Configuration Options
When you initially create and configure your Workforce Management (WFM) component Application
objects, either manually or using the Configuration Wizards, the Options tab is created with default
settings.

To customize your applications, open the Application objects in Configuration Manager and adjust
the settings as desired, using the descriptions in this topic for guidance.

Important
Perform the complete set of configuration and installation procedures as described in
Installing and Configuring Workforce Management, before configuring the Options tab
settings for the various applications.

This topic includes the following sections:

Configuring WFM Options

Creating New Sections and Options
Server Options Tab
Web Options Tab
Builder Options Tab

Configuring WFM Options

Data Aggregator Options Tab
Daemon Options Tab
Client Options Tab
Options Removed
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Creating New Configuration Sections and
Options
The settings you can configure on the Options tab control various features, such as logging, font
styles and sizes for some applications, security settings such as whether to show agent salary
information, whether to use reason codes, and many others. In many cases, the default setting will
be the most appropriate for your environment. However, Genesys recommends that you review the
available options to determine where customization might benefit your enterprise.

Important
When viewing WFM configuration options templates, you might see options beginning
with x- (for example, x-<option name>). Changing the default value of these options
is not recommended, and should only be used in exceptions when troubleshooting is
required, and with the assistance of a Genesys Customer Care representative.

Tip
When the valid values for an option are listed as true or false, you can also enter
alternate values to achieve the same result. For example, you can enter the value
true as yes or 1, and you can enter the value false as no or 0.

Creating New Sections and Options

In some cases, configuration sections and options documented for this product are not included in
the shipped version of the templates. Many users will not need these sections or options but if you
do, create them using the following procedures:

<multistep> |-| Procedure: Creating a New Section=

Purpose: To add a new section, which will contain at least one option, to the WFM database.

Prerequisite: The WFM software application template and database must allow this section.

Start of Procedure

1. On the Options tab, click the New icon or right-click in an empty area and select New.
The Add Section dialog box appears.

2. Enter the appropriate section name.
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3. Click OK.
4. Save your work.

You can now create new options in this section.

End of Procedure

|-| Procedure: Creating a New Option=

Purpose: To add a new option to the WFM database.

Prerequisite: The WFM software application template and database must allow this option.

Start of Procedure

1. On the appropriate section pane, click the New icon or right-click in an empty spot and select New.
The Edit Option dialog box appears.

2. Enter the option name and the value for the new option.
3. Click OK.
4. Save your work.
5. Perform the actions (if any) that are required to activate the option.

End of Procedure

</multistep>
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WFM Server Options
WFM Server is the only WFM component that has both configuration Annex and Options tab settings.

This topic includes the following sections:

• Options Tab Settings
• Annex Tab Settings

Options Tab Settings

From the Options tab you can modify the default WFM Server configuration settings. The tab
contains nine sections. The options in each of these sections are described below.

CalendarService Section
[+]
AdjustCarryOverByBonus
Type: Optional
Default Value: false
Valid Values: true, false
Dependencies: None

Specifies an optional way to handle a bonus assignment that does not have a specified end date as a
balance adjustment, which is incorporated into carried over hours during the next carry over.

When set to true, all assigned bonus time that does not have a specified end date is carried over to
the next configured carry-over date. The final number of carried-over hours remains subject to
maximum carry-over hours constraint. The bonus expires after the carry-over date. Used hours are
updated as they were before.

AutoPublishTimeOffToSchedule
Type: Optional
Default Value: 0
Valid Values: 0, 1, 2
Dependencies: None

Enables, disables, and configures automatic publishing of granted time off to an agent’s existing
schedule. The following settings specify WFM’s response when an agent requests time off:

• 0—Feature is off.
• 1—Feature is on; a part-day time-off cannot overlap exceptions.
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• 2—Feature is on; a part-day time-off deletes overlapped exceptions.

BatchRequest
Type: Optional
Default Value: true
Valid Values: true, false
Dependencies: None

Specifies how WFM Server processes multiple time-off requests submitted simultaneously by a single
agent. When this option is set to true, WFM Server processes these time-off items in one batch.
When this option is set to false, WFM Server processes these time-off items one-by-one.

CalendarOverScheduleData
Type: Optional
Default Value: 0
Valid Values: 0, 1, 2, 3
Dependencies: None

Enables the resolution of conflicts between granted or preferred time-off items and schedule data.
Previously, when schedule data overlapped calendar data, unscheduled time off items were not
considered when WFM Server checked agent time-off limits and balances.

• 0—Disables the resolution functionality (default value).
• 1—Enables resolution between granted calendar time-off items and overlapping schedule data.
• 2—Adds resolution of preferred time-off items to value 1 functionality.
• 3—These requests are counted against an agent’s time-off balance and limits:

• All requests with the status granted/not scheduled.
• Only wait-listed requests with the status preferred/not scheduled.

CarryOverTimeout
Type: Optional
Default Value: 1440
Valid Values: Any positive integer (-1 = off)
Dependencies: None

Specifies the time interval (in minutes) between process runs that handle automatic carry-over for
Time Off balances.

DetermineFullDayTimeOffStartEndPaidHours
Type: Optional
Default Value: false
Valid Values: true, false
Dependencies: None

Specifies whether or not WFM Server resolves the Start/End time. If set to true when a user adds a
Full-Day Time Off with the Start/End times not specified, WFM Server resolves the Start/End times.

MaxAuditReports
Type: Optional
Default Value: None
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Valid Values: Any positive integer
Dependencies: None

Specifies the number of audit reports that can be built at one time. The recommended value is 1. If
you request a greater number than is specified, the additional reports go into a queue.

HideMessagesForNotWorkingAgents
Type: Optional
Default Value: false
Valid Value: true, false
Dependencies: None

Specifies whether to prevent WFM Web from displaying error messages when Calendar items are set
for agents who have been terminated or have not yet been hired, set this value to true. If you want to
view error messages when Calendar items are set for agents who have been terminated or have not
yet been hired, set this option to false.

Important
This section and option are not included in the template by default. You must create
them yourself. See Creating New Configuration Sections and Options for instructions.

PreventTimeOffNoAvailability
Type: Optional
Default Value: 0
Valid Values: 0, 1, 2
Dependencies: None

Specifies whether an additional check is turned on or off for already-configured days of days off when
an agent requests time off.

• 0—The option is off.
• 1—Prevents an agent from requesting time off for weekdays, when the agent has no Contract

availability.
• 2—Same as described for the value 1, except weekdays when Contract nonavailability is overwritten by

an open granted availability interval. Also applies to dates with granted no-availability preferences and
granted day-off preferences and to days when an agent has a rotating day-off according to his or her
assigned rotating schedule.

When this option is on:

• If an agent requests a new time-off that overlaps an existing day-off, that agent receives an error and
the time-off is not inserted into the calendar.

• The supervisor receives a warning, which is possible to override.

WaitlistTimeout
Type: Optional
Default Value: 60
Valid Values: Any positive integer (-1 = off)
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Specifies the interval, in minutes, between process runs that handle wait-listed Calendar items.

Back to Top

Client Section
[+]
CfgServerRequestTimeout
Type: Mandatory
Default Value: 15
Valid Value: Any positive integer
Dependencies: None

Specifies the number of seconds to wait for a response from Configuration Server before timing out.
This key is used when requesting the list of objects from Configuration Server for synchronization
purposes. The value should be increased in configurations with a high number of objects or slow
network connections.

SOAPTimeout
Type: Mandatory
Default Value: 60
Valid Value: Any positive integer
Dependencies: None

Specifies the number of seconds to wait for the response from WFM Server before timing out.

Back to Top

ConfigService Section
[+]
MaxCacheSize
Type: Optional
Default Value: No default value
Valid Value: Any positive integer
Dependencies: None

Specifies the maximum size, in megabytes (MB), of the Configuration cache.

MSARestrictAccess
Type: Optional
Default Value: false
Valid Value: true, false
Changes Take Effect: Immediately
Dependencies: None

Specifies whether or not users can access Multi-Site Activites (MSA). When this option is set to true,
users must have access to all Activities under MSA to view any multi-site activity. When set to false
users must have access to at least one Activity under MSA to view multi-site activities (current
functionality).
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MinCacheSize
Type: Optional
Default Value: No default value
Valid Value: Any positive integer
Dependencies: None

Specifies the minimum size, in megabytes (MB), of the Configuration cache. The cache is preloaded
up to the minimum size.

CacheLifespan Type: Optional
Default Value: No default value (null value means the size is unlimited)
Valid Value: Any positive integer
Dependencies: None

Specifies the amount of time, in hours, that data remains in the Configuration cache without being
accessed. After this duration, the data is dropped from the cache.

CachePreloadTimeout
Type: Optional
Default Value: No default value (null value means 120 minutes)
Valid Value: Any positive integer
Dependencies: None

Specifies the time, in minutes, for preloading data in the cache. Data is preloaded up to the amount
specified in the MinCacheSize option.

Back to Top

ETL Section
[+]
DaysAhead
Type: Optional
Default Value: 14 days
Valid Values: Any integer between 1 and 365
Dependencies: None

Specifies the number of days in the future from current date to track Fact data.

DaysBack
Type: Optional
Default Value: 14 days
Valid Values: Any integer between 0 and 365
Dependencies: None

Specifies the number of days in the past from current date to track Fact data.

DayChunk
Type: Optional
Default Value: 7 days
Valid Values: Any integer between 1 and 31
Dependencies: Should be less than (DaysBack + DaysAhead)
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Specifies the number of days that will be processed at a time. The tracked day range is defined by
the values set in the DaysBack and DaysAhead parameters and is processed in the specified chunks
of data. So, this parameter determines the size of transaction. Larger transactions require more
memory and other resources, but can be processed faster.

ETLTimeout
Type: Optional
Default Value: 180 minutes
Valid Values: Any integer between 0 and 2880
Dependencies: None

Specifies the timeout interval (in minutes) between each execution of the ETL process. Negative or
zero values disable the ETL process.

Back to Top

ForecastService Section
[+]
ForecastTimestep
Type: Optional
Default Value: 15
Valid Values: 15, 30, 60 (Expert Average Engine) OR 15, 60 (Universal Modeling Engine)
Dependencies: None

Specifies the step used in the Expert Average. If the step is 60, then all values (that is, four values,
each representing a 15-minute timestep value) in the 60-minute interval will be filled with the same
predicted value.

MaxScenarioCacheSize
Type: Optional
Default Value: No default value (null value means the size is unlimited)
Valid Value: Any positive integer
Dependencies: None

Specifies the maximum size of the Forecast Scenario cache expressed in megabytes (MB).

ServiceLevelMethod
Type: Optional
Default Value: 0
Valid Value: 0, 1
Dependencies: None

Specifies whether Service Level should be calculated from the number of interactions distributed (as
in Workforce Management 6.5) or from the number of interactions offered, taking into account
abandoned interactions. The default value, 0, indicates that Service Level is calculated, based on the
number of interactions distributed. To include abandoned interactions, set the value to 1.

This option is not included in the template by default. You must create it yourself. Create this option if
you want to include abandoned interactions (value set to 1). If you do not create this option, WFM
functions as though you have set the value to 0. See Creating New Configuration Sections and
Options for instructions.
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Back to Top

Identity Section
[+]
ApplicationType
Type: Optional in a Framework 8.x environment.
Default Value: WFMServer
Valid Value: WFMServer
Dependencies: None

Specifies which Workforce Management component this application is for. Configure this option only if
you are using an application of the type ThirdPartyServer.

Back to Top

Log Section
[+]
verbose
Type: Mandatory
Default Value: all
Valid Values: all, trace, standard, none, yes (= all), no (= none)
Dependencies: None

Filters the output of log messages, based on their assigned priority.

• all—Enables output of all messages to the log file
• Trace—Enables informational and error messages and disables debug messages
• Standard—Enables error messages only and disables informational and debug messages
• None—Disables all messages.

buffering
Type: Mandatory
Default Value: false
Valid Values: true, false
Dependencies: None

Specifies whether system file buffering is turned on (true) or off (false).

segment
Type: Mandatory
Default Value: false
Valid Values: false, <number>, <number>KB, <number>MB, <number>Hr
Dependencies: None

Sets the maximum size (in KB, MB, or hours) of the log file segment, after which a new segment is
created. The default size is in KB. The number (<number>) cannot be less than 100 KB or less than

WFM Configuration Options WFM Server Options

Workforce Management Administrator's Guide 169



one hour. A value of No indicates no segmentation of the log file.

expire
Type: Mandatory
Default Value: false
Valid Values: false, <number>, <number> file, <number> day
Dependencies: None

Sets the expiration mode for old segments. The number to be stored cannot be less than 1 file or 1
day or more than 100 files or 100 days. A value of No indicates that files do not expire.

messagefile
Type: Mandatory
Default Value: wfmserver.lms
Valid Value: wfmserver.lms
Dependencies: None

Specifies the name of the file that stores application-specific log messages. The only valid value is
wfmserver.lms.

standard
Type: Mandatory
Default Value: stdout
Valid Values: log output types, such as stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Standard level are to be sent to the listed outputs. For centralized
logging, use a value of network. You can use a local file name as the value, stdout, or network.

trace
Type: Mandatory
Default Value: stdout
Valid Values: log output types, such as stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Trace level are to be sent to the listed outputs. For centralized
logging, use network. You can use a local file name as the value, stdout, or network.

debug
Type: Mandatory
Default Value: stdout
Valid Values: log output types, such as stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Debug level are to be sent to the listed outputs.

Warning
Do not use the value network unless requested by Genesys Professional Services
because it generates extremely heavy message loads that can degrade system
performance.
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all
Type: Mandatory
Default Value: stdout
Valid Values: log output types, such as stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of all levels, Standard, Trace, and Debug, are to be sent to the listed
outputs.

Warning
Do not use the value network unless requested by Genesys Professional Services
because it generates extremely heavy message loads that can degrade system
performance.

Back to Top

PerformanceService Section
[+]
MaxActivityDays
Type: Optional
Default Value: 25,000
Valid Value: Any positive integer
Dependencies: None

Controls the maximum cost of performance-related and forecast-related data that can be returned by
WFM Server. It prevents very large requests from overloading WFM Server. The value represents
Activity Days. For example, a request for 50 activities over a 31-day period would require 1550
Activity Days.

If the request requirement exceeds the MaxActivityDays option limit, then the server returns this
message:
Specified date range is too long for selected target. Please select different target
or a shorter date range.

The default value is based on a typical customer configuration. You might need to adjust it,
depending on your installed hardware, user work pattern, or if the server is too slow or short of
memory when handling certain requests.

NoCallsServiceLevel
Type: Optional
Default Value: 0
Valid Values: 0, 100
Dependencies: None

Specifies whether the Performance window shows service level as 0% or 100% when there are no
incoming interactions.
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Important
This section and option are not included in the template by default. You must create
them yourself. See Creating New Sections and Options for instructions.

RecalculateForecastStaffing
Valid Value: boolean (yes, no, true, false, y, n, 0, 1)
Default Value: false

Specifies whether or not WFM Server recalculates deferred activity forecasted staffing. When this
option is set to true, Server recalculates deferred activity forecasted staffing, based on the schedule,
if there is one. When set to false, staffing is returned as saved in the WFM database.

Back to Top

ScheduleService Section
[+]
MaxAuditReports
Type: Optional
Default Value: None
Valid Values: Any positive integer
Dependencies: None

Specifies how many audit reports can be built at one time. The recommended value for this option is
1. If you request a greater number than is specified, the additional reports go into a queue.

SplitCoverage
Type: Optional
Default Value: true or 1
Valid Values: true or 1, false or 0
Dependencies: SplitMode and SplitMS options

Specifies whether schedule coverage should be reported in fractional units in views and reports which
include this metric. The possible values are:

• false—Split coverage is not reported in fractional units, and the SplitMode option is ignored. For
example, the agent is covering one activity per timestep.

• true—Split coverage is reported in fractional units, and the SplitMode option is applied. For example, if
an agent is scheduled to cover three activities during a 15-minute interval, he will count 0.33 toward
the coverage of each activity. The agent’s split coverage might not be always 0.33. It could be 0.2, 0.8,
or any other percentage, depending on the forecast staffing requirement, but the sum is always equal
to 1 for the 15-minute timestep.

SplitMode
Type: Optional
Default Value: 0
Valid Values: 0, 1, 2
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Dependencies: SplitCoverage and SplitMS options

This option becomes affective only when the SplitCoverage option is set to true. The three possible
values and their characteristics are as follows:

• 0—The coverage split is calculated when the schedule is built or modified, and is stored along with the
schedule. This means that the coverage split does not change if you change the activity forecast
staffing requirement after the schedule is built. (You would have to rebuild the schedule to have any
effect on the coverage split.) Fractional coverage is not available for legacy schedules.

Tip
The term legacy schedule refers to a schedule that was built with an older version of
WFM in which split coverage was not yet implemented.

• 1—The coverage split is calculated when the schedule is built, and is stored along with the schedule.
This setting is similar to SplitMode = 0. However, if you have a legacy schedule or a schedule created
with SplitCoverage = false, there is no coverage split stored within the schedule. The fractional
coverage is recalculated dynamically for that schedule only.

• 2—The coverage split is always calculated dynamically for all new and legacy schedules. If you change
the activity forecast staffing requirement after the schedule is built, the coverage split is adjusted
dynamically. This mode should not be used in production environments unless it is suggested by
Genesys, because it could have severe performance impact on WFM Server operations

Important
Genesys recommends you set the SplitMode option value to 0 in most environments
(in which there are no legacy schedules that require editing with split coverage
considerations)

.
SplitMS
Type: Optional
Default Value: false
Valid Values: true, false
Dependencies: SplitMode and SplitCoverage. If SplitCoverage is false, then SplitMS is ignored.

Enables and disables multi-skill splitting of schedule coverage. When this option value is set to true
in the WFM Web Application, the coverage split is dynamically adjusted to maximize multi-skill
performance gain. It works on top of the obtained coverage.

AutoCleanupTimeout
Type: Optional
Default Value: 0 (disabled)
Valid Values: Any positive integer (minutes) or 0 (zero) (default; disables the option)
Dependencies: None
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Enables WFM Server to perform automatic schedule cleanup for terminated agents, and specifies the
time interval, in minutes, at which it does this. For example, setting the value to 60 specifies that
WFM Server automatically cleans up the schedules of terminated agents every 60 minutes. Setting
the value to 0 disables automatic schedule cleanup by WFM Server.

Special Handling for Terminated Agents

• The schedules of terminated agents will be deleted from the Master Schedule only for dates that occur
on or after the agents' termination dates.

• Each running WFM Server cleans up terminated agent schedules only for those sites that are assigned
to this particular server in the Organization > Sites > Properties section of the Configuration Utility.
If the server has no specific sites assigned to it, it will clean up all sites when automatic cleanup is
enabled.

MaxCacheSize
Type: Optional
Default Value: No default value
Valid Value: Any positive integer
Dependencies: None

Specifies the maximum size, in megabytes (MB), of the Schedule cache.

MinCacheSize
Type: Optional
Default Value: No default value
Valid Value: Any positive integer
Dependencies: None

Specifies the minimum size, in megabytes (MB), of the Schedule cache. The cache is preloaded up to
the minimum size.

MaxScenarioCacheSize
Type: Optional
Default Value: No default value
Valid Value: Any positive integer
Dependencies: None

Specifies the maximum size, in megabytes (MB), of the Schedule Scenario cache.

CachePreloadDayChunks
Type: Optional
Default Value: No default value (null value means 14 days)
Valid Value: Any positive integer
Dependencies: MinCacheSize

Specifies the chunk of days to load when performing a schedule cache preload.

CachePreloadMaxDays
Type: Optional
Default Value: No default value (null value means 365 days)
Valid Value: Any positive integer
Dependencies: MinCacheSize

Specifies the number of days to preload starting from the current date. The preload stops if the
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MinCacheSize is reached.

CachePreloadTimeout
Type: Optional
Default Value: No default value (null value means 180 minutes)
Valid Value: Any positive integer
Dependencies: None

Specifies the time, in minutes, for preloading data in the cache. Data is preloaded up to the amount
specified in MinCacheSize.

CacheLifespan
Type: Optional
Default Value: No default value (null value means the size is unlimited)
Valid Value: Any positive integer
Dependencies: None

Specifies the amount of time, in hours, that data remains in the Schedule cache without being
accessed. After this duration, the data is dropped from the cache.

Back to Top

Server Section
[+]
MaxThreadPoolSize
Type: Mandatory
Default Value: 80
Valid Value: Any positive integer
Dependencies: None

Specifies the maximum number of threads in the thread pool.

MinThreadPoolSize
Type: Mandatory
Default Value: 8
Valid Value: Any positive integer
Dependencies: None

Specifies the minimum number of threads in the thread pool.

Proxy
Type: Optional
Default Value: No default value
Valid Value: <proxyservername>:<port>
Dependencies: None

Specifies a proxy server.

SessionTimeout
Type: Mandatory
Default Value: 10
Valid Value: Any positive integer
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Dependencies: None

Specifies the timeout, in minutes, for any client session with this WFM Server.

ThreadPoolDownsizeTimeout
Type: Mandatory
Default Value: 15m (minutes)
Valid Value: Any positive integer.
Dependencies: None

Specifies how long a thread stays idle before it is removed from the thread pool. Follow the number
with s (seconds) or m (minutes). By default, the value is in minutes.

ThreadPoolUpsizeTimeout
Type: Mandatory
Default Value: 10s (seconds)
Valid Value: Any positive integer
Dependencies: None

Specifies how long a request stays in queue before the thread pool size is increased. Follow the
number with s (seconds) or m (minutes). By default, the value is in seconds.

VirtualDirectory
Type: Not applicable
Default Value: No default value
Valid Value: Not applicable
Dependencies: None

For future use.

Back to Top

Annex Tab Settings

From the Annex tab you can modify the default WFM Server configuration settings. The tab contains
one sections. The options in each of these sections are described below.

security Section
[+]
require-authentication
Type: Optional
Default Value: true
Valid Value: true, false
Dependencies: None

Specifies whether authentication is (or is not) required for third-party connections to WFM Server. The
default value true is in effect if this option is not defined.
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Important
Prior to release 8.1, the WFM API allowed third-party clients to connect to WFM using
the system account without authentication. Now, this behavior is disabled by default
and all third-party connections require proper user/password authentication.

Back to Top
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WFM Web Options
From the Options tab you can modify the default WFM Web configuration settings. The tab contains
eleven sections. The options in each of these sections are described below.

Adherence Section
[+]
RefreshTime
Type: Mandatory
Default Value: 10
Valid Value: Any positive integer
Dependencies: None

Specifies the amount of time, in seconds, between updates to the real-time agent adherence data
displayed in WFM Web.

AgentBidding Section
[+]
AllowBidding
Type: Mandatory
Default Value: true
Valid Value: true, false
Dependencies: None

Enables agent bidding as part of Schedule Bidding. See WFM Web for Supervisors Help for details.

AgentPreferences Section
[+]
AllowPreferences
Type: Mandatory
Default Value: true
Valid Value: true, false Dependencies: None

Controls whether or not Preferences will appear in the agent part of WFM Web.

Back to Top

AgentSchedule Section
[+]
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AccessLevel
Type: Optional
Default Value: 2
Valid Values: 1, 2, 3
Dependencies: None

Controls which filtering options appear in the Other Schedules view and how much data an agent
can see. (The option People I work with is always present.) Enter a valid value to specify which
other options are available:

• 1—My Team

• 2—My Team and My Site

• 3—My Team, My Site, and My Business Unit

AllowAccessToOthersSchedule
Type: Optional
Default Value: true
Valid Values: true, false
Dependencies: None

If this option value is set to true, agents can see other agents’ schedules in the Other Schedule tab
of the WFM Web for Agents Schedule view.

AllowAccessToCarpools
Type: Optional
Default Value: true
Valid Values: true, false
Dependencies: None

If this option value is set to true, agents can access Shared Transportation functionality—in the WFM
Web for Agents My Schedule tab Sidebar, and other locations. If set to false or absent from the
configuration, all carpool functionality is disabled for this installation of WFM 8.1.

Important
Shared Transportation functionality for Supervisors is not enabled or disabled by using
this configuration option. See Configuration Utility > Configuration > User Security.
Carpools and carpooling are common words in the United States for shared
transportation, but they do not describe busses and other forms of shared
transportation.

AllowInsertExceptions
Type: Optional
Default Value: false
Valid Values: true, false
Dependencies: None

If this option value is set to true, agents can access the Add Exception button—and its underlying
functionality—in the WFM Web for Agents My Schedule tab.
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CommitAgentInsertedExceptions
Type: Optional
Default Value: false
Valid Values: true, false
Dependencies: Enabled only if AllowInsertExceptions is set to true

If this option value is set to true, exceptions that are inserted by an agent are committed to the
schedule or inserted, pending approval by a supervisor.

Back to Top

AgentTimeOff Section
[+]
AllowEnterFullDayStartEnd
Type: Optional
Default Value: true
Valid Values: true, false
Dependencies: None

Set this option value to false to disable an agent’s ability to specify the start and end of a full-day
time off. Omit this option or set the value to true to enable that ability.

AllowEnterPaidTime
Type: Optional
Default Value: false
Valid Values: true, false
Dependencies: None

Controls whether an agent can specify a the number of paid hours to deduct, when creating or
editing a full-day time-off request in the Time Off Request view.

AllowTimeOffPlanner
Type: Mandatory
Default Value: true
Valid Value: true, false
Dependencies: None

Controls whether or not the time off planner appears in the agent part.

AllowWaitList
Type: Mandatory
Default Value: true
Valid Values: true, false
Dependencies: None

Controls whether the Wait-List check box—and the option that it represents—appears in the
Inserting New Time Off Items dialog box when an agent is requesting time off.
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Important
Even when this option is set to false, a supervisor may wait-list a timeoff request
when adding or editing the item through the WFM Calendar. However, if the agent
subsequently edits such a wait-listed time-off item, the status changes, and the item
is no longer wait-listed.

SeparateStartEndForEachDay
Type: Optional
Default Value: false
Valid Values: true, false
Dependencies: None

If this option value is set to true, an agent can define a separate (and different) start and end times
for each full day in a new time-off request that spans multiple days. If this option value is omitted or
set to false, an agent can define only identical start and end times for all full days in a new time-off
request that spans multiple days.

Back to Top

AgentTrading Section
[+]
AllowNoComments
Type: Optional
Default Value: false
Valid Value: true, false
Dependencies: None

If this option value is set to true, agents do not have the ability to enter comments while working
with trades.

AllowAccessToOthersSchedule
Type: Mandatory
Default Value: true
Valid Value: true, false
Dependencies: AllowScheduleTrading

If this option value is set to true, agents can see other agents’ schedules in the Schedule tab of the
WFM Web for Agents Trading view.

AllowScheduleTrading
Type: Mandatory
Default Value: true
Valid Value: true, false
Dependencies: None

If this option value is set to true, trading functionality is enabled for agents. If set to false, trading
functionality is disabled and Trading is not available in the WFM Web for Agents menu.
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TradeOnlyInsideTeam
Type: Mandatory
Default Value: true
Valid Value: true, false
Dependencies: AllowScheduleTrading, AllowAccessToOthersSchedule

Controls the type of schedules that an agent can see. If this option value is set to true, agents see
schedules only of other agents who are in the same team. If set to false, agents see schedules of all
agents who belong to the same site.

Back to Top

Client Section
[+]
SOAPTimeout
Type: Mandatory
Default Value: 60
Valid Value: Any positive integer
Dependencies: None

Specifies the number of seconds to wait for the response from WFM Server before timing out.

Back to Top

Identity Section
[+]
ApplicationType
Type: Optional in a Framework 8.x environment.
Default Value: WFMWeb
Valid Value: WFMWeb
Dependencies: None

Specifies Workforce Management component for which this application is used. Configure this optioin
only if you are using an application of the type ThirdPartyServer.

Back to Top

Log Section
[+]
all
Type: Mandatory
Default Value: stdout
Valid Values: log output types, such as stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of all levels, Standard, Trace, and Debug, are to be sent to the listed
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outputs.

Warning
Do not use the value network unless requested by Genesys Professional Services
because it generates extremely heavy message loads that can degrade system
performance.

buffering
Type: Mandatory
Default Value: false
Valid Values: true, false
Dependencies: None

Specifies whether system file buffering is turned on (true) or off (false).

debug
Type: Mandatory
Default Value: stdout
Valid Values: log output types, such as stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Debug level are to be sent to the listed outputs.

Warning
Do not use the value network unless requested by Genesys Professional Services
because it generates extremely heavy message loads that can degrade system
performance.

expire
Type: Mandatory
Default Value: false
Valid Values: false, <number>, <number> file, <number> day
Dependencies: None

Sets the expiration mode for old segments. The number to be stored cannot be less than 1 file or 1
day or more than 100 files or 100 days. A value of No indicates that files do not expire.

segment
Type: Mandatory
Default Value: false
Valid Values: false, <number>, <number>KB, <number>MB, <number>Hr
Dependencies: None

Sets the maximum size (in KB, MB, or hours) of the log file segment, after which a new segment is
created. The default size is in KB. The number (<number>) cannot be less than 100 KB or less than
one hour. A value of No indicates no segmentation of the log file.
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standard
Type: Mandatory
Default Value: stdout
Valid Values: log output types, such as stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Standard level are to be sent to the listed outputs. For centralized
logging, use a value of network. You can use a local file name as the value, stdout, or network.

trace
Type: Mandatory
Default Value: stdout
Valid Values: log output types, such as stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Trace level are to be sent to the listed outputs. For centralized
logging, use network. You can use a local file name as the value, stdout, or network.

verbose
Type: Mandatory
Default Value: all
Valid Values: all, trace, standard, none, yes (= all), no (= none)
Dependencies: None

Filters the output of log messages, based on their assigned priority.

• all—Enables output of all messages to the log file
• Trace—Enables informational and error messages and disables debug messages
• Standard—Enables error messages only and disables informational and debug messages
• None—Disables all messages.

Back to Top

Options Section
[+]
CustomActivities
Type: Optional
Default Value: none
Valid Value: a text string up to 255 characters
Dependencies: The ShowAllActivities option value must be set to false.

Controls the display of the selected agent in the Main, Schedule Details, and Printing views).
When this option is enabled, the custom value is displayed against the agents schedule, rather than
any of the activities for which they are scheduled. This value can be set to null, which displays
nothing in Web for Agents.

• If this option value is not defined or its value is empty (no text), then WFM Web displays a list of all
activities for which the agent is scheduled.

• If this option value is a text string, WFM Web displays that text string.
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• If the ShowAllActivities option value is set to true, this option has no effect; WFM Web displays a list
of all activities for which the agent has skills.

• If the ShowAllActivities option value is set to false, the value replaces the list of all activities, for
which the agent has skills.

HideNames
Type: Mandatory
Default Value: false
Valid Value: true, false
Dependencies: None

Specifies whether or not agent names are displayed in the Adherence views.

HideTerminatedAgents
Type: Optional
Default Value: false
Valid Value: true, false
Dependencies: None

Specifies whether or not WFM Web excludes agents whose termination date has passed. To exclude
these agents, set this opiton value to true. If you want to view terminated agents, set this option
value to false.

NameOrder
Type: Mandatory
Default Value: 1
Valid Value: 1, 2, 3
Dependencies: None

Determines how WFM Web presents agent names.

• 1—First name is presented first.
• 2—Last name is presented first.
• 3—Last name is presented first and is separated from first name with a comma.

NoPerformanceInSchedule
Type: Mandatory
Default Value: false
Valid Value: true, false
Dependencies: None

Controls whether or not target selection and performance data retrieval is automatic in the Schedule
Intra-Day view. It can be useful in improving the WFM performance in some situations. If this option
value is set to false (the default), target selection and performance data retrieval is automatic. If set
to true, the user must explicitly select a target for performance data, or else no performance data is
retrieved.

OpenHoursCellColor
Type: Optional
Default Value: FFCC00 (hot yellow)
Valid Value: Any standard hex code value for a color. For example, D3D3D3 is light gray.
Dependencies: None
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Specifies the color of the background in the opening hours cells of Forecast views. The default
value applies if you omit this option.

PageCharSet
Type: Optional
Default Value: No default value
Valid Value: Any standard character set value. For example, enter x-sjis for the Japanese character
set. Dependencies: None

Specifies the character set that every page in WFM Web employs. If empty, no character set is
specified.

ShowAllActivities
Type: Optional
Default Value: false
Valid Values: true, false
Dependencies: None

Specifies how the Daily Schedule pane is displayed in WFM Web for Agents. Set this option value to
false to have only the agent’s scheduled activities displayed. Set it to true to create a display
containing all possible activities for that agent, whether scheduled or not.

See the option CustomActivities for related functionality.

Table: The affect of ShowAllActivities settings on CustomActivities

Statistics Definition
true any value
false empty
false text

Back to Top

Reports Section
[+]
Charset
Type: Optional
Default Value: No default value
Valid Values: Any standard code page value. For example, enter cp1257 for a Baltic code page.
Dependencies: None

Specifies the code page to be used for fonts in generated reports. If empty, code page 1252, Latin 1,
is used.

Font
Type: Optional
Default Value: No default value
Valid Value: Any font name that exists on the computer used to generate reports.
Dependencies: None
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Specifies the font name to be used in on the computer used to generated WFM reports.

x-FontPath
Type: Optional
Default Value: No default value
Valid Value: Physical path
Dependencies: None

Physical directory path where the font resides (as specified above in Reports/Font).

OwnerCaption
Type: Mandatory
Default Value: No default value
Valid Value: Any string
Dependencies: None

Provides the default value for the report header. You can change this value in the Header field on the
first window of any Report Wizard.

OwnerVisible
Type: Mandatory
Default Value: false
Valid Value: true, false
Dependencies: None

Provides the default value for the Show Header check box in the first page of all Report Wizards.

PageLimit
Type: Optional
Default Value: 0
Valid Value: 0 and up
Dependencies: None

Specifies the maximum number of pages a normal report can contain. If this number is exceeded,
report generation is cancelled. Values less than 2 specify no limit.

PageLimitForCSV
Type: Optional
Default Value: 0
Valid Value: 0 and up
Dependencies: None

Specifies the maximum number of pages that a CSV-friendly report can contain. If this number is
exceeded, report generation is cancelled. Values less than 2 specify no limit.

PathToAutoGeneratedReports
Type: Mandatory
Default Value: None
Valid Value: a valid and accessible network path
Dependencies: None

Specifies the network path for storing generated reports. If this value is not set, then generated
reports are lost (not stored at all).

RevertDiffCalculation
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Type: Mandatory
Default Value: 0, false, no
Valid Value: 0, false, no, 1, true, yes
Dependencies: None

By default, the Difference column in the Contact Center Performance and Workforce Performance
reports is calculated as the Scheduled or Forecasted value minus the Actual value. Set this option to
1 (true) if you want the Difference column to be calculated as the Actual value minus the
Scheduled or Forecasted value.

ServerURL
Type: Optional
Default Value: No default value
Valid Value: URL
Dependencies: None

A URL for the location of the WFM Web that is used as the reports server. For more information, see
Installing WFM Web as Report Server.

ShowActualHeadcount
Type: Mandatory
Default Value: false
Valid Values: true, false
Dependencies: None

Applies to the Contact Center Performance Report and the Workforce Performance Report. If this
option value is set to false, the report displays the Actual Number of Agents that were collected
by Data Aggregator in the wm_agents_in option (logged in agents). If set to true, the report displays
the Actual Headcount, which is the wm_agent_minutes option value divided by 15.

For example, if 1 agent is logged in but works only 14 minutes per timestep, the headcount equals
0.93. Dependencies: None

Important
For CCPR, this condition is executed only for Actual data; for Planning Data
EPerfInfoItems.PERF_ITEM_SCH_HEADCOUNT is always shown as Number of Agents.

ShowSSGonFirstPageOnly
Type: Optional
Default Value: false
Valid Value: true, false
Dependencies: None

Set this option value to true to disable repeated display of the Select Schedule State Groups and
Schedule States section on each page of all reports. If disabled (set to true) the report will display
the complete list once, and then never repeat it.

Back to Top
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WFM Builder Options
From the Options tab you can modify the default WFM Builder configuration settings. The tab
contains four sections. The options in each of these sections are described below.

Client Section
[+]
CfgServerRequestTimeout
Type: Mandatory
Default Value: 15
Valid Value: Any positive integer
Dependencies: None

Specifies the number of seconds to wait for a response from Configuration Server before timing out.
This key is used when requesting the list of objects from Configuration Server for synchronization
purposes. The value should be increased in configurations with a high number of objects or slow
network connections.

SOAPTimeout
Type: Mandatory
Default Value: 120
Valid Value: Any positive integer
Dependencies: None

The SOAP connection timeout, in seconds.

Back to Top

Identity Section
[+]
ApplicationType
Type: Optional in Framework 8.x environments.
Default Value: WFMBuilder
Valid Value: WFMBuilder
Dependencies: None

Specifies the Workforce Management component for which this application is used. Configure this
option only if you are using an application of the type ThirdPartyServer.

Back to Top

Logs Section
[+]
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verbose
Type: Mandatory
Default Value: all
Valid Values: all, trace, standard, none, yes (= all), no (= none)
Dependencies: None

Filters output of log messages based on their assigned priority. All enables output of all messages to
the log file. Setting the option value to:

• trace—Enables informational and error messages and disables debug messages.
• standard—Enables error messages only and disables informational and debug messages.
• none—Disables all messages.

buffering
Type: Mandatory
Default Value: no
Valid Values: yes, no
Dependencies: None

Turns system file buffering on (yes) or off (no).

segment
Type: Mandatory
Default Value: no
Valid Values: no, <number>, <number>KB, <number>MB, <number>Hr
Dependencies: None

Sets the maximum size (in KB, MB, or hours) of the log file segment, after which a new segment is
created. The default size is in KB. The number cannot be less than 100 KB or less than one hour.
Setting this option value to no indicates no segmentation of the log file.

expire
Type: Mandatory
Default Value: no
Valid Values: no, <number>, <number> file, <number> day
Dependencies: None

Sets the Expiration mode for old segments. The number to be stored cannot be less than 1 file or 1
day or more than 100 files or 100 days. Setting this option value to no indicates that files do not
expire.

messagefile
Type: Mandatory
Default Value: wfmbuilder.lms
Valid Value: wfmbuilder.lms
Dependencies: None

Sets the name of the file that stores application-specific log messages. The only valid value is
wfmbuilder.lms.

standard
Type: Mandatory
Default Value: stdout
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Valid Values (log output types): stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Standard level are to be sent to the listed outputs. For centralized
logging, set this option value to network. You can use a local file name or stdout, as well as
network.

trace
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Trace level are to be sent to the listed outputs. For centralized
logging, set this option value to network. You can use a local file name, stdout, as well as network.

debug
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Debug level are to be sent to the listed outputs.

Warning
Do not use network unless requested by Genesys Professional Services, because it
generates extremely heavy message loads that can degrade system performance.

all
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of all levels, Standard, Trace, and Debug, are to be sent to the listed
outputs.

Warning
Do not use network unless requested by Genesys Professional Services, because it
generates extremely heavy message loads that can degrade system performance.

x-ScheduleBuilderProgressTrace
Type: Optional
Default Value: No default value
Valid Values: true, false
Dependencies: None
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Enables or disables the reporting of schedule progress in the log file.

x-ScheduleBuilderTrace
Type: Optional
Default Value: No default value
Valid Values: true, false
Dependencies: “x-ScheduleLogPath”

Indicates that WFM Builder must write scheduling data, output data, and messages to the Schedule
log file. To use this option, you must specify a Schedule log path. One log file is created for every
schedule build. Used for Schedule debugging only.

x-ScheduleLogPath
Type: Optional
Default Value: No default value
Valid Value: Path to the Schedule log directory.
Dependencies: None

For Schedule debugging only. Indicates the directory into which WFM Builder will write the file
containing Schedule log data and messages.

x-ScheduleMaxLogs
Type: Optional
Default Value: No default value
Valid Values: 1-1000
Dependencies: “x-ScheduleLogPath”

Specifies the maximum number of Schedule log files (or pairs, if the x-SwordTrace option value is
also set to yes) to keep in the folder specified in the x-ScheduleLogPath option. If you reach the
maximum number of files, WFM Builder deletes files as necessary to stay within the limit, starting
with the oldest file.

x-SwordTrace
Type: Optional
Default Value: No default value
Valid Values: yes, no
Dependencies: "x-ScheduleLogPath”

Indicates that scheduling algorithm output messages must be written to the Schedule log. Used for
Schedule debugging only.

Back to Top

Options Section
[+]
MaxSchedulingThreadPoolSize
Type: Optional
Default Value: 0
Valid Values: 0, 1, <number> (the number of CPU cores available to the process)
Dependencies: None

Limits the maximum number of CPU cores that WFM Builder uses when scheduling multi-site
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schedule scenarios. If the value is missing or is set to anything less than 1, then WFM Builder uses
the maximum number of CPU cores for scheduling.

Important
The number of CPU cores that WFM Builder might use depends upon the number of
sites that are in the schedule scenario. WFM Builder can schedule a multi-site
scenario, using a separate CPU core for each site. If there are ten sites in the schedule
scenario, then Builder can use ten CPU cores for scheduling.

MultiSiteActivitiesEnabled
Type: Optional
Default Value: false
Valid Values: true, false
Dependencies: None

Use this option if you are configuring multi-site activities to Specify that Builder will use multi-site
staffing requirements when building multi-site schedule scenarios. If this option value is set to:

• True—Use the staffing requirements of multi-site activities.
• False—Use the staffing requirements of related-site activities.

NameOrder
Type: Mandatory
Default Value: 1
Valid Values: 1, 2, 3
Dependencies: None

Specifies how names are presented in warning messages. If this option is set to:

• 1—First name is presented first.
• 2—Last name is presented first.
• 3—Last name is presented first and is separated from first name with a comma.

PreserveMarkedTime
Type: Optional
Default Value: false
Valid Values: true, false
Dependencies: None

If this option is set to:

• True—Agent days that have marked time will be excluded from intra-day reoptimization.
• False (or empty)—Does not exclude Agent days that have marked time from intra-day reoptimization.

Special100ShiftCheck
Type: Optional
Default Value: false
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Valid Values: true, false
Dependencies: None

If the option value is:

• True—Sets the Builder shift limit to 100 shifts.
• False (or empty)—Sets the Builder shift limit to 500 shifts.

Important
Error 43 appears if your configuration violates the current shift limit.

Back to Top
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WFM Data Aggregator Options
From the Options tab you can modify the default WFM Data Aggregator configuration settings. The
tab contains four sections. The options in each of these sections are described below.

Client Section
[+]
CfgServerRequestTimeout
Type: Mandatory
Default Value: 10
Valid Values: Any positive integer
Dependencies: None

Specifies the number of seconds to wait for a response from Configuration Server before timing out.
This key is used when requesting the list of objects from Configuration Server for synchronization
purposes. The value should be increased in configurations with a high number of objects or slow
network connections.

SOAPTimeout
Type: Mandatory
Default Value: 90
Valid Value: Any positive integer
Dependencies: None

Specifies the SOAP connection timeout, in seconds.

Back to Top

Identity Section
[+]
ApplicationType
Type: Optional in a Framework 8.x environment.
Default Value: WFMDataAggregator
Valid Value: WFMDataAggregator
Dependencies: None

Specifies the Workforce Management component for which this application is used. Configure this
option only if you are using an application of the type ThirdPartyServer.
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Logs Section
[+]
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verbose
Type: Mandatory
Default Value: all
Valid Values: all, trace, standard, none, yes (= all), no (= none)
Dependencies: None

Filters output of log messages based on their assigned priority. All enables output of all messages to
the log file. Setting the option value to:

• trace—Enables informational and error messages and disables debug messages.
• standard—Enables error messages only and disables informational and debug messages.
• none—Disables all messages.

buffering
Type: Mandatory
Default Value: no
Valid Values: yes, no
Dependencies: None

Turns system file buffering on (yes) or off (no).

segment
Type: Mandatory
Default Value: no
Valid Values: no, <number>, <number>KB, <number>MB, <number>Hr
Dependencies: None

Sets the maximum size (in KB, MB, or hours) of the log file segment, after which a new segment is
created. The default size is in KB. The number cannot be less than 100 KB or less than one hour.
Setting this option value to no indicates no segmentation of the log file.

expire
Type: Mandatory
Default Value: no
Valid Values: no, <number>, <number> file, <number> day
Dependencies: None

Sets the Expiration mode for old segments. The number to be stored cannot be less than 1 file or 1
day or more than 100 files or 100 days. Setting this option value to no indicates that files do not
expire.

messagefile
Type: Mandatory
Default Value: wfmdataaggregator.lms
Valid Value: wfmdataaggregator.lms
Dependencies: None

Sets the name of the file that stores application-specific log messages. The only valid value is
wfmdataaggregator.lms.

standard
Type: Mandatory
Default Value: stdout
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Valid Values (log output types): stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Standard level are to be sent to the listed outputs. For centralized
logging, set this option value to network. You can use a local file name or stdout, as well as
network.

trace
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Trace level are to be sent to the listed outputs. For centralized
logging, set this option value to network. You can use a local file name, stdout, as well as network.

debug
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Debug level are to be sent to the listed outputs.

Warning
Do not use network unless requested by Genesys Professional Services, because it
generates extremely heavy message loads that can degrade system performance.

all
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of all levels, Standard, Trace, and Debug, are to be sent to the listed
outputs.

Warning
Do not use network unless requested by Genesys Professional Services, because it
generates extremely heavy message loads that can degrade system performance.

x-DBWriterTrace
Type: Optional
Default Value: No default value
Valid Values: yes, no
Dependencies: None
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When set to yes (or true or 1), this option enables an additional logging option that is used by Data
Aggregator to record how a statistic's records are being stored in the database.

x-LogAgentEventTrace
Type: Optional
Default Value: No default value
Valid Values: yes, no
Dependencies: None

Specifies whether or not Data Aggregator writes agent event data to a log file. This option is used for
debugging only.

x-LogConfigServerConnectionTrace
Type: Optional
Default Value: No default value
Valid Values: yes, no
Dependencies: None

Specifies whether or not Data Aggregator writes Configuration Server connection data to a log file.
This option is used for debugging only.

x-LogConfigServerTrace
Type: Optional
Default Value: No default value
Valid Values: yes, no
Dependencies: None

Indicates whether Data Aggregator should write Configuration Server process data to a log file. This
option is used for debugging only.

x-LogSynchronizationTrace
Type: Optional
Default Value: No default value
Valid Values: yes, no
Dependencies: None

Specifies whether or not Data Aggregator writes Configuration Server synchronization data to a log
file. This option is used for debugging only.

x-LogWFMServerTrace
Type: Optional
Default Value: No default value
Valid Values: yes, no
Dependencies: None

Specifies whether or not Data Aggregator writes WFM Server process data to a log file. This option is
used for debugging only.

Back to Top

Options Section
[+]
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AcceptZeroSkillLevel
Type: Optional
Default Value: false
Valid Value: true, false
Dependencies: None

Specifies whether or not WFM Data Aggregator can set an agent skill level to 0. When this option is
set to true it enables Data Aggregator to set an agent skill level to 0. When set to false it prevents
(disables) Data Aggregator from setting an agent skill level to 0.

DBDumpFile
Type: Optional
Default Value: No default value
Valid Value: Any valid file name
Dependencies: None

Specifies a file to which WFM Data Aggregator writes its current data if it loses its connection to the
database. When Data Aggregator is restarted or the connection to the database is restored, it locates
the dump file, retrieves the data, writes it to the database, and then deletes the dump file. If you do
not specify a file name, the file is DBdump.dat located in \\...\Workforce Management\Data
Aggregator.

HandleTimeWriteBack
Type: Optional
Default Value: No default value
Valid Value: 1-12
Dependencies: None

Enables Data Aggregator to transfer the handling time of the recent timestep to a previous timestep
and adjust the average handling time (AHT) value of the previous timestep when there were no calls
handled in the current timestep, but a handling time was registered. This option prevents Data
Aggregator from setting the AHT value to 0 (zero) for timesteps, in which agents performed after-call
work (ACW) on calls that occurred in a previous timestep.

If this key is present and has an integer value between 1 and 12, Data Aggregator searches for the
previous timestep that is no further back than the specified key value and, in which at least one call
was handled. If Data Aggregator finds a timestep like this, it updates the AHT of that timestep to
incorporate the handle time registered during the recent timestep.

The value for this key determines the number of timesteps that WFM Data Aggregator searches back.
Therefore, the ACW must occur within 12 timesteps, or 3 hours, after call completion. A value of 0
(zero) disables this option.

Important
Some calls are brief enough to be considered short-abandoned calls, but they begin
and end in different timesteps and thus require special handling to avoid skewing Call
Center data. WFM Data Aggregator can identify a call like this because the timestep
where it ends has an associated HandleTime statistic but no HandleVolume statistic.
WFM Data Aggregator uses the value of the HandleTimeWriteBack option when
searching for the beginning of a short-abandoned call like this, to adjust the prior
timestep where that call began. See the topic "Configuration > Activities > Statistics
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Configuration for Activities” in Workforce Management Configuration Utility Help.

ReasonCodeKeyName
Type: Optional
Default Value: ReasonCode
Valid Value: Any valid reason-code key name
Dependencies: None

Specifies the reason (aux)-code key used in the enterprise. It is not necessary to configure this option
if you do not use reason codes. Data Aggregator can process reason codes that come from hard and/
or soft phones. To receive reason codes from hard phones, or in a mixed hard/soft phone
environment, set the Data Aggregator Application’s ReasonCodeKeyName option value to
ReasonCode in Configuration Manager.

Important
You can only use reason codes from hard phones if you are using Stat Server 7.x.

ReasonCodeWaitTime
Type: Optional
Default Value: 15
Valid Value: 2–600
Dependencies: None

Necessary only if you are using a pre-6.5 release of Stat Server and are using reason codes. It
specifies how long, in seconds, Data Aggregator delays processing information during a timestep
while waiting for reason code information. This parameter is useful when Stat Server and/or the
network are busy enough to delay reason code data.

ScheduleLookAheadMinutes
Type: Optional
Default Value: No default value
Valid Value: 0-1440
Dependencies: None

Specifies how many additional minutes of agent schedules should be loaded from WFM Server for
adherence calculations. Should be used only in environment where agent schedules and
configuration are updated infrequently.

SynchronizeUnassignedAgents
Type: Optional
Default Values: true, yes
Valid Value: true, yes, false no
Dependencies: None

Specifies whether or not WFM Data Aggregator should synchronize agents who are not assigned to
any site. If more than one WFM Data Aggregator is configured to perform synchronization on the
same database, then Genesys recommends that you set this option to yes for only one WFM Data
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Aggregator.

Back to Top
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WFM Daemon Options
From the Options tab you can modify the default WFM Daemon configuration settings (see Using E-
mail Notifications in WFM). This tab contains five sections. The options in each section are described
below.

Log Section
[+]
all
Type: Mandatory
Default Value: stdout
Valid Values: log output types, such as stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of all levels, Standard, Trace, and Debug, are to be sent to the listed
outputs.

Warning
Do not use the value network unless requested by Genesys Professional Services
because it generates extremely heavy message loads that can degrade system
performance.

buffering
Type: Mandatory
Default Value: false
Valid Values: true, false
Dependencies: None

Specifies whether system file buffering is turned on (true) or off (false).

debug
Type: Mandatory
Default Value: stdout
Valid Values: log output types, such as stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Debug level are to be sent to the listed outputs.

Warning
Do not use the value network unless requested by Genesys Professional Services
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because it generates extremely heavy message loads that can degrade system
performance.

expire
Type: Mandatory
Default Value: false
Valid Values: false, <number>, <number> file, <number> day
Dependencies: None

Sets the expiration mode for old segments. The number to be stored cannot be less than 1 file or 1
day or more than 100 files or 100 days. A value of No indicates that files do not expire.

segment
Type: Mandatory
Default Value: false
Valid Values: false, <number>, <number>KB, <number>MB, <number>Hr
Dependencies: None

Sets the maximum size (in KB, MB, or hours) of the log file segment, after which a new segment is
created. The default size is in KB. The number (<number>) cannot be less than 100 KB or less than
one hour. A value of No indicates no segmentation of the log file.

standard
Type: Mandatory
Default Value: stdout
Valid Values: log output types, such as stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Standard level are to be sent to the listed outputs. For centralized
logging, use a value of network. You can use a local file name as the value, stdout, or network.

trace
Type: Mandatory
Default Value: stdout
Valid Values: log output types, such as stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Trace level are to be sent to the listed outputs. For centralized
logging, use network. You can use a local file name as the value, stdout, or network.

verbose
Type: Mandatory
Default Value: all
Valid Values: all, trace, standard, none, yes (= all), no (= none)
Dependencies: None

Filters the output of log messages, based on their assigned priority.

• all—Enables output of all messages to the log file
• Trace—Enables informational and error messages and disables debug messages
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• Standard—Enables error messages only and disables informational and debug messages
• None—Disables all messages.

Back to Top

Options Section
[+]
CharSet
Type: Optional
Default Value: No default value
Valid Values: Any standard character set value. For example, enter x-sjis for the Japanese character
set.
Dependencies: None

Specifies the character set of notification messages sent. Must be specified if messages contain
specific locale characters and they are not presented correctly in the received message.

NameOrder
Type: Mandatory
Default Value: 1
Valid Values: 1, 2, 3
Dependencies: None

Specifies first and last name order when sending e-mail notifications.

• 1—First name is presented first.
• 2—Last name is presented first.
• 3—Last name is presented first and is separated from first name with a comma.

pollTimer
Type: Mandatory
Default Value: 1
Valid Value: Any positive integer
Dependencies: None

Specifies how often WFM Daemon must verify for data updates. The value is specified in minutes.

ReportGenerationTimeout
Type: Optional
Default Value: 120
Valid Value: 1-1440
Dependencies: None

Specifies the time (in minutes) after which a scheduled report task will be terminated, whether or not
report is finished. Use this option to control how long scheduled report tasks can run.

TrackAhead
Type: Mandatory
Default Value: 0
Valid Value: Any integer, positive or negative
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Dependencies: The TrackBack option. If you specify 0 for this option value and the TrackBack option
value, Daemon tracks any data changes without date range limitations. If only one of these option
values is set to 0, Daemon treats it as an indicator of the current day.

Specifies how many days in advance of the current date that WFM Daemon requests data from WFM
Server, counting from the current date. Relevant for any type of notification (see “[[|Notifications]]”).
The value specified is in days, and can be a negative number to specify the past or a positive number
to specify the future.

TrackBack
Type: Mandatory
Default Value: 0
Valid Values: Any integer, positive or negative
Dependencies: The TrackAhead option. If you specify 0 for this option value and the TrackAhead
option value, Daemon tracks any data changes without date range limitations. If only one of them is
0, Daemon treats it as an indicator of the current day.

Specifies how many days back from the current date that WFM Daemon should request data from
WFM Server, counting from the current date. Relevant for any type of notification (see
“[[|Notifications]]”). The value specified is in days, and can be a negative number to specify the past
or a positive number to specify the future.

Back to Top

Identity Section
[+]
ApplicationType
Type: Optional in a Framework 8.x environment.
Default Value: WFMDaemon
Valid Value: WFMDaemon
Dependencies: None

Identifies the WFM Daemon application.

Back to Top

Client Section
[+]
SOAPTimeout
Type: Mandatory
Default Value: 60
Valid Values: Any positive integer
Dependencies: None

Specifies the connection timeout, in seconds, to WFM Server.

Back to Top
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SMTP Section
[+]
AnonymousAccess
Type: Optional
Default Value: false
Valid Values: true, false
Dependencies: None

If this option value is set to true it enables WFM Daemon’s ability to send anonymous e-mails. If set
to false it disable WFM Daemon’s ability to send anonymous e-mails.

fromAddress
Type: Optional
Default Value: No default value
Valid Values: Any valid e-mail address
Dependencies: None

Specifies the FROM e-mail address that is presented to users that receive notifications.

Host
Type: Mandatory
Default Value: No default value
Valid Values: Not applicable
Dependencies: None

Specifies the host name of machine where the SMTP server is located.

Password
Type: Optional
Default Value: No default value
Valid Values: Any valid password
Dependencies: None

Specifies the password that is used when connecting to the SMTP server. Specified only if SMTP
server requires connection authorization.

Port
Type: Mandatory
Default Value: 25
Valid Values: Any positive integer
Dependencies: None

Specifies the SMTP server port number.

User
Type: Optional
Default Value: No default value
Valid Values: Any valid username
Dependencies: None

Specifies the username that is used to connect to the SMTP server. Specified only if SMTP server
requires connection authorization.
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WFM Client Options
The Client Application object is used both by the WFM Configuration Utility and the WFM
Database Utility. From the Options tab you can modify the default configuration settings for both
utilities.

The Client Options tab contains three sections. The options in each of these sections are described
below. If you choose to use a user-created option, you can create an OptionalSettings section. See
Creating New Configuration Sections and Options for instructions.

Client Section
[+]
CfgServerRequestTimeout
Type: Mandatory
Default Value: 15
Valid Values: Any positive integer
Dependencies: None

Specifies the number of seconds to wait for a response from Configuration Server before timing out.
This key is used when requesting the list of objects from Configuration Server for synchronization
purposes. Increase the value of this option in configurations that have a large number of objects or
slow network connections.

SOAPTimeout
Type: Mandatory
Default Value: 60
Valid Value: Any positive integer
Dependencies: None

Specifies the number of seconds to wait for the response from WFM Server before timing out.

Back to Top

Logs Section
[+]
all
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of all levels, Standard, Trace, and Debug, are to be sent to the listed
outputs.
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Important
Do not use network unless requested by Genesys Professional Services because it
generates extremely heavy message loads that can degrade system performance.

buffering
Type: Mandatory
Default Value: no
Valid Values: yes, no
Dependencies: None

Turns system file buffering on (yes) or off (no).

CSynchFile
Type: Optional
Default Value: No default value
Valid Value: Any file name and path used for Windows
Dependencies: None

Provides the file name used to output the progress of synchronization. As described in Workforce
Management Configuration Utility Help, you can synchronize the content of the WFM Database with
that of the Configuration Database.

debug
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Debug level are to be sent to the listed outputs.

Important
Do not use network unless requested by Genesys Professional Services because it
generates extremely heavy message loads that can degrade system performance.

expire
Type: Mandatory
Default Value: no
Valid Values: no, <number>, <number> file, <number> day
Dependencies: None

Sets the Expiration mode for old segments. The number to be stored cannot be less than 1 file or
1 day or more than 100 files or 100 days. If this option value is set to no, files do not expire.

messagefile
Type: Mandatory
Default Value: No default value
Valid Value: Any character string
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Dependencies: None

Sets the name of the file that stores application-specific log messages.

segment
Type: Mandatory
Default Value: no
Valid Values: no, <number>, <number>KB, <number>MB, <number>Hr
Dependencies: None Sets the maximum size (in KB, MB, or hours) of the log file segment, after which
a new segment is created. The default size is in KB. The number cannot be less than 100 KB or less
than one hour. If this option value is set to no, the log file is not segmented.

standard
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Standard level are to be sent to the listed outputs. For centralized
logging, use the option value network. You can use a local file name or stdout as well as network.

trace
Type: Mandatory
Default Value: stdout
Valid Values (log output types): stdout, stderr, syslog, network, <filename>
Dependencies: None

Specifies that log events of the Trace level are to be sent to the listed outputs. For centralized
logging, use network. You can use a local file name or stdout as well as network.

verbose
Type: Mandatory
Default Value: all
Valid Values: all, trace, standard, none, yes (= all), no (= none)
Dependencies: None

Filters output of log messages based on their assigned priority. All enables output of all messages to
the log file.

• trace—Enables informational and error messages and disables debug messages.
• standard—Enables error messages only and disables informational and debug messages.
• none—Disables all messages.

Back to Top

Options Section
[+]
AllowLessUpdates
Type: Optional
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Default Value: 0
Valid Value: 0, 1
Dependencies: None

Controls whether the Update Database to Version drop-down text box appears in the WFM Database
Utility after you choose to update your database. Normally, you would only update to the latest
database version. However, in some circumstances, you might need to choose to update to a
database version other than the most recent one. In this case, you need to use the Update Database
to Version drop-down text box.

To have the WFM Database Utility display the Update Database to Version drop-down text box, set
this value to 1. To remove this drop-down text box from the WFM Database Utility interface, set this
option to 0.

AllowMigratePerformance
Type: Optional
Default Value: 0
Valid Values: 0, 1
Dependencies: None

Specifies whether to enable the Performance Data Migration option in the WFM Database Utility
wizard. To enable it, set this option to 1. This means that you can choose to migrate performance
data from your 7.x database to your new WFM 8.x database.

HelpFile
Type: Mandatory
Default Value: wm_config-help.chm
Valid Value: wm_config-help.chm
Dependencies: None

Specifies the name of Workforce Management Configuration Utility Help.

HideTerminatedAgents
Type: Optional
Default Value: false
Valid Value: true, false
Dependencies: None

If option value is set to true, only currently-working agents are displayed. Agents whose termination
date has passed are not displayed. If this option value is set to false, you can view terminated
agents and those whose hire date is in the future.

NameOrder
Type: Optional
Default Value: 1
Valid Values: 1, 2, 3
Dependencies: None

Enables you to set the way the WFM Configuration Utility presents agent names in the Object pane
tree view. The possible values are:

• 1—First name is presented first.
• 2—Last name is presented first.
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• 3—Last name is presented first and is separated from first name with comma.

CommandTimeout
Type: Optional
Default Value: 7200
Valid Values: positive integers
Dependencies: None

Important
This option applies to WFM 7.1.1 releases only. WFM 7.1.0, 7.1.2, 7.2, 7.6 and greater
do not require this option.

Specifies the timeout, in seconds, after which the WFM Database Utility disconnects from the
database during a database update. For an average-sized database, 600 seconds is sufficient to
perform a full update. For unusually large databases, you will need to set this value higher.

LocalTimezones
Type: Optional
Default Value: false
Valid Values: true, false
Dependencies: None

Specifies the time configuration that Configuration Utility assumes for each time zone affected during
synchronization: GMT or local time. Choose the value that matches the values in Configuration
Utility's Time Zone settings Daylight Saving time information dialog. They reflect either a GMT offset,
or local time.

• false—WFM Configuration Utility will assume GMT time zone settings for each time zone affected
during synchronization.

• true—WFM Configuration Utility will assume local time zone settings for each time zone affected during
synchronization.

Tip
To apply the new setting: open Configuration Utility, delete the current timezone
configuration, and run Synchronization.

Back to Top

OptionalSettings Section
[+]
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Important
This section is optional. You must create this section if you need a different font or a
larger font size on the labels and text boxes in the WFM Configuration Utility. This
option is intended particularly for users of the Chinese, Korean, and Japanese localized
versions of the application. See Creating New Configuration Sections and Options to
find procedures about how to create new sections and new options.

FontSize
Type: Optional
Default Value: 8 pt.
Valid Values: 8, 9, or 10 pt.
Dependencies: None

Intended for users of the Chinese, Korean, or Japanese version of the WFM Configuration Utility. It
enables you to adjust the point size of the typeface to accommodate the 9 pt. default size of these
characters.

Font
Type: Optional
Default Value: No default value
Valid Value: Any valid font name
Dependencies: None

Specifies the font used in the WFM Configuration Utility and/or the WFM Database Utility interfaces.
Either or both of the Utilities could point to the Application object you are configuring.

HideDA_settings
Type: Optional
Default Value: false
Valid Value: true, false
Takes Effect: If the current module is closed by navigating to another module and then reopened, or if
the application is restarted. Dependencies: None

Specifies access (permitted or restricted) to Data Aggregator settings and statistics configuration for
Activities in the Client Application. When this option value is set to true, users cannot access these
settings.

Back to Top
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WFM Options Removed
This section lists the WFM options that no longer supported by WFM and have been removed.

Data Aggregator Options Tab

AgentEventsFromInterface
This option removed in release WFM 8.1.1.
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WFM Statistics: Recommended Settings
This topic provides recommendations for configuring statistics for Genesys Stat Server, Voice
Interactions, and Genesys eServices (Multimedia) Interactions, in the following sections:

• Configuring Stat Server Statistics
• Configuring Statistics for Voice Interactions
• Configuring WFM Statistics for eServices (Multimedia) Interactions
• Procedures
• Tables: Recommended Stat Server Statistics

Configuring Stat Server Statistics

You configure the Stat Server statistics that WFM Data Aggregator tracks and records using the WFM
Configuration Utility. Therefore, you must configure certain Stat Server settings required by WFM
before launching the WFM Configuration Utility and completing the WFM Data Aggregator
configuration.

If you use the WFM Data Aggregator Configuration Wizard (instead of performing a manual
installation and configuration) and you select the Wizard’s Add WFM Statistics option, the Wizard
completes all the necessary Stat Server configuration. In this case, the statistics have the variant
names (starting with WFM) listed in parentheses in the Statistic Name rows of the Stat Server
Statistics Settings tables beginning with Table 1 in the section Configuring Statistics for Voice
Interactions.

Important
The Wizard only adds the voice statistics described in Table 1 on this page and Tables
1-6 in the section Configuring Statistics for Voice Interactions, not the Genesys
eServices (Multimedia) statistics. You must configure most eServices statistics
manually in Stat Server. See details in Tables 1-16 in the section Configuring WFM
Statistics for eServices (Multimedia) Interactions and Tables 1-12 in the section
Statistics For iWD Interactions.

In addition, you must locate or configure in Configuration Manager the necessary Stat Server
statistics for tracking WFM activities, so they will be available when configuring WFM Data Aggregator
statistics in the WFM Configuration Utility.

Warning
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You must restart Stat Server after configuration changes.

You must configure two parameters in Stat Server: TimeProfile and TimeRange.

Back to Top

TimeProfile
WFM Data Aggregator uses TimeProfile to order statistics for WFM activities from Stat Server based
on a specific interval of time. This time interval is configured in Stat Server as TimeProfile.

If you use the WFM Data Aggregator Configuration Wizard instead of performing a manual installation
and configuration, and select the Wizard’s Add WFM Statistics option, the Wizard completes all the
necessary time profile configuration. In this case, the time profiles have these variant names (starting
with WFM), such as:

• WFMProfile,Growing=0:00+0:15

• WFMTimeProfile,Growing=0:00+0:15

To configure the time profile, check the TimeProfiles section on the Options tab of the Stat Server
Application object. If it does not exist, create this section.

After locating or creating this section, add the options:

• WFMProfile,Growing=0:00+0:15

• TimeProfileName,Growing=0:00+0:15

TimeProfileName indicates the name of the time profile to be used. The 0:15 parameter indicates
that the request statistics are based on 15-minute intervals.

Important
A 15-minute interval is the only timestep currently supported.

Back to Top

TimeRange
WFM Data Aggregator uses TimeRange to request that the service-factor statistics be calculated,
based on the specified time interval. Usually, service factor is calculated as X% of calls answered
in Y seconds. The Y seconds must be configured as the TimeRange parameter.

After you configure the time range, Stat Server uses it by default and returns the value for any

WFM Statistics: Recommended Settings WFM Options Removed

Workforce Management Administrator's Guide 216



service-factor statistic as X% of calls answered in [TimeRange] seconds. To configure the time
range, check for the TimeRanges section of the Stat Server Application object. If it does not exist,
create this section.

If you use the WFM Data Aggregator Configuration Wizard instead of performing a manual installation
and configuration, and select the Wizard’s Add WFM Statistics option, the Wizard creates the
necessary time range configuration. In this case, the time ranges have these variant names (starting
with WFM):

• WFMTimeRange10=0-10

• WFMTimeRange15=0-15

• WFMTimeRange20=0-20

• WFMTimeRange30=0-30

• WFMTimeRange60=0-60

• WFMTimeRange90=0-90

After locating or creating this section, add these options:

• TimeRange10=0-10

• TimeRange15=0-15

• TimeRange20=0-20

• TimeRange30=0-30

• TimeRange60=0-60

• TimeRange90=0-90

In this case, 10, 15, 20, and so on, represent the Y seconds portion of the service factor calculation
described above.

You can configure multiple time ranges for multiple service-level goals. A Customer Service goal of 80
percent of calls answered in 30 seconds and a Corporate Customer Service goal of 90 percent of calls
answered in 10 seconds is configured as follows:

• CustTimeRange '0-30'

• CorpTimeRange '0-10'

After you configure TimeRange statistic, use this option when configuring the Stat Server request in
the WFM Configuration Utility.

Important
After restarting Stat Server, be certain that during initialization the TimeProfile and
TimeRange statistics proceed successfully. See the Stat Server documentation for
more details.
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Back to Top

Procedures

Click the red arrow to see a list of procedures related to the topics on this page.

Locating Preconfigured Stat Server Statistics in Configuration Manager
Purpose: To locate preconfigured Stat Server statistics.

Start of Procedure

1. Click the plus sign (+) next to Environment in the Configuration Manager tree view.
2. Click Applications.

The list of available Applications appears in the right-hand pane of the window.
3. Double-click the Stat Server Application object.

The Properties window appears, containing several tabs.
4. Click the Options tab.

The preset statistics are listed on the Options tab.
5. Scroll through the list to determine which statistics (from those discussed in this chapter) are already

available, and which ones you need to create.

End of Procedure

Next Steps:

• Complete the Creating New Stat Server Statistics for each statistic you need to create.
• Complete the Entering Settings for New Statistics for each new statistic.

Creating New Stat Server Statistics
Purpose: To create new Stat Server statistics.
Prerequisite: The statistics that WFM requires are not in the preset list.

Start of Procedure

1. On the Stat Server Option tab, click the Create New Section/Option icon.
The Add Statistic window appears.

2. Enter a statistic name from the Stat Server Statistics Settings tables starting with Table .
3. Click OK.

The new statistic appears in the Option tab of the Statistics list.
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Important
Certain Genesys eServices (Multimedia) statistics require additional configuration. For
more details, see Configuring WFM Statistics for eServices (Multimedia) Interactions.

End of Procedure

Next Steps:

• Complete the procedure Entering Settings for New Statistics for each new statistic.

Entering Settings for New Statistics
Summary: After you create new statistics, you must configure each to attach the correct properties
to each. You can create one or more separate requests for each activity.

For example, if an activity named CustomerCare is handled by two different queues, the interaction
volume can be obtained by creating a separate request to Stat Server for the
TotalNumberCallsInbound statistic for each queue. WFM Data Aggregator automatically sums these
results to calculate the total number of CustomerCare interactions.

Warning
Stat Server statistics are used to collect historical data. It is critical that the statistic
requests be configured correctly.

Purpose: To configure the new statistics just created.
Prerequisite: You have completed the Creating New Stat Server Statistics.

Start of Procedure

1. Double-click a new statistic.
The Properties window appears, but is blank.

2. In the Properties window, right-click in the blank area and, from the shortcut menu, select New. The Edit
Option dialog box opens.

3. Enter four option names and values for each new statistic.
4. In the Option Name box, enter an option name from Table 1: Recommended Stat Server Statistics.
5. In the Option Value box, enter the corresponding option value.

Important
Enter the option values exactly as shown in Table 1: Recommended Stat Server
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Statistics.

6. Click OK.
The new settings appear in the Properties window.

7. Repeat Steps 1–5 until you have defined properties for all four options.
8. After entering all the required properties, click OK.
9. To create the next statistic, click the Create New Section/Options icon again.

10. Continue the procedure until you have created all the recommended statistics.
11. Click OK.

End of Procedure

If you need more information about Stat Server statistics, see the Stat Server documentation.

If you need more information about Stat Server statistics, see the Stat Server documentation.You can
copy-and-paste a generic set of these recommended statistics, in the topic Using Copy-and-Paste
Format for Statistics.

Tables: Recommended Stat Server Statistics

View tables.. [+]

Interaction Volume
Item Description

Statistic Name TotalNumberCallsEntered

Statistic Configuration
Option/Value pairs

Objects = Queue, RoutePoint, GroupQueues
Category = TotalNumber
MainMask = CallEntered
Subject = DNAction

Comments Predefined. Collects the number of interactions that
enter the object.

Abandonment Volume
Item Description

Statistic Name TotalNumberCallsAband

Statistic Configuration
Option/Value pairs

Objects = Queue, RoutePoint, GroupQueues
Category = TotalNumber
MainMask = CallAbandoned
Subject = DNAction
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Item Description

Comments Predefined. Collects the number of interactions
abandoned while waiting in the object.

Statistic Name TotalNumberShortAbandons

Statistic Configuration
Option/Value pairs

Objects = Queue, RoutePoint, GroupQueues
Category = TotalNumberInTimeRange
MainMask = CallAbandoned, CallAbandonedFromRinging
Subject = DNAction

Comments Predefined. Collects the number of interactions
abandoned while waiting in the object.

Quality of Service
Item Description

Statistic Name ServiceFactor1

Statistic Configuration
Option/Value pairs

Objects = Queue, RoutePoint, GroupQueues
Category = ServiceFactor1
MainMask = CallAnswered, CallAbandoned,
CallAbandonedFromRinging
Subject = DNAction

Comments

Predefined. You must configure a time range to use
this statistic. Reports the percentage of
interactions answered by
agents within the time range. Calculated as interactions
answered divided by total interactions (answered +
abandoned).

Statistic Name TotalNumberCallsDistrib

Statistic Configuration
Option/Value pairs

Objects = Queue, RoutePoint, GroupQueues
Category = TotalNumber
MainMask = CallDistributed
Subject = DNAction

Comments
Predefined. Reports the number of interactions
distributed to other objects from the specified
object.

Statistic Name AverTimeBeforeAnswering

Statistic Configuration
Option/Value pairs

Objects = Queue, RoutePoint, GroupQueues
Category = AverageTime
MainMask = CallAnswered
Subject = DNAction

Comments
Not predefined. Reports the average time an
interaction range before being answered.
Calculated as a ratio of total wait time for
interactions to be answered divided by the number
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Item Description
answered. Only interactions answered during the
current time interval are counted.

Handle Time
Item Description

Statistic Name TotalHandleTime

Statistic Configuration
Option/Value pairs

Objects = Agent, Place, GroupAgents, GroupPlaces
Category = TotalAdjustedTime
MainMask = CallInbound, CallOutbound, AfterCallWork
Subject = DNAction

Comments
Predefined. Reports the total time an agent spent
handling inbound or outbound interactions and
doing offline or after call work.

Statistic Name TotalNumberCallsHandled

Statistic Configuration
Option/Value pairs

Objects = Agent, Place, GroupAgents, GroupPlaces
Category = TotalNumber
MainMask = CallInbound, CallOutbound
Subject = DNAction

Comments
Not predefined. Reports the number of inbound and
outbound interactions that ended during a specific
timestep.

You can copy-and-paste a generic set of these recommended statistics, in the topic, "Using Copy-and-
Paste Format for Statistics".

Back to Top
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Configuring WFM Statistics for Voice
Interactions
You can copy-and-paste a generic set of these recommended statistics, into those described in the
topic Using Copy-and-Paste Format for Statistics.

Table 1: Interaction Volume

Item Description

Statistic Name

TotalNumberCallsEntered
or
WFMTotalNumberCallsEntered
(if you used the WFM Data Aggregator Configuration
Wizard to configure Stat Server)

Statistic Configuration
Option/Value pairs

Objects = Queue, RoutePoint, GroupQueues
Category = TotalNumber
MainMask = CallEntered
Subject = DNAction

Comments Predefined. Collects the number of interactions that
enter the object.

Table 2: Abandonment Volume

Item Description

Statistic Name
TotalNumberCallsAband
or
WFMTotalNumberCallsAband

Statistic Configuration
Option/Value pairs

Objects = Queue, RoutePoint, GroupQueues
Category = TotalNumber
MainMask = CallAbandoned
Subject = DNAction

Comments Predefined. Collects the number of interactions
abandoned while waiting in the object.

Back to Top

Table 3: Short Abandonment Volume

Item Description
Statistic Name TotalNumberShortAbandons
Statistic Configuration Objects = Queue, RoutePoint, GroupQueues
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Item Description

Option/Value pairs
Category = TotalNumberInTimeRange
MainMask = CallAbandoned, CallAbandonedFromRinging
Subject = DNAction

Comments

Predefined. Collects the number of interactions
abandoned within a configurable time
period—typically a few seconds—while waiting in
the object. Short Abandons are usually considered
to be wrong numbers or similar, and are typically
excluded when computing statistics.

Quality of Service

Table 4: Distributed Interactions

Item Description

Statistic Name
TotalNumberCallsDistrib
or
WFMTotalNumberCallsDistrib

Statistic Configuration
Option/Value pairs

Objects = Queue, RoutePoint, GroupQueues
Category = TotalNumber
MainMask = CallDistributed
Subject = DNAction

Comments
Predefined. Reports the number of interactions
distributed to other objects from the specified
object.

Back to Top

Table 5: Service Factor

Item Description

Statistic Name
ServiceFactor1
or
WFMServiceFactor1

Statistic Configuration
Option/Value pairs

Objects = Queue, RoutePoint, GroupQueues
Category = ServiceFactor1
MainMask = CallAnswered, CallAbandoned,
CallAbandonedFromRinging
Subject = DNAction

Comments
Predefined. You must configure a time range to use
this statistic. Reports the percentage of
interactions answered by agents within the time
range. Calculated as interactions answered divided
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Item Description
by total interactions (answered + abandoned).

Table 6: Average Speed of Answer

Item Description

Statistic Name
AverTimeBeforeAnswering
or
WFMAverTimeBeforeAnswering

Statistic Configuration
Option/Value pairs

Objects = Queue, RoutePoint, GroupQueues
Category = AverageTime
MainMask = CallAnswered
RelMask = CallAnswered
Subject = DNAction

Comments

Not predefined. Reports the average time an
interaction rang before being answered. Calculated
as a ratio of total wait time for interactions to be
answered divided by the number answered. Only
interactions answered during the current time
interval are counted.

Back to Top

Handle Time

Table 7: Total Handle Time

Item Description

Statistic Name
TotalHandleTime
or
WFMTotalHandleTime

Statistic Configuration
Option/Value pairs

Objects = Agent, Place, GroupAgents,
GroupPlaces
Category = TotalAdjustedTime
MainMask = CallInbound, CallOutbound,
OfflineWorkType1
Subject = DNAction

Comments
Predefined. Reports the total time an agent spent
handling inbound or outbound interactions and
doing offline work.

Table 8: Interactions Handled
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Item Description

Statistic Name
TotalNumberCallsHandled
or
WFMTotalNumberCallsHandled

Statistic Configuration
Option/Value pairs

Objects = Agent, Place, GroupAgents,
GroupPlaces
Category = TotalNumber
MainMask = CallInbound, CallOutbound
Subject = DNAction

Comments
Not predefined. Reports the number of inbound and
outbound interactions that ended during a specific
timestep.
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Configuring WFM Statistics for eServices
(Multimedia) Interactions
The recommendations in this topic only describe how to configure statistics, based on Interaction
Queues. If you want to copy-and-paste a generic set of these recommended statistics, see Using
Copy-and-Paste Format for Statistics.

This topic includes the following sections:

• Statistics For Chat Interactions
• Statistics For E-Mail Interactions
• Statistics For iWD Interactions

Statistics For Chat Interactions

This section contains recommended statistics for Genesys eServices (Multimedia) statistics for chat
interactions.

Table 1: Interaction Volume

Item Description
WFM statistic object type Interaction queue
ConfigServer object type Script
Statistic name <name is user-definable>

Statistic Configuration
Option/Value pairs

AggregationType = Total
Category = JavaCategory
Description = The total number of interactions of the specified
media type that entered this staging area during the specified
period.
JavaSubCategory = eServiceInteractionStat.jar:OMQ Total
Entered
MediaType = chat
Objects = StagingArea

Statistic created by Must be configured manually.

Table 2: Abandonment Volume

Item Description
WFM statistic object type Interaction queue
ConfigServer object type Script
Statistic name Chat_Total_Abandoned_From_Queue

WFM Statistics: Recommended
Settings
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Item Description

Statistic Configuration
Option/Value pairs

AggregationType = Total
Category = JavaCategory
Description = The total number of email interactions
abandoned.
JavaSubCategory = eServiceInteractionStat.jar:OMQ Total
Abandoned
MediaType = chat
Objects = StagingArea

Statistic created by Must be configured manually.

Back to Top

Quality of Service
Table 3: Average Speed of Answer

Item Description
WFM statistic object type Interaction queue
ConfigServer object type Script
Statistic name <name is user-definable>

Statistic Configuration
Option/Value pairs

AggregationType = Total
Category = JavaCategory
JavaSubCategory = eServiceInteractionStat.jar:OMQ Average
Waiting Time
MediaType = chat
Objects = StagingArea

Statistic created by Must be configured manually.

Table 4: Distributed Interactions

Item Description
WFM statistic object type Interaction queue
ConfigServer object type Script
Statistic name <name is user-definable>

Statistic Configuration
Option/Value pairs

AggregationType = Total
Category = JavaCategory
JavaSubCategory = eServiceInteractionStat.jar:OMQ Total
Distributed
MediaType = chat
Objects = StagingArea

Statistic created by Must be configured manually.

Back to Top

Handle Time
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Table 5: Total Handle Time

Item Description
WFM statistic object type GroupAgents, GroupPlaces
ConfigServer object type GroupAgents, GroupPlaces
Statistic name Interactions_Processing_Time

Statistic Configuration
Option/Value pairs

Category = TotalTime
Description = The total amount of time that this resource spent
handling interactions during the specified period.
MainMask = InteractionHandling
Objects = Agent, GroupAgents, GroupPlaces, Place
Subject = AgentStatus

Statistic created by Genesys eServices (Multimedia) Wizard
Filter <name is user-definable>
Filter configuration MediaType=workitem & PairExists(“Queue”,X)

Filter created by Must be configured manually. X is the name of the
interaction queue.

Table 6: Interactions_Handled

Item Description
WFM statistic object type GroupAgents, GroupPlaces
ConfigServer object type GroupAgents, GroupPlaces
Statistic name Interactions_Processed

Statistic Configuration
Option/Value pairs

Category = TotalNumber
Description = The total number of interactions that were
handled by this resource during the specified period.
MainMask = InteractionHandling
Objects = Agent, GroupAgents, GroupPlaces, Place
Subject = AgentStatus

Statistic created by Genesys eServices (Multimedia) Wizard
Filter <name is user-definable>
Filter configuration MediaType=workitem & PairExists(“Queue”,X)

Filter created by Must be configured manually. X is the name of the
interaction queue.

Back to Top

Statistics For E-Mail Interactions

This section contains recommended statistics for Genesys eServices (Multimedia) statistics for e-mail
interactions.

Table 7: Interaction Volume
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Item Description
WFM statistic object type Interaction queue
ConfigServer object type Script
Statistic name IxnQueue_Email_Entered

Statistic Configuration
Option/Value pairs

AggregationType = Total
Category = JavaCategory
Description = Total number of e-mail interactions that entered
the queue.
JavaSubCategory = eServiceInteractionStat.jar:EQR Total
Entered
Objects = StagingArea

Statistic created by Genesys eServices (Multimedia) Wizard.

Back to Top

Handle Time
Table 8: Total Handle Time

Item Description
WFM statistic object type GroupAgents, GroupPlaces
ConfigServer object type GroupAgents, GroupPlaces
Statistic name nteractions_Processing_Time

Statistic Configuration
Option/Value pairs

Category = TotalTime
Description = The total amount of time that this resource spent
handling interactions during the specified period.
MainMask = InteractionHandling
Objects = Agent, GroupAgents, GroupPlaces, Place
Subject = AgentStatus

Statistic created by Genesys eServices (Multimedia) Wizard
Filter <name is user-definable>
Filter configuration MediaType = E-mail & PairExists(“Queue”,X)

Filter created by Must be configured manually. X is the name of the
interaction queue.

Table 9: Interactions Handled

Item Description
WFM statistic object type GroupAgents, GroupPlaces
ConfigServer object type GroupAgents, GroupPlaces
Statistic name Interactions_Processed

Statistic Configuration
Option/Value pairs

Category = TotalNumber
Description = The total number of interactions that were
handled by this resource during the specified period.
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Item Description

MainMask = InteractionHandling
Objects = Agent, GroupAgents, GroupPlaces, Place
Subject = Action

Statistic created by Genesys eServices (Multimedia) Wizard
Filter <name is user-definable>
Filter configuration MediaType = E-mail & PairExists(“Queue”,X)

Filter created by Must be configured manually. X is the name of the
interaction queue.

Back to Top

Backlog
Table 10: E-mails

Item Description

Statistic name
EmailsWaitingInQueue
or
WFMEmailsWaitingInQueue

Statistic Configuration
Option/Value pairs

Objects = StagingArea
Category = JavaCategory
AggregationType = Current
JavaSubCategory = eServiceInteractionStat.jar:OMQ Current
Waiting Processing
MediaType = email

Comments
Number of email interactions that have been
submitted to a queue and are currently awaiting
processing.

Back to Top

Statistics For iWD Interactions

This section contains recommended statistics for Genesys eServices (Multimedia) statistics for
intelligent Workload Distribution (iWD) interactions.

Table 11: Interaction Volume

Item Description
ConfigServer object type Script
Statistic name <name is user-definable>
Statistic Configuration AggregationType = Total
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Item Description

Option/Value pairs

Category = JavaCategory
Description = The total number of interactions of the specified
media type that entered this staging area during the specified
period.
JavaSubCategory = eServiceInteractionStat.jar:OMQ Total
Entered
MediaType = MediaX
Objects = StagingArea

Statistic created by
Must be configured manually. MediaX is the media
type for corresponding intelligent Workload
Distribution.

Table 12: Abandonment Volume

Item Description
WFM statistic object type Interaction queue
ConfigServer object type Script
Statistic name <name is user-definable>

Statistic Configuration
Option/Value pairs

AggregationType = Total
Category = JavaCategory
Description = Total number of e-mail interactions abandoned.
JavaSubCategory = eServiceInteractionStat.jar:OMQ Total
Abandoned
MediaType = MediaX
Objects = StagingArea

Statistic created by
Must be configured manually. MediaX is the media
type for corresponding intelligent Workload
Distribution.

Back to Top

Quality of Service
Table 13: Average Speed of Answer

Item Description
WFM statistic object type Interaction queue
ConfigServer object type Script
Statistic name <name is user-definable>

Statistic Configuration
Option/Value pairs

AggregationType = Total
Category = JavaCategory
JavaSubCategory = eServiceInteractionStat.jar:OMQ Average
Waiting Time
MediaType = MediaX
Objects = StagingArea

Statistic created by Must be configured manually. MediaX is the media
type for corresponding intelligent Workload
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Item Description
Distribution.

Table 14: Distributed Interactions

Item Description
WFM statistic object type Interaction queue
ConfigServer object type Script
Statistic name <name is user-definable>

Statistic Configuration
Option/Value pairs

AggregationType = Total
Category = JavaCategory
JavaSubCategory = eServiceInteractionStat.jar:OMQ Total
Distributed
MediaType = MediaX
Objects = StagingArea

Statistic created by
Must be configured manually. MediaX is the media
type for corresponding intelligent Workload
Distribution.

Back to Top

Handle Time
Table 15: Total Handle Time

Item Description
WFM statistic object type GroupAgents, GroupPlaces
ConfigServer object type GroupAgents, GroupPlaces
Statistic name Interactions_Processing_Time

Statistic Configuration
Option/Value pairs

Category = TotalTime
Description = The total amount of time that this resource spent
handling interactions during the specified period.
MainMask = InteractionHandling
Objects = Agent, GroupAgents, GroupPlaces, Place
Subject = AgentStatus

Statistic created by Genesys eServices (Multimedia) Wizard
Filter <name is user-definable>
Filter configuration MediaType = MediaX

Filter created by Must be configured manually. X is the name of the
interaction queue.

Table 16: Interactions_Handled

Item Description
WFM statistic object type GroupAgents, GroupPlaces

WFM Statistics: Recommended
Settings
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Item Description
ConfigServer object type GroupAgents, GroupPlaces
Statistic name Interactions_Processed

Statistic Configuration
Option/Value pairs

Category = TotalNumber
Description = The total number of interactions that were
handled by this resource during the specified period.
MainMask = InteractionHandling
Objects = Agent, GroupAgents, GroupPlaces, Place
Subject = AgentStatus

Statistic created by Genesys eServices (Multimedia) Wizard
Filter <name is user-definable>
Filter configuration MediaType = MediaX

Filter created by Must be configured manually. X is the name of the
interaction queue.

Back to Top
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Managing the WFM Database
Use Workforce Management (WFM) Database Utility to configure, update, maintain, back up and
restore, and if required, migrate your database. The Database Utility provides a number of functions
in a single interface that enable you to perform these tasks, which are described in these sections:

• Overview
• New Database Configuration
• Update Your WFM Database
• Database Maintenance
• Back Up and Restore Your Database
• Database Migration
• ETL Database Setup
• Procedures

Overview

Use the Database Utility to:

• Create and configure a new database.
• Update your database to that latest release.
• Perform other database updates as needed.
• Perform regular maintenance, such as cleanup of obsolete data.
• Migrate data from a previous WFM releases to a WFM 8.5 database.

Important
In order for the Configuration Utility to work properly, you must set Microsoft SQL and
Oracle database management systems to be case-insensitive.

The WFM Database Utility and the WFM Configuration Utility use the same
Application object, which is typically named WFM Client Application.

Back to Top
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New Database Configuration

If your first installed release of this product is Workforce Management 7.6 (or higher) or if you are
migrating from release 6.x, you will use a new database. The WFM Database Utility populates and
configures the new database for you, setting up the necessary tables, views, indexes, and so on. For
instructions, see Installing WFM Database Utility. If you are already using WFM 7.x, its not necessary
to install a new database. Simply perform a database update to transition your database to release
8.1.

DB2 Configuration Recommendations
The settings in this section are required when you create the WFM database, and will optimize its
performance. Click the + sign to display the details for each recommended setting. See also
Configuring the DB2 Database.

LOGFILSIZ

[+]
Default value LOGFILSIZ = 1000

Recommended LOGFILSIZ = 1000
Update with this

Command
UPDATE DATABASE CONFIGURATION FOR db_name
USING LOGFILSIZ 1000;

LOGPRIMARY

[+]
Default value LOGPRIMARY = 3

Recommended LOGPRIMARY = 10
Use with this

Command
UPDATE DATABASE CONFIGURATION FOR db_name
USING LOGPRIMARY 10;

LOGSECOND

[+]
Default value LOGSECOND = 2

Recommended LOGSECOND = 2
Use with this

Command
UPDATE DATABASE CONFIGURATION FOR db_name
USING LOGSECOND 2;

STMTHEAP

[+]
SQL SQL statement heap (4KB)

Description
The statement heap is used as a work space for the
SQL compiler during compilation of an SQL
statement. This parameter specifies the size of this
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work space.

IBM'S description

In most cases the default value of this parameter is
acceptable. If you have very large SQL statements
and the database manager issues an error (that the
statement is too complex) when it attempts to
optimize a statement, you
should increase the value of this parameter in regular
increments (such as 256 or 1024) until the error situation is
resolved.

Default value (STMTHEAP) = 2048
Recommended (STMTHEAP) = 65535

Use with this
Command

UPDATE DATABASE CONFIGURATION FOR db_name
USING STMTHEAP 65535;

APPLHEAPSZ

[+]
SQL SQL statement heap (4KB)

Description
This parameter defines the number of private
memory pages available to be used by the
database manager on behalf of a specific agent or
subagent.

IBM'S description
Increase the value of this parameter if your
applications receive an error indicating that there is
not enough storage in the application heap.

Default value (APPLHEAPSZ) = 256
Recommended (APPLHEAPSZ) = 1000

Use with this
Command

UPDATE DATABASE CONFIGURATION FOR db_name
USING APPLHEAPSZ 1000;

MON_HEAP_SZ

[+]

Description Database system monitor heap size configuration
parameter.

IBM'S description

The amount of memory required for monitoring
activity depends on the number of monitoring
applications (applications taking snapshots or
event monitors), which switches are set, and the
level of database activity.

Default value (MON_HEAP_SZ) = 66
Recommended (MON_HEAP_SZ) = 90

Use with this
Command

UPDATE DATABASE CONFIGURATION FOR db_name
USING MON_HEAP_SZ 90;
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SHEAPTHRES

[+]

IBM'S description

Ideally, you should set this parameter to a
reasonable multiple of the largest sortheap
parameter you have in your database manager
instance. This parameter should be at least two
times the largest sortheap defined for any
database within the instance.

Default value SHEAPTHRES = 16130
Recommended SHEAPTHRES = 20000

Use with this
Command

UPDATE DATABASE CONFIGURATION FOR db_name
USING SHEAPTHRES 20000;

Back to Top

Buffer Pool
The default buffer pool Page size (4) and other values are too small. Genesys recommends you enter
the following values for the settings in the Alter Buffer Pool dialog box:

Table 1: Recommended Buffer Pool Settings for DB2

Setting Default value Recommended value
Page Size 4 32
Bufferpool size 1000 60000
Size in 4KB pages 1000 60000

Regular Table
Space

Create a Regular table space using buffer pool
with 32KB Page size.

System Temporary
table space

Create a System Temporary table space using
buffer pool with 32KB Page size.

User Temporary
Table Space

Create a User Temporary table space using buffer
pool with 32KB Page size.

Using the Table Spaces
In the Change User dialog box, on the Table Space tab, ensure the table spaces you want to use,
are checked (see figure below).

Important
Ensure you create the same user as your operating system user.
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Figure: Using newly created table spaces when creating new users

Back to Top

Tuning the Transaction Log Characteristics
Before you enable a database for spatial operations, ensure that you have enough transaction log
capacity. The default values for the transaction log configuration parameters do not provide sufficient
transaction log capacity if your plans include:

• Enabling a database for spatial operations in a Windows environment
• Using the ST_import_shape stored procedure to import from shape files
• Using geocoding with a large commit scope
• Running concurrent transactions

If you plan to use any of these now or in the future, you need to increase the capacity of your
transaction log for the database, by increasing one or more of the transaction log configuration
parameters. Otherwise, you can use the default characteristics and proceed to tuning the application
heap size.

Recommended Minimum Values

See the table below for the recommended minimum values for the three transaction log configuration
parameters.

Table 2: Recommended minimum values for transaction configuration parameters

Parameter Description Default value Recommended
minimum value

LOGFILSIZ
Specifies the log file size
as a number of 4-KB
blocks

1000 1000
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Parameter Description Default value Recommended
minimum value

LOGPRIMARY
Specifies how many
primary log files are to
be pre-allocated to the
recovery log files

3 10

LOGSECOND Specifies the number of
secondary log files 2 2

If the capacity of your transaction log is not adequate, the following error message is issued when
you try to enable a database for spatial operations: GSE0010N Not enough log space is
available to DB2.

Back to Top

Update Your WFM Database

From time to time, Genesys issues Maintenance Releases (MR) of its products. Some of the Workforce
Management updates require database updates. If so, you can perform them using the WFM
Database Utility.

Important
If you are migrating from WFM 7.x to 8.1, all you need to do to your database is to
update it. You do not need to create a new database.

Do You Need to Update Your Database?
You might need to update your database, but perhaps you are not sure. Use the steps to help you
decide:

1. Open the WFM Database Utility.
2. Check lower-right in the main window to see whether it indicates that your database is up-to-date. The

database version number should correspond to the version number of the WFM Database Utility you
are running.

To update the database, see Performing a Database Update.

Database Maintenance

To properly maintain your database, you might need to clean it up periodically to remove obsolete
data. To do so, see Performing a Database Cleanup.

Back to Top
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Back Up and Restore Your Database

You can use the WFM Database Utility to back up the data in your Workforce Management database
to a local file and then restore it if necessary. The local files are in Microsoft Access format.

Important
An Access 2002 .MDB file has a maximum database size of about 2 GB.

To backup and/or restore your WFM database, see Performing a Backup and Restoring Your Database.

Starting in 8.1.3, you can use the beta Backup-Restore Utility (BRU), which provides an improved
method of backing up and restoring the WFM Database. See Using the Backup-Restore Utility.

Database Migration

At some point, you might have to migrate data from a previous release to a current one. To do this,
use the WFM Database Utility to transfer your existing data into the new database. After reading this
topic, see the Migrating Data.

• If you are migrating from release 7.x to 8.1, use the Update Database feature of the Database Utility.

To migrate data into a WFM 8.1 database that is in use, you must update the database to the latest
version required by the WFM Database Utility you are using. To do this, use the Update Database
feature of the WFM Database Utility.

• If you are migrating from release 6.x to 8.1, you must migrate your 6.5 data to a new 8.1 database,
which the migration utility creates for you.

You can migrate performance data from a WFM 6.5. database to your WFM 8.1 database after you
have started using WFM 8.1. This enables you to bring performance data into your database that was
collected during the database migration.

For migration instructions, see the "Workforce Management Migration Procedures” chapter in the
Genesys Migration Guide.

ETL Database Setup

You can set up an WFM ETL (Extract, Transform and Load) database schema to enable Genesys
Infomart or other third-party reporting applications to easily create reports, by incorporating WFM
data. Previously, the only way to build customer reports was to use the WFM API.

ETL functionality obtains Schedule, Adherence and Performance information from WFM and stores it
into a documented relational database schema. For more information about this functionality or to
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set up an ETL database schema, see Setting up an ETL Database.

Back to Top

Procedures

Click the red arrow to view a list of procedures related to the topics on this page. <multistep>

|-| Configuring the DB2 Database=

Purpose: To modify the value of one or more configuration parameters in the database.

Prerequisites:

• You have system administration and installation experience and skill with the associated tools.
• The DB2 database is installed.

Start of Procedure

1. From the Configure Database window of the DB2 Control Center, or by reviewing the output from the
GET DATABASE CONFIGURATION command, find the current value for the LOGFILSIZ, LOGPRIMARY, and
LOGSECOND parameters.

2. Change one, two, or three of the values, based on the information in Table 2.
3. Enter a value for each parameter that you want to change.

You can change the values by issuing one or more of the following commands, where db_name identifies
your database:
• UPDATE DATABASE CONFIGURATION FOR db_name USING LOGFILSIZ 1000

• UPDATE DATABASE CONFIGURATION FOR db_name USING LOGPRIMARY 10

• UPDATE DATABASE CONFIGURATION FOR db_name USING LOGSECOND 2

If the only parameter that you change is LOGSECOND, the change takes effect immediately. In this case,
proceed to tuning the application heap size.

4. If you change the LOGFILSIZ, LOGPRIMARY parameter, or both:
a. Disconnect all applications from the database.
b. If the database was explicitly activated, deactivate the database.
Changes to the LOGFILSIZ or LOGPRIMARY parameters take effect the next time either the database is activated or a connection to
the database is established.

Table 3: Parameter Recommendations Comparison

Parameter Description Default value Developer's
value QA value

(LOGFILSIZ) Log file size (4KB) 1024 10000 10000
(LOGPRIMARY) Number of 3 64 128
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Parameter Description Default value Developer's
value QA value

primary log files

(LOGSECOND)
Number of
secondary log
files

0 16 72

End of Procedure

|-| Performing a Database Update=

Purpose: To update WFM database.

Start of Procedure

1. Open the WFM Database Utility.
2. Select the Database Update radio button.
3. Click Next.
4. If you enabled the AllowLessUpdates option in the WFM Client Application object, from the drop-

down list, choose the database version to which you wish to update. If not, your database is updated to
the latest available version.

Important
In some cases you might not choose the most recent version. For example, you might need to restore from a
backup. You must select the same version as the database in the backup file. After restoring, you can then
update your database version.

5. Click Finish.
The WFM Database Utility runs the appropriate scripts and displays a message indicating the results of
the update.

End of Procedure

|-| Performing a Database Cleanup=

Purpose: To remove obsolete data from your database.

Prerequisite: Your database is up-to-date.

Start of Procedure

1. Open the WFM Database Utility.
2. Select the Cleanup Database radio button and then, click Next.
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Important
Your database must be up-to-date to perform a database cleanup.

3. From the drop-down list, select a date.
Data up to (but not including) this date will be deleted.

4. In the dialog box that appears, select the items you want to remove.

Warning
Double-check your choices before you click Finish. You cannot retrieve deleted data.

5. Click Finish.
The WFM Database Utility removes all data up to the date you selected in the Wizard. Data for the
selected day is not deleted.

End of Procedure

|-| Performing a Backup=

Purpose: To back up the data in your WFM database.

Start of Procedure

1. Open the WFM Database Utility.
2. Select the Backup Database to .MDB File radio button.
3. Specify the file name and the location into which data is to be written.
4. Select the type(s) of data you want to back up.

By default, all data types (except Audit Data) are selected. You must always back up Core data. In
addition, you can choose to back up all data (by selecting Entire Database) or select from Audit
Data, Performance, Forecast, or Schedule data.

5. Click Next.
The next dialog box shows that tables that are to be backed up.

6. Click Finish to complete the process or Back to change your selections.
The WFM Database Utility performs the backup and presents a results message at the end.

End of Procedure

|-| Restoring Your Database=

Purpose: To restore the data in your WFM database.
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Start of Procedure

1. Open the WFM Database Utility.
2. Select the Restore Database from .MDB File radio button.
3. Specify the file name and the location from which data is to be retrieved and then, click Next.
4. Click Next to create the database into which files are to be restored.

Important
You do not need to create a database ahead of time. The restore utility creates the correct database version
for your data restoration.

5. Select the type(s) of data you want to restore.
By default, all data types that were backed up in the selected backup file are selected, and you cannot
select data types that were not backed up. You must always restore Core data. In addition, you can
choose to restore all data (by selecting Entire Database) or select from Audit Data, Performance,
Forecast, or Schedule data.

6. Click Next.
The next dialog box displays the tables that are to be backed up or restored.

7. Click Finish to complete the process or Back to change your selections.

Warning
Alternatively, you could select Cancel to cancel a database restoration in progress. However, if you do so,
your database is corrupted and you must clear up the affected sections or create a new database.

The WFM Database Utility performs the restoration and presents a results message at the end.

End of Procedure

|-| Migrating Data=

Purpose: To migrate data from a previous release to a current one.

Start of Procedure

1. Open the WFM Database Utility.
2. Select the Migrate Performance Data radio button.
3. When the Database Migration Wizard opens, follow the prompts.
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Important
If you are migrating from release 6.x to 8.1, and you enabled the AllowMigratePerformance option in the
WFM Client Application object, the Wizard prompts you to transfer performance data from your 6.x
database to your new WFM database. When you migrate data after you start using the WFM database, all
performance data of the type(s) you select is overwritten by the performance data from the 6.x database.

End of Procedure

</multistep>

Back to Top
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Using the Backup-Restore Utility
Starting in 8.1.3, a beta version of the command-line WFM Backup-Restore Utility (BRU) is included in
the WFM Database Utility (DBU) Installation Package (IP). Unlike the WFM DBU backup file (.MDB
format), which has a maximum 2 Gb file size limit, the BRU uses a new backup file format (.DB) and
has no file size limit. This new backup file format, which is much faster than DBU format, is expected
to replace the current backup file format in future WFM releases. The BRU supports backups for
MSSQL, Oracle, and DB2 databases to the new backup file (.DB) format. The backups created by BRU
are accepted by Genesys Customer Care. However, support for restoring these databases is currently
limited and should not be used in production environments, since BRU is still in the beta stage and
has not been fully tested.

Command Line and Usage Commands

User the following command line and usage commands syntax:

WFMBRU.exe <command> <data source> -FILE <file name>.db [<additional options>]

Table: Usage Commands

Option Description
-BACKUP Backup the WFM database to a backup file.

-RESTORE Restore the WFM database from the backup file
(database is created if it does not exist).

-UPDATE

Update the WFM database to the latest schema
version (can be combined with -RESTORE).
Can also be used to create the latest schema on an
empty database (the database is created if it does
not exist).

-CLEANUP Delete all data in the database.

-DROP
Drop entire database.
Can be combined with the -RESTORE and/or
-UPDATE options.

Table: Data Source (Connection Strings)

Connection string Description

-DSN <OLE DB connection string>
Enables specification of the OLE DB connection
string directly (should not be used with –DB option)
See usage examples in Table: String Format for
Various Databases for details.

-DB <Connection String>
Specifies the connection in simplified syntax that is
later translated into OLE DB connection string
format.
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Table: String Format for Various Databases

Database String format Example
Access "access;<file name>" access;backup.mdb

MSSQL "mssql;<DBMS Name>;<Database
Name>;<User>;<Password>"

mssql;dbhost;
dbname;sa;password

MSSQL (Fast Native Client)
"mssql++;<DBMS
Name>;<Database
Name>;<User>;<Password>"

mssql++;dbhost;
dbname;sa;password

Oracle "oracle;<DBMS
Name>;<User>;<Password>" oracle;ORA11;scott;tiger

DB2 "db2;<DBMS
Name>;<User>;<Password>" db2;DBSERVER;Jason;brody

Important
If you plan to use the MSSQL (Fast Native Client) connection string format (see Table:
String Format for Various Databases), ensure the BRU host is preinstalled with a
version of the MSSQL Native Client that is the same version as the DBMS.

Table: Additional Options

Option Description

-ADMIN <admin user>@<admin password>
Specifies the admin user credentials that might be
necessary for operations, such as creating or
dropping the database.

-SCRIPT <database script file>
Specifies the WFM database script file that is used
to create or update the database schema.
Must be used to create or update the WFM ETL
database.

-SKIP_TABLES <comma-separated list of
tables>

Enables specification of the database tables that
you want to exclude from the backup or restore.
The list must not contain spaces or must be
encapsulated in double quotes.

Examples of Usage Command Lines

Converting an existing Access .mdb backup file to the BRU format:

WFMBRU.exe -BACKUP -DSN "Provider=Microsoft.Jet.OLEDB.4.0;Data Source=<backup>.mdb"
-FILE <backup>.db
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Important
This command does not work with WFMBRU x64, because it requires the x64 Jet driver,
which does not exist. Use the 32-bit version of WFMBRU.exe.

Backup MSSQL database:

WFMBRU.exe -BACKUP -DSN "Provider=SQLOLEDB;Data Source=<DBMS Name>;Initial
Catalog=<Database Name>;User ID=<User Name>;Password=<Password>;" -FILE <backup>.db

Backup Oracle database:

WFMBRU.exe -BACKUP -DSN "Provider=OraOLEDB.Oracle;Data Source=<DBMS Name>;User
ID=<User Name>;Password=<Password>;" -FILE <backup>.db

Important
Use 32-bit WFMBRU.exe if you installed the 32-bit Oracle client on your system or the
64-bit WFMBRU.exe if your Oracle client is 64-bit.

Backup DB2 database:

WFMBRU.exe -BACKUP -DSN "Provider=IBMDADB2;DSN=<DBMS Name>;User ID= <User
Name>;Password=<Password>" -FILE <backup>.db

Restore to MSSQL database:

WFMBRU.exe -RESTORE -DSN "Provider=SQLOLEDB;Data Source=<DBMS Name>;Initial
Catalog=<Database Name>;User ID=<User Name>;Password=<Password>;" -FILE <backup>.db

Retore to MSSQL database using native client: (super fast):

WFMBRU.exe -RESTORE -DSN "Provider=SQLNCLI;Data Source=<DBMS Name>;Initial
Catalog=<Database Name>;User ID=<User Name>;Password=<Password>;" -FILE <backup>.db

Restore and Update to MSSQL database (super fast):

WFMBRU.exe -RESTORE –UPDATE -DSN "Provider=SQLNCLI;Data Source=<DBMS Name>;Initial
Catalog=<Database Name>;User ID=<User Name>;Password=<Password>;" -FILE <backup>.db

Update MSSQL database to the latest schema version only:

WFMBRU.exe –UPDATE -DSN "Provider=SQLNCLI;Data Source=<DBMS Name>;Initial
Catalog=<Database Name>;User ID=<User Name>;Password=<Password>;"
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Using ETL Database Schema
Using a WFM ETL (Extract, Transform and Load) database schema enables Genesys Interaction
Insights and other third-party reporting applications to easily create reports that incorporate Genesys
Workforce Management (WFM) data. Once configured, this functionality can obtain Schedule,
Adherence, and Performance information from WFM and store it into a documented relational
database schema. (Prior to WFM 8.1.3, the only way to build customer reports was to use WFM API.)

ETL Database Schema and Script

WFM itself does not use the data from ETL storage for any task. ETL stores the data into the
designated database schema, for use only by Genesys Interaction Insights or third-party reporting
applications. The ETL schema can co-exist with the main operational WFM database, act as a
standalone database, or be part of any other database. WFM provides the SQL script to create the
database schema, but does not specify which physical tablespace, user, or database on which to
create it.

The script is included in WFM Database Utility (DBU) IP, but is not executed automatically by the DBU.
The database administrator must execute the script, by using a third-party SQL interpreter. The script
is found in the \Scripts folder in WFM Database Utility deployment folder.

Database Tables and Categories
The ETL database schema contains two types of tables: Fact tables and Dimension tables. Dimension
tables somewhat correspond to the WFM organization, configuration, and policy objects. The
Dimension tables provide sorting, grouping, and filtering capabilities for reports. The Fact tables
contain adherence, performance, and schedule information and can be sorted, grouped, and filtered
by dimensions.

The ETL schema contains the following Dimension and Fact tables:

Dimension Tables Schedule Fact Tables
WFM_BU WFM_SCH_AGENT_DAY
WFM_SITE WFM_SCH_AGENT_STATE
WFM_TEAM
WFM_SSG
WFM_STATE

WFM Server's Role in the ETL Process

WFM Server has built-in ETL functionality. However, you must configure some WFM Server
Application options to enable it (see Enabling ETL Functionality).
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In the following two deployment options, you must also create a connection to WFM Server for the
ETL database schema to function properly:

1. If the ETL schema is created in a database, other than the WFM database, two WFM Server instances
are required—one that is connected to the operational WFM database and one connected to the ETL
database. In this setup, the ETL WFM Server instance (with the connection to the ETL database), also
connects to the main WFM Server instance (with the connection to WFM database) and obtains data, by
using the WFM binary API (also used to generate WFM internal reports). This means, a connection to
the main WFM Server must be added to the ETL WFM Server Application. When WFM operational
and ETL schemas share the same database, a single WFM Server instance is sufficient to perform both
functions—serving WFM API requests and performing ETL data storage.

2. If you set up a dedicated WFM Server to perform ETL functions only and the server accesses only the
ETL database and not the operational WFM database, you must disable all cache preload functions,
because the corresponding database tables are not available in the ETL database. The WFM Server IP
contains the WFM Server Application template for a dedicated ETL Server. It will create the ETL
options, set the default values, and disable cache preload functionality and wait list processes. The
dedicated ETL WFM Server generates an error if a reporting client tries to obtain its data, by using the
WFM API.

ETL Process Flow
When the ETL process starts, it synchronizes the WFM operational database with the ETL database.
During synchronization, the process first transfers all new Dimension information the WFM
operational database to the ETL database. Then, updates all of the Dimension objects that were
updated in operational database since the last run of the ETL process. After the Dimension
information is synchronized, the process transfers newly updated or modified Fact information in the
same way. However, the process does not try to synchronize all Fact information, but only a specified
number of days in the past and future. The number of days is specified by setting the configuration
options in the WFM Server Application (see below).

Enabling ETL Functionality

You can configure the ETL database schema, by using the following options, which are configured in
the WFM Server Application, in the ETL section under the Options tab:

• DaysAhead—The number of days (from the current day) to look ahead for Fact data.
• DaysBack—The number of days (from the current day) to look back (to the past) for Fact data.
• DayChunk—The number of days that will be processed at a time.
• ETLTimeout—A non-zero value that starts the ETL process within WFM Server. The number represents

the timeout interval between executions of the ETL process.

For a detailed description of these configuration options, see the ETL Section in WFM Server Options.
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Troubleshooting WFM
In this topic find troubleshooting tips, steps to verify your configuration, and solutions for common
problems. You will find:

• Architectural issues, such as configuration of the WFM components and the connections between them
• Configuration conflicts in WFM that result in forecasting and scheduling errors
• Information about when to use log files for error tracking

Important
After working through the suggestions in this chapter, if your configuration appears to
be correct but WFM still does not function properly, contact Genesys Customer Care
for further assistance.

Click one of these three main troubleshooting topics to learn about the issues or scenarios that might
be helpful to you.

Troubleshooting WFM Components and Connections

Troubleshooting Your WFM Configuration

Using Log Files to Troubleshoot WFM
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Troubleshooting WFM Components and
Connections

Important
Issues addressed in this section can also affect WFM Web functionality such as
forecasting and scheduling. Be sure to review all possible sources of errors during
your troubleshooting process.

To troubleshoot your Workforce Management components and connections, click any of the following
topics to find suggestions for resolutions to specific issues:

• Expired Digital Signature or Security Certificates
• Blank Screen When Attempt to Access WFM Web
• Unable to Connect to Data Source
• Determine the MDAC Version
• DA Server Not Found" Error
• "Host Not Found" Error
• WFM Data Aggregator Does Not Start
• WFM Web Does Not Open
• Applets Do Not Load in WFM Web
• Cannot Log In to WFM Web
• "WFM Server Cannot be Reached" Error
• The Agent Weekly Preference View Does Not Display 24-Hour Graphical Data
• Synchronization with the Configuration Database Takes an Unreasonably Long Time
• Unacceptably Slow Response from WFM Configuration Utility

See Other Troubleshooting Topics

• Troubleshooting Your WFM Configuration
• Using Log Files to Troubleshoot WFM

________________________________________________________________________________________________________
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Expired Digital Signature or Security Certificates

Even if you set up Genesys (or Sun) as a trusted publisher in your browser, you might see one of the
following messages:

The digital signature was generated with a trusted certificate but has expired or is
not yet valid.
The security certificate has expired or is not yet valid.

As a common practice, Genesys renews its certificates once a year. Sun does not provide certificate
renewal for javahelp, so it expired in 2004.

Here is how to respond to that warning message:

• During your first access of WFM Web, check the always trust option in both warning messages. This will
mark certificates as trusted and the user will not see these warnings again.

• Import the certificates to the Java plug-in manually for each new user. Certificates for import could be
exported from any workstation where WFM Web has been already accessed and certificates where
confirmed with the always trust option check.

An applet that is signed with a certificate that has expired is still safe to download or use, but only if
the applet was signed when the certificate that was issued by the Certificate Authority (CA) was still
valid. If it was, then according to the specification for signing Java applets, the applet is valid. Also,
according to the specification, it is the responsibility of the JVM to warn the user if an applet has been
modified after it was digitally signed with a certificate issued by a CA.

As long as the JVM does not return an error stating that the applet has been modified since it was
signed, the applet is still valid and safe to run.

Back to Top

Blank Screen When Attempt to Access WFM Web

If you are using Tomcat and this issue occurs, it might be because you only have the Java Runtime
Environment (JRE) installed and not Sun’s Java Developers Kit (JDK) software. Tomcat 5.0.x requires
the JDK. If you look at the Tomcat logs, you will see an error saying that java compiler was not found.
If you don’t want to install the JDK, then the other option is to use Tomcat 5.5.x, which only requires
the JRE.

Back to Top

Unable to Connect to Data Source

If you cannot connect to your database, verify the following:

• That the correct versions of Microsoft Data Access Components (MDAC) and Jet are installed on your
computer. See Determine the MDAC Version.
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• You have added the Database Access Point (DAP) on the Connections tab of the Application object of the
component you are using.

• You have configured the DAP correctly.
• Your database is set to be case insensitive.

Back to Top

Determine the MDAC Version

Microsoft supplies a free diagnostic program, MDAC Configuration Checker, that scans your computer
to determine whether or not you are running the correct version of MDAC. You can download the
program from the Microsoft web site. See Supported Operating Environment Reference Manual for
the current MDAC requirements.

Back to Top

"DA Server Not Found" Error

Data Aggregator is not running. Start it manually, under Windows Services.

Back to Top

"Host Not Found" Error

The host names you configure in Configuration Manager are case sensitive and must be lowercase.

• Rename the host and try the procedure again.

Back to Top

WFM Data Aggregator Does Not Start

When WFM Data Aggregator is running as a Windows Service on a host computer and the host is shut
down and restarted, Data Aggregator leaves an open connection to Configuration Server. This causes
Data Aggregator to fail to start after rebooting. In particular, Service Manager indicates a status of
Starting for the WFM Data Aggregator service for a long time after you try to start it.

In this situation, use the Closing an Incorrect Connection Between Data Aggregator and Configuration
Server to restart WFM Data Aggregator.

Back to Top

Troubleshooting WFM Troubleshooting WFM Components and Connections

Workforce Management Administrator's Guide 255

https://docs.genesys.com/Documentation/System/Current/SOE/Welcome


WFM Web Does Not Open

Pop-up blockers interfere with WFM Web for Supervisors operation. If you are running a pop-up
blocker on your computer, disable it before trying to open WFM Web for Supervisors.

Back to Top

Applets Do Not Load in WFM Web

WFM Web uses Java Server Pages (JSPs) to create its dynamic web pages. To use WFM Web, your
browser must have Java support. If the necessary plug-in was not installed with the browser, you can
download the plug-in from www.oracle.com. To learn which version of Java is required, consult the
WFM section at the end of the “Product Prerequisites” table in the Supported Operating Environment
Reference Manual.

On Supervisors’ workstations, WFM Web uses Java applets that are run by Sun’s Java Plug-in. On
Windows operating systems the Java Plug-in is running as ActiveX, which means that supervisors
must have rights to run ActiveX controls.

Back to Top

Cannot Log In to WFM Web

The ConfigServer.properties file might be configured incorrectly. This could happen if you installed
WFM Web without being connected to Configuration Server or if you manually entered incorrect
values when you were configuring the WFM Web Application object.

In this situation, correct the configuration by completing the Correcting the ConfigServer.properties
File.

Back to Top

"WFM Server Cannot be Reached" Error

There are two different issues that might be responsible for this error message. If you receive this
message sporadically, you might have too few TCP sockets (see Scenario 1). If it occurs every time
you open WFM Web, it is probably because it is not correctly configuration (see Scenario 2).

Scenario 1
This error message may occur because there are too few TCP sockets for the number of WFM Web for
Supervisors connections you are trying to establish. To improve performance:

• Install WFM Web on a separate computer.
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• Increase the refresh rate from the default value (2 seconds) to 5 seconds. This should increase the
number of supervisors that are able to simultaneously access the Adherence views by approximately
100 percent.

Scenario 2
You might have specified the wrong application type when you installed WFM Web. If so, uninstall and
reinstall WFM Web, entering the correct values in the Installation Wizard screens.

• If you are running WFM in a Framework 6.x environment, the WFM Web application type must be
ThirdPartyServer.

• If you are running in a 7.x environment, the application type should be WFM Web.

Back to Top

The Agent Weekly Preference View Does Not Display 24-Hour
Graphical Data

Important
This resolution applies to UNIX environments only.

If your Unix server does not have an X Server installed or you have not set the DISPLAY environment
variable, the WFM Web Agent Weekly Preferences window is presented without 24-hour graphical
information.

For non-Windows environments (such as Unix and Linux), you must have X or some form of X (X11
Server or X Windows server) running and point the DISPLAY environment variable to the machine
running X.

Back to Top

Synchronization with the Configuration Database Takes an
Unreasonably Long Time

If you are using Microsoft SQL, to reduce synchronization time, make sure that the database
AutoShrink feature is turned on.

Back to Top
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Unacceptably Slow Response from WFM Configuration Utility

If your WFM Configuration Utility is not located on the same LAN as the WFM Database, you might
see very long response times when the WFM Configuration Utility updates database information.

If you experience this issue, Genesys recommends that you deploy the WFM Configuration Utility over
Citrix or Windows Terminal Services.

This issue should not affect users on the same LAN as the WFM Database.

Back to Top

Procedures

Click the red arrow to view a list of procedures related to the topics on this page. <multistep>

|-| Closing an Incorrect Connection Between Data Aggregator and Configuration Server=

Purpose: To enable WFM Data Aggregator to restart

Start of Procedure

1. In Configuration Manager, rename the WFM Data Aggregator Application object, and then click OK to
close the Properties window.

2. Reopen the Properties window and change the Application object name back to the original and then
click OK again. Doing this clears the connection.

End of Procedure
After this, WFM Data Aggregator should immediately connect to Configuration Server. To prevent this
issue from happening again, before shutting down and/or rebooting the host computer, use the
Services window to stop the WFM Data Aggregator Service.

If WFM Data Aggregator fails to start, it writes a message to the daerror.log file, which is located in
the WFM Data Aggregator working directory. Use this log file to diagnose the issue that is preventing
WFM Data Aggregator from starting correctly.

|-| Correcting the ConfigServer.properties File=

Purpose: To correctly configure the ConfigServer.properties file.

Start of Procedure

1. Remove the incorrectly configured application from the servlet runner.
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2. Reinstall WFM Web, providing correct values during the installation.
3. Deploy the newly installed application.
4. If reinstalling WFM Web does not resolve the issue, check that you have entered the correct URL for

WFM Web, remembering these points:
• The URL is case sensitive.
• Do not include login.asp or login.jsp in the URL. The URL should simply point to the application

virtual directory.

End of Procedure
Back to Topic
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Troubleshooting Your WFM Configuration
To troubleshoot your Workforce Management configuration, click any of the following topics to find
suggestions for resolutions to specific issues:

• Inaccurate Actual Headcount for Multi-Site Activities and Activity Groups
• Performance Shows No Intra-Day Statistics
• Headings Do Not Match Columns in Exported Reports
• Real-Time Agent Adherence Is Not Working Correctly
• Agents Are Not Being Scheduled
• Calculation of Average Handling Time Based on TotalTime Statistics
• Cannot Find Agents or Sites
• Errors or Warnings When Creating a Schedule
• Data on Active Interactions Disappears
• Forecast Appears Inaccurate
• Schedules Are Highly Over- or Understaffed
• WFM Configuration Utility Error Messages

See Other Troubleshooting Topics

• Troubleshooting WFM Components and Connections
• Using Log Files to Troubleshoot WFM

_____________________________________________________________________________________________________

Inaccurate Actual Headcount for Multi-Site Activities and Activity
Groups

In WFM 8.1, the Performance subsystem, Daily Average Actual Headcount algorithm for Multi-Site
Activities (MSA), Activity Group (AG), and Site Activities differs from the algorithm used in 8.0 and
prior releases.

Function of the Algorithm
In prior releases, the Actual Headcount algorithm for MSA and AG levels tended to produce inaccurate
Actual Headcount in configurations that included multi-skilled agents, or schedules and MSA or AG
configured for more than one Associated Activity from the same site.
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This issue is resolved by using the new algorithm introduced in 8.1, that produces accurate Actual
Headcount for MSA and Activity Groups. It includes the following important changes to the Actual
Headcount timestep and Daily Average algorithms:

1. Dedicated for MSA and AG levels, Data Aggregator aggregates the Actual Headcount separate from the
Associated Activities Actual Headcount.

2. MSA level Daily Average Actual Headcount algorithm takes into account the MSA and Associated
Activities open hours.

3. Site Activity level Average Actual Headcount algorithm takes into account the Activity open hours.
4. Agent Minutes (<agent adherent minutes> divided by 15) Headcount algorithm is used instead of

LoggedIn Agents Headcount.

Example: If 1 agent is logged in (adherent), but works only 14 minutes per-timestep, the Actual
Headcount in Agent Minutes equals 14/15 = 0.93.

Calculations Model for Multi-Site Activities Level
In the WFM Performance subsystem, Multi-Site Activity (MSA) Actual Headcount Daily Average is
calculated in the following ways, depending on the state of the Multi-Site Activities button:

When the Use Multi-Site Activities button is set to ON:

• The Actual Headcount Daily Average is calculated by using MSA open hours and MSA per-timestep
Actual Headcount data.

• If any timesteps outside MSA open hours contain non-zero values, WFM includes the values for these
timesteps in the Actual Headcount Daily Average calculations.

• The Actual Headcount is calculated by using the Agents Minutes algorithm (see item 4 above).

When the Use Multi-Site Activities button is set to OFF:

• The Actual Headcount Daily Average is calculated, by using the Associated Activities open hours and the
sum of the Associated Activities per-timestep Actual Headcount data.

• If any timesteps outside the Associated Activities open hours contain non-zero values, WFM includes the
values for these timesteps in the Multi-Site Activity Actual Headcount Daily Average calculations.

• The Actual Headcount is calculated, by using the Agents Minutes algorithm (see item 4 above).

Calculations for Activity Group Level
In the WFM Performance subsystem, Activity Group Actual Headcount Daily Average is calculated in
the following way:

• The Actual Headcount Daily Average is calculated, by using the Associated Activities Actual Headcount
data per-timestep for entire day.

• The Actual Headcount is calculated by using the Agents Minutes algorithm (see item 4 above).
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Calculations for Site Activity Level
In the WFM Performance subsystem, Site Activity Actual Headcount Daily Average is calculated in the
following way:

• The Actual Headcount Daily Average is calculated, by using Activity open hours and the Activity per-
timestep Actual Headcount data.

• If any timesteps outside of the Activity open hours contain non-zero values, WFM includes the values for
these timesteps in the Activity Actual Headcount Daily Average algorithms.

• The Actual Headcount is calculated by using the Agents Minutes algorithm (see item 4 in Overview).

Important
In releases prior to 8.1, open hours were not taken into account for MSA and Site
Activities Daily Average algorithms. WFM used the Associated Activities Actual
Headcount data from timesteps for the entire day for Multi-Site Activity Actual
Headcount Daily Average algorithms, whether the Use Multi-Site Activities button was
set to ON or OFF.

Performance Reports
Performance reports (by default) show the Actual Headcount, based on the LoggedIn Agents that are
collected by Data Aggregator, while Performance Intra-Day displays the Actual Headcount, based on
Agents Minutes (see item 4 above).

To change the Performance reports Actual Headcount calculation to Agent Minutes (to match
Performance Intra-Day calculation), the WFM Web Application option ShowActualHeadcount in the
Reports section must be set to true.

Back to Top

Performance Shows No Intra-Day Statistics

If the WFM Web Performance subsystem does not display statistics for Interaction Volume, Average
Handling Time, Service Level, and other key Intra-Day statistics, verify that:

• WFM Data Aggregator has initialized successfully; has made successful connections to Configuration
Server, Stat Server, and the WFM database; and has been running for 30 minutes.

• A schedule has been published for the current time interval.
• The correct Stat Server name appears in the Site Properties window in the Configuration >

Organization module of the WFM Configuration Utility.
• The necessary statistics are configured in the Statistics window in the Configuration > Activities

module of the WFM Configuration Utility.
• Time zones are configured correctly for the business unit or site.
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• The statistics are monitoring the correct Genesys objects, such as queues, routing points, and so on.
• The TimeProfile parameter is correctly configured in Stat Server.

Headings Do Not Match Columns in Exported Reports

When you export the reports, select the MS Excel Tabular option.

Back to Top

Real-Time Agent Adherence Is Not Working Correctly

If the Real-Time Agent Adherence window is empty, then verify that:

• A schedule has been published for the current time interval.
• You have associated the correct WFM Data Aggregator name with the site that contains the agents you

are looking at in the WFM Configuration Utility.
• You have configured a connection to the appropriate Stat Server in the WFM Data Aggregator

Application object.
• Your WFM Data Aggregator Application object specifies a connection to your WFM Server on the

Connections tab.
• T-Server, Stat Server, and WFM Data Aggregator are running properly.
• Stat Server is configured to connect to the appropriate T-Server.

Important
If there are no agent names visible in the Real-Time Agent Adherence window,
publish a schedule for the current day.

Agents Are Not Being Scheduled

Verify that:

• The agents’ hire dates are not the same as the current date and come before the start of the schedule
period.

• The agents are associated with a Contract that can be scheduled.
• The agents’ Contract is not associated with shifts that are incorrectly configured, preventing the agents

who is in that Contract from being given any shifts.
• The agents have skills configured.
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• The agents have skills that qualify for at least one of the activities you are scheduling.

Calculation of Average Handling Time Based on TotalTime
Statistics

Average Handling Time (AHT) is calculated by taking the total duration of all interactions that are
completed during a timestep, divided by the total number of interactions handled during that
timestep.

In cases where Total Handle Time is collected for an interval, but no interactions have been handled
in that interval, WFM can optionally associate the Handle Time with the previous interval. To enable
this feature, use the HandleTimeWriteBack configuration option. See the Options Section in WFM
Data Aggregator Options.

Back to Top

Cannot Find Agents or Sites

Verify that:

• WFM is synchronized with Configuration Manager.
• The WFM user experiencing this issue has permission to view the site, agents, and logins for the missing

sites and/or agents.

Errors or Warnings When Creating a Schedule

In most cases, when schedule results are not as expected, a configuration error is the cause. With a
valid configuration, you rarely see errors.

If the configuration settings lead to a disparity between the staffing requirements and the actual
schedule, the Schedule Validation window records the problems. Sometimes it indicates which
parameters you must change to correct the disparity.

When schedule validation warnings appear, it is essential to begin narrowing down the scope of the
scheduling problem by isolating a single agent, team, contract, shift, or other object until the
problematic configuration point is identified and resolved. The most frequent causes of schedule
errors and warnings include:

• Incompatibility between day-off constraints and constraints set for weekly hours or schedule planning
period hours.

• Incorrectly configured meal and shifts constraints.
• Exceptions inconsistent with contract or rotating pattern constraints.
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If you are unsure how to troubleshoot the schedule results or are reluctant to change WFM
configuration data, contact Genesys Customer Care.

Data on Active Interactions Disappears

If you close WFM Data Aggregator using the Windows NT Task Manager, you will lose all data on
currently active interactions, because Windows NT does not allow enough time for WFM Data
Aggregator to save the active data.

Back to Top

Forecast Appears Inaccurate

Verify that:

• The statistics being used to collect data for each activity are appropriate.
• The Genesys objects (queues, routing points, and so on) used to monitor statistics are appropriate.
• The Genesys objects are not combining data for interactions that should be associated with different

activities. For example, if multiple interaction types are coming through a single routing point, then
attached data must be used to filter statistics by interaction type.

• There is no historical data with null values in the WFM historical data table
wm_perf_activities.wm_callvol. You can verify this by exporting the historical data to a local file
using the WFM Configuration Utility.

• You have a sufficient quantity of historical data for the forecasting method you are using. The Expert
Average Engine requires one full week of historical data and the Universal Modeling Engine requires at
least one year of historical data.

Schedules Are Highly Over- or Understaffed

Verify that:

• The schedule was built after a forecast was published.
• There is sufficient flexibility in the working hours constraints for the agents’ weekly and schedule-

planning periods, configured in the Contracts module.
• There is sufficient flexibility in the working days constraints.
• There is sufficient flexibility in the weekend day-off rules for the schedule-planning period.
• The agents’ contract availability is flexible enough to cover the open hours for the desired activities.
• Team constraints are not enabled or are configured with enough flexibility to adequately cover the

entire day’s interaction volumes.
• All shifts have valid configurations.
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• All scheduled agents have received the correct number of weekly and/or schedule-planning period
hours. If they haven’t, this indicates a configuration error.

Back to Top

WFM Configuration Utility Error Messages

• Database Access Point is not found!

Verify that your DAP is selected on the Connections tab of the WFM Configuration Utility Application
object.

• Too many Database Access Points are specified!

Verify that only one DAP is selected on the Connections tab of the WFM Configuration Utility
Application object.

• Server does not exist or access denied.

Verify that the correct database server name is entered in the DBMS Name field of the DAP
Application object’s DB Info section.

• Could not resolve service name.

Verify that the correct database server type is selected in the DBMS Type field of the DAP Application
object’s DB Info section.

• Cannot open database requested in login <database name>. Login fails.

Verify that the correct database name is entered in the Database Name field of the DAP Application
object’s DB Info section.

• Login failed for user <user name>.

Verify that the correct user name is entered in the User Name field of the DAP Application object’s DB
Info section.

Back to Top
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Using Log Files to Troubleshoot WFM
Workforce Management log files are intended to be used for diagnosis of configuration and program
errors. They should not be used in normal day-to-day operation because they slow WFM performance.

If you contact Genesys Customer Care for assistance with WFM, you might be instructed to turn on
logging and attempt to re-create the problem. The logs can provide Technical Support with important
information on the nature of the malfunction.

Each component of WFM uses its own log file. For information on configuring logs, see the Log option
information for each component’s Options tab.

By default, the WFM log files are stored in \\<Workforce Management directory>\Logs.

You can view WFM log files with any ASCII viewer, such as Notepad.

If WFM Data Aggregator fails to start, it writes a message to the daerror.log file, which is located in
the WFM Data Aggregator working directory. Use this log file to diagnose the problem that prevented
WFM Data Aggregator from starting correctly.

See Other Troubleshooting Topics

• Troubleshooting WFM Components and Connections
• Troubleshooting Your WFM Configuration
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WFM Localization
Genesys localizes (translates) Workforce Management (WFM) into a number of languages. You can
localize WFM 8.1 components by using Genesys localization software or by using the self-localization
method.

If Genesys localizes into your language, you can use the Genesys-provided localization software to
localize WFM Daemon, Server, Builder, Data Aggregator, and Web. Otherwise, you can use the self-
localization method to localize WFM Web Supervisor and Agent. Contact your Genesys sales
representative to inquire about specific localized versions.

The two methods of localization are described in detail in the following topics.

Using Genesys Localization Software

Using Self-Localization

Legal Notice:
Customer-enabled language translation functionality is provided on an as-is basis for internal use
only. Outside distribution of this functionality and/or any translation(s) created using such
functionality is not permitted except under a separate agreement negotiated with Genesys
specifically for the purpose of distributing Genesys-related translations.

Partners who intend to redistribute translated versions must first sign the GENESYS PARTICIPANT
ENABLED LANGUAGE TRANSLATION AGREEMENT consistent with the "Participant Enabled Language
Translation Distribution License".

Important
This does not imply or ensure that all preferred elements of localization within the
product for any possible locale are done. For example, right to left mirroring (Arabic)
or vertical text presentation (some Chinese).
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Using Genesys Localization Software
This topic describes how to localize WFM 8.1.1 and later, by using the Genesys localization software.
If you are deploying WFM and want to localize it, contact a Genesys representative to obtain localized
software.

This topic includes the following sections:

• User and System Locales on Windows
• Preparing WFM for Genesys Localization
• Installing the Language Packs

Starting in release 8.1.1, WFM uses Language Packs (LP) to provide localized resources for the end
user. The Language Pack is a separate IP, which is installed over the component IP. It contains only
localized resources, which replace the resources in the original product IP. The Language Pack
contains resources for a single language, so every language requires a separate LP. If you are
installing more than one LP, you must install them one at a time. Only one Language Pack can be
used over one component IP at one time.

WFM has LPs for the following components:

• WFM Web
• WFM Daemon
• WFM Server
• WFM Data Aggregator
• WFM Builder

WFM Configuration Utility does not have an LP. It requires the full localized product IP to be deployed,
just as it did prior to release 8.1.1.

Context Information in Localization Kits
WFM localization kits now include context information. The kits contain resources for translation that
appear in the product. The information about how the resource is used by the product, can be used to
improve translation. In addition, context information simplifies verification testing, enabling the tester
to easily find and check the effects of translated content.

Back to Top

User and System Locales on Windows

The WFM server (Server, Builder, and Data Aggregator) services choose the installed Language Pack
according to the locale. It uses the exact language match or, if it is unavailable, the Language Pack
for the same language group.
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WFM servers checks the user or system account locale of the operating system on which it is running.
By default it is either the user account (Windows 2003) or system account (Windows 2008). To adjust
the user and system account settings, see the procedures Adjusting the System Account Locale
(Windows 2008), Adjusting the User Account Locale (Windows 2003), and Verifying the Locale in the
Windows Registry.

After checking the locale, WFM servers attempt to load a Language Pack whose language (or
language group) matches this locale. For example, if the user account locale or system account locale
is French (Canada) and the French (Canada) Language Pack is not installed, then the French (France)
Language Pack is used. If the process is run as a service (which is usually the case), then the system
account locale must be adjusted.

Important Information About Changing Locales on Windows with Java
Applications Installed
An incompatibility was detected when WFM Web and Daemon applications are running on Windows
operating systems with Java 7 relating to the rules that govern locale settings. (See article #4700857
on the vendor website www.oracle.com.)

Changes to the WFM local settings are made in different locations, depending which Java version you
are using. In Java 7, the Display language settings determine the locale settings. In Java 6, the
Regional Settings dialog in Control Panel determine the locale settings.

Also, if you are installing WFM on Windows versions earlier than Windows Vista—for example,
Windows 2003 or Windows XP—you cannot set the display language, because the these OSs always
use the language that is selected during installation meaning, the local settings cannot be changed.

You can use one of two workarounds to set a different locale setting for WFM applications:

1. Select the appropriate display language that contains the locale settings you want to use.
2. If step 1 cannot be done, complete one or both of following steps:

1. Revert Java 7 to Java 6 behavior—Set the -Dsun.locale.formatasdefault Java 7 option to true
and then, set the locale settings in the Regional Settings in Control Panel to the locale you want to
use.

2. On any version of Java—Explicitly override the locale setting for the JVM by changing the
-Duser.language, -Duser.region, -Duser.country Java options.

Back to Top

Preparing WFM for Genesys Localization

The following information and links to procedures will help you to prepare WFM for localization.
Complete all of these procedures or only the ones that are required to complete your WFM
localization.
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Task Summary: Preparing WFM for Genesys Localization

Task Procedures

Adjust and verify the system account locale.
• Adjusting the System Account Locale in

(Windows 2008)
• Verifying the Locale for the System Account

Adjust the user account locale. Adjusting the User Account Locale (Windows 2003)
Change the date format in WFM e-mail
notifications. Changing the Date Format in E–mail Notifications

Adjust WFM Web to display the weekday in the
correct language.

Adjusting WFM Web to Display Weekday in the
Correct Language

Read about how to prepare the Web interfaces. Preparing the WFM Web Interfaces

Configure the date/time format and your language
preference in the WFM Web interfaces.

• Changing the Preferred Language Settings in
the Web Browser

• Changing the Date and Time Format in the Web
Agent Interface (Solaris)

• Overriding the User Account Locale (Windows
• Overriding the User Account Locale (Solaris)

Important
After you have completed the procedures in the Task Summary: Preparing WFM for
Genesys Localization (above), complete the procedures in Installing the WFM
Language Packs.

Back to Top

Installing the Language Packs

Click the red arrow to view simple procedures that will help you to install the Language Packs for
each of the WFM components. Complete all of the procedures to localize your WFM deployment.
<multistep>

|-| Installing the Web Language Pack=

Purpose: To localize WFM Web by installing the Web Language Pack.

Prerequisite: The WFM Web IP is installed on the host.
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Start of Procedure

1. Start the Web Language Pack IP for the language you are installing and follow the steps in the
Installation Wizard.

2. If WFM Web is already deployed in the servlet container, undeploy it using the servlet container-specific
instructions.

Important
You must undeploy WFM Web from the servlet container, but do not uninstall it
from system.

3. Deploy the WFM Web wfm.war file that was updated by the Language Pack IP, by using the servlet
container specific instructions.

WFM Web uses localized resources from the Language Pack.

End of Procedure

|-| Installing the Daemon Language Pack=

Purpose: To localize WFM Daemon by installing the Daemon Language Pack.

Prerequisite: The WFM Daemon IP is installed on the host.

Start of Procedure

1. Stop the WFM Daemon process.
2. Start the WFM Daemon Language Pack IP for the language you are installing and follow the steps in the

Installation Wizard.
3. Start the WFM Daemon process.

The WFM Daemon uses localized resources from the Language Pack.

End of Procedure

|-| Installing the Server, Builder, and Data Aggregator Language Pack=

Purpose: To localize WFM Server, Builder, or Data Aggregator by installing the associated Language
Pack.

Prerequisites:

• The WFM Server, Builder, or Data Aggregator IP is installed on the host.
• The user account locale is adjusted to match the Language Pack that is being installed. See Adjusting
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the User Account Locale (Windows 2003) or Adjusting the System Account Locale (Windows 2008).

Start of Procedure

1. Stop the WFM Server, Builder, or Data Aggregator process.
2. Start the WFM Server, Builder, or Data Aggregator Language Pack IP for the language you are installing

and follow the steps in the Installation Wizard.
3. Start the WFM Server, Builder, or Data Aggregator process.

End of Procedure

</multistep>

Back to Top
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Preparing for Genesys Localization

Important
After you have completed these procedures, go to Installing the Language Packs.

<multistep>

|-| Adjusting the System Account Locale (Windows 2008)=

Purpose: To adjust the system account locale on the WFM server (Server, Builder, and Data
Aggregator) to match the language in a specific Language Pack.

Important
Before you install any WFM Language Pack, complete the procedures below on the
Windows 2008 host.

Start of Procedure

1. On the host, go to Control Panel > Regional and Language Options.
2. On the Formats tab, in the Formats section, select the language/region that matches the Language

Pack you will be installing later and click Apply. (See figure below.)
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Formats—Region and Language Settings (Windows 2008)

3. On the Administrative tab, click Copy Settings.... (See figure below.)
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Administrative—Region and Language Settings (Windows 2008)

4. In the Copy your current settings to: section, check the Welcome screen and system accounts
checkbox. (See figure below.)

File:WM 812 Welcome RegSettings locale2008.png
Welcome—Region and Language Settings (Windows 2008)

5. To save the settings, click OK and/or Apply on each tab before closing.
6. Reboot the system.

End of Procedure

Next Steps:

• Complete the Verifying the System Account Locale in the Windows Registry to verify that the correct
locale is configured for the local system account.
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|-| Verifying the System Account Locale in the Windows Registry=

Purpose: To adjust the user account locale on the WFM server (Server, Builder, and Data
Aggregator) to match the language in a specific Language Pack.

Prerequisite:

• The system account locale or user account locale is adjusted to match the language in the installed LP.
See the Procedure: Adjusting the System Account Locale (Windows 2008) or Adjusting the User Account
Locale (Windows 2003).

Start of Procedure

1. On the WFM server (Server, Builder, and Data Aggregator), in the Windows Registry Editor, open the
following hive: HKEY_USERS\.DEFAULT\Control Panel\International

2. Check the following locale-related keys (see figure below):

• Locale

• sCountry

• sLanguage

Tip
To interpret any specific locale ID, see the Microsoft article, "Locale IDs Assigned by
Microsoft".
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Verify Locale in the Windows Registry

• Save and close the registry.

End of Procedure

|-| Adjusting the User Account Locale (Windows 2003)=

Purpose: To adjust the user account locale on the WFM server (Server, Builder, and Data
Aggregator) to match the language in a specific Language Pack.

Important
Before you install any WFM Language Pack, complete the procedures below on the
Windows 2003 host.

Start of Procedure

1. On the host, go to Control Panel > Regional and Language Options.
2. On the Regional Options tab, in the Standards and formats section, select the language/region that

matches the Language Pack you will be installing later. (See figure below.)
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Regional Options—Region and Language Settings (Windows 2003)

3. On the Advanced tab, copy the regional settings to the local system or default account, by adding a
check mark to the Default user account settings checkbox. (See figure below.)
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Advanced—Region and Language Settings (Windows 2003)

4. To save the settings, click Apply and/or OK.
5. Reboot the system.

End of Procedure

|-| Changing the Date Format in E–mail Notifications=

The WFM Daemon service, which uses the operating system account locale to provide the date
format, dictates the format for WFM e-mail notifications. By default, WFM Daemon is installed under
the system account and therefore, it uses the system user (or default user) locale. You can change
the date format in e-mail notification sent by WFM Daemon by changing the locale settings for the
system user account and set the language (country) to match the desired date format.

If changing the system account locale is not an option (for example, if other services are using the
locale settings), you can instruct WFM Daemon to override the service user account locale settings.
See the procedure below.

Purpose: To change the date format in e-mail notifications by overriding the WFM Daemon service
user account locale settings.
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Start of Procedure

1. Verify the WFM Daemon service name. (By default, it is WFMDaemon.)
2. Stop the WFM Daemon service.
3. Open the Windows Registry Editor and navigate to the following registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Apache Software Foundation\Procrun2.0\<WFM Daemon service
name>\Parameters\Java
Where: <WFM Daemon service name> is the name of the WFM Daemon service. For example, the
default key path is:
HKEY_LOCAL_MACHINE\SOFTWARE\Apache Software Foundation\Procrun2.0\WFMDaemon\
Parameters\Java

4. Open the Option value and add the Java language, region, and country options using the following
syntax (see Figure below):
• -Duser.language=fr

• -Duser.region=CA

• -Duser.country=CA

Windows Registry Editor—Changing the Date/Time Format

5. Press Enter to add a new line.
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Important
You must add a new line after the last option, otherwise the option is not parsed.

6. Click OK to apply the changes, and close the Registry Editor.
7. Start the WFM Daemon process and check the e-mail notifications date format.

End of Procedure

|-| Adjusting WFM Web to Display Weekday in the Correct Language=

To correctly display the weekday in certain language character sets, you must modify a configuration
option in the WFM Web Application.

Purpose: To configure the WFM Web Application to display the weekday in in certain language
character sets (or in the correct language you prefer).

Start of Procedure

1. In the WFM Web Application properties, click the Options tab.
2. In the Options section, select the PageCharSet option and set the value to the code page that specifies

the language you want to use. For example, to correctly display the weekday in the French language,
the set the option value as follows: PageCharSet = windows-1252

End of Procedure

</multistep>
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Preparing the WFM Web Interfaces
Sometimes the date and time format in the WFM Web Applications have a different format than the
required company standard. This section contains information about the date and time formats and
includes procedures that describes how to change the format in each WFM Web Interface. See the
following topics:

• Web Supervisor
• Web Agent
• Web Reports

Generally, date and time format in the Web Applications are determined by the operating system’s
locale settings. For example, the Language (Country) locale is read from the operating system and
the Java Runtime Environment (JRE) sets the appropriate date and time format accordingly. However,
some WFM Web Application interface date and time formats are determined by locale settings on
other hosts.

Important
The JRE does not take into consideration any custom formatting on the Windows
platform. It simply reads the Language (Country) format from the locale settings and
sets date and time format accordingly. For example, if the date and time format is
English (Canada), the time format is always AM/PM whether the Windows settings
have been customized or not, because that is the default for this country.

Therefore, to use the 24h time format in the WFM Web Applications, you must select the relevant
language (country) for which the 24h format is the default. For the English language, it could be
either English (United Kingdom) or English (Ireland).

The date and time format for each of the three WFM Web Application interfaces—Supervisor, Agent,
and Reports—is determined by the language preference that is configured in the browser that is
being used.

Web Supervisor

The WFM Web Supervisor interface date and time format is determined by the language preference
that is configured in the browser that is being used. This enables each supervisor to choose the date
and time format for their own workstation. See Changing the Preferred Language Settings in the Web
Browser.

To configure the date and time format for WFM Web Supervisor on a Windows host, complete Steps 1
and 2 in the Adjusting the User Account Locale (Windows 2003).
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Web Agent

The WFM Web Agent interface date and time format is determined by the Web Server host and
Server service user account locale. This enables a unified Web Agent view of the date and time
format for all agents.

There are two ways to change the date and time format in the WFM Web Agent interface:

1. Change Web Server (Tomcat) service operating system user account locale. By default, the Tomcat
service is installed under the Local System account (or default account) like most of the services.

• To change the date and time format in the Web Agent interface on Windows, see in the Adjusting the
System Account Locale (Windows 2008) or Adjusting the User Account Locale (Windows 2003).

• To change the date and time format in the Web Agent interface on Solaris, see the Changing the Date
and Time Format in the WFM Web Agent Interface (Solaris).

• Set Tomcat JVM locale options to override operating system user account locale. If, for any reason, you
cannot change the locale settings for the System Local account to change the Java date and time format,
you can override the locale settings for only the Tomcat environment, by using the -Duser.language and
-Duser.country Java options

• To configure these options on Windows, see the Overriding the User Account Locale by Setting the
Tomcat JVM Locale Options (Windows).

• To configure these options on Solaris, see the Overriding the User Account Locale by Setting the Tomcat
JVM Locale Options (Solaris).

Web Reports

The WFM Web Reports date and time format is determined by the Web Server host or Web Server
service user account locale that is executing Reports. If there is one WFM Web instance or several
Web instances, without a dedicated WFM Web for the Reports instance, the date and time format is
taken from the Web Server host that is hosting WFM Web. If there is a dedicated WFM Web for the
Reports instance, the Reports date and time format is obtained from the Web Server host for the
Reports or Web Server service user account locale.

To change the date and time format for Reports, complete the same procedures as those used for
WFM Web Agent on the WFM Web for Reports host or Tomcat instance. See Web Agent. If it is the
same instance as WFM Web Agent, the settings will affect both the Web Agent and Web Reports date
and time formats.

<multistep>

|-| Changing the Preferred Language Settings in the Web Browser=

Purpose: To change the preferred language settings in the web browser.
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Tip
This procedure describes the steps to change the language settings in Internet
Explorer. However, language preference settings might be in different locations for
each vendor’s browser (for example, FireFox or Chrome), and even different versions
of the browser. For information about how to change the settings in the browser you
are using, Genesys recommends you check the vendor’s web site or Help.

Start of Procedure

1. In Internet Explorer, go to Tools > Internet Options.
2. In the Internet Options dialog, on the General tab click Languages.
3. In the Language Preferences dialog, click Add.
4. In the Add Language dialog, select the language you want to use and click OK.

Important
Ensure the language you select is the first language in the list. If there is more
than one language in the list, highlight your selection and then click Move Up until
your language preference is at the top of the list.

5. Click OK twice to save the settings and close the Internet Options dialog.

End of Procedure

|-| Changing the Date and Time Format in the Web Agent Interface (Solaris)=

Purpose: To change the date and time format in the Web Agent interface to match the LP language.

Summary: In Solaris, the Java Virtual Machine (JVM) obtains the default locale from the current user
environment.

Start of Procedure

1. Type locale at the command prompt to determine the current locale setting.
2. Set the LANG environment variable to set the change locale parameter. For example: :> export

LANG=en_GB

3. To verify that the locale is changed, type locale at the command prompt again. The following output is
displayed:
:>locale
LANG=en_GB
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LC_CTYPE="en_GB"
LC_NUMERIC="en_GB"
LC_TIME="en_GB"
LC_COLLATE="en_GB"
LC_MONETARY="en_GB"
LC_MESSAGES="en_GB"
LC_ALL=

4. Restart Tomcat.

End of Procedure

For more information about Solaris locale values and how to change them, see the Sun Solaris
documentation on the vendor web site.

|-| Overriding the User Account Locale (Windows)=

Purpose: To override the user account locale by using Tomcat JVM locale options on Windows.

Start of Procedure

1. Open the Apache Tomcat Properties window.
2. Select the Java tab.
3. To set the locale settings for the Tomcat JVM, in the Java Options text box, add the -Duser.language

and -Duser.country (or -Duser.region) options. See the examples and figure below.

Examples:

• To have English weekday names and UK date format dd/mm/yy @HH:MM, add:
• -Duser.language=en

• -Duser.region=GB

• -Duser.country=GB

• To have English weekday names and US date format mm/dd/yy @hh:mm AM/PM, add:
• -Duser.language=en

• -Duser.region=US

• -Duser.country=US

• To have French weekday names and CA date format yy-mm-dd @HH:MM, add:
• -Duser.language=fr

• -Duser.region=CA

• -Duser.country=CA
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Figure: Java Options—Apache Tomcat Properties

• Restart Tomcat.

End of Procedure

|-| Overriding the User Account Locale (Solaris)=

Purpose: To override the user account locale by using Tomcat JVM locale options on Solaris.

Start of Procedure

1. In the JRE, update the JAVA_OPTS environment variable with the -Duser.language, -Duser.region, and
-Duser.country options.
For example, see the following options string: JAVA_OPTS="$CATALINA_OPTS -server -Xms128m
-Xmx256m -Djava.awt.headless=true -Duser.language=en -Duser.region=GB
-Duser.country=GB"

Important
The options in the example might be different in an actual Java environment.
These options were used as an example only.
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2. Restart Tomcat.

End of Procedure

</multistep>
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Using Self-Localization
You can localize the GUIs for WFM Web Supervisor and WFM Web Agent without having to obtain
localized software from Genesys. This enables Genesys partners and customers to deploy translated
versions of these user interfaces, when Genesys does not provide localized versions of WFM.

This topic includes the following sections:

• Requirements
• Precautions
• Initial and Subsequent Localization
• Tools and File Descriptions
• Applying the Localization.bat File Options
• Procedures

The WFM Agent and Supervisor components each draw their GUI text from a properties file, which
you can modify. You can localize WFM to any language that you wish, by translating the text in these
files.

Perform this localization carefully, by making backups that you can use to undo mistakes and by
using text that has the precise meaning of the words and phrases that you are translating. Genesys
assumes no responsibility for work performed by anyone, other than a Genesys employee.

Important
Self-localization does not affect all text in WFM Web. The text of some messages (such
as the resolution of Calendar items, Schedule Build Validation messages, and others)
do not reside in the wfm.war properties files, and are therefore, not localized.

Requirements

Ensure you have the following requirements to complete your self-localization:

• JDK (the Java Development Kit, same version as required by WFM Web) must be located in the path
JAVA_HOME.

• Certificate to sign Java code.

Using localization.bat
The localization.bat batch file is installed in the same directory where WFM Web was initially
installed. Use this file to:
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• Extract the agent.properties and supervisor.properties properties files from the wfm.war file.
• Update the wfm.war file by reinserting the two WFM Properties files. Run the localization.bat file

from the Windows command line interface.

For example, To display the help message, which summarizes all functionality, enter:
C:\Program Files\GCTI\WFM76\Web>localization -h

Display help message.. [+]
USAGE:

localization -{xuci} [wfm-war-file] OR -{eh}

[-a OR -a8 [agent-properties-file]] [-s [supervisor-properties-file]]

Options:

-x    extract properties from WFM war

-u    update WFM war with new properties

-c    create WFM localization jar archive

-i    insert WFM localization jar in the war archive

-a    define path to agent properties file

-a8   define path to agent800 properties file

-s    define path to supervisor properties file

-e    show examples

-h,/? show this message

Parameters:

[wfm-war-file]               path to WFM war

[agent-properties-file]      path to agent properties file

[supervisor-properties-file] path to supervisor properties file

Additional Info:

If you not define the file name the default name will be used.

For war it is 'wfm.war' in current folder.

For agent it is 'agent.properties' in current folder.

For agent800 it is 'agent800.properties' in current folder.

For supervisor it is 'supervisor.properties' in current folder.

CAUTION:

WFM Localization Using Self-Localization

Workforce Management Administrator's Guide 290



Please backup the original properties to the safe place

already after extraction.

You may use them for restoring if something goes wrong.

Back to Top

Precautions

Before localizing your WFM deployment, ensure you take the following precautions:

• Back up wfm.war before you make your changes. You may need to replace the modified file if your
changes have unexpected results.

• Back up the properties files before you make your changes, for the same reason that you back up
wfm.war.

• Back up wfm.war, as well as the properties files, after you make your changes too. When you install a
WFM Web patch, you also install a new (non-localized) wfm.war file. The backup allows you to restore
your changes accurately and with a minimum of effort.

• With that backup, you can restore your changes accurately and with a minimum of effort after installing
a WFM Web patch, which includes a new (non-localized) wfm.war file.

• Wait for the extraction and updating processes to finish; they do not display status.

Due to changes in the Java security model, localized resources must be placed into signed wfm-
localization.jar. See docs.oracle.com, The localizer is responsible for obtaining a certificate and
for signing the file wfm-localization.jar.

Task Summary: WFM Localization Process
Task Summary

1. Extract the properties files from inside wfm.war
2. Localize the properties files. See Localizing WFM the First Time
3. Create the file wfm-localization.jar, including inside translated resources from task 2 of this
summary.
4. Sign the wfm-localization.jar file (from task 3).
5. Update wfm.war with the signed wfm-localization.jar (from task 4).
6. Deploy the new wfm.war on the web application server.

Important
Before you begin the self-localization process, read this entire section, especially the
Precautions and Requirements sections.
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Back to Top

Initial and Subsequent Localizaton

You will use different procedures for the initial and subsequent localization of WFM.

Initial Localization
The first time you localize WFM, you must follow the steps in the Localizing WFM the First Time. When
you localize the text in your WFM web archive, you are modifying the program’s software—the
messages, menus and other elements of the screen display. By doing this yourself, you must accept
responsibility for any possible errors you might make and ensure that you can recover from any
possible errors. Therefore:

• Accept responsibility by following these instructions closely. Do not take shortcuts.
• Ensure error recovery by backing up your files before and after every change.

All Subsequent Localizations
In the future, if there is an updated version of WFM Web that you need to deploy (for example, a
patch or software update) and you have already localized WFM, follow the steps in the Localizing
WFM the Next Time (Subsequently).

Procedures

<multistep>

|-| Localizing WFM the First Time=

Purpose: To localize WFM for the first time (the initial process).

Start of Procedure

1. Make a backup copy of the existing wfm.war file and save it in a safe place (in a different directory, with
a different name, or both). The wfm.war file is an important WFM software component, and you might
need to replace a broken version.

Important
You must make a backup of the wfm.war file before and after you make changes
so that you can update the new, non-localized wfm.war file that arrives with any
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new patches that are released.
In a worst-case scenario, you can always reinstall WFM Web from the original
software release disk or FTP download that you received from Genesys.

2. Extract the supervisor.properties and agent.properties properties files from the wfm.war file, by
using the software tool localization.bat. Click Start > Run to open a command window. Then enter:
localization -x
...where -x extracts the properties files. See Using localization.bat for ways to specify file names and
locations.

3. Make a backup copy of the properties files before you change them, rename them with a descriptive
name (for example, agent.properties.english.v8.1.000.10), and then store them in a safe place.
You will need these in the future to compare with newer properties files when software updates to WFM
Web are released.

4. Using a text editor, update the two properties files by changing the English text strings to the language
you want to use.

Tip
To help identify the text strings in context, you might want to run WFM in another
window while you do this work.

5. Make a backup copy of these localized properties files, rename them with a descriptive name (for
example, agent.properties.czech.v8.1.000.10) and then store them in a safe place.

6. Create the wfm-localization.jar file, by using the localization -c option.
7. Sign the wfm-localization.jar file, by using Java's utility keytool, which is documented here:

docs.oracle.com.
8. Update the wfm.war file. Use the localization -i option.
9. Deploy the wfm.war file to the WFM Web Server, by completing the following steps:

• Stop Tomcat.
• Copy the edited wfm.war file and then paste it into the Tomcat folder.
• Restart Tomcat.

End of Procedure

|-| Localizing WFM the Next Time (Subsequently)=

Purpose: To localize WFM after an updated version has been deployed (subsequent to the initial
localization).

Prerequisite: Your WFM deployment has been localized at least once before. See Initial Localization.
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Start of Procedure

1. Use the localization.bat file to extract the two properties files (one for the WFM Web for Agents GUI
and one for the WFM Web for Supervisors GUI) from the wfm.war file. (See step 2 in the Localizing WFM
the First Time

2. Compare the new versions of the properties files with the original ones, by using the windiff tool (or
any text editor that provides comparison capabilities) to identify any new or changed strings that
require localization.

3. Using the text editor, update the two localized properties files that you created in step 3 in Localizing
WFM the First Time, adding any new string resources in the appropriate place.

Tip
Make a new backup copy of the properties files; if you make a mistake, you can
continue to work, by using the backup you created in step 4 in Localizing WFM the
First Time.

4. Create and sign the wfm-localization.jar file and update the file wfm.war, by using the same tools as
described steps 6 and 7 in Localizing WFM the First Time.

5. Deploy the updated wfm.war file on the Web application server. See instructions for deleting the .war
file from Tomcat (step 9 in Localizing WFM the First Time).

End of Procedure

</multistep>

Back to Top

Tools and File Descriptions

Use the tools specified in the table below to localize your installation of WFM.

Tool Description

localization.bat
Use this batch file to extract and update the
properties files from wfm.war. See Using
localization.bat.

wfm.war
This Web archive file contains the WFM properties
files agent.properties and
supervisor.properties.

agent.properties Edit the text inside this properties file, to localize
the WFM Web for Agents GUI.

agent800.properties Edit the text inside this properties file, to localize
parts of the WFM Web for Agents GUI.

supervisor.properties Edit the text inside this properties file, to localize
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Tool Description
the WFM Web for Supervisors GUI.

wfm-localization.jar The archive that contains the translated resources.

Text editor Use a non-formatting text editor (such as Notepad
or Wordpad) to edit the properties files.

Windows system tools
Use the appropriate system tools to stop and
restart the web application server, and to copy the
localized wfm.war to its appropriate location.

Web Application Server
This appendix uses Tomcat as the default device
that enables access to WFM. However, depending
on your configuration and version of WFM, it could
instead be WebSphere.

Back to Top

Applying the Localization.bat File Options

This section describes how to use the options in the Localization.bat file and provides examples.

Specifying the Defaults
Each file used by the localization.bat file has a default name and a default
location. To use these defaults, enter the command line in its simplest format:
See examples.. [+]

• localization -x
This command line applies all the defaults:
• The web archive is named wfm.war and is located in the current directory.
• The Properties files that are extracted from wfm.war are named agent.properties and

supervisor.properties and are saved to the current directory.

• localization -u
Do not use this option; it has been replaced by options -c and -i

• localization -c
This option creates the file wfm-localization.jar from localized resources, making it available for
signing.

• localization -i
This option inserts the file wfm-localization.jar into wfm.war. Be certain that wfm-
localization.jar is signed before inserting or the problems described in docs.oracle.com will appear
when you try to run WFM Web for Supervisors.

Specifying Directories
You can specify absolute paths or relative paths to the directories that hold the
files. See examples.. [+]
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• localization -x “C:\Program Files\GCTI\WFM76\Web\wfm.war”
wfm.war is in the absolute directory C:\Program Files\GCTI\WFM76\Web\. You can also specify
absolute directories for the properties files. For example:
localization -u -a “\Program Files\GCTI\WFM76\Web\propfiles\agent.properties”
localization -x -s “\Program Files\GCTI\WFM76\Web\propfiles\supervisor.properties”

• localization -x “..\safe\wfm.war”
wfm.war is in the directory \safe\, whose position is relative to the current directory (they share the
same parent directory). You can also specify relative directories for the properties files. For example:
localization -x -a “..\propfiles\agent.properties”
localization -u -s “..\propfiles\supervisor.properties”

Specifying Filenames
You can specify different filenames for any of the files. See examples.. [+]

• localization -u “wfmLOCALIZED.war”
The web archive is named wfmLOCALIZED.war. You can specify names for the properties files. For
example:
localization -x -a “agentORIGINAL.txt”
localization -u -s “supervisorREVISED.txt”

Combining Options
You can combine any or all of these options. This example occupies a single
command line, and has been wrapped in arbitrary places for readability: See
examples.. [+]

• localization -u “C:\Program Files\GCTI\WFM76\Web\wfmLOCALIZED.war”
-a “C:\Program Files\GCTI\WFM76\Web\propfiles\agentORIGINAL.txt”
-s “..\propfiles\supervisorREVISED.txt”

Help
To see usage examples, enter this command line: localization -e

Back to Top
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WFM Metrics
You will find everything you need to know about Workforce Management (WFM) metrics, by clicking
on these topic links.

Schedule Summary Report

Contact Center Performance Report

Agent Adherence Report

End Notes

Tip
A period in these metrics refers to the specific granularity of the report being run. For
Intra-day granularity a period is 15 minutes; for Daily granularity a period is 1 day;
and so on.
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Schedule Summary Report
In this topic, find information about the Workforce Management Schedule Summary reporting
metrics. To go directly to a specific metric, click any link in the tables below.

• AHT – Difference
• AHT – Forecasted
• AHT – Scheduled

• ASA – Difference
• ASA – Forecasted
• ASA – Scheduled

• Budget –
Difference
• Budget –
Forecasted
• Budget –
Scheduled

• Coverage –
Difference
• Coverage –
Published
• Coverage –
Scheduled

• Difference –
Calculated
• Difference –
Required

• Interaction
Volume –
Difference
• Interaction
Volume –
Forecasted
• Interaction
Volume –
Scheduled

• Number of
Agents

• Occupancy –
Difference
• Occupancy –
Forecasted
• Occupancy –
Scheduled

• Service Level –
Difference
• Service Level –
Forecasted
• Service Level –
Scheduled

• Staffing –
Calculated
• Staffing –
Required

Tip
A period in these metrics refers to the specific granularity of the report being run. For
Intra-day granularity a period is 15 minutes; for Daily granularity a period is 1 day;
and so on.

See Other Metrics Topics

• Contact Center Performance Report Metrics
• Agent Adherence Report Metrics
• Endnotes (for Metrics)

____________________________________________________________________________________________________________________

Number of Agents

Number of Agents is also called Headcount or Agents in Seats. If an agent is multi-skilled and is
scheduled for more than one activity for a given period, he will actually count as 1 headcount for
each of the activities for which he is scheduled. Therefore, in comparison with Coverage, Headcount
can double count an agent if he is multi-skilled and is scheduled for more than one activity during a
particular period.
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For example, if an agent is scheduled for two activities in a particular 15-minute timestep, he might
count as 0.5 towards the Coverage of each of those activities, but he would count as 1 Headcount
towards each of those activities. Unlike Coverage, where an agent could count towards partial
coverage if he’s scheduled for something other than activity work for part of a 15-minute timestep,
for Headcount it is all or nothing. This means that as long as an agent is scheduled for at least 1
minute of work on an activity during a given 15-minute timestep, he will count as 1 Headcount
towards that activity.

Back to Top

How the Total / Average is Calculated
The value for Headcount in the totals/averages row at the top of this view (or bottom of the report) is
a simple average of all the values for all the timesteps of the selected time period (which can be:
Intra-day, Daily, nWeeks, or Monthly).

Service Level – Scheduled

The Service Level that you should achieve on this activity, with the number of agents currently
scheduled for this activity. Due to agent rounding, this value may differ from the original service level
objective that was stated when the staffing forecast was built.

For example, WFM might forecast a staffing requirement of 12 agents to meet a service level
objective of 80% of interactions answered within 20 seconds. But a Service Level Percentage Forecast
may report a higher number, such as 83.48%. This is because 12 was the minimum number of agents
required to meet the 80% service level objective but, with that number of agents, the contact center
can be expected to achieve a slightly better service level than 80%. With one less agent (11 agents),
the contact center would not be expected to achieve the 80% service level.

How the Total / Average is Calculated
A weighted average, calculated across the open hours:

AVG SL Scheduled = S (Scheduled SLi * Forecasted IVi) / S (Forecasted IVi)

Where:

Scheduled SLi= Calculated Service Level based on the number of scheduled agents for timestepi
Forecasted IVi= Forecasted Interaction Volume for timestepi

timestepi= timestep number over the open hours

Back to Top

Service Level—Forecasted

The Service Level Percentage objective that you should be able to achieve when staffing with the
number of agents from the staffing forecast (also known as Budget – Difference).
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How the Total / Average is Calculated
A weighted average, weighted by Forecasted IV:

AVG SL Forecasted = Σ (Forecasted SLi * Forecasted IVi) / Σ (Forecasted IVi)

Where:

Forecasted SLi= Forecasted Service Level for timestepi
Forecasted IVi= Forecasted Interaction Volume for timestepi

timestepi= timestep number over the open hours

Service Level – Difference

Service Level – Scheduled minus Service Level – Forecasted.

Interaction Volume – Scheduled

The number of interactions that can be handled based on the schedule coverage. Calculated by using
the inverse of the WFM’s staffing forecast algorithm.

WFM uses a modified Erlang algorithm to derive Calculated Staffing based on the IV, the AHT, and
service objectives stated when building the forecast. Therefore, to calculate the scheduled interaction
volume, WFM uses that formula in reverse.

Back to Top

How the Total / Average is Calculated
The sum is across the entire report time range.

Interaction Volume – Forecasted

The interaction volume taken from the Master Forecast.

How the Total / Average is Calculated
The sum across the entire report time range.
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Interaction Volume – Difference

Interaction Volume – Scheduled minus Interaction Volume – Forecasted.

AHT – Scheduled

The Average Handling Time (AHT) per interaction that you should achieve, based on the schedule
coverage. Calculated by using the inverse of the WFM’s staffing forecast algorithm.

WFM uses a modified Erlang algorithm to derive Calculated Staffing, based on the IV, AHT, and
service objectives stated when building the forecast. Therefore, to calculated the scheduled AHT, it
uses that formula in reverse.

Back to Top

How the Total / Average is Calculated
A weighted average, weighted by Forecasted IV:

AVG AHT Scheduled = Σ (Scheduled AHTi * Forecasted IVi)/ Σ (Forecasted IVi)

Where:

Scheduled AHTi= Scheduled Average Handling Time for timestepi
Forecasted IVi= Forecasted Interaction Volume for timestepi

timestepi= timestep number over the open hours

AHT – Forecasted

Average Handling Time of interactions, taken from the Master Forecast.

How the Total / Average is Calculated
A weighted average, weighted by Forecasted IV:

AVG AHT Forecasted = Σ (Forecasted AHTi * Forecasted IVi)/ Σ (Forecasted IVi)

Where:

Forecasted AHTi= Forecasted Average Handling Time for timestepi
Forecasted IVi= Forecasted Interaction Volume for timestepi

timestepi= timestep number over the open hours
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AHT – Difference

AHT – Scheduled minus AHT – Forecasted.

Back to Top

Budget – Scheduled

The budget for this schedule based on the number of agents from the Coverage – Scheduled column.
The calculation is based on a full-time equivalent’s hourly wage, as well as on the Planned
Overhead % and Unplanned Overhead % (which were specified when the staffing forecast was built).

For a 15-minute timestep, the formula is:

(Coverage/4)*((100/(100-Planned Overhead))*(100/100-Unplanned Overhead)* Hourly Wage)

The unit of measure is in whatever monetary unit was used when the Hourly Wage was specified
while building the forecast.

How the Total / Average is Calculated
This figure is in the sum across the entire report time range.

Budget – Forecasted

The budget for the schedule based on the number of agents from the “Staffing – Calculated” column,
based on a full-time equivalent’s hourly wage, as well as the Planned Overhead % and Unplanned
Overhead % (specified when the staffing forecast was built).

For a 15-minute timestep, the formula is:

(Staffing/4)*((100/(100-Planned Overhead))*(100/100-Unplanned Overhead)* Hourly Wage)

The unit of measure is in whatever monetary unit was used when the Hourly Wage was specified
when building the forecast.

How the Total / Average is Calculated
This figure is in the sum across the entire report time range.

Back to Top
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Budget – Difference

Budget – Scheduled minus Budget – Forecasted.

Staffing – Calculated

A value taken directly from the staffing forecast, for the particular timestep.

How the Total / Average is Calculated
The value in the column footer is calculated based on the same approach as what is described for
Coverage – Scheduled.

Staffing – Required

A value taken directly from the staffing forecast, for the particular timestep. It will be populated only
if you put some values in the optional Required Staffing column in your staffing forecast.

How the Total / Average is Calculated
The value in the column footer is calculated based on the same approach as what is described for
Coverage – Scheduled.

Difference – Calculated

Coverage – Scheduled minus Staffing – Calculated.

Back to Top

How the Total / Average is Calculated
The value in the column footer is calculated based on the same approach as what is described for
Coverage – Scheduled.

Difference – Required

Coverage – Scheduled minus Staffing – Required.
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Coverage – Scheduled

The actual amount of time that an agent should count towards coverage of the work in this time
period. If an agent is multi-skilled and is scheduled for multiple activities during a given period, he
may count fractionally towards the coverage of each activity (for example, as 0.5 toward each of two
activities for which he’s scheduled).

If an agent has something other than activity work scheduled for part of a period, that will be
subtracted from the amount of time he’s counted towards the coverage of that activity work. For
example, an agent who is scheduled for an activity for a given 15-minute timestep but has a break
for the first 5 minutes of that timestep, would count as 0.67 towards the coverage of that activity for
that period.

Back to Top

How the Total / Average is Calculated
This figure is in FTEs. For the calculation, see Endnote 1.

The value in the totals/averages row at the top of this view (or bottom of the report) is calculated as
follows:

1. WFM calculates the sum of the agents which are covering this activity within each timestep during the
day.

2. The value calculated in step 1 is multiplied by 15 minutes in order to get the total time of activity work.
3. The value calculated in step 2 is divided by the value set for Paid Hours a Day, which was entered

while building staffing forecast for this activity.

Coverage – Published

The original values from the Coverage – Scheduled column the last time a schedule scenario was
published to the Master Schedule.

How the Total / Average is Calculated
The value in the column footer is calculated based on the same approach as what is described for
Coverage – Scheduled.

Coverage – Difference

Coverage – Scheduled minus Coverage – Published.
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ASA – Scheduled

The Average Speed of Answer that you should achieve on this activity, with the number of agents
currently scheduled for this activity.

The totals/average row for ASA Scheduled reports a weighted average, calculated across the open
hours and weighted by Forecasted IV (exactly as for Service Level – Scheduled):

A weighted average, weighted by Forecasted IV:

AVG ASA Scheduled = S (Scheduled ASAi * Forecasted IVi) / S (Forecasted IVi)

Where:

Scheduled ASAi= Calculated Average Speed of Answer based on the number of scheduled agents
for timestepi
Forecasted IVi= Forecasted Interaction Volume for timestepi

timestepi= timestep number over the open hours

Back to Top

ASA – Forecasted

The totals/average row for ASA Forecasted reports a weighted average, calculated across the open
hours and weighted by Forecasted IV (exactly like for Service Level – Forecasted):

A weighted average, weighted by Forecasted IV:

AVG ASA Forecasted = S (Forecasted ASAi * Forecasted IVi) / S (Forecasted IVi)

Where:

Forecasted ASAi= Calculated Average Speed of Answer based on the number of scheduled agents
for timestepi
Forecasted IVi= Forecasted Interaction Volume for timestepi

timestepi= timestep number over the open hours

ASA – Difference

ASA – Scheduled minus ASA – Forecasted.

Occupancy – Scheduled

The Occupancy that you should achieve on this activity, with the number of agents currently
scheduled.
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How the Total / Average is Calculated
The totals/average row for Occupancy reports a weighted average, calculated across the open
hours and weighted by Forecasted IV (exactly as for Service Level – Scheduled:

A weighted average, calculated across the open hours and weighted by Forecasted IV:

AVG Occupancy Scheduled = S (Scheduled Occi * Forecasted IVi) / S (Forecasted IVi)

Where:

Scheduled Occi= Calculated Occupancy based on the number of scheduled agents for timestepi
Forecasted IVi= Forecasted Interaction Volume for timestepi

timestepi= timestep number over the open hours

Occupancy – Forecasted

The Occupancy objective that you should be able to achieve when staffing with the number of agents
from the staffing forecast (Staffing – Calculated).

Back to Top

How the Total / Average is Calculated
The totals/average row for Occupancy reports a weighted average, calculated across the open
hours and weighted by Forecasted IV (exactly as for Service Level – Forecasted):

A weighted average, weighted by Forecasted IV:

AVG Occupancy Forecasted = S (Forecasted Occi * Forecasted IVi) / S (Forecasted IVi)

Where:

Forecasted Occi= Forecasted Occupancy for timestepi
Forecasted IVi= Forecasted Interaction Volume for timestepi

timestepi= timestep number over the open hours

Occupancy – Difference

Occupancy – Scheduled minus Occupancy – Forecasted.

Back to Top
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Contact Center Performance Reporting
Metrics
In this topic, find information about the Workforce Management Contact Center Performance
reporting metrics. Click any link in the Contents to go directly to a specific metric.

• Abandon Factor –
Actual
• Abandon Factor –
Scheduled

• AHT – Actual
• AHT – Difference
• AHT – Forecasted
• AHT – Percentage

• ASA – Actual
• ASA – Scheduled

• Coverage – Difference
• Coverage – Optimal
• Coverage –
Percentage
• Coverage – Scheduled

• Interaction Volume – Actual
• Interaction Volume – Difference
• Interaction Volume –
Forecasted
• Interaction Volume –
Percentage

• Number of Agents – Actual
• Number of Agents – Difference
• Number of Agents – Percentage
of Difference
• Number of Agents – Scheduled

• Service Level – Actual
• Service Level – Scheduled

Tip
A period in these metrics refers to the specific granularity of the report being run. For
Intra-day granularity a period is 15 minutes; for Daily granularity a period is 1 day;
and so on.

See Other Metrics Topics

• Schedule Summary Report Metrics
• Agent Adherence Report Metrics
• Endnotes (for Metrics)

_____________________________________________________________________________________________________________________

Important
The Difference calculation is controlled by the WFM Web Application option
RevertDiffCalculation in Management Framework’s Configuration Manager.
false (default): Scheduled or Forecasted minus Actual
true: Actual minus Scheduled or Forecasted
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This document uses the default value.

Coverage – Scheduled

The actual amount of time that an agent should count toward coverage of the work in this time
period. If an agent is multi-skilled and is scheduled for multiple activities during a given period, he
may count fractional amounts of time toward the coverage of each activity (for example, 0.5 toward
each of two activities for which he is scheduled).

If an agent has something other than activity work scheduled for part of a period, that will be
subtracted from the amount of time counted toward the coverage of that activity work. For example,
an agent who is scheduled for an activity for a given 15-minute timestep, but who has a break for the
first five minutes of that timestep, would count as 0.67 toward the coverage of that activity for that
period.

Back to Top

How the Total / Average Is Calculated
This figure is in FTEs. For the calculation, see Endnote 1.

The value in the totals/averages row at the top of this view (or at the bottom of the report) is
calculated as follows:

1. WFM calculates the sum of the agents who are covering this activity within each timestep during the
day.

2. The value calculated in Step 1 is multiplied by 15 minutes in order to get the total time of activity work.
3. The value calculated in Step 2 is divided by the value set for Paid Hours a Day, which was entered

while building the staffing forecast for this activity.

Coverage – Optimal

The coverage that would have been required in order to meet the original service objectives, based
on the actual IV and AHT.

Coverage – Difference

Coverage – Optimal minus Coverage – Scheduled.
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Coverage – Percentage
Coverage – Optimal

———————————————————————————————————————————————
Coverage – Optimal minus Coverage – Scheduled
in concept: Optimal / (Optimal – Scheduled)

Number of Agents – Scheduled

The number of agents scheduled for this period, also known as headcount.

Back to Top

How the Total / Average is Calculated
A simple average across the entire report time range. Thus, even if activity is only open for a portion
of the day, if this report were run for a intra-day period, the average would be calculated over 96
timesteps.

Number of Agents – Actual

The number of agents who were actually logged in during this period, also known as headcount.

How the Total / Average is Calculated
A simple average of the number of time steps when agents were logged in.

Σ (Agentsi) / Number of time steps

Where

Agentsi is the number of agents logged in (as reported by Stat Server) during timestepi

Number of Agents – Difference

Number of Agents – Scheduled minus Number of Agents – Actual.

Number of Agents – Percentage of Difference
(Number of Agents – Scheduled minus Number of Agents – Actual)

————————————————————————————————————————————————————————————————
Number of Agents – Scheduled
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in concept: (Scheduled – Actual) / Scheduled

Interaction Volume – Forecasted

The number of interactions forecasted for this period (taken directly from the Master Forecast).

Back to Top

How the Total / Average is Calculated
This Sum is spread across the entire report time range.

Interaction Volume – Actual

The number of interactions actually received. The exact nature of this metric will depend on what
Stat Server statistic is configured for Interaction Volume.

For example, for voice interactions, normally this is based on Number of Calls Entered.

How the Total / Average is Calculated
The sum is of Interaction Volume for each time step within the report time range.

Σ (IVi)

Where:

IVi is the Interaction Volume recorded by Stat Server during timestepi

Interaction Volume – Difference

Interaction Volume – Forecasted minus Interaction Volume – Actual.

Interaction Volume – Percentage
(Interaction Volume – Forecasted minus Interaction Volume – Actual)

—————————————————————————————————————————————————————————————————————
Interaction Volume – Forecasted

in concept: (Forecasted - Actual) / Forecasted

Back to Top
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AHT – Forecasted

Forecasted Average Handling Time for this period (taken directly from the Master Forecast)

How the Total / Average is Calculated
A weighted average, weighted by Forecasted IV:

AVG AHT Forecasted = Σ (Forecasted AHTi * Forecasted IVi) / Σ (Forecasted IVi)

Where:

Forecasted AHTi = Forecasted Average Handling Time for timestepi
Forecasted IVi = Forecasted Interaction Volume for timestepi

timestepi = timestep number over the open hours

AHT – Actual

Actual Average Handling Time for calls handled during this period. This metric is based on what Stat
Server statistics are configured for Total Handle Time and Number of Calls Handled.

How the Total / Average is Calculated
A weighted average, weighted by Number of Calls Handled:

Σ (AHTi * CallsHandledi) / Σ (CallsHandledi)

Where:

AHTi = AHT recorded by Stat Server for timestepi
CallsHandledi = Number of interactions handled during timestepi as recorded by Stat Server.

AHT – Difference

AHT – Forecasted minus AHT – Actual.

AHT – Percentage
(AHT – Forecasted minus AHT – Actual)

———————————————————————————————————————
AHT – Forecasted

in concept: (Forecasted - Actual) / Forecasted

Back to Top
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Service Level – Scheduled

The Service Level that was scheduled to be achieved, based on the scheduled number of agents.

How the Total / Average is Calculated
A weighted average, weighted by Forecasted IV:

AVG SL Scheduled = Σ (Scheduled SLi * Forecasted IVi) / Σ (Forecasted IVi)

Where:

Scheduled SLi = Calculated Service Level based on the number of scheduled agents for
timestepi
Forecasted IVi = Forecasted Interaction Volume for timestepi

timestepi = timestep number over the open hours

Service Level – Actual

The Service Level that was actually achieved. This metric is based on what Stat Server statistics are
configured for Service Factor, Number of Calls Distributed, Average Speed of Answer, and Time
Range.

How the Total / Average is Calculated
A weighted average, weighted by Number of Calls Distributed:

Σ (SFi * CallsDistributedi) / Σ (CallsDistributedi)

Where:

SFi= Service Factor recorded by Stat Server for timestepi

CallsDistributedi = Number of calls distributed during timestepi as recorded by Stat Server.
(This value does not appear in the report but is recorded by Stat Server. For more details, see
Endnote 2.)

ASA – Scheduled

The Average Speed of Answer that was scheduled to be achieved, based on the scheduled number of
agents. Calculated by using the inverse of the WFM’s staffing forecast algorithm.

WFM uses a modified Erlang algorithm to derive Calculated Staffing, based on the IV, AHT, and
service objectives such as ASA that were stated when building the forecast. Therefore, to calculated
the Scheduled ASA it uses that formula in reverse.
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How the Total / Average is Calculated
A weighted average, weighted by Forecasted IV:

AVG ASA Scheduled = Σ (Scheduled ASAi * Forecasted IVi) / Σ (Forecasted IVi)

Where:

Scheduled ASAi = Calculated ASA based on the number of scheduled agents for timestepi
Forecasted IVi = Forecasted Interaction Volume for timestepi

timestepi = timestep number over the open hours

Back to Top

ASA – Actual

The Average Speed of Answer that was actually achieved. This metric is based on what Stat Server
statistics are configured for ASA.

How the Total / Average is Calculated
A weighted average, weighted by Number of Calls Distributed:

Σ (ASAi x CallsDistributedi) / Σ (CallsDistributedi)

Where:

ASAi = Average Speed of Answer for timestepi as recorded by Stat Server
CallsDistributedi = Number of calls distributed during timestepi as recorded by Stat Server

Abandons Factor – Scheduled

The expected number of abandoned interactions based on the scheduled number of agents.
Calculated by using the inverse of the WFM’s staffing forecast algorithm.

WFM uses a modified Erlang algorithm to derive Calculated Staffing, based on the IV, AHT, and
service objectives such as Abandonment percentage that were stated when building the forecast.
Therefore, to calculate the Scheduled Abandons, WFM uses that formula in reverse.

How the Total / Average is Calculated
A weighted average, weighted by Forecasted IV:

AVG AF Scheduled = Σ (Scheduled AFi * Forecasted IVi) / Σ (Forecasted IVi)

Where:

Scheduled AFi = Calculated Abandon Factor based on the number of scheduled agents for
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timestepi
Forecasted IVi = Forecasted Interaction Volume for timestepi

timestepi = timestep number over the open hours

Abandons Factor – Actual

The actual number of abandoned interactions during a specific period, based on which Stat Server
statistics are configured for Abandoned Interactions.

How the Total / Average is Calculated
A weighted average, weighted by Number of Calls Distributed:

Σ (Abandonsi * CallsDistributedi) / Σ (CallsDistributedi)

Where:

Abandonsi = Number of calls abandoned during timestepi as recorded by Stat Server
CallsDistributedi = Number of calls distributed during timestepi, as recorded by Stat Server

Back to Top
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Agent Adherence Reporting Metrics and
End Notes
In this topic, find information about Workforce Management Agent Adherence reporting metrics and
endnotes.

See Other Topics About WFM Metrics

• Schedule Summary Report Metrics
• Contact Center Performance Report Metrics

Agent Adherence Report

There is only one Adherence reporting metric.

Percentage Adherence Per Day
The percentage of the day during which the agent was adherent to his or her scheduled state.

How the Percentage is Calculated
100 - ((NC+UNC)*100/(ST+UNC))

Where:

NC = Noncompliant time
UNC = Noncompliant time outside of scheduled time
ST = Scheduled time

Endnotes

This secton contains detailed descriptions and definitions for formula symbols that are used to
calculate WFM metrics.

Endnote 1
The Formula for FTEs:
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FTEs = (staffingi ÷ stepsHr ÷ paidHrsi x (100 ÷ (100 - pOverheadHrsi)))

Where:

n = Number of time steps in a day (96)
i = Current time step

staffing = Calculated staffing requirements
stepsHr = Time steps in one hour (4)
paidHrs = Paid Hours in a Day as specified in staffing forecast

pOverhead = Planned Overhead percentage as specified in staffing forecast

Back to Top

Endnote 2
The Total/Average value of Service Level in the Contact Center Performance report is calculated as
a weighted average, where for the weight coefficient we use the TotalNumberCallsDistributed
configuration option.

That is, for an Activity when we define the Quality of Service Statistic type in the WFM Configuration
Utility, we are required to specify three statistics:

1. Service Factor
2. Distributed Interactions
3. Average Speed of Answer

(plus two time ranges required for Service Factor statistic calculation)

The Number of Distributed Interactions statistic (or TotalNumberCallsDistributed) plays the role of the
weight coefficient in order to calculate the weighted average value of Service Level per:

Timestep
If we calculate Service Level for the same activity
several objects (for example, across some Queues)
this gives us the possibility to get an accurate
result rather then a simple average.

Day A weighted average gives a very accurate result in
comparison with simple average.

So the calculation of Total Service Level per day is done by the formula:

SUM (SLi x TNCDi)
Service Level Total =   ————————————————————

SUM (TNCDi)

Where:

i = 1 ... 96 (intra-day 15 minute timesteps from 00:00 through 23:45)
SLi = Service Level value for the timestepi

TNCDi = TotalNumberCallsDistributed value for the timestepi

Here is a simple example of the calculation, using this data:
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Timestep SL TNCD TNCDxSL
10:45 am 60.00 20 1200
11:00 am 90.00 1 90
11:15 am 20.00 150 3000
11:30 am 65.00 35 2275

If we assume that during the day we have only 4 timesteps of historical data, our Total Service Level
will be:

60x20 + 90x1 + 20x150 + 65x35      6565
SL weighted = —————————————————————————————— =  —————— = 31.87

20+1+150+35                206

Here an example of calculating a simple average:

60+90+20+65
SL simple average =  ————————————— = 58.7

4

This example shows that a timestep with Service Level=90 where only one call has been processed
should have minimal impact on the overall Service Level for the day, in comparison with a timestep
where SL=20 and 150 calls have been processed. This is the reason the calculation is done in this
way.

The user won’t be able to see TotalNumberCallsDistributed in the report, as this value is stored in
the WFM database for internal purposes only (in the table WM_perf_activities in the field
WM_distrib_calls, for each activity and for each timestep).

Also keep in mind that TotalNumberCallsDistributed is not the same as Interaction Volume, since
in general Interaction Volume is configured as TotalNumberCallsEntered (Answered + Abandoned),
while TotalNumberCallsDistributed is the number of calls which are being distributed from the
queue.

Back to Top
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WFM Primers
Workforce Management primers provide detailed information about certain Workforce Management
(WFM) functions and features and suggest ways in which you might use them in your deployment to
optimize the efficiency of your contact center.

Primers contain suggestions and example, which may or may not be applicable to your environment,
but the information is provided to help you to make the best choice, based on these recommended
uses and applications.

Primers are provided for these important WFM features:

Multi-Forecasting

Time Off

Overlays
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Time Off Primer
In this topic, find information that you can use, in conjunction with the details in [WFM Web for
Supervisors Help] and [WFM Web for Agents Help], to learn about how WFM processes time off and
how to configure and use it to suit the needs of your workforce and contact center.

This topic contains the following sections:

• Time-Off Types and Time-Off Rules
• Time-Off Limits
• Time-Off Request and Approval Process
• Agent Time-Off Planner

Time-Off Types and Time-Off Rules

You must understand the basics of the time off features in WFM to use them correctly and efficiently.
Before you can use time off, you must configure Time Off Types and Time Off Rules.

Time-Off Types
Probably the simpler of the two objects, because each time off type is simply a container. You add
time off to, or remove time off from, each container. You can create and arbitrarily name an unlimited
number of time-off types.

You create time off types for each individual site. You can use time off to track an agent request or
maintain a balance of requests on a regular basis. Time off types include vacation, personal time off,
flexible time off, paid sick days, floating holidays, and more.

Time-Off Rules
These are associated with a specific time-off type. The rules define:

• The rate at which time off is accumulated for an agent, and how and when an agent can request time
off.

• Whether or not a time off request will be manually approved, or auto-approved by the WFM system.

Important
Time-off types are configured on a per site basis. Therefore, if an agent has
outstanding time-off requests and is moved to a different site, the requests are
hidden, because WFM tracks them only at the initial site. The default time-off type
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Vacation is the only exception. Vacation is considered valid for all sites in the system,
and time-off requests for vacation are retained in the system even after the agent
moves from site-to-site. In addition, WFM recalculates the agent's time-off balance(s)
when the agent moves from one site to another, based on the change in time-off
rules. Moving an agent to a different site does not affect his/her time-off status.

Figure: Relationship Between Time Off Types, Time Off Rules, and the Agents Assigned to Them

Notes About the Figure Above

• Agents are assigned to time off rules, not directly to time off types.
• The association of time off rules to time off types is many-to-one, because for a single time–off type (for

example, personal time off), different agents might be given this type of time off at different
rates—perhaps based on seniority. For example, you might want requests from a certain type of agent
for paid sick days to be auto-granted by the system, but for another type of agent you might want the
same requests to be manually reviewed.

• When you create a time off rule, you define whether it is a rule of the type award (a fixed number of
hours) or accrual (a number of hours that accumulates during the year). In the figure below, all Floating
Holiday time offs are awarded and all Personal Time Offs are accrued. Compensation Time can be either
awarded or accrued, depending on an Agent's assigned time off rule.
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Figure: Awarded versus Accrued Time Off

Back to Top

Notes About the Figure Above

• An agent can be assigned to mulitiple time off rules.
Example 1: Jun Woo has three time off rules assigned to him. One rule defines how he will be awarded
a Floating Holiday each year and when he can use that time off. The second rule defines the rate at
which he will accrue Personal Time Off, how much balance he can have, and when he can use it. The
third rule defines how he will be awarded Compensation Time each year.

• Not all agents need to be assigned to a rule for each time off type.
Example 2: John Smith has a Floating Holiday award rule and a Personal Time Off accrual rule.
However, he has no time off rule defining how he can accrue or be awarded Compensation Time.
Therefore, he will have no balance of this time off type and will not be able to request it.

Exception Used as Time Off
When you configure an exception type in WFM Configuration Utility, you can use the option
Exception is used as time off to designate the exception as time off. This is a legacy feature
from earlier versions of WFM, which supported only one type of time off. WFM now supports an
unlimited number of time off types, which means Agents and Supervisors can request both full day
and partial-day time off. Therefore, Genesys recommends that you do not use exceptions to
represent time off.

When Type Off Types No Longer Apply
A combo box in the upper-left corner of an agent’s Time Off Planner displays all the time off types
that are configured for that agent’s site. Some of these might not relevant for the agent. (Agents are
assigned to Time Off Rules, which in turn are associated with Time Off Types.)
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An agent can create, edit, delete, or recall time off requests only for those types correspond to a Time
Off Rule that is assigned to that agent. Therefore, an agent might be able to view Time Off Types
corresponding to Time Off Rules are no longer assigned to him or her. The agent can see these “old”
Time Off Types, but he or she cannot interact with them. They appear below the Others legend in the
combo box.

Figure: Time-Off Types Combo Box

Back to Top

Time-Off Types that the agent can use appear above the Others legend.

WFM enables an Agent to select a Time Off Type from below the Others legend in the combo box;
however, the agent cannot perform any functions with it (such as requesting time off or viewing his
or her time off balance).

Time Off Limits

Before giving your Agents the ability to request time off, you should configure Time Off Limits. To do
so, use the Calendar module in WFM Web Supervisor.

If you have the correct permissions, you can configure the maximum number of Agents who can take
time off for each 15-minute interval of each calendar day.

For example, you could configure that from midnight to 8 a.m. on March 3, 2007, 5 Agents can be
allowed to take time off, whereas from 8 a.m. to 4 p.m., only 3 Agents can be take time off. You can
set time off limits either for an absolute number of Agents, or for a maximum percentage of Agents.

Additionally, you can set time off limits at three levels: Site, Team, and Activity.

Important
You cannot set different time off limits for different time off types. A single set of time
off limits governs the total amount of time off of all types that can be granted for a
specified time of day, for a specified date.

Time Off Request and Approval Process

There are two different processes for scheduling time off for agents. The process that is used
depends on whether the user is planning for a future schedule period (see Planning for Time Off in
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the Future) or working within a schedule period that is already published to the Master Schedule (see
Planning for Time Off for the Crrent Schedule Period).

Planning for Time Off in the Future
For future time periods (schedule days that are not yet published to the Master Schedule), the
process works as shown in the below.

Figure: Future Time Periods Process

Back to Top

The Time Off Planner (in the WFM Web Agent Application) and the Calendar (in the WFM Web
Supervisor Application) are really two different ways to input the same information. The Time Off
Planner is the Agent’s method of entering Calendar items. It allows the Agent to enter time off, but
that is all.

The Supervisor’s Calendar module has much more power: the Supervisor can enter all types of
Calendar items, including shifts, working hours, exceptions, days off, and time off.
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Both of these schedule-building input tools have the same result: the time off items are recorded in
the WFM Calendar.

Granted Time Off versus Preferred Time Off

WFM considers only time off items with the status granted when building a schedule scenario. It does
not include time off items with the status preferred.

Important
WFM enables a Supervisor to consider Agent preferences when building schedules.
These preferences include: day off, availability, and shift preferences; but not time off
preferences.

Time Off Items in the Calendar Hierarchy

When you enter multiple types of Calendar items for the same Agent on the same day, WFM uses its
internal hierarchy to resolve their status.

• Example 1: Full-Day Time Off versus Rotating Schedule Day In—An Agent is assigned a Rotating
Pattern for the week starting September 17, 2006, and for the date of September 19 his Rotating
Pattern assignment states he should be on a Day In. But a supervisor grants a full-day time off for
September 19. Now, the agent has two conflicting Calendar items for the same day: a working day
according to the Rotating Pattern assignment, and a full-day time off according to the Calendar. The
Calendar hierarchy specifies that the full-day time off item should be granted and this should cause the
Rotating Pattern assignment for that day should be declined. The statuses are reflected in the Calendar
and the supervisor can read the reasons there. Some items in the Calendar do have a higher priority
that full-day time off items.

• Example 2: Full-Day Exception versus Full-Day Time Off—A full-day exception is granted for an
agent in the Calendar for the same day as a full-day time off. The Calendar hierarchy specifies that the
full-day exception should take priority and the full-day time off item should be declined. The hierarchy
of the WFM Calendar is described in the WFM Web for Supervisor Helpa in the topic Calendar Items
Overview.

Back to Top

Using the Calendar to Understand the Status of Time Off Items

You can view the Actual Status of any item in the Calendar; a status of Granted, Preferred, or
Declined confirms that no schedule has been published for this Agent for this date. In a built and
published schedule, the Actual Status of an item will be either Scheduled or Not Scheduled. If a
Calendar item was not scheduled, you can view a Reason field which will describe why it was not
scheduled (in the Reason column).

Planning for Time Off for the Current Schedule Period
To enter agent time off items for days that are already published to the Master Schedule, use either
of these methods:

WFM Primers Time Off Primer

Workforce Management Administrator's Guide 324



1. Enter time off directly into the Master Schedule.

Important
The agent can view this time off entry in his schedule by logging in to the WFM Web for Agents application.
He/she will also see a change to his time off balance in the WFM Web for Agents Time Off Planner and he/she
can see that time off for this day is scheduled, when he views his Time Off Planner. However, no entry for this
time off will be made in the WFM Calendar, because the Calendar is a planning tool, and is meant for entering
items such as exceptions, time off, days off, etc., that are to be considered when building a schedule scenario.

2. Enter the granted time off request into the WFM Calendar.
3. Click the Update Schedule icon.

WFM has now automatically updated the Master Schedule with the agent's Granted Time Off.

Using the Update Schedule from within the Calendar updates the Master Schedule from the Calendar
for the agent's time-off request, which streamlines the review and approval process and eliminates
the need to manually rebuild the schedule.

Important
From within the Calendar module, users can update the Master Schedule with a
granted Time Off items for any agent on any date for which the agent has a schedule
published, and the Time Off request is compatible with the agent's existing schedule.
For more details, see the WFM Web for Supervisors Help topics Calendar Items
Overview and Update Schedule Options.

Agent Time Off Planner

Agents request time off and see the status of these requests through WFM Web for Agents Time Off
Planner. If you do not want your agents to have access to the Time Off Planner, you can disable this
through the Time Off Planner Enabled setting. In Configuration Manager, for your WFM Web
application object, open Options > AgentTimeOff, and set the variable AllowTimeOffPlanner to
false.

Time Off Balance in Agent’s Time Off Planner
The Time Off Planner displays the balances for an agent's time off, in this way: the agent selects a
time off type and clicks on a date in the yearly planning calendar to view balances for that type, up to
that date.

The agent can also view the types of Time Off hours prior to the selected date: already granted,
preferred, declined and scheduled, bonus, advance, and carried-over.

When an agent’s Time Off Rule is changed, his time off is recalculated, based on the new rules.
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See some examples.. [+]

• If a Time Off Rule is assigned to an agent and you change any of the rule's properties.
• If a Time Off Rule is assigned to an agent and you use the Time Off tab under Configuration >

Organization > Agent properties to change the rule.
• If a Time Off Rule is assigned to an agent and you use the Assignments tab under Policies > Time

Off Rules > Time Off Rule properties to remove the assignment.

In each case, the user is asked to approve the calculation before it is performed.

Warning
Moving to a different site can affect an agent’s time-off balance. An agent who moves
to a different site might appear to lose a portion of her existing time-off balance,
because WFM tracks that time off only at the old site. To preserve the time-off hours
that the agent earned at the previous site, her supervisor must enter these hours as a
bonus to the new Agent Rule under the new site. For details, see the WFM
Configuration Utility Help topic Agent Time Off > Bonus Time Off Hours.

Back to Top

Recalling Time Off Requests
An agent can recall a time off request that is in preferred or granted status, as long as the time off
item has not been scheduled. Use the WFM Web for Agents Time Off Planner; see the topic
Requesting Time Off.

After an agent’s time off request has been granted, scheduled, and published to the Master Schedule,
the agent cannot recall the time off.

Only the supervisor can do that, by manually changing the agent’s schedule for that date, through
the Master Schedule. And only the supervisor can schedule a different activity for the agent for that
date, in lieu of the time off.

Wait Listed Time Off Requests
When an agent makes a time-off request, he can optionally ask for it to be wait-listed. (See step 7 in
the WFM Web for Agents Help topic Requesting Time Off: If you want your request to be wait-listed,
click the Wait-list check box.)

Important
Wait-listing means that if a time-off request is denied because the time off limits have
been reached, the request stays in a preferred status in case an opening becomes
available. The request could eventually be granted by a supervisor, although this is
not guaranteed.
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In detail, this means that if the time off request would be declined because the time off limits have
already been reached, wait listing gives it a preferred status. If some time off slots become available
for certain dates due to cancellations, or if the Supervisor decides to raise the time off limits for a
certain date, the Supervisor user can review all of these preferred time off items in the Calendar and
grant some of them. There is a field in the Calendar which displays the date and time that the Agent
or Supervisor submitted each time off item, to help the supervisor manage the wait list. Agents’ time
off requests are not pulled automatically from this wait list; these requests must be manually granted
by the supervisor.

Viewing the Status of Time Off Requests
Agents can view the status of any time off request, for any calendar date, with some limitations. If an
agent requests time off for a date on a schedule that is already been published to the Master
Schedule:

• This request will not be scheduled.
• The Agent can view the reason it was not scheduled, in the Reason column.
• The request, with the same status and reason, will appear in the WFM Calendar, where Supervisors can

see it.

However, the supervisor will not know to look for the request unless the agent tells him to look for it.
Therefore, if an agent sees time off requests with status Not Scheduled in the Time Off Planner, she
should alert her supervisor.

The supervisor can then do one of two things:

1. Grant the time off through the WFM Calendar and rebuild/republish the agent’s schedule for the
affected date(s).

2. Manually add the time off to the Master Schedule.

The Time Off Planner gives agents a limited view into their time off status in the WFM Calendar.
Therefore, when a supervisor adds or deletes time off in the WFM Calendar, he must rebuild and
republish the schedule for the affected date(s).

Back to Top

WFM Primers Time Off Primer

Workforce Management Administrator's Guide 327



Overlays Primer
Workforce Management Overlays are events designed to indicate the abnormalities in historical data
or anticipated ones in the future. Abnormalities, such as fluctuation of interaction volumes, AHT
(other than the usual, seasonal fluctuation), or intra-week and intra-day trends. If events occur that
highlight an abnormality, of the type that happens multiple times or can happen in again in the
future, you can arrange these overlay events (or Overlays) into overlay groups. Some examples are
billing, promotion, or catalog drops.

This Overlays topic includes the following sections:

• Impact of Overlay Events on Prediction Data
• Impact of Overlay Events on Historical Data
• Calculating an Overlay's Impact

Impact of Overlay Events on Prediction Data

Overlays impact prediction data directly when a specific overlay event occurs over a prediction
interval.

Two types of overlays exist, based on how the impact on prediction data is calculated:

• Multiplicative—Increase (or decrease) every step of predicted data by a percentage. The percentage
is defined by overlay impact distribution, multiplied by the strength of the event. The duration of the
interval is affected by event changes.

• Overriding—Re-distribute (but does not change) the volume of an event's interval. The total volume
does not change, but it might be moved from one event-step to another.

Multiplicative Overlays
This type of overlay factor has existed in WFM since early versions and was called Factor. Each step
(daily or hourly) of prediction data covered by the event is adjusted by a certain percentage, which is
also multiplied by event strength.

Overriding Overlays
This type of overlay is designed to keep the predicted total of the affected period and adjust the
distribution of the volumes within that period. WFM applies the events of this overlay type as the last
step of the prediction. It applies the seasonal components (intra-day, daily, or yearly) and
multiplicative overlays before the overriding overlays are calculated.

The overriding overlay distributes the volumes according to the weight (or the percentage) of each
event-step (daily or hourly). It adjusts the volume of each event-step, so the event-step receives its
portion of the total of the entire event period, according to its weight.
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For example, an overriding overlay has 3 event-steps with the following weights: 20, 30, 50. If the
predicted total of the entire interval is 1000, then the first event step receives 200, the second 300,
and the last one 500.

Important
The initial predicted total of the event-step is not considered when the impact of this
overlay type is calculated. The weight of the event-step is determined by the overlay
itself, and the predicted total of the entire interval that is affected by the event, is
considered.

When the event-step (daily or hourly) is calculated, its total is distributed proportionally to 15-minute
timesteps to a volume of each timestep before the event was applied. So, the intra-day or intra-hour
pattern is preserved.

The overriding overlay event type cannot be calculated when it overlaps with other events of the
same type, even if both events belong to different overlays. However, it can overlap with events of
multiplicative overlays.

Event Impact Distribution

There are three ways to determine the impact of each event-step:

1. By using start-end.
2. By keeping the entire detailed distribution.
3. By performing the calculation for each event-step during the prediction.

These three methods of determining impact distribution are applicable to both multiplicative and
overriding overlay type. WFM specifies how each overlay's impact distribution will be determined and
applies it to all of the overlay's events.

Start-end

WFM determines the overlay's impact distribution by specifying start and end impact values. It
gradually changes the impact by the same amount every event-step from start value to end value.
For example, if the start value is 100 and the end value is 200 and it is a daily overlay with a length
of 6 days, then the impact on the first day is 100, on the second day it is 120, then 140, 160, 180 and
200 on the last day.

Back to Top

Distribution

The overlay saves the impact of each event-step separately. You can either determine the impact by
precalculating it, by entering it manually, or by using a combination of both methods.
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Always Calculating

The overlay impact is always calculated during the prediction. To ensure the calculation is successful,
the historical period must have one or more events for the same overlay. The impact of the overlay is
determined by the prediction algorithm according to the historical data, and it is then used in the
prediction.

Impact of Overlay Events on Historical Data

Events within any overlay type can have a ignore historical data flag. If this flag is set for an event,
the historical data interval data covered by the event is not used in the calculation of either volume
prediction or impact of overlays (see Calculating an Overlay's Impact).

If an event does not have the ignore historical data flag set, the the data covered by the event is
considered for prediction.

Important
In 7.6.1, WFM does not do perform any additional processing of historical data that is
affected by the event. WFM simply uses it or ignores it.

Calculating an Overlay's Impact

You can determine the impact of overlay by analyzing the historical data and using a prediction
algorithm. The algorithm analyzes the period of historical data, which contains one or more overlay
events to be calculated.

You can pre-calculated Overlays before starting volume forecasting or during volume forecasting
(see, Event Impact Distribution). If the historical data and method used are the same, the results will
be identical.

Impact of Multiplicative Overlays
WFM calculates Multiplicative overlays by separating seasonal component (yearly, daily, intra-day)
from the event impact for each event of the overlay in the given historical data. The impact is divided
by the strength of the event and then averaged.

When the impact of an event is applied to the prediction interval, it is multiplied by the strength of
that event.

Impact of Overriding Overlays
The percentage of each event-step in the total of the whole event period is calculated for each event
and then averaged. For example, a historical period has two daily overlay events that are 3 days
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long. The 3 days of the first event are: 150, 200, 150 (that is 30%. 40%, 30% of the total
respectively) and the 3 days of the second event are: 150, 150, 200. In this example, the overlay is
calculated as 30%, 35%, 35%.

Back to Top
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Multi Forecasting Primer
In this topic, find information about the Workforce Management approach to multi-site forecasting in
a networked contact center, where some call types and activities are distributed to agents working
across multiple sites. It also describes the Genesys approach to multi-skill forecasting, where agents
with multiple skills can increase the center’s efficiency by performing multiple tasks within a single
timestep.

This topic contains the following sub topics:

• Multi-Site Forecasting
• Multi-Skill Forecasting

Multi-Site Forecasting

A contact center analyst can use Genesys WFM to model a networked contact center, where some
call types and activities are distributed to agents working across multiple sites. To model a multi-site
environment, follow the steps and guidelines outlined in these sections:

Set Up Multi-Site Activities
These multi-site activities are work activities that are handled at the site (child) level, and in the
object tree they appear higher in the hierarchy.

Determine the Total Demand
To configure Multi-Site Forecasting (MSF) properly, you need data to inform your choices. To gather
that data, you can configure WFM to collect:

• Historical Interaction Volume (IV) and Average Handle Times (AHT) for multi-site activities
• Historical average handle times at the child level

After you build a volume forecast at the multi-site activity level and understand the total demand for
this call type across all sites, you can configure MSF for two scenarios:

Option A: Contact centers that do a percentage allocation across their sites

To configure for this scenario, perform these steps:

1. Split the volume of the multi-site activity to the site level.
2. Build staffing forecasts at the site level for each child activity.

Option B: Virtual contact centers that do routing based on resource availability, open hours,
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etc.

To configure for this scenario, perform these steps:

1. Split the volume of the multi-site activity to the site level.
2. Build a staffing forecast at the multi-site activity level. (See Figure: Comparing two multi-site scenarios

below.)
3. Split the staffing forecast to each child activity.

Important
The volume split is the required first step, so that the staffing splitting algorithm
understands the demand at each site.

Figure: Comparing two multi-site scenarios

Back to Top

Volume Splitting
In a multi-site enterprise, when you split the volume of multi-site activity interaction to the child sites,
you must decide which Average Handling Time (AHT) to use:

• AHT collected at the multi-site activity level
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• AHT collected at the child activity level

To inform your decision, determine if there is a measurable difference in AHT at the various sites in
the enterprise. For example, if one site consists of many less-skilled agents (perhaps they are new to
their jobs), you may expect to see a longer AHT at this site for some activities. In this case, you would
do well to use the child AHT rather than the multi-site AHT.

After you split the volume to the child sites, decide if you want to:

• Build staffing forecasts for each activity, at the site level
• Build staffing forecast at the multi-site activity level and then split that forecast to the site level

Be aware, when WFM splits the interaction volume to the child sites, the forecast splitting algorithm
considers:

• Agent skills
• Contract availability
• Activity open hours
• Time zones
• Agent hire/termination dates
• Granted, pre-planned items from the WFM Calendar (days off, time off, shifts, working hours,

availability, exceptions, and rotating patterns)

In the figure below, you can see model of the contact center environment that WFM uses when
splitting volumes from the multi-site activity level to the site (child) activity level.
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Figure: Model of Contact Center Environment Used by WFM

Key to Figure: Model of the Contact Center Environment

See more.. [+]
IV—Interaction Volume at the multi-site activity level. There is a separate IV for each of three MSAs
(1, 2, 3)

Arrows—The distribution of the activity work from the multi-site activity level to the site level.

1, 2, 3—These numbers represent MSAs.

AHTsubscript—Average Handle Time. When each MSA is split to the site level, there is a separate set
of AHT values for each activity/site combination. As described above, this is an option. The user
might also choose to use the AHT collected at the multi-site level, in which case, for example, AHT3A
and AHT3B would be equivalent.

Circles—The agent pool at each site. At site A, there are two sets of agents. One set of agents has
skills that qualify them to work on activities 1 and 2. The other set of agents has skills that qualify
them to work on MSAs 1, 2, and 3. At site B, there are also two sets of agents. One set can only work
on activity 2, and the other set can work on either MSA 2 or 3.
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Model of the Contact Center Environment Explained

See more.. [+]
As the activity work is distributed from the multi-site level to the site level, WFM must estimate (for
each timestep) the percentage of time that an agent will be handling each type of activity for which
she is skilled. In some cases, there is only one choice.

For MSA 1: No agents at site B are skilled to handle that activity. Thus, all the workload must be
distributed to site A.

For MSA 3: Agents at both site A and site B who can handle this activity. But the diagram shows
other factors to consider in distributing activity 3 work:

• Not every agent at every site can handle activity 3.
• Some of the agents who can handle activity 3 can also handle other activities.

Therefore, when WFM estimates for each agent how much of each timestep should be allocated to a
certain type of work, WFM will consider:

• The demand for the activity
• The number of agents who can handle that activity across all sites
• The work allocation of these other agents

Volume Splitting Using Percentages

You can specify a percentage to allocate volumes from a multi-site activity to each Child (site) activity
or apply a template. The interval can be the entire forecast scenario, weekday, or timestep.

For more information about this feature, see the Web for Supervisor Help topic Forecast > Forecast
Scenarios > Volume Split Wizard.

Back to Top

Staffing Splitting
As described above in Scenario B, for virtual contact centers, you can build a staffing forecast at the
multi-site activity level and then split that staffing forecast across the child activities. This allows the
enterprise to more accurately model a virtual routing environment where there is an efficiency gain in
the way that calls are handled. WFM recalculates service objectives at this multi-site level and makes
these calculations available in the Performance and Schedule views, and in reports.

When building the staffing forecast at the MSA level, you may specify the indirectly occupied time
(IOT) and service objectives.

However, you cannot specify the hourly wage or paid hours a day when building the MSA staffing
forecast. Instead, you specify those values during the splitting process, when you split the calculated
staffing from the MSA level to the child activity level.
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Important
Before you split the staffing forecast from the MSA level to the child activity level, you
must first split the volume forecast so that the staffing splitting algorithm knows the
resource demand at each site.
The staffing splitting wizard gives you the option to consider the AHT values of the child activities. You can
use it to better estimate how to distribute staffing requirements across child activities.

Although the staffing splitting wizard splits calculated staffing by default, it offers you
the option to split required staffing.

After the staffing split is accomplished, you can view results data for calculated staffing (and
optionally, required staffing) at the child activity level.

You can examine this data at the MSA level or as the sum or weighted average of the child activities,
in these views:

• Schedule Coverage
• Intra-Day Schedule
• Schedule Summary
• Performance views

You can manipulate the MSA staffing results in the same way that you can manipulate child activity
staffing. Forecast graphs are also available for MSA staffing.

Multi-Skill Forecasting

A multi-skilled contact center presents an opportunity for increased productivity.

An agent might be idle in a single-skill environment because she cannot answer calls that are
queuing for an activity/skill which she may posses—but a skill that the schedule prevents her from
using.

In a multi-skilled environment, she can use her additional skills to answer those calls.

Important
A high-load environment does not present much opportunity for increased efficiency,
because the agents have very little idle time. However, in an overstaffed
environment, agents have more idle time and can use their multiple skills to increase
efficiency.
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How WFM Supports Multi-Skilled Agents
A multi-skilled agent is qualified to work on multiple activities, and therefore may perform different
types of work during a shift.

In a multi-skill environment, an agent might be available for multiple activities during any timestep.
That agent can be scheduled to work for an activity for only part of a time interval, and only the
fraction of the time period during which she or he works is counted.

Because of this, the value for staffing can be expressed as a fraction. Consider the following example
of a 15-minute timestep:

Example: An agent is scheduled to work on Activity A for 10 minutes and for 5 minutes on Activity B.
She is counted as 2/3 (or .667) of an agent for Activity A, and as 1/3 (or .333) of an agent for Activity
B.

Back to Top

Enabling Multi-Skill Support

Display procedure..[+]
To enable multi-skill support, follow these steps:

1. Open Genesys Administrator.
2. Open the WFM Server Application.
3. From the Options tab, open the section ScheduleService.
4. Create a new option named SplitMS and set the value to true. (See figure below.)

Figure: Enable Multi-Skill Support

Calculating Multi-Skill Equivalents
Consider the comparison of Single Skill Equivalents (SSE) to Multi-Skill Equivalents (MSE) in the figure
below.

The Multi-Skilled forecasting algorithm takes into account how many agents (with their various skill
sets) could be available to work on each Activity, as well as how the occupancy of an average agent
would be divided among this Activity and the other Activities on which the agent could work.
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Figure: Comparing Multi-Skill and Single-Skill Equivalents

When building a schedule, WFM can optionally use the staffing forecast in Multi-Skilled Equivalents
(MSEs) while taking into account agents that the schedule is being built for, as well as agents for
whom schedules have already been built.

If the MSE option is set, in the Performance views/reports and Schedule views/reports, coverage for
an Activity is based on MSEs, calculated from actual agent schedules. See the figure below, which
depicts multi-skill gains.

Figure: Multi-Skill Gains

Back to Top
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Using Copy-and-Paste Format for Statistics
In this topic, find four examples of the statistics that are defined in the topic WFM Statistics:
Recommended Settings. Use these examples only as generic starting points for your configuration,
making the modifications necessary to ensure they function properly within your environment.

These statistics do not include any of the required filters or timeranges; those items are specific to
your installation. Add these filters only if they are missing from the relevant section(s) of your
configuration.

This topic contains the following sections:

• Using the Copy-and-Paste Format
• Multimedia Statistics for E-mail Interactions
• Statistics for Chat Interactions
• Statistics for intelligent Workload Distribution Interactions
• Statistics for Voice Interactions

Using the Copy-and-Paste Format

All of the statistics in this topic appear in this format:

[WFMTotalNumberCallsEntered]
Category=TotalNumber
MainMask=CallEntered
Description=The total number of interactions
Subject=DNAction
Objects=Queue,RoutePoint,GroupQueues

You can amend the text within the square brackets (use underscores rather than spaces) and the
description line. For example, you could change the above example to this:

[Special_Call_Entered_Stat_4_Steve]
Category=TotalNumber
MainMask=CallEntered
Description=This reflects the number of inbound calls received
through a queue
Subject=DNAction
Objects=Queue,RoutePoint,GroupQueues

Back to Top
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Multimedia Statistics for E-mail Interactions

[WFM_Email_Entered]
AggregationType=Total
Category=JavaCategory
Description=The total number of interactions
JavaSubCategory=eServiceInteractionStat.jar:EQR Total Entered
Objects=StagingArea
[WFM_Email_Handle_Time]
Category=TotalTime
MainMask=InteractionHandling
Description=Total time spent handling interactions
Objects=Agent,GroupAgents,GroupPlaces,Place
Subject=AgentStatus
[WFM_Email_Handled]
Category=TotalNumber
MainMask=InteractionHandling
Description=Total number of interactions handled
Objects=Agent,GroupAgents,GroupPlaces,Place
Subject=DNAction

Back to Top

Statistics for Chat Interactions

[WFM_Chat_Entered]
AggregationType=Total
Category=JavaCategory
Description=The total number of interactions
JavaSubCategory=eServiceInteractionStat.jar:OMQ Total Entered
Objects=StagingArea
MediaType=chat
[WFM_Chat_Abandoned]
AggregationType=Total
Category=JavaCategory
Description=The total abandoned from queue
JavaSubCategory=eServiceInteractionStat.jar:OMQ Total Abandoned
Objects=StagingArea
MediaType=chat
[WFM_Chat_Average_Speed_Answer]
AggregationType=Total
Category=JavaCategory
Description=Average time taken to answer
JavaSubCategory=eServiceInteractionStat.jar:OMQ Average Waiting Time
Objects=StagingArea
MediaType=chat
[WFM_Chat_Total_Distributed]
AggregationType=Total
Category=JavaCategory
Description=Total Distributed
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JavaSubCategory=eServiceInteractionStat.jar:OMQ Total Distributed
Objects=StagingArea
MediaType=chat
[WFM_Chat_Handle_Time]
Category=TotalTime
MainMask=InteractionHandling
Description=Total time spent handling interactions
Objects=Agent,GroupAgents,GroupPlaces,Place
Subject=AgentStatus
[WFM_Chat_Handled]
Category=TotalNumber
MainMask=InteractionHandling
Description=Total number of interactions handled
Objects=Agent,GroupAgents,GroupPlaces,Place
Subject=DNAction

Back to Top

Statistics for intelligent Workload Distribution Interactions

[WFM_OMedia_Entered]
AggregationType=Total
Category=JavaCategory
Description=The total number of interactions
JavaSubCategory=eServiceInteractionStat.jar:OMQ Total Entered
Objects=StagingArea
MediaType=MediaX
[WFM_OMedia_Abandoned]
AggregationType=Total
Category=JavaCategory
Description=The total abandoned from queue
JavaSubCategory=eServiceInteractionStat.jar:OMQ Total Abandoned
Objects=StagingArea
MediaType=MediaX
[WFM_OMedia_Average_Speed_Answer]
AggregationType=Total
Category=JavaCategory
Description=Average time taken to answer
JavaSubCategory=eServiceInteractionStat.jar:OMQ Average Waiting Time
Objects=StagingArea
MediaType=MediaX
[WFM_OMedia_Total_Distributed]
AggregationType=Total
Category=JavaCategory
Description=Total Distributed
JavaSubCategory=eServiceInteractionStat.jar:OMQ Total Distributed
Objects=StagingArea
MediaType=MediaX
[WFM_OMedia_Handle_Time]
Category=TotalTime
MainMask=InteractionHandling
Description=Total time spent handling interactions
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Objects=Agent,GroupAgents,GroupPlaces,Place
Subject=AgentStatus
[WFM_OMedia_Handled]
Category=TotalNumber
MainMask=InteractionHandling
Description=Total number of interactions handled
Objects=Agent,GroupAgents,GroupPlaces,Place
Subject=DNAction

Back to Top

Statistics for Voice Interactions

[WFMTotalNumberCallsEntered]
Category=TotalNumber
MainMask=CallEntered
Subject=DNAction
Objects=Queue,RoutePoint,GroupQueues
[WFMTotalNumberCallsAband]
Category=TotalNumber
MainMask=CallAbandoned, CallAbandonedFromRinging
Subject=DNAction
Objects=Queue,RoutePoint,GroupQueues
[WFMTotalNumberCallsDistrib]
Category=TotalNumber
MainMask=CallDistributed
Subject=DNAction
Objects=Queue,RoutePoint,GroupQueues
[WFMServiceFactor1]
Category=ServiceFactor1
MainMask=CallAnswered,CallAbandoned,CallAbandonedFromRinging
Subject=DNAction
Objects=Queue, RoutePoint, GroupQueues
[WFMAverTimeBeforeAnswering]
Category=AverageTime
MainMask=CallAnswered
RelMask=CallAnswered
Subject=DNAction
Objects=Queue, RoutePoint, GroupQueues
[WFMTotalHandleTime]
Category=TotalAdjustedTime
MainMask=CallInbound, CallOutbound, AfterCallWork
Subject=DNAction
Objects=Agent, Place,GroupAgents,GroupPlaces
[WFMTotalNumberCallsHandled]
Category=TotalNumber
MainMask=CallInbound,CallOutbound
Subject=DNAction
Objects=Agent,Place,GroupAgents,GroupPlaces

Back to Top
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MS SQL Database Replication
In this topic, find information that will help you to replicate and maintain your MS SQL database for
your Workforce Management deployment, based on the assumption that there is an existing single
database instance.

Before you begin replicating the database, ensure that the existing instance is updated to the latest
version. For new WFM installations, create a database as described in Create Your WFM Database.

This topic includes the following sections:

• System Requirements
• Setting Up the Database Replication
• Maintaining Database Replication
• Application-Level Access Limitations

System Requirements

The replication solution requires MS SQL Server 2008 R2 Enterprise Edition server.

Setting Up the Database Replication
There are two ways to set up the replication: copying during replication and
copying before replication. Display procedures... [+]
<multistep> |-| Copying During Replication=

Purpose: To create a copy of ? the during replication.

Prerequisite: Your original WFM database has been updated to the latest WFM Database version (if
it is not a new installation of WFM).

Start of Procedure

1. Make a WFM Database Utility (DBU) backup of the original database.
2. Create new database instances in all locations; On each instance, run the WFM Database Utility (DBU)

to create the WFM table structure. (In this case, the original WFM database is not used.)
3. Set up replication:

a. Enable distribution on all servers manually, or by using a script named 1 Before Replication.
Enable Distribution - run on all servers.sql, that is provided by the DBU in the
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installation directory \scripts\.
b. Create a Publication on one Database Server manually, or by using the script named 2 Before

Replication. Create Publication - run on one server only.sql, that is provided by the
DBU in the installation directory \scripts\.

c. Make the Publication peer-to-peer manually, or by using the script named 3 Before Replication.
Enable Peer-To-Peer Replication - run on one server only.sql, that is provided by the
DBU in the installation directory \scripts\.

Important
For the scripts listed in steps 3a, 3b, and 3c, specific Database Server
names—and in some cases, other information, such as database name, files
location, publication name, user login, and password—must be entered into
the script before running it.

d. Configure the ranges for the primary key values. Identity value ranges must be assigned for
replicated tables which use auto-incremented identify fields. WFM Database Utility provides a
script named 4 Reseed. Change Identify Field Ranges - run on all servers.sql, that you
can find in the installation directory \scripts\.

Important
The identity ranges on each database instance must be unique and values in the script must be modified
manually, based on the number of database instances used.

5. Restore the WFM DBU database backup (from Step 1 above) to any single database instance.

Restored data is synchronized across all locations by MSSQL Server replication.

End of Procedure

|-| Copying Before Replication=

Purpose: To create a copy of ? the before replication.

Prerequisite: Your original WFM database has been updated to the latest WFM Database version (if
it is not a new installation of WFM).

Start of Procedure

1. Back up your WFM database, using DBU backup or MSSQL backup tools.
2. Create new additional database instances, if needed. (In this case, the original WFM database is not

used.)
3. Create and restore the database on each new instance using WFM Database Utility or restore the

MSSQL backup from Step 1.
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4. Set up replication:
a. Enable distribution on all servers manually, or by using a script named 1 Before Replication.

Enable Distribution - run on all servers.sql, that is provided by the DBU in the
installation directory \scripts\.

b. Create a Publication on one Database Server manually, or by using the script named 2 Before
Replication. Create Publication - run on one server only.sql, that is provided by the
DBU in the installation directory \scripts\.

c. Make the Publication peer-to-peer manually, or by using the script named 3 Before Replication.
Enable Peer-To-Peer Replication - run on one server only.sql, that is provided by the
DBU in the installation directory \scripts\.

Important
For the scripts listed in steps 4a, 4b, and 4c, specific Database Server
names—and in some cases, other information, such as database name, files
location, publication name, user login, and password—must be entered into
the script before running it.

d. Configure the ranges for the primary key values. Identity value ranges must be assigned for
replicated tables which use auto-incremented identify fields. WFM Database Utility provides a
script named 4 Reseed. Change Identify Field Ranges - run on all servers.sql, that you
can find in the installation directory \scripts\.

Important
The identity ranges on each database instance must be unique and values in the script must be modified
manually, based on the number of database instances used.

End of Procedure

</multistep>

Back to Top

Maintaining Database Replication
After you have backed up your database, you can use the procedure and other
information in this section to restore it. Display procedure... [+]

Copying During Replication
Purpose: To restore a back up of the replicated database.
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Start of Procedure

1. Verify that none of the database instances are in use.
2. For MSSQL backups, use Microsoft tools and documentation to restore the backup of the replicated

database.
3. For WFM Database Utility backups, use the Database Restore functionality on a single instance of the

database.

All data will be replicated and synchronized across the instances.

End of Procedure

Replication Issues
Due to unforeseen usage scenarios or operational mistakes in access rights configuration, there
might be occasional data collisions caused by replication. Solve these collisions on a case-by-case
basis, using MSSQL conflict resolution tools.

Back to Top

Application-Level Access Limitations

Genesys recommends that you deploy the WFM application so that all actively running WFM Server
and WFM Data Aggregator components access the same database instance. (Actively running means
that these components are updating the database.) You could set up WFM Configuration Utility
instances to access and write to different instances of database; If you do, Genesys recommends
certain applications and user restrictions (see Site Access Rights and Module Access Rights.

Using certain deployment and access limitations ensures that multiple database instances are not
modifying the same data at the same time. The MSSQL database replication does not resolve data
collisions caused by complex simultaneous modifications of the same data records on different
database instances. To prevent collisions on the application level, assign access rights and restrict
certain functionality so that it is performed only on the main database instance.

Site Access Rights
When you are configuring the system you must decide which site will be configured by using WFM
Configuration Utility, and on which database instance.

For users who connect to that instance and want to change the data by using WFM Configuration
Utility, you must limit access to only those sites that are to be modified in that particular database
instance.

Module Access Rights
The WFM Configuration Utility contains functionality that involves the modification of data for
multiple sites, or data that is not related to a site object and therefore, cannot be protected by site
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access rights. There are also subsystems which provide access to data that is also modified by WFM
Server through the WFM Web interface. Accessibility to this functionality must be limited only to
users who are connecting to the main database by using the Configuration Utility.

The following list of subsystems, menu items, or functions must be restricted in local database
instances, and be available only to users who are connecting to the main database server.

• Main Synchronization—Security option: General > Allow synchronization

• Agents Update—Security option: General > Allow synchronization

• Global Settings—Security option General > Allow to modify Global settings

• User Security—Security option Configuration > User Security

• Skills—Security option Configuration > Skills

• Time Zones—Security option Configuration > Time Zones

• Organization/BU, Sites—Enable only the security option Configuration > Organization >
Add/Edit/Delete

• Organization Teams—These can be accessible on remote sites, but only in read only mode. Enable only
the security option Configuration > Organization > Read

• Schedule State Groups—Enable only the security option Configuration > Schedule State Groups

Important
On the Master database, users must enable both options: Modules > Configuration
> Organization > Read and Modules > Configuration > Organization >
Add/Edit/Delete. This setting enables users to perform any action on BUs, Sites and
Teams.
In Remote locations, users must enable only Modules > Configuration > Organization > Read. This
setting enables users to move agents between teams, but they cannot delete or create a BU, site or team.

Disable the Modules > Configuration > Organization > Add/Edit/Delete option for
users who connect to and work on remote locations or databases.

Back to Top
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List of Terms
Many important terms are used throughout the Workforce Management (WFM) application and
documentation. This page lists these terms and their definitions in alphabetical order. (Click the
appropriate tab.)

A

Abandonment Percentage

The percentage of interactions in which the customer ends the interaction before an agent begins
handling it. You can set a value for this service objective in the Forecast module’s Staffing Build
Wizard in WFM Web.

Accrual Rule

See Time-Off Rule.

Activities Groups

Activities Groups are lists that you create. They contain more than one activity, but can be
manipulated like a single activity, to avoid repetitive tasks, such as configuring a dozen activities for
the same agent.

Activity

WFM database objects that represent contact center tasks in which agents can be engaged. You can
track and manage these activities through the WFM Web Forecast, Schedule, and Performance
modules. You can schedule up to 100 Activity objects simultaneously for each site, depending on
your specific needs.

There are three types of activities: immediate work, deferred work, and fixedstaff work. These were
formerly called phone activity, multimedia activity, and exclusive activity, respectively.

See also Multi-Site Activity and Activities Groups.

Back to Top
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Activity Set

An activity or group of activities that you can assign to multi-skilled agents for a specified period of
time. During that time, the agents can work on no other activities. If the Activity Set was created with
strict checked selected, then Scheduler cannot schedule meals at times that would interrupt the
activity set.

Adherence

A WFM function that enables you to view agent real-time adherence. After you have created the
forecast and schedule, adherence shows how closely the actual agent behavior matches (complies
with) the schedule. You can configure the length of time that an agent can deviate from the schedule
and continue to comply with it. See also Performance.

Agent

A database object imported from the Configuration Database that represents a contact center
employee. In the WFM Configuration Utility, you can assign Agent objects a number of additional
properties that pertain specifically to the WFM environment.

Back to Top

Agent State

See Schedule State Group.

Agents Logged In

See Working Agents.

Alert

A Performance module function indicating that administrator action might be necessary. For example,
too many calls are being abandoned, or too few agents are logged in.

The Alert function uses Master Forecast and Master Schedule data as a baseline for performance
levels. The alert appears when current performance statistics deviate from the forecasted or
scheduled levels by an amount that you specify.
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Back to Top

Alternative Break

Not used in WFM 7.0 or later.

Alternative Time Zone

See User Time Zone.

Application Template

An object in Configuration Manager that contains the default configuration information for an
application. WFM requires the following application templates: WFM Client (for the WFM
Configuration Utility and the WFM Database Utility), WFM Server, WFM Data Aggregator, WFM Web,
WFM Builder, and WFM Daemon. Application templates are used only in Configuration Manager, when
installing applications.

Back to Top

Aux Code

See Reason Code.

Availability

A contract parameter that indicates the time period during which an agent is prepared to work. Shifts
should fall within the availability period.

Agents can also make personal availability preferences. These personal preferences, if granted,
override the agent’s contract availability settings.

Availability Pattern

A one-week set of preferred availability, with start times and durations specified for each day. Each
agent creates his or her own availability by using WFM Web for Agents.

Back to Top
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Availability Preference

A Preference that enables an agent to request specific hours during which they are available to work
for single or multiple days. Supervisors grant or decline availability preferences for the whole request
period or day-by-day. If they are not granted, availability preferences are treated similarly to shift and
day-off preferences. If they are granted, they override the agent’s Contract availability settings.

Average Handle Time

Also known as AHT. The average amount of time it takes incoming interactions to be distributed to
agents. You can configure this statistic in the Configuration Utility to include noninteraction time,
such as After-Call Work, as a part of the AHT.

Average Speed of Answer

Also known as ASA. The average amount of time agents take to respond to incoming interactions.
WFM uses this statistic to calculate staffing forecasts, and as a basis for contact center performance
values.

Average Time to Abandon

Also known as ATA. The average amount of time that callers wait in the queue before abandonment.
The calculation considers only the calls that are abandoned.

Back to Top

B

Backup/Restore Utility

See WFM Database Utility.

Bonus Time-Off Hours

Extra time off that is assigned to an agent in addition to regularly accrued or awarded time off. Bonus
time off is included in time-off hours carried over, if the allowable number of hours carried over is
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large enough to accommodate it. You configure time-off rules by using the Time-Off Rules module in
the WFM Configuration Utility.

Break

A short rest period during an agent’s scheduled work time. Breaks can be paid or unpaid.

Budget

An estimated budget based on working hours and the hourly rate of the contact center staffing
forecast. The budget is calculated in the staffing forecast, using an average of the number of working
hours and the average hourly wage for each contract, multiplied by the number of agents of each
contract type. The budget is also displayed in the Schedule Summary view as the estimated cost of a
schedule.

Business Unit

A database object that represents activities performed at multiple sites. You create business units in
the WFM Configuration Utility and assign already existing sites to them. A site can belong to only one
business unit. Formerly called virtual PABX, virtual switch, or virtual contact center.

Business Unit Staffing

The total staffing requirements for a business unit. Staffing requirements are different for each
activity within the business unit. A staffing requirement forecast may be calculated at the business
unit level and then split to the individual sites that handle the activities. Or, you can build staffing
requirement forecasts separately for each site included within the business unit.

The approach that you take will depend on the type of routing used within the business unit.

Back to Top

C

Calculated Staffing

A staffing forecast based on an interaction volume/AHT forecast, using service-objective criteria that
you specify while building the staffing forecast.
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Calendar

A WFM feature located in WFM Web for Supervisors that enables supervisors with appropriate
security access to view, add, modify, and delete availability, exceptions, working hours, shifts, and
time off for a site, team, or agent. You can view and modify preference statuses by using the
Calendar. You also set time-off limits in the Calendar module. Formerly called Planner.

Calendar Item

Each shift, exception, preference, and so on that appears on the Calendar. You can add and edit
Calendar items and, when appropriate, change their status.

Calendar Logic

The hierarchical ranking of exceptions, preferences, shifts, working hours, time off, and availability
used in the Calendar and by Scheduler. This ranking indicates to Scheduler which items must be
incorporated and, among those that can be either incorporated or denied, which should be allotted
first. Granted items are incorporated into schedules; Preferred items might be incorporated,
depending on other scheduling constraints. The hierarchy determines which item takes priority when
more than one is entered for the same agent at the same time.

Back to Top

Call Volume

See Interaction Volume.

Carry-Over

A date that you define, on which a specified number of each agent’s total timeoff hours (unused
time-off hours plus any bonus time-off hours) are transferred forward to the new year. You must set
the number of hours that can be transferred for each agent.

See also Time-Off Rule.

Comments

Information about agents, workload forecasts, staffing forecasts, and schedules that you enter in
special dialog boxes within WFM Web.
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Compliance

See Adherence.

Back to Top

Configuration Component

A set of objects created in Configuration Manager and the WFM Configuration Utility that defines
some aspect of the WFM environment.

Configuration Manager

A Genesys Framework tool that you use to set up the database environment during installation of any
Genesys product, release 6 or later. You use Configuration Manager to configure WFM application
settings, and connections between WFM and other Genesys components, such as Stat Server and
Configuration Server.

Consistency Check

An automatic assessment for some user-entered settings that enables WFM to identify some
incompatible constraints. For example, WFM checks part-day exceptions to determine whether they
are valid or invalid, and it checks contract working hour and working day settings for internal
consistency.

Contact Center

See Site.

Contract

Describes categories of employees for scheduling and tracking purposes—for example, full-time,
part-time, seasonal, contractor, salaried, and commissioned. Contract parameters include working
hours, settings for required days off, and profile agent configuration. Formerly called employment
type.

Back to Top
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D

Data Aggregator

See WFM Data Aggregator.

Daylight Savings Information

Time offsets that you configure to ensure that WFM takes daylight saving time into account when
creating forecasts, schedules, adherence and performance monitoring, and reports. Formerly called
PABX time offset information.

E

Employee

See Agent.

Employment Type

See Contract.

Error

See Schedule Validation Error.

Event

A specific instance when a factor is in effect. You define an event by specifying the appropriate factor
and the dates when it will affect site operations. Examples of events include advertising campaigns,
catalog mailings, and holidays that affect interaction volume. You do not have to specify events for
forecasting, but events provide a useful tool for fine-tuning an interaction volume forecast.

See also Factor.
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Exception

Any time during an agent’s schedule when the agent is not performing activity work. Examples of
exceptions include long lunches, meetings, training, and child care.

See also Exception Type.

Back to Top

Exception Type

A category, that you define, of time off or non-activity work that affects scheduling. Exception types
are created to fit the business rules for a site. Exception types include information on compensation,
whether the exception is a working or nonworking exception, and whether the exception type should
be used when scheduling meetings.

See also Exception.

Exclusivity Set

See Activity Set.

Expert Average Engine

A forecasting method that uses statistical analysis of historical data to produce day-of-week, weekly,
and (if sufficient historical data exists) yearly trend patterns. At least one full week of historical data
is required in order to use the Expert Average Engine; at least six weeks is recommended for high-
quality daily and weekly results. The impact of events, such as marketing campaigns, is applied
directly to the forecast day-of-week and weekly curves. For this reason, this engine is best suited to
sites with fairly stable interaction patterns.

Exporting

Enables you to save forecast and historical data to files that you specify. You perform exports by
using the Import/Export Data module in the WFM Configuration Utility. See also Importing.

Extracting

Enables you to extract the forecast and schedule information in the Master Forecast and in the
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Master Schedule in the Workforce Management database to scenarios that you specify. You extract
data by using the Publish Forecast or Publish Schedule functions in WFM Web.

See also Master Forecast and Master Schedule.

Back to Top

F

Factor

Anything that is expected to affect the interaction volume for particular activities, and therefore staff
and schedule requirements. For example, a special promotion or a new advertising campaign may
require additional staff. WFM takes such factors into consideration as it forecasts agent requirements
and creates schedules. Events are built based on factors.

See also Event.

Filter

An option for changing the view settings of a WFM Web for Supervisors window.

Forecast

A prediction of interaction volume and average handling time for a future period, based on historical
information for similar periods. If sufficient historical data is unavailable, WFM creates forecasts from
templates or numbers that you enter.

Historical data is collected automatically from Stat Server for all types of transactions by using
computer-telephony integration (CTI), an event-based technology, rather than automatic call
distribution (ACD) sampled data. This makes it possible to forecast for any media type.

Full-Time Equivalent

Also known as an FTE. An abstract term used to quantify a forecast and budget in tangible, human
terms. For information about how WFM calculates an FTE, see Endnote 1.

Back to Top
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H

Headcount

The number of agents scheduled for a certain timestep. For more information, see Number of
Agents—Scheduled.

Historical Data

Records of previous contact center performance stored in the WFM database. You can import
historical data that was collected prior to installation of WFM if it is in the form of comma-delimited
text files (CSV format). Large amounts of reliable historical data are the most accurate basis for
forecasting.

Hot Standby

A high-availability architecture that includes a second WFM Data Aggregator server that is initialized
and ready to take over if the primary server terminates unexpectedly. The second server is
synchronized with the first, so there is no loss of data during the transition.

Back to Top

I

Importing

Enables you to apply previously collected historical data to new forecasts by using the Import/
Export Data module in the WFM Configuration Utility to import the historical data. Importing
historical data is usually part of the initial WFM configuration. Afterward, WFM Data Aggregator
collects historical data automatically as it runs, or, if you prefer, you can import historical data
manually on a regular basis.

See also Exporting.
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Indirectly Occupied Time

The percentage of time that agents are scheduled for work but are not directly interacting with
customers. For example, agents might be starting their computers, or they might be away from their
desks.

Interaction Volume

The number of interactions per a specific unit, such as timestep, day, month, and so on. Interactions
may include not only calls, but also e-mail, faxes, Web-based chats, and so on.

Intra-Day Schedule

A section of the Schedule module that displays the schedule for the selected day(s).

Intra-Day Views

Schedule and performance information displayed in WFM Web.

The Schedule Intra-Day windows show agent schedules for the current day and enable you to
make immediate adjustments to the schedule when necessary—for example, moving or cancelling
breaks during an unexpectedly busy period.

Through graphs and tables, the Performance Intra-Day window displays the current day’s actual
versus scheduled status.

Back to Top

L

Log Files

Files that contain information about what a component does and how it is performing. You (or
Genesys Customer Care) can use log files for error tracking. Each WFM component uses its own log
file, which is usually stored in the Workforce\Logs directory. If you are using the Framework
Management Layer, you can send status information for WFM Server, WFM Builder, WFM Daemon,
and WFM Data Aggregator to the Centralized Logging console.
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Long Period

See Schedule Planning Period.

M

Marked Time

A period that you have indicated in one of the Schedule Intra-Day views as belonging to one of the
marked-time types configured in the WFM Configuration Utility Marked Time module. You can
configure as many marked-time types as you want.

Marked time is extremely flexible. It can be used to distinguish any period that you want to view and
report on as belonging to a specific category. For example, you might use marked time to indicate
overtime hours, so that you can view them in the Schedule Marked Time Report or the Schedule
Marked Time Totals Report.

Master Forecast

A forecast published to the WFM database that is available to any authorized user at any time. If you
want, you can extract forecast data from the Master Forecast to a scenario of your choosing.

See also Extracting.

Master Schedule

A schedule published to the WFM database that is available to any authorized user at any time. If you
want, you can extract schedule data from the Master Schedule to a scenario of your choosing. You
must have data published to the Master Forecast for a particular time range in order to build useful
schedule scenarios. Otherwise, the Scheduler will have no target staffing requirements against which
to build the schedule.

See also Extracting.

Maximum Occupancy

The maximum percentage of time that an agent is working while logged in. This is a service objective
that can be specified when building a staffing forecast.
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Meal

A specific break period during an agent’s scheduled work time, usually paid.

Meeting

An exception type that you configure using the Meeting Planner or the Meeting Scheduler. Scheduler
sets the time for meetings after you specify all attendees and meeting parameters (possible dates
and time, recurrence rules, and so on). The scheduling algorithm finds the optimum time to schedule
the meeting while it builds agent schedules, and it adds a Meeting exception to each attendee’s
schedule. You can also manually assign meetings to agents at any time.

Modules Pane

A section of the WFM Web for Supervisors and WFM Configuration Utility interfaces. You use this pane
to select the module that you want to use on the working pane of the interface. The modules that are
available depend on your security permissions. See also User Security.

Multi-Site Activity

A collection of activities performed at multiple physical sites. Multi-site activities enable you to view
several local activities as one WFM object. The performance information is split among the sites that
perform the activity. You can build interaction volume forecasts, staffing forecasts, and view contact
center performance for multi-site activities. Formerly called virtual activity.

See also Activity and Multi-Site Activity Forecast.

Back to Top

Multi-Site Activity Forecast

A forecast for an activity that is composed of various single-site activities at multiple local sites.
Creating forecasts for multi-site activities is slightly different than for single-site activities. Because
multi-site activities are split among different sites, you must also split the forecast interaction volume
and staffing requirements. Formerly call virtual forecast.

See also Multi-Site Activity.
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Multi-Skilled Agent

An agent who is qualified to work on multiple activities, and who might therefore be performing
various different types of work during a shift. Multi-skilled agents can greatly increase contact center
efficiency. However, if multi-skilled agents are receiving too many interaction types to handle
productively, you can control the types of activities they do during set parts of the day, using task
sequences. See also Task Sequence.

Multi-Skilled Equivalent

Sometimes referred to as MSE. A WFM calculation of the number of agents required in order to handle
the forecast workload, which includes and accounts for agents who have multiple skills. An agent can
be scheduled to work only part of a time interval, and only the fraction of the time period during
which she works is counted—and the value for staffing is expressed as a fraction.

The Multi-Skilled forecasting algorithm takes into account how many agents (with their various skill
sets) could be available to work on each Activity, as well as how the occupancy of an average agent
would be divided among this Activity and the other Activities on which the agent could work.

When building a schedule, WFM can optionally create the staffing forecast in MSEs while taking into
account those agents for whom the schedule is being built, as well as those agents for whom
schedules have already been built.

Back to Top

N

Number of Agents

The headcount scheduled for a certain timestep. Also known as Agents in Seats. For more
information, see Number of Agents—Scheduled.

O

Objects Pane

A section of the WFM Web for Supervisors and WFM Configuration Utility interfaces. You use this pane
to select the specific object or objects to configure, or about which to view data, on the working pane
of the interface. The objects that are available for selection on the Objects pane vary, depending on
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your selection on the Modules pane and your security permissions.

See also Modules Pane and User Security.

Optimization

The degree to which a schedule precisely correlates staffing levels with staffing requirements.
Optimization is always a goal, but you can set it to be a higher or lower priority, depending on how
many agent preferences should be fulfilled. Configuring optimization allows a balance between agent
satisfaction levels and workload demands.

Overlap Template

A type of forecast template that you can use to replace historical data in a forecast. For example, if
you have no historical data for a certain time period, apply an overlap template to fill in the gap.

Overstaffing

More agents have been scheduled than are required for the workload.

Overtime

Hours worked over and above the standard working hours. You configure overtime rules in WFM Web
for Supervisor in the Schedule > Master Schedule > Overtime Requirements module.

Back to Top

P

PABX

See Site.

List of Terms Multi Forecasting Primer

Workforce Management Administrator's Guide 364



Paid Hours

The total number of hours that an agent works, including meals and paid breaks. This number may
not correspond to the total number of hours the agent spends at work, because it does not include
unpaid time, such as unpaid breaks.

Pending Schedule Changes

Changes to the Master Schedule or a schedule scenario made by a user who does not have the
Approve Changes security permission enabled. Pending changes are visible only to the user who
created them, and to the qualified user who reviews them and decides whether they should be
included in the official version of the schedule.

Performance

A measure of the extent to which actual site indicators, such as average speed of answer, service
level, interaction volume, and so on, correspond with the forecast and scheduled values. You can
track performance by using the Performance module in WFM Web for Supervisors.

Planned Overhead

The percentage of time that agents are not handling interactions or performing direct contact center
work. For example, an agent might be taking a break, participating in a training session, or meeting
with peers or supervisors. Formerly named Working Overhead.

Planner

See Calendar.

Planner Logic

See Calendar Logic.

Back to Top
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Policies Object

A configuration object that defines a rule governing the work schedules of agents. Policies objects
include agent work times, break times, available shifts, and any other constraints that affect
scheduling, whether set by the company, labor unions, country or local laws, or any other source. You
define these policies as WFM objects by using the WFM Configuration Utility. WFM then considers
them when making forecasts and creating schedules.

Preference Fulfillment

The percentage of schedule variations requested by agents, such as days off, specific shift times, and
availability, that were assigned in the schedule. Because having preferences scheduled is important
for agent satisfaction, WFM enables specified levels of preference fulfillment to be included in the
schedule building process. You can also set priorities for which agents’ preferences are most likely to
be fulfilled, based on rank, seniority, or both.

Preferences

Agent requests for particular shifts, days off, availability, and time off.

Profile

An agent type that you define, composed of a contract plus a skill set, or based on an actual agent.
Scheduler uses profiles to create a type of generic schedule called a Profile Schedule to which you
can then assign actual agents.

See also Profile Schedule and Scheduling, Profile-Based.

Profile Schedule

A schedule created using profiles. You can create a schedule by using only profiles, or by using a
combination of profiles and actual agents. You can assign to profile schedule slots agents who are not
already incorporated into the schedule as real agents.

Publishing

Publishing saves a forecast scenario to the database, which means that you can use the forecast to
create agent schedules. A published forecast is available to any authorized user at any time. This
forecast is called the Master Forecast.
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Publishing a schedule saves schedule scenario data to the Master Schedule in the WFM database.
Until you publish a schedule, it is not available for tracking in the Adherence and Performance
modules.

Back to Top

Q

Quality of Service

One or more statistics that WFM uses to compare the actual values with the service objectives
projected in the schedule for each activity. This includes statistics that track service level and
average speed of answer. It is used for immediate activities.

R

Real-Time Agent Adherence

A WFM feature that shows monitors how well agents are complying with their schedules.

Reason Code

Information entered by an agent that supplements real-time agent states. A reason helps define the
precise nature of the agent state to which it is attached. To use reasons, you must have either a
switch that supports the inclusion of reason codes with Genesys TEvents or a custom agent desktop
that adds reason codes. Formerly called aux code.

Report Viewer

A WFM module that displays all information contained in reports, prints the reports, or exports them
to files in various formats.

Required Staffing

Staffing requirements that you set, in contrast to those established by WFM. You can set these
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requirements well in advance for hiring and budgeting purposes, and then compare these
requirements to the staffing forecast generated using historical data or templates. Use of required
staffing is optional. You can enter required staffing information in the Staffing Intraday window or
load it from the appropriate template. You can also copy it from calculated staffing forecast data.

Back to Top

Rescheduling

The process of rebuilding a schedule after the schedule has been modified.

Rotating Pattern

A set of weekly schedule patterns that you can have Scheduler assign to agents. The weekly pattern
can include a combination of shifts, days off, specified working hours, and availability periods. For
example, you can define a weekly pattern called Weekends Off (WOff) and one called Monday and
Tuesday Off (MTOff), and then create a rotating pattern consisting of a 4-week sequence of three
WOff shifts followed by one MTOff shift. This ability to create rotating shift sequences permits
enormous scheduling control.

Rotating Schedule

See Rotating Pattern.

Back to Top

S

Schedule

An arrangement of shifts, breaks, meals, exceptions, and so on, based on the predicted workload and
the available agent pool. WFM builds schedules that are optimized within the site’s business
constraints. Constraints include available people with required skills, service-objective requirements,
employment contracts, business policies, and agent preferences. An optimized schedule ensures the
least-possible overstaffing while still meeting service objectives.
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Schedule Coverage

How well a schedule covers the forecasted staffing requirements.

Schedule Planning Period

A period of time that you set, from two to six weeks or a calendar month, which Scheduler then uses
when assigning working hours and required days off. The schedule planning period enables
supervisors to ensure that agents receive the number of hours and days off specified in their
contracts. WFM runs a consistency check to identify cases in which the settings for weekly working
hours are inconsistent with those assigned for the schedule planning period.

Important
Although the consistency checks are designed to eliminate as many inconsistencies
as possible, some configuration discrepancies might not appear until after you build a
schedule.

See also Consistency Check.

Schedule Server

A component that no longer exists in Genesys WFM 7.0 and later. See WFM Builder.

Back to Top

Schedule State Group

A collection of schedule states that is linked to a site. Schedule State Group configuration is very
important in order to correctly track adherence. You can include the following schedule states in
schedule state groups: breaks, meals, exception types, and activities configured for the site, Day
Off, Time Off, and No Activity. You associate each schedule state group with one or more Genesys
events, such as CallRinging or WaitForNextCall, and you can also include an additional reason
code (formerly an aux code) that further identifies what the agent is doing.

See also Reason Code.
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Schedule Summary

Both a view and a report in WFM that display a schedule’s service objectives, interaction volume,
average handling time, budget, and number of agents.

Schedule Validation Error

A scheduling problem severe enough to terminate the schedule building process. Errors are usually
caused by incorrect configuration information, but some are more serious and must be reported to
Genesys Customer Care. For a complete list of errors, see “Schedule Validation Errors” in WFM Web
for Supervisors Help.

See also Validation.

Schedule Validation Warning

A warning issued during scheduling. The scheduling algorithm ignores the encountered problem and
goes on. When the scheduling process generates (and stacks) too many warnings, memory
management problems can yield unrecoverable errors.

See also Validation.

Scheduling, Profile-Based

A scheduling method that enables the creation of blank schedules—that is, schedules that are
constructed from empty shift slots rather than by assigning actual agents to the specific shifts.
Agents are assigned to the schedule slots after the schedule is built. Using blank schedules, you can
construct schedules before hiring employees, or have agents bid on desirable schedule slots.

See also Profile Schedule and Profile.

Back to Top

Security Access

Limitations for certain users on access to information about some sites or objects. You configure
security settings in the User Security module in the WFM Configuration Utility. You can customize
user security so that only sites and objects for which the user has security authorization appear in
WFM tree views.

See also User Security.
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Service Level

A customer service goal that you define as the percentage of interactions handled within a time limit.
Service Level is one of the service objectives that you can set when building a staffing forecast.
WFM will receive actual Service Level statistics from Stat Server, and several views and reports within
WFM allow you to compare actual vs. forecasted and scheduled Service Levels.

Service Objective

The customer service goals that you set for Service Level, Occupancy, Average Speed of Answer,
Abandonment%, and so on. You set values for these goals in the Forecast Staffing Build Wizard in WFM
Web for Supervisors.

See also Service Level, Maximum Occupancy, Average Speed of Answer, and Abandonment
Percentage.

Shift

The possible work times at a site. Shifts are defined by time of day, duration, days of the week, and
so on. For example, you might have first, second, swing, night, front-of-week, or back-of-week shifts.

Back to Top

Single-Skill Equivalent

Sometimes referred to as SSE. A WFM calculation of the number of agents required in order to handle
the forecast workload, with the assumption that each agent has only one skill. Because multi-skilled
agents are more efficient than single-skilled agents, WFM factors in an efficiency constant to reflect
accurately the equivalence between single-skill equivalents and the actual agents who are being
scheduled.

See also Multi-Skilled Equivalent.

Site

The locations associated with an enterprise. Sites can sometimes correspond to switches in
Configuration Manager. Users must have appropriate security access to view and make changes for
sites. You can associate multiple sites to form a business unit. Formerly called contact center or
location.

See also Business Unit.
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Site Rule

Defines a site-specific parameter. You can set the Minimum Duration Between the End of the Day
and Start of Next Working Day, Maximum Start Time Difference for Members of the Same
Team, and Schedule Planning Period Type parameters on the Contracts General tab.

Skill

A work-related expertise, such as Billing or Spanish. Each work activity in WFM has a set of one or
more skills and skill levels associated with it, and an agent must possess those skills in order to be
scheduled to work on that activity. You define skills in Configuration Manager, and they become
available in WFM after you synchronize the WFM database with the Configuration Database in the
WFM Configuration Utility. Skill updates appear in WFM immediately, through automatic
synchronization that WFM Data Aggregator performs. If a skill is required for an activity, all agents
scheduled for that activity must have that skill.

Back to Top

Soft Restart

A feature that enables WFM Data Aggregator to accommodate configuration changes without
requiring a restart.

Split Interaction Volume

Division of the interaction volume forecast for a multi-site activity among the single-site activities
that make up the multi-site activity. If several single-site activities are open, WFM splits the volume
by using the ratio of the number of agents available to work each single-site activity, as determined
by their skillsets, whether they are multi-skilled, and their availability at a given timestep.

You lose coverage for the predicted interaction volume if none of the singlesite activities is open
during a particular timestep when the multi-site activity is open and has a forecast interaction
volume.

See also Multi-Site Activity and Multi-Site Activity Forecast.

Split Staffing

A division of staffing from the staffing forecast scenario of a multi-site activity. If a multi-site activity
has one or more associated activities, you can use the Staffing Split Wizard to split the result
between associated activities after building the calculated and required staffing. This functionality is
available only within a forecast scenario. See the ""Forecast > "Forecast Scenarios" > "Staffing Split
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Wizard" topic in Web for Supervisors Help.

Staffing

The number of agents with certain skills required in order to meet a certain interaction volume at a
certain time.

Statistic

WFM Data Aggregator collects, from Stat Server, information about statistics that are specific to WFM,
such as Interaction Volume, Handle Time, and Quality of Service. Use these statistics to assess
contact center performance and agent-adherence levels, as well as to build historical data for future
forecasting.

Back to Top

Suitability

The extent to which a schedule minimizes occasions when the number of agents working is greater
(overstaffed) or less (understaffed) than the number necessary to handle the actual workload.

Swapping

A feature that enables contact center managers to go into a published schedule and manually
exchange agent schedule assignments. This feature enables customized preference fulfillment in
cases where an agent with less seniority or a lower rank has had a preference granted in place of a
more senior or highly ranked agent.

Synchronization Constraint

A WFM parameter that you can set to ensure that an agent starts each workday at the same time for
a specified number of weeks, or for an entire schedule period. This feature enables more fixed,
predictable schedules. Synchronization includes a Flexibility option, which allows Scheduler to
vary the schedule start and end times within a specified range. Allowing some flexibility optimizes
schedules.
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Synchronization with Configuration Manager

A process that brings the data in the WFM database into correspondence with the data in the
Configuration Database. Synchronization enables changes made to agent, site, users (supervisors or
managers), time zone, or skill information in Configuration Manager to appear in WFM. You can use
the WFM Configuration Utility to manually perform a complete synchronization or to synchronize only
certain object types. In addition, WFM Data Aggregator automatically updates certain agent
information and agent skills settings without the need for manual synchronization.

Back to Top

T

Task

An activity that is selected as part of a task sequence.

See also Task Sequence.

Task Sequence

A defined period of time during which agents can work only on a specified set of tasks (called an
activity set). Task sequences enable you to control how much the nature of an agent’s work changes
during part of a day. You can prevent agents from being asked to jump constantly from activity to
activity, a situation that can result in agent confusion and fatigue, and lower productivity.

You configure task sequences for shifts. After a task sequence is configured, you can assign it to any
compatible shift in the same site.

See also Activity Set.

Team

A group of agents that is defined to suit scheduling and business requirements. You can organize
teams by agent skill sets, schedule, sales targets, achievements, geographies, or any other
factor—for example, tax-exempt bond fund specialists, e-mail agents, Christmas sales drive, and
platinum customer care. An agent can belong to only one team.
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Template

A set of data that you configure as a basis for forecasting, typically for sites that have little or no
historical activity, or those with historical data that is incomplete because of outages. Template types
include: Interaction Volume, Average Handling Time, Service Level, Interaction Volume
Data Overlap, Planned Overhead, Indirectly Occupied Time, Maximum Occupancy, and AHT
Overlap. Use the Staffing template to set intra-day staffing requirements.

Back to Top

Threshold

The amount of time before an agent is supposed to enter a particular schedule state; or, after the
schedule state ends, the amount of time that the agent can be in that state and still be considered to
be adhering to the schedule. For example, suppose that an agent is scheduled to start a shift at
12:00 PM, and the Start Before threshold is set to 5 minutes. If the agent starts the shift at 11:54
AM, which is beyond the 5-minute threshold, this appears on the adherence reports as a non-
adherent event.

Time Off

Formerly called vacation and of only one type. Now, you can configure multiple types, with different
parameters and different time-off rules. In WFM Web for Agents, agents use the Time Off module to
view, request, and remove time off.

See also Time-Off Type, Time-Off Limit, and Time-Off Rule.

Time-Off Limit

A feature located in the Calendar module of WFM Web for Supervisors. Use it to set the maximum
number of agents in each category (Activity, Team, and Site) who might have time off during a
particular timestep. You can set only one time-off limit for each time-off type. Formerly called
vacation limit.

Time-Off Rule

Parameters that define the accumulation of accrued time off, the allocation of awarded time off,
when and how many time-off hours can be carried over from year to year, the granting of time-off
requests, and so on. You create these rules and associate them with agents in the Time-Off Rules
module of the WFM Configuration Utility. Formerly called accrual rule.
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Time-Off Type

A module in the WFM Configuration Utility that you use to create the different time-off types that you
want to assign to agents and track using reports. You can configure one or more time-off rules for
each time-off type.

See also Time-Off Rule.

Back to Top

TimeProfile

A Stat Server parameter that WFM Data Aggregator uses to order statistics for WFM activities based
on a specific interval of time. This time interval is configured in Stat Server as the TimeProfile
parameter.

TimeRange

A Stat Server parameter that WFM Data Aggregator uses to request that service-level statistics be
calculated based on the specified time interval. Usually, service level is calculated as X% of calls
answered in Y seconds. The Y seconds must be configured as the TimeRange parameter.

Trading

Enables agents with compatible schedules to trade them. Agents can do this by using the WFM Web
for Agents interface. Supervisors can view, approve, and decline trades by using the WFM Web for
Supervisors interface. Agents can propose trades to all agents with compatible schedules, or they can
send trade invitations only to specific individuals. Agent trades that fulfill all constraints are
automatically accepted, reducing the time needed for supervisors to review trades.

Tree View

The lower-left pane (the Objects pane) of the WFM Configuration Utility and WFM Web interfaces
contains a tree structure that displays some objects. The top level in the hierarchy represents the
enterprise, and under this level you will see objects associated with whichever module is selected on
the Modules pane, which is located above the Objects pane.

Back to Top
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U

Understaffing

Fewer agents have been scheduled than are required for the workload.

Universal Modeling Engine

A forecasting method that uses a complex algorithm to identify trends and patterns in historical data,
and then creates a forecast based on these trends and patterns. The Universal Modeling Engine
requires more than one year’s worth of historical data. The engine is configured to disregard days in
the historical data that contain special events if no such events occur during the forecast period. This
eliminates some misleading “noise” from the forecasts. If an event occurs in the forecast, the impact
is extracted from historical data and applied to the baseline forecast. The Universal Modeling Engine
is best suited to sites with a large quantity of high-quality historical data.

Unplanned Overhead

The percentage of agents who are being paid, but who are not working. For example, an agent may
be on time off, out sick, or on a company-sponsored holiday. You can provide an estimate for
unplanned overhead when building a staffing forecast, and then compare this to the actual
unplanned overhead in the Actual Overheads Report. The unplanned overhead percentage is also
used as part of the Estimated Budget calculation.

Tip
Unplanned overhead percentages do not affect the staffing requirement forecast.

Formerly named Nonworking Overhead.

Back to Top

User Security

A module in the WFM Configuration Utility that you use to set security access limitations for all
nonagent users. You can limit access to specific sites, teams, activities, and so on. In some cases, you
can configure some users to have view-only access to WFM objects, and others to have full access.
You can also grant permission to edit the schedule without having the changes incorporated into the
official version of the schedule.
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See also Security Access, Pending Schedule Changes, and Modules Pane.

User Time Zone

A time zone other than the local one. You can choose to have the timesteps in the Performance
Intra-Day and Graphs windows labeled with the time in the user time zone. You do this by selecting
the User Time Zone button on the Actions toolbar or selecting User Time Zone from the Actions
menu.

For example, suppose that your local contact center is in Pacific time, and the current time is 1:00
PM. Furthermore, suppose that the user time zone is eastern standard time, and the current time is
4:00 PM. If you select User Time Zone, the labels for the current timestep in the Performance Intra-
Day and Graphs windows change to 4:00 PM. The performance data does not change.

Additionally, reports that you view after selecting User Time Zone display timesteps that correspond
to the time at which the events reported on happened in the user time zone.

Formerly called alternative time zone.

Back to Top

V

Vacation

See Time Off.

Validation

The process that Scheduler uses to check schedule settings against various constraints, such as
activity open hours and agent availability, when you build a schedule. If there are inconsistencies
that might cause the schedule you have configured to be unworkable, Scheduler generates warnings
or errors.

If there are only warnings, Scheduler builds the schedule and displays the warnings in the Schedule
Validation window. These short warnings indicate what you should do to correct the problem. For a
list of schedule validation warnings, with explanations of their meanings, see the “Schedule
Validation” topic in the WFM Web for Supervisors Help.

See also Schedule Validation Warning.

More serious inconsistencies result in schedule errors, which prevent Scheduler from publishing the
schedule at all. For a list of schedule validation errors, with explanations of their meanings, see the
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“Schedule Validation” topic in the WFM Web for Supervisors Help.

See also Schedule Validation Error.

Version

Information about the release number and database version of the instance of the WFM Configuration
Utility, WFM Database Utility, or WFM Web you are running. To see this information, click About on the
main toolbar in any of these applications. The About window displays the program release number,
database version, database update status, data source, and user name. If the WFM database has not
been updated and therefore is not compatible with the current release of WFM, the Database Update
field in the Configuration Utility About window appears in red.

Virtual Activity

See Multi-Site Activity.

Back to Top

Virtual Agent

Not used in Workforce Management 7.1 and later.

Virtual Contact Center

See Business Unit.

Virtual Forecast

See Multi-Site Activity Forecast and Split Interaction Volume.

Virtual Switch

See Business Unit.
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Virtual Team

Not used in Workforce Management 7.1 and later.

Virtual Workforce

Not used in Workforce Management 7.1 and later. See Business Unit Staffing.

Back to Top

W

Warning

See Schedule Validation Warning.

Weekly Pattern

A sequence of days configured to be part of a rotating pattern. Weekly pattern settings include days
off, shifts, start times, and paid hours.

WFM Builder

A WFM server that builds the WFM schedules. This functionality was formerly provided by Schedule
Server.

WFM Configuration Utility

A WFM application that you can use to configure enterprise objects such as Agents, Activities, and
Rotating Patterns; Policies objects such as working hours, activity open hours, and time-off
rules and user security settings; and that you can use to import and export historical data. This
functionality was formerly provided in the Workforce Manager application.
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WFM Data Aggregator

A WFM server that collects data for each activity, such as the number of interactions or the average
handling time. The data is compared to planned values in the Adherence and Performance modules.

Back to Top

WFM Database Utility

A utility that includes various database-related functionality, including database creation, backup/
restore, updating, and maintenance. The backup feature copies all of the WFM database tables into a
local file in Microsoft Access database (.MDB) format. The restore feature saves the data from the
.MDB file to the WFM database.

WFM Reports Server

A WFM server dedicated to creating the WFM reports. Starting with Workforce Management 7.2, a
separate WFM Web application is used as the dedicated reports server. In pre 7.2 releases, WFM
contained a WFM Reports Server component.

WFM Server

A server that manages all the requests from the WFM Web application—for example, retrieving agent
schedules upon request and providing them to WFM Web. WFM Server manages the requests and
responses from WFM Web applications, from the WFM database, and from all the other WFM
components (such as WFM Builder). WFM Server also writes to the WFM database any changes made
in the WFM Web Schedule window.

WFM Web

The WFM component that enables agents and supervisors to harness the power and convenience of
the Web to access and use WFM. WFM Web makes realtime and past performance data available
whenever it is needed. WFM Web has two parts: Supervisor and Agent.

Supervisors can use WFM Web to create forecasts, create and monitor schedules, make schedule
changes, view and approve or deny schedule trade requests, view contact center performance,
monitor real-time agent adherence, and view reports.

Agents can use WFM Web to check scheduled activities and working hours; communicate preferred
shift, working hours, and time-off requests to administrators; and make schedule trades with other
agents.

List of Terms Multi Forecasting Primer

Workforce Management Administrator's Guide 381



Back to Top

What-If Scenario

A feature within the WFM Web Performance module that you can use to create a model of intra-day
contact center performance under different conditions that you configure. With the What-If Scenario
feature, you can modify several performance values and then recalculate the service-objective
impact based on the modified data. For example, you can use a what-if scenario to assess the
potential impact of a change in site staff attendance, or the effect of a higher call volume on service
objectives.

Workforce

See Staffing.

Workforce Access Group

Not used in Workforce Management 7.1 and later. See User Security.

Working Agents

Those agents who are logged in.
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